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คาํนํา 

ในระยะเวลาหลายสบิปีทีผ่า่นมา แม ้Excel ถกูพัฒนาใหเ้ป็นโปรแกรมทีเ่ป็นประโยชนม์ากขึน้ มี

คําสัง่และมเีครือ่งมอืใหม่ๆ เตรยีมไวใ้หเ้ลอืกใชม้ากขึน้กวา่แตก่อ่นก็ตาม ทัง้ๆที ่Excel จะเป็น 

Excel ไดก้็เพราะการมสีตูรเพือ่ใชใ้นการคํานวณ แตต่วัสตูรที ่Excel มอียูก่ลบัมกีารเปลีย่นแปลง

นอ้ยมาก มสีตูรใหมท่ีจํ่าเป็นตอ่การใชง้านเกดิขึน้เพยีงเล็กนอ้ยเทา่นัน้ สว่นทีเ่ปลีย่นแปลงสตูร

ใน Excel 2010 ก็มุง่ปรับปรงุใหม้คีวามละเอยีดในการคํานวณยิง่ขึน้ 

หลกัสตูรฉลาดใชส้ารพัดสตูร Excel อยา่งมอือาชพีก็ผา่นรอ้นผา่นหนาวมาหลายปีเชน่กนั 

หลกัสตูรนีมุ้ง่ใหผู้ใ้ช ้Excel รูจั้กคดิ ฉลาดเลอืกใชส้ตูร Excel ใหถ้กูกบัสถานการณ์ โดยเลอืก

เฉพาะสตูรทีม่คีวามจําเป็นตอ้งนํามาใชง้านขึน้มาอบรมเพือ่ทราบขอ้ด ีขอ้เสยี และขอ้ควรระวงั 

แนะนําวธิคีดิออกแบบตารางใหเ้หมาะสมกบัการคํานวณ และหาทางกระตุน้ใหผู้เ้ขา้อบรมเรยีนรู ้

วธิแีกปั้ญหาไดด้ว้ยตวัเอง 

อยา่งไรก็ตามเนือ่งจากระยะเวลาอบรมมเีพยีง 3 วนั ไมส่ามารถแนะนําเรือ่งราวและถา่ยทอด

ประสบการณ์การใชส้ตูรไดค้รบถว้น จงึขอแนะนําใหอ้า่นคูม่อืเลม่นีซ้ ึง่มเีนือ้หาทีอ่าจไมม่โีอกาส

หยบิยกขึน้มาอบรมอยูอ่กีมาก 

คูม่อืประกอบการอบรมเลม่นีไ้ดร้วบรวมเนือ้หาสําคญัของหลายหลกัสตูร ทัง้หลกัสตูรสดุยอด

เคล็ดลบัและลดัของ Excel หลกัสตูรหนัมาใช ้Excel จัดการฐานขอ้มลูแทน Access กนัดกีวา่ 

และหลกัสตูรประยกุตใ์ช ้Excel เพือ่วางแผนความตอ้งการวสัดแุละจัดตารางการผลติ ตลอดจน

การใชส้ตูรใน VBA อกีทัง้ไดนํ้าตวัอยา่งคําถามคําตอบและสตูรแบบแปลกๆจากเว็บหลายแหง่

มารวมไว ้จงึหวงัวา่ผูเ้ขา้อบรมจะไดเ้ปิดหเูปิดตาและไดแ้นวทางนํากลบัไปสรา้งงานของตน 

ประเด็นสําคญัของการสรา้งสตูร คอื ตอ้งรูจั้กคดิและสรา้งสตูรไดด้ว้ยตวัเอง มใิชล่อกสตูรของ

คนอืน่มาใชแ้ลว้แกะหรอืแกไ้ขตอ่ใหด้ขี ึน้กวา่เดมิไมเ่ป็น 

 

       สมเกยีรต ิฟุ้งเกยีรต ิ

         17เมษายน 2555 
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วธิปีรบั Excel ใหพ้รอ้ม 

ตอ่การใชง้านอยา่งมอือาชพี 

1. ตอ้งการปรบัใหก้ดปุ่ ม Enter เพือ่

บนัทกึคา่แลว้อยูท่ ีเ่ซลลเ์ดมิ สัง่ 

File > Options > Advanced > ตดั

กาชอ่ง After pressing Enter, 

Move selection  

 

ทัง้นีใ้น Excel 2007 สัง่ Office > 

Excel Options แทน File > 

Options > 

 

(Excel 2003 : Tools > Options > Edit > ตดักาชอ่ง Move selection after Enter) 

 

2. ตอ้งการปรบัใหก้ดปุ่ ม F2 เพือ่ Edit แกไ้ขบน Formula Bar แทนในเซลล ์สัง่ File > 

Options > Advanced > ตดักา

ชอ่ง Allow editing directly in 

cells  

 

(Excel 2003 : Tools > Options 

> Edit > ตดักาชอ่ง Edit directly 

in cell) 

 

คําสัง่นีย้งัมผีลทําใหเ้มือ่ดับเบลิคลกิทีเ่ซลลส์ตูรแลว้ Excel จะยา้ยตําแหน่งไปยงัตําแหน่ง

เซลลต์น้ทางทีอ่า้งองิในสตูรนัน้ และเมือ่กดปุ่ ม F5 > Enter จะยา้ยกลบัมาทีเ่ซลลเ์ดมิที่

เคยดบัเบลิคลกิ 
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3. ตอ้งการเปลีย่นระบบการคาํนวณเป็น manual สัง่ File > Options > Formulas > กา

ชอ่ง Manual จากนัน้ตอ้งกดปุ่ ม F9 เพือ่สัง่คํานวณทกุแฟ้มหรอืกด Shift+F9 เพือ่สัง่

คํานวณเฉพาะแฟ้มทีเ่ลอืกอยูเ่ทา่นัน้ 

(Excel 2003 : Tools > Options > Calculation > กาชอ่ง Manual) 

 

หมายเหต ุระบบการคํานวณจะเปลีย่นตามระบบของแฟ้มแรกทีเ่ปิดขึน้กอ่นเสมอ 

 

4. ตอ้งการเปิดใหใ้ช ้Macro และ Update Links ไดอ้ตัโนมตัทิกุแฟ้มในโฟลเดอรท์ ี่

กาํหนดวา่ปลอดภยั สัง่ File > Options > Trust Center > กดปุ่ ม Trust Center 

Settings... (Excel 2003 : Tools > Macro > Security > Security Level > กาชอ่ง 

Medium) 

 

 

เลอืกเมนู Trusted Locations จากเมนูดา้นซา้ย จากนัน้กดปุ่ ม Add new location... เพือ่
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เลอืกชือ่โฟลเดอร ์(Trusted Folder) ตามตอ้งการ  

 

นอกจากนีสํ้าหรับ Excel 2010 เป็นตน้มายงัมเีมนู Trusted Documents เพือ่ใชค้วบคมุการ

เปิดแฟ้มเพือ่ทําใหแ้ฟ้มใดทีเ่คยเปิดโดยให ้Macro ทํางานหรอื Update Links มากอ่นก็จะ

เปิดแบบนัน้ใหเ้องในคราวตอ่ไป 
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การกาํหนดตาํแหนง่อา้งองิ 

บทความนีม้จีดุประสงคใ์หผู้ท้ีเ่คยใช ้Excel มากอ่นและมพีืน้ฐานมาบา้งจนพอทราบวา่ตําแหน่ง

อา้งองิ (Cell Reference) ในตาราง Excel คอือะไรและนําไปใชก้นัอยา่งไร จะไดเ้ปิดหเูปิดตา

เรยีนรูเ้คล็ดลบัทีค่นทัว่ไปอาจมองขา้มหรอืไมน่กึฝันวา่จะเป็นไปได ้แลว้สามารถนําตําแหน่ง

อา้งองิไปใชก้บัสตูรและคําสัง่ไดอ้ยา่งพลกิแพลงมากยิง่ขึน้ โดยเฉพาะการเลอืกใสเ่ครือ่งหมาย 

$ ใหก้บัตําแหน่งอา้งองินัน้ ไมว่า่จะเป็น $ ในเซลลส์ตูร, $ ใน Conditional Format, $ ใน 

Data Validation, หรอื $ ในในเครือ่งมอือืน่ๆของ Excel ก็ตาม ผมถอืวา่ $ เป็นหวัใจของการใช ้

Excel ทเีดยีว 

ต ัง้หลกักนักอ่นวา่จะใช ้Excel อยา่งคอมพวิเตอร ์

คณุลองนกึดซูวิา่มนุษยเ์ราไดรั้บประโยชนจ์ากการใชเ้ครือ่งคอมพวิเตอรต์า่งจากสมยัทีย่งัมแีต่

เครือ่งคดิเลขใหใ้ชก้นัอยา่งไรบา้ง หลายคนน่าจะตอบวา่ เครือ่งคอมพวิเตอรต์อ้งชว่ยใหคํ้าตอบ

ทีเ่ร็วกวา่เครือ่งคดิเลขใชไ่หม แลว้ความเร็วทีว่า่นีถ้กูวดัมาจากเวลาทีใ่ชไ้ปของเครือ่ง

คอมพวิเตอรห์รอืเวลาของคณุกนัละ่ 

แน่นอนทีส่ดุวา่เครือ่งคอมพวิเตอรย์อ่มทํางานเร็วกวา่เครือ่งคดิเลข และเครือ่งคอมพวิเตอรร์ุน่

ใหมย่อ่มทํางานไดเ้ร็วกวา่เครือ่งคอมพวิเตอรร์ุน่เกา่ ยิง่ใช ้Excel ทีต่ดิตัง้บนเครือ่งคอมพวิเตอร์

รุน่ลา่สดุ ก็ยิง่ไดคํ้าตอบผลลพัธจ์ากการคํานวณเร็วขึน้ ซึง่ถา้ใครหลงเขา้ใจวา่ตวัเองใช ้Excel 

แบบคอมพวิเตอรเ์ป็นอยูแ่ลว้เพยีงเพราะดจูากความเร็วของเครือ่งคอมพวิเตอรท์ีใ่ชอ้ยู ่ก็เป็น

ความเขา้ใจทีถ่กูตอ้งเพยีงบางสว่น (และเป็นสว่นทีไ่มสํ่าคญัเทา่ใดเสยีดว้ย) เพราะถา้คณุใช ้

Excel อยา่งคอมพวิเตอรเ์ป็น ตอ่ใหย้กเครือ่งคอมพวิเตอรร์ุน่โบราณทีทํ่างานชา้เป็นเตา่ ก็จะ

พบวา่คณุไมไ่ดเ้สยีเวลาตา่งกนัมากนัก 

ลกัษณะของการใช ้Excel อยา่งคอมพวิเตอรม์ดีงันี ้

1. คณุจะตอ้งเสยีเวลาสรา้งงานนานหน่อย เนือ่งจากตอ้งหาทางคดิสรา้งงานใหเ้หมาะสม

กบัแตล่ะสถานการณ์ ซึง่คณุควรตัง้หลกัไวว้า่ แฟ้มงานทีส่รา้งขึน้มานัน้ จะตอ้งสามารถ

นํากลบัมาใชซ้ํ้าแลว้ซํ้าอกีไดโ้ดยไมต่อ้งยอ้นกลับไปแกไ้ขใหมอ่กีแมแ้ตน่อ้ย 
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2. หากจําเป็นตอ้งแกไ้ข ตอ้งสามารถแกไ้ขปรับปรงุแฟ้มไดง้า่ย ใชเ้วลาไมม่าก และไม่

สง่ผลกระทบตอ่การคํานวณเดมิทีถ่กูตอ้งอยูแ่ลว้ ทัง้นีไ้มว่า่จะกําหนดใหผู้ท้ีทํ่าหนา้ที่

แกไ้ขนัน้คอืคณุซึง่เป็นผูส้รา้งแฟ้มนัน้เอง หรอืแมแ้ตจ่ะเป็นผูอ้ืน่ซึง่ไมเ่คยใชแ้ฟ้มนัน้มา

กอ่นก็ตาม 

3. สามารถลดจํานวนคนและไมต่อ้งเพิม่อตัรากําลงัคนตามปรมิาณงานทีเ่พิม่ขึน้ 

4. ประหยดัเงนิลงทนุ เพราะไมต่อ้งจา่ยเพือ่ซือ้เครือ่งหรอืโปรแกรมคอมพวิเตอรร์ุน่ใหม ่

5. คณุตอ้งมคีวามสขุและมเีวลาวา่งใหก้บัชวีติมากขึน้ 

สตูรฉลาด (Smart Formula) 

Smart Formula แปลวา่ สตูรฉลาด ซึง่สตูรฉลาดทีว่า่นีจ้ะฉลาดไดก้็ตอ่เมือ่ใชค้วามฉลาดของ

คณุในการสรา้งสตูรขึน้มา เพือ่ใหม้ลีกัษณะการใชง้านไดต้ามนี ้

ในชทีหนึง่ๆหรอืตารางหนึง่ๆ ตอ้งมสีตูรตน้ฉบบัเพยีงเซลลเ์ดยีว ซึง่สามารถนําไปใชไ้ด ้

กบัเซลลอ์ืน่ๆไดท้ัง้ตาราง แลว้เมือ่ใดทีจํ่าเป็นตอ้งแกไ้ขสตูรใหม ่ก็จัดการแกไ้ขสตูรนี้

เพยีงเซลลเ์ดยีวแลว้ Copy นําไป Paste เพือ่ใชไ้ดก้บัทกุเซลลใ์นตาราง 

ในโครงสรา้งของตวัสตูรฉลาดอาจใชว้ธิกํีาหนดตําแหน่งอา้งองิแบบเซลลเ์ดยีวหรอืแบบกําหนด

ขอบเขตตารางก็ได ้โดยไมว่า่จะใชว้ธิใีดก็หลกีหนกีารกําหนดตําแน่งอา้งองิทีม่เีครือ่งหมาย $ 

กํากบัตําแหน่ง 3 แบบตอ่ไปนีไ้ปไมพ่น้ 

• ตาํแหนง่อา้งองิแบบ Absolute Reference มเีครือ่งหมาย $ วางไวด้า้นหนา้ของทัง้

ตําแหน่ง Row และ Column เชน่ =$A$1 โดยใหใ้ชตํ้าแหน่งอา้งองิแบบนีก้บักรณีที่

ตอ้งการนําคา่คงทีไ่ปใช ้

• ตาํแหนง่อา้งองิแบบ Relative Reference เป็นตําแหน่งอา้งองิซึง่ไมม่เีครือ่งหมาย 

$ เชน่ =A1 ซึง่สตูรทีอ่า้งองิแบบนีจ้ะตอ้งใชท้ีเ่ซลลเ์ดมิเซลลเ์ดยีวไปตลอด ไมส่ามารถ 

Copy นําไป Paste เพือ่ทําใหไ้ดค้า่เดมิซํ้าทีเ่ซลลอ์ืน่ไดอ้กี เพราะตําแหน่งอา้งองิจะ

เขยือ้นตา่งจากตําแหน่งเดมิเสมอ ดงันัน้จงึเป็นการอา้งองิแบบทีใ่ชใ้นเซลลส์ตูรกนันอ้ย

ทีส่ดุ แตก่ลบัถกูนํามาใชก้นัมากใน Conditional Formatting หรอื Data Validation 

• ตาํแหนง่อา้งองิแบบ Mixed Reference เป็นตําแหน่งอา้งองิทีน่ยิมใชก้นัมากทีส่ดุ 

โดยผูส้รา้งสตูรตอ้งเลอืกใสเ่ครือ่งหมาย $ ดา้นหนา้ตําแหน่ง Row หรอื Column เพยีง

อยา่งใดอยา่งหนึง่ เชน่ =A$1 เพือ่คงตําแหน่ง Row 1 ไวต้ามเดมิตลอด หรอื =$A1 



11 

 

Copyright of www.ExcelExpertTraining.com 

เพือ่คงตําแหน่ง Column A ไวต้ามเดมิตลอด ไมว่า่จะ Copy นําสตูรไป Paste ที่

ตําแหน่งอืน่ก็ตาม 

วธิสีรา้งสตูรใหม้ตํีาแหน่งอา้งองิทีม่เีครือ่งหมาย $ นําหนา้ตําแหน่งของ Row และหรอื Column 

นี ้ใหใ้ชว้ธิ ีPointing แลว้กดปุ่ ม F4 ซํ้าไปเรือ่ยๆจนกวา่จะไดตํ้าแหน่ง $ ตามตอ้งการ 

1. ใหเ้ริม่จากพมิพเ์ครือ่งหมายเทา่กบั = ลงไปในเซลลท์ีต่อ้งการสรา้งสตูร (เพือ่แสดงการ

ยดึครองเซลลนั์น้ไวก้อ่นวา่ เป็นเซลลท์ีจ่ะรับสตูรลงไปเมือ่เรากดปุ่ ม Enter) 

2. จากนัน้ใชว้ธิชี ีล้งไปในเซลลท์ีต่อ้งการ (Pointing แปลวา่ ชี)้ โดยใช ้Mouse คลกิเลอืก

เซลลท์ีต่อ้งการ ไมว่า่จะอยูต่า่งชทีหรอืตา่งแฟ้มกนัก็ตาม เชน่ คลกิทีเ่ซลล ์A1 จะได ้

สตูร =A1 

3. จากนัน้ใหก้ดปุ่ ม F4 ไปเรือ่ยๆ จะพบวา่มเีครือ่งหมาย $ แทรกลงในสตูรใหเ้องตามลําดบั

ทีม่กีารกดปุ่ ม F4 ดงันี ้A1  $A$1  A$1  $A1  A1  แลว้จะมเีครือ่งหมาย $ 

วนซํ้าไปอกี 

4. เมือ่ไดตํ้าแหน่ง $ ควบคมุตําแหน่ง Row และหรอื Column ตามตอ้งการแลว้ใหก้ดปุ่ ม 

Enter เพือ่รับสตูรลงไปในเซลล ์แลว้จะพบวา่ Excel จะพากลบัมาทีเ่ซลลซ์ึง่พมิพ์

เครือ่งหมายเทา่กบันําหนา้สตูรเอาไวต้ัง้แตแ่รกน่ันเอง 

การใสเ่ครือ่งหมาย $ เพือ่เป็นการควบคมุตําแหน่งอา้งองิไวไ้มใ่หเ้ขยือ้นนี ้นอกเหนอืจากการทํา

ใหค้ณุสามารถ Copy สตูรไปใชใ้นเซลลอ์ืน่ไดท้ันทแีลว้ ยงัเป็นเรือ่งน่าสงัเกตวา่ชว่ยทําใหแ้ฟ้ม

มขีนาดเล็กลงกวา่แฟ้มทีม่สีตูรซึง่ไมม่ ี$ กําหนดไวเ้ลย (ขอใหท้ดลองลบเครือ่งหมาย $ ทิง้

จากสตูรในตารางขนาดใหญเ่พือ่เปรยีบเทยีบดขูนาดแฟ้ม โดยใชคํ้าสัง่ Replace เครือ่งหมาย $ 

แตไ่มไ่ด ้Replace with ดว้ยเครือ่งหมายใด) 

นอกจากตําแหน่งอา้งองิทีต่อ้งมเีครือ่งหมาย $ เป็นองคป์ระกอบสําคญัแลว้ ในโครงสรา้งของ

สตูร Smart Formula ยงัอาจจําเป็นตอ้งพึง่สตูร IF, And, Or หรอืสตูรอืน่ๆซึง่ทําหนา้ทีต่ดัสนิใจ 

เพือ่ชว่ยทําใหส้ตูรมเีงือ่นไขในการคํานวณตา่งไปจากเดมิไดเ้องทนัท ีเมือ่มกีารนําสตูรเดยีวกนั

ไปใชซ้ํ้าทีตํ่าแหน่งเซลลอ์ืน่ 
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ตวัอยา่ง Smart Formula แบบใชต้ําแหนง่อา้งองิเซลลเ์ดยีว 

ขอใหส้รา้งตารางสตูรคณู ซึง่นําตวัเลขบนหวัตารางมาคณูกบัตวัเลขดา้นขา้งซา้ยของตาราง 

 

ขัน้ตอนการสรา้ง 

1. เริม่จากเลอืกเซลล ์C3 แลว้พมิพเ์ครือ่งหมายเทา่กบั = ลงไป 

2. จากนัน้คลกิเซลล ์C2 จะไดส้ตูร =C2 

3. กดปุ่ ม F4 เพือ่เปลีย่นสตูรใหเ้ป็น =C$2 

4. พมิพเ์ครือ่งหมายคณู * 

5. จากนัน้คลกิเลอืกเซลล ์B3 จะไดส้ตูร =C$2*B3 

6. กดปุ่ ม F4 เพือ่เปลีย่นสตูรเป็น =C$2*$B3 

7. กดปุ่ ม Enter เพือ่รับสตูรลงไปในเซลล ์C3 

8. Copy ไปทบัตาราง C3:F5 

คําอธบิาย 

• เซลล ์C3 เป็นเซลลท์ีม่สีตูร Smart Formula ซึง่โดยทัว่ไปจะเลอืกใหเ้ซลลห์วัมมุ

ดา้นซา้ยบนของตารางเป็นเซลลท์ีม่สีตูร Smart Formula 

• คณุอาจเลอืกสรา้งสตูรคณูโดยใชเ้ลข 2 นําหนา้แลว้นําไปคณูกบัเลข 10 เพือ่ทําใหไ้ด ้

สตูร =C$2*$B3 หรอืจะเลอืกใชเ้ลข 10 นําหนา้แลว้นําไปคณูกบัเลข 2 ซึง่จะทําใหเ้กดิ

สตูร =$B3*C$2 ก็ไดแ้ละทําใหเ้กดิผลลพัธถ์กูตอ้งเทา่กนัทัง้สองแบบ แตข่อแนะนําให ้

สรา้งพฤตกิรรมในการสรา้งสตูรของตนวา่ “ทกุสตูรทีส่รา้งขึน้จะนําตาํแหนง่อา้งองิ

ตามแนวนอนขึน้กอ่นตาํแหนง่อา้งองิตามแนวต ัง้เสมอ” ซึง่หลกันีจ้ะชว่ยใหค้ณุแกะ

สตูรของตวัเองไดง้า่ยขึน้ และหากสงัเกตสตูรอืน่ๆของ Excel เชน่ Index หรอื Offset 



13 

 

Copyright of www.ExcelExpertTraining.com 

จะใชตํ้าแหน่งอา้งองิจากแนวนอน Row ขึน้กอ่นตําแหน่งอา้งองิจากแนวตัง้ Column 

เชน่กนั 

• C$2 ตอ้งมเีครือ่งหมาย $ วางไวห้นา้เลข 2 เนือ่งจากตารางสตูรคณูนีม้ ีRow 2 เป็น

ตําแหน่งอา้งองิทีต่อ้งควบคมุไวไ้มใ่หเ้ปลีย่น สว่นตวั C ไมต่อ้งมเีครือ่งหมาย $ นําหนา้ 

เพือ่ปลอ่ยให ้C เปลีย่นตําแหน่งเป็น Column D E F หรอื Column อืน่ๆตามแตว่า่จะใช ้

สตูรนีห้รอืไม ่

• $B3 ตอ้งมเีครือ่งหมาย $ วางไวห้นา้ Column B เนือ่งจากตารางสตูรคณูนีม้ ีColumn B 

เป็นตําแหน่งอา้งองิทีต่อ้งควบคมุไวไ้มใ่หเ้ปลีย่น สว่นเลข 3 ไมต่อ้งมเีครือ่งหมาย $ 

นําหนา้ เพือ่ปลอ่ยใหเ้ลข 3 เปลีย่นตําแหน่งเป็น Row 4 5 6 หรอื Row อืน่ๆตามแตว่า่

จะใชส้ตูรนีห้รอืไม ่

• หลกัการใสเ่ครือ่งหมาย $ นี ้ใหจํ้าไวว้า่ “ถา้ตําแหน่งอา้งองิในสตูรมาจากคา่ตาม

แนวนอน ใหใ้ส ่$ ไวห้นา้ Row (เพราะ แนวนอน = Row) แตถ่า้ตําแหน่งอา้งองิในสตูร

มาจากคา่ตามแนวตัง้ ใหใ้ส ่$ ไวห้นา้ Column (เพราะ แนวตัง้ = Column)” 

ตวัอยา่ง Smart Formula แบบใชต้ําแหนง่อา้งองิตามขอบเขตพืน้ทีห่วั

ตาราง 

ขอใหส้รา้งตารางสตูรคณู ซึง่นําตวัเลขบนหวัตารางมาคณูกบัตวัเลขดา้นขา้งซา้ยของตาราง 

 

วธิกีารสรา้งคลา้ยกบัวธิแีรก แทนทีจ่ะคลกิเลอืกเซลล ์C2 หรอืเซลล ์B3 วธินีีใ้หค้ลกิเลอืกเซลล ์

C2:F2 และ B3:B5 ซึง่เป็นหวัตารางดา้นบนและดา้นซา้ยทัง้หมด แลว้กดปุ่ ม F4 เพือ่ทําใหเ้กดิ

สตูร =$C$2:$F$2*$B$3:$B$5 

1. เริม่จากเลอืกเซลล ์C3 แลว้พมิพเ์ครือ่งหมายเทา่กบั = ลงไป 

2. จากนัน้คลกิเลอืกเซลลบ์นหวัตารางดา้นบนจากเซลลเ์ลข 2 - 5 จะไดส้ตูร =C2:F2 
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3. กดปุ่ ม F4 เพือ่เปลีย่นสตูรใหเ้ป็น =$C$2:$F$2 

4. พมิพเ์ครือ่งหมายคณู * 

5. จากนัน้คลกิเลอืกเซลลบ์นหวัตารางดา้นซา้ยจากเซลลเ์ลข 10 - 30 จะไดส้ตูร 

=$C$2:$F$2*B3:B5 

6. กดปุ่ ม F4 เพือ่เปลีย่นสตูรเป็น =$C$2:$F$2*$B$3:$B$5 

7. กดปุ่ ม Enter เพือ่รับสตูรลงไปในเซลล ์C3 

8. Copy ไปทบัตาราง C3:F5 

คําอธบิาย 

• สตูรแบบทีอ่า้งองิกบัตําแหน่งทัง้หมดบนหวัตารางหรอืขา้งตาราง แลว้ใสเ่ครือ่งหมาย $ 

ใหก้บัตําแหน่งทัง้ Row และ Column นี ้ผมตัง้ชือ่เรยีกวา่ สตูรแบบลอ้มร ัว้ โดยทีส่ตูร 

=$C$2:$F$2*$B$3:$B$5 จะทําหนา้ทีนํ่าตําแหน่งอา้งองิบนรัว้ตามแนวตัง้ฉากทีต่ดักนั

มาคณูกนัทลีะตวัใหเ้อง ทําใหไ้มต่อ้งคอยพะวงวา่จะตอ้งเลอืกใสเ่ครือ่งหมาย $ เพือ่

ควบคมุตําแหน่งอา้งองิตามแนวใดเป็นหลกั 

• ถา้เปรยีบเทยีบกบัสตูรคณูวธิแีรกซึง่ใชตํ้าแหน่งอา้งองิแบบเซลลเ์ดยีว จะพบวา่การใช ้

สตูรอา้งองิแบบเซลลเ์ดยีวมคีวามยดืหยุน่มากกวา่ เชน่เมือ่หวัตารางมขีนาดใหญม่ากขึน้ 

ก็สามารถ Copy สตูรไปใชต้อ่ไดท้ันท ีแตถ่า้สรา้งสตูรแบบลอ้มรัว้ จะตอ้งสรา้งสตูรใหม่

เพือ่กําหนดตําแหน่งอา้งองิในสตูรใหม้ขีนาดขยายตาม (เวน้แตว่า่คณุทราบวธิขียาย

ขอบเขตตําแหน่งอา้งองิ ซึง่จะนํามาอธบิายตอ่ไปในภายหลงั) 

• จดุออ่นของสตูรแบบลอ้มรัว้ก็คอื สตูรแบบนีใ้สเ่ครือ่งหมาย $ ควบคมุตําแหน่งแบบ 

Absolute จงึคํานวณหาคําตอบใหไ้ดเ้ฉพาะตารางจาก C3:F5 ซึง่อยูภ่ายในขอบเขต

ของรัว้เป็นแนวของตําแหน่งคงที ่หาก Copy สตูรไปใชน้อกรัว้จะเกดิ Error ขึน้ตามรปู 
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ตวัอยา่ง Smart Formula แบบใชต้ําแหนง่อา้งองิแบบ Array ตาม

ขอบเขตพืน้ทีห่วัตาราง 

ขอใหส้รา้งตารางสตูรคณู ซึง่นําตวัเลขบนหวัตารางมาคณูกบัตวัเลขดา้นขา้งซา้ยของตาราง 

 

ขัน้ตอนการสรา้ง 

1. แทนทีจ่ะเลอืกเซลล ์C3 เพยีงเซลลเ์ดยีว คราวนีใ้หเ้ลอืกพืน้ทีต่ารางจากเซลล ์C3:F5 

ทัง้หมดพรอ้มกนัไวก้อ่น 

2. จากนัน้พมิพเ์ครือ่งหมายเทา่กบั = 

3. คลกิเลอืกเซลล ์C2:F2 บนหวัตาราง จะไดส้ตูร =C2:F2 

4. พมิพเ์ครือ่งหมายคณู * 

5. คลกิเลอืกเซลล ์B3:B5 จากขา้งตาราง จะไดส้ตูร =C2:F2*B3:B5 

6. จากนัน้แทนทีจ่ะกดปุ่ ม Enter ใหก้ดปุ่ ม Ctrl+Shift+Enter พรอ้มกนัทเีดยีว 3 ปุ่ ม จะ

ทําใหเ้กดิเครือ่งหมายวงเล็บปีกกาปิดหวัทา้ยสตูรใหเ้องกลายเป็น {=C2:F2*B3:B5} 

คําอธบิาย 

• สาเหตทุีต่อ้งเลอืกพืน้ทีต่าราง C3:F5 ไวก้อ่นแทนการเลอืกเซลล ์C3 เพยีงเซลลเ์ดยีว 

เพือ่ทําใหผ้ลลพัธท์ีไ่ดจ้ากสตูร Array คนืคา่กระจายคําตอบลงไปในตารางใหค้รบทกุ

ตําแหน่ง 

• ลองใช ้Mouse คลกิลงไปในชอ่ง Formula Bar เลอืกเฉพาะสว่นของสตูร C2:F2 แลว้

กดปุ่ ม F9 จะพบวา่ตําแหน่งอา้งองิสว่นนีเ้ปลีย่นเป็น {2,3,4,5} จากนัน้ใหก้ดปุ่ ม Esc 

เพือ่คนืสภาพสตูรตามเดมิ 



16 

 

Copyright of www.ExcelExpertTraining.com 

• ลองใช ้Mouse คลกิลงไปในชอ่ง Formula Bar เลอืกเฉพาะสว่นของสตูร B3:B5 แลว้

กดปุ่ ม F9 จะพบวา่ตําแหน่งอา้งองิสว่นนีเ้ปลีย่นเป็น {10;20;30} จากนัน้ใหก้ดปุ่ ม Esc 

เพือ่คนืสภาพสตูรตามเดมิ 

• หากกดปุ่ ม F2 ตามดว้ย F9 จะพบวา่สตูร Array เดมิบน Formula Bar {=

C2:F2*B3:B5} จะเปลีย่นเป็น ={20,30,40,50;40,60,80,100;60,90,120,150} แลว้

ขอใหส้งัเกตวา่มเีครือ่งหมาย Comma และ Semi-Colon ขัน้อยูร่ะหวา่งตวัเลข (ซึง่

เครือ่งหมาย Comma , นีแ้สดงถงึวา่คา่ถดัไปยงัคงอยูใ่น Row เดมิ สว่นเครือ่งหมาย 

Semi-Colon ; แสดงวา่คา่ถดัไปตอ้งขึน้ Row ใหม)่ 

• ดงันัน้ ={20,30,40,50;40,60,80,100;60,90,120,150} จงึแสดงใหเ้ห็นวา่สตูร Array 

นีค้นืคา่เป็นคําตอบซึง่มขีนาดความกวา้ง 4 Column และมคีวามสงู 3 Row ตามขนาด

พืน้ทีต่ัง้แต ่C3:F5 ทีต่อ้งเลอืกไวก้อ่น เพือ่ใหก้ระจายคา่ลงไปใหค้รบน่ันเอง 

• หากหวัตารางมขีนาดเปลีย่นไป ตอ้งลบสตูร Array ทีส่รา้งไวเ้ดมินีท้ ิง้ไปกอ่นแลว้จงึ

สรา้งสตูร Array ใหมล่งไป ซึง่ในการลบสตูร Array ทิง้นี ้หากตอนทีส่รา้งสตูรเกดิจาก

การสรา้งพรอ้มกนัทเีดยีวหลายเซลล ์จะเลอืกลบสตูรทิง้บางเซลลไ์มไ่ด ้ตอ้งเลอืกเซลล ์

C3:F5 ทัง้หมดแลว้จงึสัง่ลบสตูรทิง้พรอ้มกนัทเีดยีวจงึจะลบได ้

• เนือ่งจากสตูร Array ในตัวอยา่งนีเ้กดิจากการสรา้งพรอ้มกนัทัง้ตารางดว้ยสตูรเดยีว จงึ

ทําให ้Excel คํานวณสตูรทัง้ตารางสตูรคณูเพยีงครัง้เดยีว ถอืเป็นเคล็ดลบัและลดัที่

น่าสนใจเป็นอยา่งยิง่เพราะถา้สรา้งไดจ้ะทําใหแ้ฟ้มคํานวณเร็วขึน้อยา่งผดิหผูดิตาทเีดยีว 

(เร็วกวา่ตวัอยา่งสตูรคณูซึง่สรา้งสตูรลงไปในเซลลเ์ดยีวแลว้ตอ้ง Copy ไป Paste 

เพือ่ใหคํ้านวณซํ้าอกีในเซลลอ์ืน่) 

• หากตอ้งการคน้หาวา่สตูร Array ทีเ่ห็นนัน้สรา้งขึน้พรอ้มกนัจากเซลลใ์ดถงึเซลลใ์ด ให ้

เริม่จากคลกิเลอืกเซลลส์ตูร Array นัน้ๆกอ่นเพยีงเซลลเ์ดยีว แลว้กดปุ่ ม F5 > 

Special > กาชอ่ง Current array จะ

พบวา่ Excel เลอืกพืน้ทีต่ารางสว่นทีเ่กดิ

จากการสรา้งดว้ยสตูร Array พรอ้มกนันัน้ ให ้

ทนัท ีจากนัน้หากตอ้งการลบหรอืสรา้ง

สตูร Array ใหมล่งไปก็ใหก้ระทําตอ่พืน้ที่

ตารางทีเ่ลอืกใหแ้ลว้นัน้รว่มกนัเสมอ 
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วธิคีน้หาสตูร 

เมือ่เจอปัญหาในงาน ใหค้อ่ยๆวเิคราะหปั์ญหาทลีะขัน้ตอน แบง่ปัญหาแยกออกเป็นขัน้ๆ 

ตามลําดบัการคํานวณ ตามลําดบัการตดัสนิใจ ควรลองสรา้งแนวทางแตล่ะขัน้ลงบนกระดาษ

กอ่น เพือ่จัดลําดบัการสง่คา่ไปทลีะขัน้ใหถ้กูตอ้ง แลว้ลองใชม้อื ใชเ้ครือ่งคดิเลข คดิคํานวณ

อยา่งครา่วๆกอ่นวา่ จะใชส้ตูรคํานวณอยา่งไร และไดผ้ลลพัธอ์อกมาเป็นเทา่ใด 

ปัญหาทีว่า่ยาก อาจยากเพราะเราทําใหม้นัยากขึน้เอง เชน่ คํานวณวา่ ถา้ซือ้สนิคา้ตน้ทนุ 127 

บาทตอ่หน่วย มาปรับกําไรขึน้อกี 13.45% จะตอ้งกําหนดราคาขายเทา่ใด 

ปัญหานีทํ้าใหง้า่ยลง โดยใชเ้ลขตวักลมแทนตวัเลขจรงิไปกอ่น ลองคํานวณตน้ทนุ 100 บาท

แทน 127 บาท ลองกําหนดกําไรเป็น 10% แทน 13.45% จะคํานวณไดผ้ลลพัธง์า่ยขึน้จรงิ

ไหม  

สาเหตทุีเ่ราปรับปัญหาใหง้า่ยลงนี ้เพือ่ใหม้องทีลํ่าดบัขัน้การคํานวณแทนทีจ่ะมวัวุน่อยูก่บั

ตวัเลข เมือ่ไดข้ัน้การคํานวณทีต่อ้งการแลว้ จงึหนัมาสรา้งมาคน้หาสตูร Excel ทีจ่ะใช ้ภายหลงั

จากสรา้งสตูรเสร็จแลว้ เราจะเปลีย่นตวัเลขใหย้ากขึน้เทา่ใดก็ไดท้ัง้นัน้ Excel จะคํานวณให ้

เสร็จในพรบิตา 

ขอใหย้ดึหลกัวา่ Excel มสีตูรคํานวณสําหรับปัญหาของเราทกุอยา่ง บางปัญหาตอ้งใชส้ตูร

รว่มกบัสตูรอืน่ตอ่ๆกนัไป บางปัญหาตอ้งใชส้ตูรซอ้นสตูร แตบ่างปัญหาใชส้ตูรๆเดยีวก็ได ้

ผลลพัธแ์ลว้ ขัน้ตอนการแกปั้ญหาจงึเป็นภาระของมนุษย ์ตอ้งหาสตูรทีต่อ้งการใชใ้หเ้จอ 

แทนทีจ่ะเสยีเงนิซือ้หนังสอืเรือ่งสตูร ใหเ้ปิดดจูาก Excel Help ซึง่ตดิมากบัโปรแกรม Excel อยู่

แลว้ (หนังสอืเรือ่งสตูรทีข่ายกนั สว่นมากมกัลอกคําอธบิายจาก Excel Help ไปใช ้มนีอ้ยเลม่

มากทีเ่ขยีนอธบิายดว้ยตวัเอง) 
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วธิแีกะสตูร 

ลองพจิารณาสตูรคํานวณหาเวลาสิน้สดุในงาน Material Requirements Planning ตอ่ไปนี ้

=INDEX(Begin,COUNTIF(Cum_Hour,"<"&(I10+((INDEX(Cum_Hour,MATCH(VLOOKU
P(J10,Begin,1),Begin,1),1)-INDEX(Working_Hour,MATCH(VLOOKUP(J10,Begin,1) 
,Begin,1),1))+((J10-VLOOKUP(J10,Begin,1))*24))))+1,1)+(((I10+((INDEX( 
Cum_Hour,MATCH(VLOOKUP(J10,Begin,1),Begin,1),1)-INDEX(Working_Hour,MATCH 
(VLOOKUP(J10,Begin,1),Begin,1),1))+((J10 - VLOOKUP(J10, Begin, 1))*24)))-
(INDEX(Cum_Hour,(COUNTIF(Cum_Hour,"<"&(I10+((INDEX (Cum_Hour,MATCH( 
VLOOKUP(J10,Begin,1),Begin,1),1)-INDEX(Working_Hour,MATCH( VLOOKUP(J10, 
Begin,1),Begin,1),1))+((J10-VLOOKUP(J10,Begin,1))*24))))+1),1)-INDEX( 
Working_Hour,(COUNTIF(Cum_Hour,"<"&(I10+((INDEX(Cum_Hour,MATCH(VLOOK
UP(J10,Begin,1),Begin,1),1)-INDEX(Working_Hour,MATCH(VLOOKUP( 
J10,Begin,1),Begin,1),1))+((J10-VLOOKUP(J10,Begin,1))*24))))+1),1)))/24) 

• เริม่จากสงัเกตเครือ่งหมายเทา่กบั เครือ่งหมายวงเล็บ และเครือ่งหมายลกูน้ํา ซึง่เป็น
องคป์ระกอบแยกโครงสรา้งของสตูร  

• สงัเกตตวัอกัษรตวัใหญ ่เป็นชือ่สตูรและตําแหน่งอา้งองิ  
• เมือ่กดปุ่ ม F2 หรอืคลกิลงไปในสตูรบน formula bar จะพบวา่ Excel เปลีย่นสแีตล่ะ

สว่นของสตูร พรอ้มกบัมกีรอบสตีรงกนัลอ้มรอบเซลล ์เพือ่ชีใ้หเ้ห็นตําแหน่งของ
เซลลซ์ึง่ถกูนําไปอา้งองิในสตูร  

• ใหค้ลกิลงบนสตูร แลว้ใชแ้ป้นพมิพเ์ลือ่นลกูศรผา่นเครือ่งหมายวงเล็บ จะพบวา่ 
เครือ่งหมายวงเล็บคูก่นัทัง้ดา้นหนา้และดา้นหลงั จะเปลีย่นเป็นสดํีาเขม้ประมาณ 2 
วนิาท ีเพือ่บอกวา่เป็นวงเล็บคูเ่ดยีวกนั  

• เมือ่พบวงสตูรทีเ่ป็นวงเล็บชดุเดยีวกนัแลว้ ใหค้ลกิเลอืกสตูรนัน้ในชอ่ง Formula 
Bar แลว้กดปุ่ ม F9 จะเห็นผลลพัธเ์ฉพาะสว่นทีเ่ลอืกไว ้แลว้ใหก้ดปุ่ ม Esc เพือ่
ยอ้นกลบัไปแสดงสตูรตามเดมิ 

• ให ้double คลกิลงไปในเซลลส์ตูร จะพบวา่ Excel ยา้ยตําแหน่งตวัชีไ้ปเลอืกเซลล์
ตน้ทางทีใ่ชใ้นสตูร ทัง้นีต้อ้งตดักาชอ่ง Allow editing directly in Cells ในคําสัง่ 
File > Options > Advanced ไวก้อ่น และเมือ่ไปยงัเซลลต์น้ทางแลว้หากตอ้งการ
ยา้ยกลบัมายงัเซลลส์ตูรเดมิ ใหก้ดปุ่ ม F5 แลว้กดปุ่ ม Enter 

• ควรใสว่รรคระหวา่งเครือ่งหมายทีใ่ชใ้นสตูร เพือ่แยกใหห้า่งออกจากกนั จะได ้
สะดวกในการแกะสตูร หากตอ้งการแยกสตูรขึน้บรรทดัใหมใ่นสตูรเดมิ ใหก้ด 
Alt+Enter  

• หากอยูร่ะหวา่งการแกไ้ขสตูร แตย่งัแกไ้ขไมเ่สร็จ ใหพ้มิพเ์ครือ่งหมายคําพดูใส่
ดา้นหนา้เครือ่งหมายเทา่กบั เพือ่ทําใหส้ตูรกลายเป็นตวัอกัษรไปกอ่น หากไมใ่ชว้ธินีี้
ตอ้งคอยระวงัอยา่กด Enter เพราะ Excel จะรับสตูรลงไปและเตอืนขอ้ผดิพลาดหรอื
แกไ้ขสตูรตา่งไปจากทีต่อ้งการ 



 

• 

• 

• 

• 

• 

• 
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วธิสีรา้งสตูรซอ้นสตูร 

จดุประสงคข์องการนําสตูรมาซอ้นสตูร เพือ่ทําใหส้ตูรๆเดยีวสามารถคํานวณใหผ้ลลพัธไ์ดเ้ลย
ทนัท ีโดยไมต่อ้งพึง่พาสตูรในเซลลอ์ืน่ๆ ทําใหเ้กดิประโยชนด์งันี ้

• ชว่ยจํากดัเซลลท์ีต่อ้งใชเ้พือ่สรา้งสตูร  
• ชว่ยใหค้น้หาเซลลส์ตูรไดง้า่ยเนือ่งจากสตูรถกูนํามารวมกนัไวเ้พยีงทีเ่ดยีว  
• หากมจํีานวนเซลลท์ีม่สีตูรยาวๆจํานวนไมม่ากนัก จะทําให ้file มขีนาดเล็ก

ลง เนือ่งจากไมต่อ้งเปลอืงเซลลห์รอื sheet เพือ่แยกเก็บสตูร และชว่ยให ้
คํานวณรวดเร็วขึน้  

สว่นขอ้เสยีของการสรา้งสตูรซอ้นสตูรก็คอื สรา้งยาก และทําใหแ้กไ้ขสตูรในภายหลงัยากขึน้ 
จงึตอ้งเปรยีบเทยีบขอ้ดขีอ้เสยีดงักลา่วนีเ้สมอ หากสรา้งเองใชเ้องแกไ้ขเองคงไมต่อ้งหว่งนัก 
แตถ่า้สรา้งสตูรแลว้ทิง้ไวใ้หค้นอืน่แกไ้ข คงตอ้งลมืกนัไปเลยวา่ จะเริม่ตน้แกไ้ขกนัยงัไงด ี
สว่นมากมกัสรา้งสตูรขึน้ใหมเ่ลยดกีวา่ 

หลกัการสรา้งสตูรซอ้นสตูร 

1. ควรรวมกลุม่ของสตูรซึง่คํานวณเป็นลําดบัตอ่เนือ่งกนัไวเ้ป็นสตูรเดยีว และแยก
ขัน้ตอนซึง่ไมต่อ่เนือ่งออกเป็นอกีสตูรหนึง่  

2. ควรแยกสตูรออกใหทํ้างานคนืคา่ซึง่มคีวามหมายสมบรูณ์ในขัน้นัน้ๆ และงา่ยตอ่การ
ตรวจสอบวา่ ลําดบัการคํานวณขัน้ใดผดิพลาด จะไดส้ะดวกตอ่การแกไ้ขใหถ้กูตอ้ง  

3. อยา่รวมทกุขัน้ตอนของการคํานวณไวใ้นสตูรๆเดยีวจนยาวเกนิไป  

วธิสีรา้งสตูรซอ้นสตูร 

ใหส้รา้งสตูรซึง่ควรเป็นสตูรวงเล็บในสดุกอ่นสตูรอืน่ สตูรนีม้กัใชคํ้านวณหาคา่พืน้ฐานแรกสดุ 
ซึง่จะถกูนําไปใชเ้ป็นตวัแปรในสตูรอืน่ถดัไป เชน่ สรา้งสตูรคํานวณหาเลขทีบ่รรทดั ดว้ยสตูร  
=MATCH( MinimumCost, TotalCost, 0)  

จากนัน้จงึสรา้งสตูรอืน่ครอ่มขา้งนอกเพือ่นําผลลพัธจ์ากสตูร Match ไปใช ้เชน่ 

=INDEX( LotSize, MATCH( MinimumCost, TotalCost, 0), 1) 

ถา้เป็นสตูรชว่ยการตดัสนิใจ เชน่ สตูร IF ใหพ้จิารณาหาสตูรซึง่ใชต้ดัสนิใจอืน่ๆ มาซอ้นเขา้ไป
ในสตูรเดมิเมือ่ถงึตวัแปรซึง่ตอ้งการใชส้ตูรอืน่คํานวณคา่ให ้เชน่ ตอ้งการตดัสนิคะแนน 0 - 50 
ใหเ้กรด C ถา้คะแนน 51 - 80 ใหเ้กรด B แตถ่า้เกนิกวา่ 80 ใหเ้กรด A ใหส้รา้งสตูรหาเกรด A 
ใหไ้ดก้อ่น 
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=IF(คะแนน>80,"A","BC")  

แลว้คอ่ยพจิารณาตอ่วา่ จะตดัสนิเกรด B C ตอ่ไปดว้ยสตูร IF อยา่งไร 

=IF(คะแนน>80,"A",IF(คะแนน>50,"B","C"))  

ถา้ไมถ่นัดสรา้งสตูรตอ่กนัซอ้นกนัไปเลยทเีดยีว ใหส้รา้งสตูรแยกแตล่ะขัน้ตอนออกไปลงใน
เซลลแ์ยกจากกนักอ่น แลว้จงึ copy ตวัสตูร ไป paste ทบัในตําแหน่งอา้งองิ เชน่ 

A1: =NOW() 

A2: =DAY(A1) 

ให ้copy สตูร NOW() จากเซลล ์A1 ไปทบัคําวา่ A1 ในเซลล ์A2 จะไดส้ตูรซอ้นกนัเป็น 
=DAY(NOW()) 

วธิ ีcopy สตูร ใหค้ลกิเลอืกสว่นของสตูรทีต่อ้งการจากสตูรบน Formula Bar เชน่ เลอืกคําวา่ 
NOW() แลว้คลกิขวาเลอืก copy (หรอืกด Ctrl+c) แลว้กด Esc หนึง่ครัง้เพือ่ออกจากการเลอืก 
แลว้จงึไปคลกิเลอืกคําวา่ A1 บน Formula Bar ของสตูรในเซลล ์A2 แลว้คลกิขวาสัง่ paste 
(หรอืกด Ctrl+v) 
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วธิสีรา้งชือ่ซอ้นชือ่ 

ใชคํ้าสัง่ Formulas > Define Name เพือ่ตัง้ชือ่ใหก้บัสตูร หลงัจากนัน้จงึนําชือ่นัน้ไปซอ้นใน
ชือ่อืน่ตอ่ไปอกี เชน่ สตูรในงานวางแผนการผลติ ซึง่ใชเ้วลาเริม่งาน และเวลาทีใ่ชทํ้างาน 
คํานวณหาเวลาสิน้สดุงาน ตอ่ไปนี ้

Calc1 =VLOOKUP(RelativeStart, Begin, 1)  

Calc2 =INDEX(Working_Hour, MATCH( Calc1, Begin, 1 ), 1 )  

Calc3 =INDEX(Cum_Hour, MATCH( Calc1, Begin, 1 ), 1 )  

Calc4 =Calc3 - Calc2  

Calc5 =RelativeStart - Calc1  

Calc6 =Calc4 + ( Calc5*24 )  

Calc7 =RelativeHour + Calc6  

Calc8 =COUNTIF(Cum_Hour, "<" & Calc7 ) + 1  

Calc9 =INDEX(Working_Hour, Calc8, 1)  

Calc10 =INDEX(Cum_Hour, Calc8, 1)  

Calc11 =Calc10 - Calc9  

Calc12 =(Calc7 - Calc11) / 24  

Calc13 =INDEX(Begin, Calc8, 1)  

Calc14 =Calc13 + Calc12  

วธินํีาชือ่ทีต่ัง้ไวม้าใสใ่นสตูร ใหก้ดปุ่ ม F3 เพือ่เลอืกชือ่ทีต่ัง้ไว ้เพือ่สรา้งสตูรลงไปในเซลลก์อ่น
แลว้จงึ Copy สตูรไปใสต่อ่ในชอ่งสตูรของ Define Name 

เวลาใชง้านก็นําสตูรชือ่ Calc14 ไปใชเ้ทา่นัน้ ก็จะคํานวณสตูรทัง้หมดตัง้แต ่Calc1 – Calc13 
ใหอ้ตัโนมตั ิ

  



26 

 

Copyright of www.ExcelExpertTraining.com 

เร ือ่งทีไ่มค่อ่ยรูก้นัเกีย่วกบัสตูร 

โปรแกรม Microsoft Excel รุน่ใหม ่มไิดม้เีสน่หอ์ยูท่ีร่ปูรา่งหนา้ตาบนหนา้จอทีป่ระกอบไปดว้ย

แถบรบิบอนแบบใหม(่ทีย่งัไมค่อ่ยคุน้เคย) และมพีืน้ทีต่ารางซึง่มขีนาดใหญม่ากขึน้กวา่เดมิ

หลายเทา่เพยีงเทา่นัน้ แตส่าเหตทุีทํ่าให ้Excel มเีสน่ห ์กลายเป็นโปรแกรมยอดนยิมมานาน

แสนนาน ก็เพราะมอีงคป์ระกอบสําคญั น่ันคอื Excel ตัง้แตรุ่น่แรกๆไดจั้ดเตรยีมสตูรสําเร็จรปูไว ้

มากมายใหนํ้ามาใชก้นั หากสตูรทีม่อียูย่งัไมส่ามารถใชคํ้านวณหาคําตอบทีต่อ้งการได ้เราก็

สามารถนําสตูรทีม่อียูนั่น้มาใชร้ว่มกนั ซอ้นกนั หรอืผกูสตูรเขา้ดว้ยกนั จนกลา่วไดว้า่เราสามารถ

ใช ้Excel คํานวณหาคําตอบไดก้บัโจทยก์ารคํานวณทกุเรือ่ง ปัญหาใดทีค่ดิวา่ไมส่ามารถใช ้

Excel หาคําตอบ น่ันเป็นเพราะคนเราตา่งหากทีย่งัคดิไมอ่อก ไมใ่ชว่า่ใช ้Excel หาคําตอบ

ไมไ่ด ้บางปัญหาอาจตอ้งใชเ้วลาคดินับสบิปีกวา่จะทราบวา่ตอ้งเอาสตูรนัน้มาซอ้นกบัสตูรนีแ้ลว้

ก็จะไดคํ้าตอบทีต่อ้งการออกมาน่ันเอง 

เคล็ดลบัทีช่ว่ยใหส้ามารถใชส้ตูรจนชํา่ชอง มใิชว่า่ตอ้งรูจั้กสตูรทกุสตูรที ่Excel มอียูห่รอก 

เพราะสตูรทีใ่ชง้านกนัประจํานัน้มไีมม่ากนัก แครู่จั้กการใชส้ตูร Sum, If, And, Or, Choose, 

VLookup, Match, Index, CountIF, SumIF, Offset, Indirect, และ Array Formula ใหเ้ป็น 

และสามารถนําสตูรแคน่ีแ้หละมาใชร้ว่มกนัใหเ้ป็นก็เพยีงพอแลว้ แตก่วา่จะใชส้ตูรใหเ้ป็นยงัมี

หลายเรือ่งทีต่อ้งทําความเขา้ใจกนั หากคดิเพยีงวา่ขอใชส้ตูรเหลา่นีเ้ป็นก็พอแลว้ คณุก็จะถงึ

ทางตนัในไมช่า้ โดยบทความนีจ้ะขอนําเรือ่งทีไ่มค่อ่ยรูก้นัเกีย่วกบัสตูรมาอธบิาย หลายเรือ่ง

เป็นเรือ่งสําคญัทีค่ดิกนัวา่ไมสํ่าคญั บางเรือ่งก็งา่ยแตค่ดิไมถ่งึวา่เรือ่งงา่ยน่ันแหละยงัมอีะไร

หลายอยา่งซอ่นอยูอ่กี 

ทําอยา่งไรใหเ้กง่สตูร Excel   

1. ไมจํ่าเป็นตอ้งซือ้หนังสอืเกีย่วกบัสตูร เพยีงแคเ่ปิดโปรแกรม Excel แลว้กดปุ่ ม F1 ก็จะ

เปิด Excel Help ขึน้มาคน้หาสตูรที ่Excel มอียูไ่ดแ้ลว้ ถา้คณุตอ้งการซือ้หนังสอื

เกีย่วกบัสตูร ขอใหห้าซือ้หนังสอืทีอ่ธบิายเรือ่งสตูรไดล้ะเอยีดกวา่ทีม่ใีน Help (ซึง่หา

ไดย้ากมาก เพราะคนแตง่หนังสอืมกัเขยีนอธบิายตา่งจาก Help ไมม่าก) 

2. ถา้ซือ้หนังสอื Excel มาแลว้ ขอใหเ้ปิดอา่นตัง้แตห่นา้แรกจนถงึหนา้สดุทา้ยโดยไมต่อ้ง

เปิดคอมพวิเตอร ์เพราะถา้มวัเปิดอา่นไปทําตวัอยา่งไปบนหนา้จอพรอ้มกนั กวา่จะอา่น

หมดเลม่ก็จะใชเ้วลาเกนิปีครึง่ (ซึง่ Excel จะมรีุน่ใหมใ่หพ้วกเราไดใ้ชง้านกนัประมาณ
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ทกุปีครึง่ แลว้คณุจะตอ้งซือ้หนังสอื Excel รุน่ใหมม่าตัง้ตน้อา่นกนัตัง้แตห่นา้แรกกนัใหม่

อกี สดุทา้ยกไ็มส่ามารถรูจั้ก Excel ครบทัง้หมดสกัท)ี 

3. ถา้ยงัไมไ่ดซ้ือ้หนังสอื ขอใหไ้ปที ่www.xlfdic.com ซึง่จะมแีฟ้มตวัอยา่งการใชส้ตูร 

Excel กวา่ 150 สตูรให ้download มาศกึษากนัไดฟ้ร ี

4. ขอใหพ้ยายามรอบรูก้อ่นรูล้กึ คณุควรรอบรูไ้วก้อ่นวา่ Excel มสีตูรอะไรบา้ง จากนัน้เมือ่

ถงึเวลาทํางานจงึคอ่ยใชเ้วลารูล้กึเรยีนรูส้ตูรแตล่ะสตูรใหค้ลอ่งในภายหลงั 

5. ตัง้หลกัไวเ้ลยวา่ Excel มสีตูรทีค่ณุสามารถนํามาใชก้บังานทกุอยา่งของคณุไดอ้ยูแ่ลว้ 

ถา้ไมม่สีตูรสําเร็จรปูทีคํ่านวณลดัหาคําตอบไดโ้ดยตรง ใหห้าทางนําสตูรหลายสตูรมาใช ้

งานรว่มกนั 

6. เริม่แรกทีท่ดลองใชส้ตูร ควรใชก้บัโจทยง์า่ยๆทีท่ราบคําตอบทีถ่กูตอ้งอยูแ่ลว้ จะได ้

เขา้ใจหลกัการคํานวณที ่Excel ใชว้า่มขีัน้ตอนการคดิคํานวณอยา่งไร และเมือ่ได ้

คําตอบตรงกบัทีท่ราบ จะชว่ยทําใหค้ณุเกดิความมัน่ใจ และเกดิความกลา้ทีจ่ะนําสตูรไป

ใชใ้นปัญหาอืน่ตอ่ไป ลองคดิดวูา่ =2*3 กบั =123*4.56 สตูรใดทีง่า่ยกวา่กนั 

7. ถา้สตูรคํานวณไดคํ้าตอบอืน่ตา่งจากทีต่อ้งการ อยา่คดิวา่ตวัเองสรา้งสตูรผดิ แตค่วร

พยายามคดิคน้หาใหไ้ดว้า่คําตอบทีไ่ดนั้น้หมายถงึการคํานวณของอะไร หลายๆครัง้

ทเีดยีวทีค่ณุจะไดส้ตูรลดัและลบัแปลกๆทีค่นอืน่ไมรู่จั้กกนั 

8. อยา่รรีอทีจ่ะสรา้งสตูรใหเ้ห็นผลลพัธก์บัตาวา่ถกูหรอืผดิ ถา้คณุเอาแตก่ลวัๆกลา้ๆไมย่อม

สรา้งสตูรสกัทกี็จะไมม่วีนัเกง่สตูรไดห้รอก ขอใหส้รา้งสตูรบอ่ยๆ สตูรทีผ่ดิหรอืถกู

เหลา่นัน้จะเป็นบทเรยีนสอนคณุใหเ้กง่กวา่คนอืน่ทีไ่มเ่คยยอมทําผดิ 

9. ถา้ปัญหาการคํานวณซบัซอ้นยากมาก ควรแยกเซลลใ์หใ้ชเ้ซลลห์ลายๆเซลลแ์ยก

คํานวณสตูรแตล่ะขัน้ จากนัน้จงึคอ่ยหาวธินํีาสตูรมาตอ่กนัเป็นสตูรยาวๆสตูรเดยีวใน

เซลลเ์ดยีว 

10. พยายามหาทางแกปั้ญหาสรา้งสตูรดว้ยตวัเองใหไ้ด ้ถา้ทําไดเ้องแลว้คณุจะเกดิความ

ภาคภมูใิจ เกดิความกลา้และอยากลอง ทําใหเ้กง่ขึน้ไปไดเ้อง อยา่ลอกสตูรคนอืน่มาใช ้

ถา้พยายามอยา่งไรแลว้คดิสตูรไมอ่อก ขอใหค้น้หาคําตอบจาก Google กอ่นทีจ่ะเอย่

ปากถามใคร 

หวงัวา่คําแนะนํา 10 ขอ้นีจ้ะเป็นแนวทางชว่ยใหค้ณุกลายเป็นคนเกง่สตูร Excel และขอฝากคน

ทีช่อบใชส้ตูรรุน่ใหมท่ีเ่พิง่เกดิขึน้ใน Excel 2007 ขึน้ไปวา่ อยา่เพิง่รบีรอ้นนําสตูรใหม่ๆ เหลา่นัน้

มาใช ้เพราะตราบใดทีเ่พือ่นของคณุยงัคงใช ้Excel รุน่เกา่กวา่อยู ่เขาจะไมส่ามารถนําแฟ้มของ

คณุทีส่รา้งไวโ้ดยใชส้ตูรรุน่ใหมม่าคํานวณไดเ้ลย คณุน่ันแหละทีจ่ะตอ้งรับภาระยอ้นกลบัไป

แกไ้ขสตูรรุน่ใหมใ่หเ้ป็นรุน่เกา่เพือ่เปิดแฟ้มใน Excel รุน่เกา่ทีค่นอืน่เขายงัไมเ่ลกิใชก้นั 
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Formula vs Function 

ทัง้สองคํานีถ้า้แปลเป็นไทยก็แปลวา่ “สตูร” เหมอืนกนั โดยคําวา่ Formula เป็นคําทีม่ี

ความหมายกวา้งกวา่ Function กลา่วคอื  

• Formula หมายถงึ สตูรทกุอยา่งทีม่เีครือ่งหมายเทา่กบั = นําหนา้ เชน่ =A1 หรอื 

=1+2 หรอื =Now() 

• Function หมายถงึ สตูรสําเร็จรปูทีต่ดิมากบัโปรแกรม Excel เชน่ สตูร Sum, Max, 

Min, If, VLookup หรอื Now เป็นตน้ 

ดงันัน้เพือ่ทําความเขา้ใจใหต้รงกนั ในบทความนีจ้ะใชคํ้าวา่ สตูร ซึง่หมายถงึทัง้ Formula และ 

Function หรอือกีนัยหนึง่ สตูรก็คอือะไรก็ตามทีม่เีครือ่งหมาย = นําหนา้ สว่นตวัผมเองจะเขยีน

อธบิายเรือ่งสตูรในกระดาษโดยใชต้วัใหญป่นตวัเล็ก เชน่ Sum หรอื VLookup เพือ่ชว่ยใหอ้า่น

แตล่ะคําของสตูรไดง้า่ย แตเ่มือ่ถงึคราวนําไปใชใ้น Excel โปรดพมิพส์ตูรดว้ยตวัเล็กทัง้หมด

เสมอ 

Text vs Number 

คา่ทีพ่มิพบ์นัทกึลงไปในเซลลห์รอืผลจากการคํานวณมอียูเ่พยีง 3 อยา่งคอื คา่ทีถ่อืเป็นText 

คา่ทีถ่อืเป็น Number และคา่ที ่error ไมส่ามารถนําไปใชคํ้านวณตอ่ได ้

• Text คอื คา่ทีพ่มิพล์งไปในเซลลห์รอืเกดิจากสตูรคํานวณแลว้จะชดิซา้ยของเซลล์

ทนัท ี(โดยไมต่อ้งกําหนด Format) เชน่ พมิพคํ์าวา่ abc หรอื กขค หรอืแมแ้ตต่วัเลขที่

พมิพต์อ่ทา้ยเครือ่งหมายฝนทอง เชน่ ‘123 หรอืผา่นการกําหนด Format Number ให ้

ถอืเป็นแบบ Text ซึง่โดยทัว่ไปหากเซลลด์า้นขวายงัวา่งอยู ่จะพบวา่ถา้เซลลม์ ีText ที่

ยาวกวา่ความกวา้งของเซลล ์จะยอมให ้Text นัน้แสดงตอ่ไปในเซลลด์า้นขวา 

• Number คอื คา่ทีพ่มิพล์งไปในเซลลห์รอืเกดิจากสตูรคํานวณแลว้จะชดิขวาของเซลล์

ทนัท ี(โดยไมต่อ้งกําหนด Format) เชน่ พมิพต์วัเลข 123 หรอืพมิพว์นัที ่14/2/2009 

ซึง่โดยทัว่ไปถา้เซลลม์คีวามกวา้งไมพ่อทีจ่ะแสดงตวัเลขทัง้หมด Excel จะแสดงดว้ย

เครือ่งหมาย ####### ซํ้าจนเต็มเซลล ์(แกไ้ดโ้ดยคลกิขวาลงไปในเซลลแ์ลว้สัง่ 

Format Cells > Alignment > กาชอ่ง Shrink to fit เพือ่สัง่ให ้Excel ยอ่ขนาด

ของ Font ใหม้ขีนาดพอดทีีจ่ะแสดงไดเ้ต็มความกวา้งของเซลล)์ 

• Error เป็นผลทีเ่กดิจากการคํานวณทีไ่มส่ามารถนําไปคํานวณตอ่ได ้เชน่  
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o #N/A เมือ่สตูรหาขอ้มลูทีต่อ้งการไมพ่บ (Not Available) 

o #NAME? เมือ่สตูรหาชือ่ทีต่อ้งการไมพ่บ เชน่ =answer โดยทีใ่นแฟ้มนัน้

ไมไ่ดต้ัง้ชือ่ Range Name วา่ answer ไวก้อ่น 

o #NULL! เมือ่สตูรหาตําแหน่งทีต่ดักนัไมไ่ด ้เชน่ =A:A B:B 

o #NUM! เมือ่สตูรใชต้วัเลขทีเ่ป็นไปไมไ่ดใ้นการคํานวณ เชน่ =Sqrt(-1) 

o #REF! เมือ่ตําแหน่งเซลลท์ีเ่คยอา้งไวใ้นสตูรถกู delete ทิง้ไป 

o #VALUE! เมือ่สตูรไมส่ามารถคํานวณได ้เชน่ นําตวัเลขคณูตวัอกัษร =123*a 

หลกัการใช ้Excel ทีด่ ีคอื คา่ใดๆทีเ่กีย่วขอ้งกบัตวัเลข ก็ขอใหเ้ป็นตวัเลขทีช่ดิขวาของ

เซลลเ์สมอ ไมค่วรใชต้วัเลขทีช่ดิซา้ยของเซลล ์

ขนาดแฟ้ม vs ประเภทขอ้มลู 

ขนาดของแฟ้มขึน้กบัประเภทของขอ้มลู โดยเรยีงลําดบัขนาดแฟ้มจากเล็กไปใหญไ่ดต้ามนี ้

1. แฟ้มทีเ่ก็บขอ้มลูเป็น Number เชน่ 1, 111, 123 

2. แฟ้มทีเ่ก็บขอ้มลูเป็น Text เชน่ a, aaa, abc 

3. แฟ้มทีเ่ก็บขอ้มลูเป็นสตูรทีค่นืคา่เป็น Number เชน่ =1, =111, =123 

4. แฟ้มทีเ่ก็บขอ้มลูเป็นสตูรทีค่นืคา่เป็น Text เชน่ =”a”, =”aaa”, =”abc” 

ทีแ่ปลกก็คอื ขนาดของแฟ้ม ไมข่ึน้กบัความยาวของคา่ในเซลล ์เชน่ ถา้เซลลม์คีา่ทีบ่นัทกึไว ้

เป็น 1 หรอืเพิม่ความยาวตวัเลขเป็น 111 หรอื 123 ก็จะมขีนาดแฟ้มเทา่กนักบั 1 ตวัเดยีว หรอื

ถา้สรา้งเป็นสตูร =1 หรอืเพิม่ความยาวตวัเลขเป็น =111 หรอื =123 จะมขีนาดแฟ้มเทา่กนักบั 

=1 

ดงันัน้ถา้ตอ้งการลดขนาดแฟ้มใหเ้ล็กทีส่ดุ แทนทีจ่ะพมิพเ์ลข 1 แลว้สรา้งสตูรบวกเลขตอ่กนัไป

ทลีะเซลลใ์หก้ลายเป็นลําดบัตวัเลข 1, 2, 3, 4, 5 ก็ควรพมิพเ์ลขลงไปในเซลลโ์ดยตรงแทน

การสรา้งสตูร และสตูรใดๆทีคํ่านวณเสร็จเรยีบรอ้ยไปแลว้และไมม่กีารเปลีย่นแปลงคําตอบตา่ง

จากเดมิอกีแลว้ เราก็ควร Copy แลว้ Paste Special ใหก้ลายเป็น Value จะทําใหแ้ฟ้มเล็กลง

ไปมากทเีดยีว 

สว่นเซลลส์ตูรทีเ่กดิ Error ขึน้ก็ควรใชส้ตูร IF ปรับ Error ใหเ้ปลีย่นเป็นคา่อืน่แทน ดงันี ้



30 

 

Copyright of www.ExcelExpertTraining.com 

• ในกรณีที ่A1 คนืคา่เป็น Number ใหใ้ช ้=IF( IsError(A1), 0, A1)  

• ในกรณีที ่A1 คนืคา่เป็น Text ใหใ้ช ้=IF( IsError(A1), “คําเตอืนใดๆก็ได”้, A1)  

ซึง่ตวัผมเอง นยิมใชส้ตูร =IF( IsError(A1), 0, A1) ทัง้ในกรณีทีเ่ดมิคนืคา่เป็น Number หรอื 

Text ก็ตาม เพราะสามารถใช ้Format ปรับการแสดงเลข 0 ใหแ้สดงเป็นคา่อืน่หรอืแมแ้ตทํ่าให ้

ดเูหมอืนกลายเป็นเซลลว์า่งไดต้อ่ไป 

ตาํแหนง่เซลลท์ีเ่ลอืกสําหรบัสรา้งสตูร 

เห็นหวัขอ้นีแ้ลว้คงสงสยักนัวา่ตําแหน่งเซลลท์ีเ่ลอืกสรา้งสตูรลงไปนัน้เป็นประเด็นทีต่อ้งใสใ่จ

กนัดว้ยหรอื ถา้คดิกนังา่ยๆวา่ “ในเมือ่ฉันตอ้งการจะสรา้งสตูรลงไปตรงนีก้็ตอ้งตามใจฉัน ฉันจะ

สรา้งสตูรลงไปตรงนีเ้สยีอยา่ง ใครจะทําไม” ก็แสดงวา่คณุมองขา้มอะไรทีเ่ป็นเรือ่งสําคญัอยา่ง

หนึง่ไปแลว้ 

ตําแหน่งเซลลท์ีค่ณุสรา้งสตูรหาคําตอบลงไป สามารถชีเ้ป็นชีต้ายใหก้บังานของคณุทเีดยีว 

เพราะถา้อยูม่าวนัหนึง่ เมือ่ยา้ยเซลลส์ตูรไปทีตํ่าแหน่งอืน่ สตูรทีเ่คยคํานวณหาคําตอบไดต้ลอด

มา อาจคนืคา่เป็นคําตอบทีผ่ดิหรอืแสดงผลลพัธแ์ตกตา่งไปจากเดมิก็ได ้

วธิทีดสอบสตูรทีค่ณุหรอืใครสรา้งขึน้วา่เป็นสตูรทีใ่ชไ้ดห้รอืไม ่ใหท้ดลองยา้ยเซลลส์ตูรไปทีอ่ืน่ 

ยา้ยไปเรือ่ยๆหลายๆตําแหน่ง พรอ้มกนันัน้ทดลองยา้ยตารางขอ้มลูทีใ่ชอ้า้งองิไปทีอ่ืน่ดว้ย ลอง 

Insert Row หรอื Column แทรกตารางขอ้มลูเขา้ไปอกี ถา้สตูรนัน้ยงัคงหาคําตอบได ้

เหมอืนเดมิ แสดงวา่สตูรนัน้ใชง้านได ้

ทราบไหมวา่ถา้ตารางขอ้มลูทีเ่ก็บคา่อยูใ่นตารางชว่ง B2:D5 คณุควรสรา้งสตูรคํานวณซึง่

เกีย่วขอ้งกบัการใชข้อ้มลูในตารางนีไ้วท้ีเ่ซลลใ์ด ซึง่จะรับประกนัวา่สตูรทีส่รา้งขึน้จะสามารถ

นําไปใชง้านตอ่ไดท้กุที ่

คําตอบก็คอื หา้มสรา้งสตูรในแนวเดยีวกบัตารางขอ้มลู น่ันคอื อยา่สรา้งสตูรในชว่ง Column B 

ถงึ D และชว่ง Row 2 ถงึ 5 

สาเหตทุีห่า้ม เพราะการสรา้งสตูรใดๆทีม่ตํีาแหน่งอา้งองิไปยงัคา่ในแนวเดยีวกบัตารางขอ้มลู 

อาจคนืคา่เป็นคําตอบเป็นคา่ในตารางตามแนวเดยีวกนัก็ได ้
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หากสรา้งสตูรในเซลลซ์ึง่ไมไ่ดอ้ยูใ่นแนวเดยีวกบัชว่ง Column B ถงึ D และชว่ง Row 2 ถงึ 5 

แลว้คณุหาทางปรับสตูรนัน้ใหคํ้านวณหาคําตอบทีต่อ้งการ ยอ่มรับประกนัไดว้า่ สตูรนัน้เป็นสตูร

ทีใ่ชง้านไดจ้รงิและจะยงัคงคนืคา่เป็นคําตอบเดมิไปตลอด ไมว่า่จะยา้ยเซลลส์ตูรไปทีตํ่าแหน่ง

อืน่ก็ตาม 

พอพบวา่สตูรทํางานไดจ้รงิแลว้ จากนัน้จะยา้ยเซลลส์ตูรไปวางไวใ้นแนวคูข่นานกบัตารางขอ้มลู

ทีใ่ชใ้นการคํานวณก็ไมว่า่กนั 

สตูรก็มจีงัหวะหายใจดว้ยนะ   

ผูท้ีใ่ช ้Excel เป็นประจําตอ้งรูจั้กสตูรตอ่ไปนีเ้ป็นอยา่งด ี=IF(C2=0, 0, B2/C2) 

สตูรขา้งตน้นีค้อืสตูรทีใ่ชสํ้าหรับปรับสตูรทีนํ่าตวัเลขมาหารกนัไมใ่หแ้สดงคําเตอืน Error วา่ 

#DIV/0! ขึน้มา  

เมือ่เซลล ์C2 ซึง่เป็นเลขตวัหารมคีา่เป็น 0 ใหค้นืคา่ 0 เป็นตวัเลขคําตอบแทน แตถ่า้เซลล ์C2 

ไมไ่ดเ้ป็นเลข 0 ก็ยอ่มนํา C2 มาหาร B2 ไดต้ามปกต ิผูท้ีส่รา้งสตูรหารกนัจะหลกีเลีย่งสตูร

ดงักลา่วนีไ้มไ่ด ้

ขอถามวา่ เวลาทีค่ณุสรา้งสตูร คณุมพีฤตกิรรมในการสรา้งสตูรกนัอยา่งไร คณุจะพมิพล์งไปใน

เซลลว์า่ =if(c2=0,0,b2/c2) รวดเดยีวใหค้รบทัง้หมดแลว้จงึกดปุ่ ม Enter หรอืไม ่หรอืจะคอ่ยๆ

พมิพ ์=if แลว้หยดุหายใจพักหนึง่แลว้จงึพมิพ ์c2=0 ตอ่ แลว้ก็หยดุพักหายใจอกีเฮอืกหนึง่จงึ

คอ่ยๆพมิพส์ว่นทีเ่หลอืตอ่ 

ขอ้ผดิพลาดทีพ่บบอ่ยในการสรา้งสตูรของคนทีเ่พิง่เรยีนรูก้ารใช ้Excel ก็คอื มกัหลงลมื

เครือ่งหมายวงเล็บ พมิพเ์ครือ่งหมาย Comma ขาดไป บางครัง้พมิพส์ลบัที ่บางครัง้พมิพข์าด 

บางครัง้พมิพเ์กนิ ทําใหเ้มือ่กดปุ่ ม Enter ลงไปแลว้ Excel ตอ้งเตอืนขึน้มาบนจอใหค้ณุทราบวา่

สตูรทีส่รา้งนัน้ผดิ 

ผูส้รา้งสตูรตอ้งมสีมาธพิอตวั สมาธทิีว่า่นีเ้กดิจากการรูจั้กวา่เมือ่ใดจะหยดุเมือ่ใดจะสรา้งตอ่ ถา้รู ้

หลกัจังหวะหายใจจะชว่ยใหค้ณุสรา้งสตูรไดง้า่ยขึน้ ไมว่า่สตูรสัน้ๆหรอืสตูรยากๆยาวๆก็ใชห้ลกั

จังหวะหายใจนีก้นัทัง้นัน้ 
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จังหวะหายใจทีว่า่นี ้ไมใ่ชจั่งหวะหายใจของ Excel หรอกนะ Excel มนัไมไ่ดม้กีารหายใจ

เหมอืนกบัมนุษย ์แตเ่ป็นจังหวะหายใจของคณุน่ันแหละ ตอ้งรูว้า่เมือ่ใดทีค่วรจะหยดุแลว้หายใจ

สกัเฮอืกหนึง่แลว้จงึสรา้งสตูรตอ่ ซึง่เรือ่งการหายใจนีไ้มต่อ้งลอกจังหวะการหายใจใหเ้หมอืนกบั

ผมก็ได ้ตวัใครตวัมนั ขอใหเ้ลอืกจังหวะหายใจทีต่วัเองคดิวา่ถนัดก็แลว้กนั 

ขอยกสตูรทัง้หมดมาดกูนัอกีครัง้  

=IF(C2=0, 0, B2/C2)  

มาดกูนัวา่ถา้เป็นวธิขีองผม จะสรา้งสตูรนีโ้ดยหยดุพักเพือ่หายใจกนัตรงไหนบา้ง เอา้หายใจเขา้

แลว้นะ จากนัน้เริม่สรา้งสตูรโดยใชว้ธิตีามลําดบัตอ่ไปนี ้

1. พมิพเ์ครือ่งหมายเทา่กบั 

2. พมิพคํ์าวา่ if( 

3. หยดุเพือ่หายใจ จากนัน้สรา้งสตูรตอ่ดว้ยขัน้ตอ่ไป 

4. หยบิเมาสค์ลกิเซลล ์C2 

5. แลว้พมิพ ์=0, ตอ่ 

6. หยดุเพือ่หายใจ 

7. ในใจอา่นสตูรทีไ่ดต้ามนี ้=if(C2=0, วา่ถา้เซลลต์วัหารมคีา่เทา่กบั 0 ละ่กอ้ 

8. พมิพ ์0, ตอ่ 

9. หยดุเพือ่หายใจ 

10. ในใจอา่นสตูรทีพ่มิพ ์0, วา่ ใหคํ้าตอบทีไ่ดเ้ป็น 0 แทนนะ จากนัน้ 

11. หยบิเมาสค์ลกิเซลล ์B2 

12. พมิพเ์ครือ่งหมายหาร / 

13. แลว้หยบิเมาสค์ลกิเซลล ์C2 

14. หยดุเพือ่หายใจ 

15. ในใจอา่นสตูร B2/C2 ทีไ่ดม้าวา่ แตถ่า้ตวัหารไมใ่ชเ่ลข 0 ใหคํ้าตอบทีไ่ดเ้ป็นสตูรหาร

กนัตามปกต ิ

16. จากนัน้จงึกดปุ่ ม Enter รับสตูรลงไปในเซลล ์โดยไมต่อ้งพมิพเ์ครือ่งหมายวงเล็บปิด 

เพราะถา้มวีงเล็บเปิดตวัเดยีว Excel จะพมิพเ์ครือ่งหมายวงเล็บปิดใหเ้อง 

จับหลกัไดไ้หมเอย่ ขอใหส้งัเกตวา่ใหห้ยดุเพือ่หายใจไดห้ลงัจากพมิพจ์บตรงเครือ่งหมายนัน้ๆ

ไง ถา้ใชเ้ครือ่งหมายจดุจดุแทนชว่งหยดุเพือ่หายใจ จะไดส้ตูรตามแบบนี ้ 
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=if(.........C2=0,.........0,......... B2/C2 

ฝึกหยดุเพือ่พักหายใจใหไ้ดจั้งหวะ วธินีีจ้ะชว่ยลดขอ้ผดิพลาดหลงลมืการใสเ่ครือ่งหมายวงเล็บ

หรอืเครือ่งหมาย Comma ในการสรา้งสตูรไปไดเ้ยอะทเีดยีว 

ธรรมชาตขิองสตูร   

ถา้เขา้ใจธรรมชาตติอ่ไปนีข้องสตูร จะทําใหเ้ราใชส้ตูร Excel ไดง้า่ยโดยไมต่อ้งทอ่งจําและลด

ขอ้ผดิพลาดเมือ่นําสตูรมาใช ้

1. ชือ่สตูรเป็นตัวอกัษรภาษาองักฤษตวัใหญ ่เชน่ IF, MAX, MIN ดงันัน้เวลาพมิพส์ตูรใหพ้มิพ์

ตวัเล็ก พอกดปุ่ ม Enter แลว้จะพบวา่ ถา้เราสะกดชือ่สตูรถกูตอ้ง Excel จะเปลีย่นตวัอกัษร

จากตวัเล็กไปเป็นตวัใหญท่ัง้หมดใหท้นัท ี

2. เราสามารถพมิพส์ตูรโดยถา้ในสตูรมเีครือ่งหมายวงเล็บเปิดเพยีงวงเล็บเดยีว พอกดปุ่ ม 

Enter จะพบวา่ Excel พมิพเ์ครือ่งหมายวงเล็บปิดใหเ้อง แตถ่า้มวีงเล็บเปิดหลายตวั เราตอ้ง

ใสเ่ครือ่งหมายปิดวงเล็บใหค้รบทกุคู ่เพราะถา้กดปุ่ ม Enter ลงไป Excel จะพยายามคดิใส่

เครือ่งหมายวงเล็บปิดใหค้รบแตอ่าจใสว่งเล็บปิดผดิคูใ่หก้็ได ้

3. วงเล็บในสตูรตอ้งใสใ่หค้รบคูแ่ละถกูตําแหน่ง มวีงเล็บเกนิดกีวา่ขาดวงเล็บ 

4. ถา้ไมใ่สว่งเล็บ Excel จะไลคํ่านวณตามลําดบัดงันี ้ยกกําลงักอ่นแลว้ตามดว้ยคณูหรอืหาร

แลว้ตามดว้ยบวกหรอืลบ (คณูหาร หรอืบวกลบ มศีกัดิศ์รเีทา่กนั จะไลคํ่านวณจากซา้ยไป

ขวาแลว้แตว่า่เครือ่งหมายใดมกีอ่น) ดตูวัอยา่งทา้ยขอ้ 7 

5. โครงสรา้งสตูร Excel ถกูสรา้งขึน้มาเลยีนแบบลําดบัความคดิของมนุษย ์ดงันัน้ถา้เราเขา้ใจ

ตวัเองวา่เรามองเราคดิทลีะขัน้อยา่งไร เราก็จะสรา้งสตูรไดง้า่ยโดยไมต่อ้งทอ่ง เชน่ เวลา

เราคดิเรือ่งเงือ่นไขวา่ ถา้ทําด ีตอ้งไดด้ ีแตถ่า้ไมทํ่าด ีตอ้งไดเ้รือ่งอืน่ๆ ตวัสตูร IF ของ 

Excel ก็จะมลํีาดบัในโครงสรา้งสตูรตามแบบทีเ่ราคดิออกมาเป็น =IF(ทําดใีชไ่หม, ไดด้,ี 

ไดอ้ืน่ๆ) ขอใหอ้า่นรายละเอยีดประเด็นนีจ้ากบทความเรือ่ง เมือ่สตูร Excel มชีวีติจติใจ หรอื

จากลงิค ์www.excelexperttraining.com/blogs/archives/z300-ExcelCore000706.php 

6. ในโครงสรา้งสตูร ถา้มกีารอา้งองิกบัตําแหน่งเซลลต์ามแนวนอนและแนวตัง้ จะตอ้งใส่

ตําแหน่งอา้งองิตามแนวนอนไวก้อ่นแนวตัง้เสมอ ดไูดจ้ากสตูร Index หรอืสตูร Offset 

(ดงันัน้เราควรสรา้งสตูรคํานวณบวกลบคณูหารอืน่ๆใหใ้ชตํ้าแหน่งอา้งองิตามแนวนอนกอ่น

แนวตัง้ดว้ยเชน่กนั เพือ่เป็นแบบแผนชว่ยใหเ้ขา้ใจทีไ่ปทีม่าและแกะสตูรไดง้า่ย) 
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7. ถา้ในโครงสรา้งสตูรประเภทฐานขอ้มลู มตีวัแปร (Option) ทีอ่าจใสห่รอืไมใ่สก่็ได ้เชน่สตูร 

VLookup หรอืสตูร Match ขอใหย้ดึหลกัวา่ 

7.1. ถา้ไมใ่ส ่Option หรอืละไว ้หรอืใสต่วัเลข 1 นัน้ สตูรนีจ้ะใชก้บัตารางขอ้มลู ทีเ่รยีงคา่

จากนอ้ยไปมาก (จําไวว้า่เรยีงตามธรรมชาตติอ้งเรยีงจากนอ้ยไปมากเสมอ) 

7.2. ถา้ใส ่Option เป็น False หรอืใสต่วัเลข 0 สตูรนีจ้ะใชก้บัตารางขอ้มลูทีไ่มเ่รยีงลําดบั 

(จําไวว้า่ 0 แปลวา่ไม ่หมายถงึไมต่อ้งเรยีงลําดบั) 

7.3. ถา้ใส ่Option เป็นตวัเลข -1 นัน้ สตูรนีจ้ะใชก้บัตารางขอ้มลู ทีเ่รยีงคา่จากมากไปนอ้ย 

(จําไวว้า่เรยีงผดิธรรมชาตติอ้งเรยีงจากมากไปนอ้ย) 

ตวัอยา่งลําดบัการคาํนวณตามเครือ่งหมายบวกลบคณูหาร 

ถา้สรา้งสตูร =1+2-3*4/5^6 ลงไปในเซลล ์Excel จะคํานวณตามหลกัการดงันี ้

1. คํานวณเครือ่งหมายยกกําลงั ^ กอ่น น่ันคอืจะคํานวณ 5^6 

2. ตามดว้ยการคํานวณคณูหรอืหาร แลว้แตว่า่เครือ่งหมายใดมากอ่นจากซา้ยไปขวา น่ันคอื

จะคํานวณ 3*4 แลว้จงึนําผลคณูทีไ่ดไ้ปหารดว้ยคําตอบทีไ่ดจ้าก 5^6 

3. ตามดว้ยการคํานวณบวกหรอืลบ แลว้แตว่า่เครือ่งหมายใดมากอ่นจากซา้ยไปขวา น่ันคอื

จะคํานวณ 1+2 แลว้จงึนําผลบวกทีไ่ดไ้ปลบกบัผลลพัธท์ีไ่ดจ้าก 3*4/5^6 

จะสรา้งสตูรใหวุ้น่กนัไปไดแ้คไ่หน   

สตูรสําเร็จรปูของ Excel 2003 ทีเ่ราใชก้นัจนชนิ (จนไมอ่ยากเปลีย่นมาใช ้Excel 2007 หรอื 

Excel รุน่ทีใ่หมก่วา่) มขีอ้กําหนดในตวัสตูรวา่ ในวงเล็บของสตูรสําเร็จรปูหนึง่ๆนัน้ สามารถซอ้น

สตูรเขา้ไปไดอ้กี 7 สตูร และในวงเล็บของบางสตูรจะถกูแบง่ Argument หรอืตวัแปรทีค่ัน่ดว้ย

เครือ่งหมาย comma แบง่ไดส้งูสดุ 30 Arguments (หรอือกีนัยหนึง่ใส ่Comma ไดส้งูสดุ 29 

ตวัเพือ่แบง่สว่นในวงเล็บออกเป็น 30 สว่น) และสตูรทีย่าวทีส่ดุทีส่ามารถพมิพล์งไปในเซลล์

หนึง่ๆไดนั้น้ ยาวไดส้งูสดุ 1,024 ตวัอกัษร 

ขอ้กําหนดเหลา่นีนั้บวา่เพยีงพอกบัการคํานวณทัว่ไป นานๆทจีงึมโีจทยท์ีต่อ้งใชจ้นเกนิกวา่

ขดีจํากดั ซึง่แกไ้ขไดง้า่ยๆโดยแยกการคํานวณเป็นสว่นๆ แลว้แบง่แตล่ะเซลลใ์หแ้ยกคํานวณ

แตล่ะสว่นของสตูร จากนัน้จงึนําผลการคํานวณทีไ่ดม้าคํานวณรว่มกนัตอ่เป็นขัน้ๆ หรอืไมก่็ตอ้ง

ฉลาดเลอืกใชส้ตูรอืน่ทีคํ่านวณไดคํ้าตอบแบบเดยีวกนัแทน  
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สําหรับสตูรสําเร็จรปูใน Excel รุน่ 2007 เป็นตน้มา ปรับขอ้กําหนดดงักลา่วเป็นดงันี ้

1. ในวงเล็บของสตูรสําเร็จรปู สามารถซอ้นสตูรเขา้ไปไดอ้กี 64 สตูร (Nested levels of 

functions) 

2. ในวงเล็บของสตูรสําเร็จรปู สามารถแบง่ออกเป็น 255 arguments (Arguments in 

Functions) 

3. ในเซลลห์นึง่ๆรับสตูรไดย้าวทีส่ดุ 8,192 characters (Length of formula contents) 

ขอ้กําหนดเหลา่นีเ้ปิดกวา้งใหเ้ราสรา้งสตูรไดส้บายขึน้ ซึง่ขอแนะนําวา่อยา่ใชค้วามสบายจนเกนิ

ตวั เพราะตวัคณุน่ันแหละทีจ่ะถกูลงโทษหากสรา้งสตูรแบบสบายเกนิไป เพราะหากตอ้ง

ยอ้นกลบัมาแกะสตูรเพือ่แกไ้ขอกีในภายหลงั มนัไมใ่ชง่านทีง่า่ยเลยทีจ่ะแกะสตูรซอ้นกนัหลาย

สบิชัน้ 

พงึระลกึไวเ้สมอวา่ สตูรทีค่ณุสรา้งตัง้แตแ่รกนัน้ ตอ้งเป็นสตูรทีใ่ชง้านไดต้ลอดไปโดยไมต่อ้ง

ยอ้นกลบัมาแกไ้ขสตูรอกี แตถ่า้จําเป็นตอ้งแกไ้ขสตูร ก็ตอ้งแกไ้ขไดง้า่ย ไมว่า่คณุหรอืเพือ่น

ของคณุก็ตอ้งแกะสตูรไดง้า่ย 

ดงันัน้การที ่Microsoft ปรับขอ้จํากดัของสตูรใหย้ดืหยุน่มากขึน้นี ้ถา้สตูรใดทีค่ณุคดิวา่มเีงือ่นไข

ของการคํานวณไมย่ากนัก"ตอ่การจําของคณุ"และงา่ยทีจ่ะยอ้นกลบัมาแกไ้ข ก็เชญิซอ้นสตูรเขา้

ไปหลายๆชัน้ไดต้ามใจ แตถ่า้มทีางเลอืกอืน่ทีด่กีวา่ เชน่ มสีตูรอืน่ หรอืตอ้งปรับโครงสรา้ง

ตารางเสยีใหมเ่พือ่ใหเ้ขา้กบัสตูรนัน้ ก็ขอแนะนําใหต้ดัสนิใจเลอืกใหด้ ี

สตูรทีห่าคา่ได ้ก็ใชบ้อกตาํแหนง่ได ้  

เชือ่ไหมวา่เรือ่งทีจ่ะอธบิายนีแ้ทบทกุคนทีใ่ช ้Excel ทราบกนัดอียูแ่ลว้ ใชก้นัอยูท่กุวนั แตน่กึไม่

ถงึวา่สตูรทีห่าคา่ได ้จะใชบ้อกตําแหน่งทีแ่ปลกแตกตา่งจากทีเ่ขา้ใจกนัอยา่งไร 

พอสรา้งสตูรลงไปในเซลลใ์ดๆก็ตามวา่ =A1 สตูรนีก้็จะดงึคา่จากเซลล ์A1 มาแสดงใหเ้ห็น 

และพรอ้มกนันัน้เราก็จะทราบดว้ยวา่ คา่ทีไ่ดน้ีม้าจากเซลล ์A1 เพราะดจูากตวัสตูรทีใ่ชตํ้าแหน่ง

อา้งองิ =A1 น่ันเอง 

ทีพ่เิศษไปกวา่นี ้หากคณุตดักาในชอ่ง Allow edit directly in cells ทิง้ไป (ใน Excel Options 

> Advanced หรอืใน Excel 2003 ใชเ้มนู Tools > Options > Edit) จะพบวา่เมือ่ดบัเบลิคลกิ

ทีเ่ซลลส์ตูร =A1 จะยา้ยตําแหน่ง cursor ไปทีเ่ซลลต์น้ทาง A1 ใหท้นัท ี
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สิง่ทีอ่ธบิายขา้งตน้นีเ้คยอธบิายมาหลายตอ่หลายครัง้ในการอบรมและในเว็บ 

ExcelExpertTraining.com ซึง่พฤตกิรรมแบบนีแ้หละทีนํ่าไปสูเ่รือ่งแปลกทีค่าดไมถ่งึ จากเดมิ

ทีเ่ขยีนวา่ "สตูรทีห่าคา่ได ้ก็ใชบ้อกตําแหน่งได"้ ขอเขยีนใหมใ่หล้ะเอยีดชดัเจนกวา่เดมิวา่ 

สตูรใดๆทีส่ามารถหาคา่ทีเ่ก็บไวจ้ากตารางไดโ้ดยตรง สตูรนัน้ยอ่มเป็นสตูรทีบ่อก

ตําแหน่งได ้โดยอยา่สรา้งสตูรนัน้ลงไปในเซลล ์แตต่อ้งนําสตูรนัน้ไปซอ้นในสตูรอืน่ก็จะ

กลายเป็นสตูรทีบ่อกตําแหน่ง  

ยกตวัอยา่งเชน่ สตูร =INDEX(A1:B10,5,2) เป็นสตูรหาคา่จากตารางขอ้มลูชว่ง A1:B10 ใน

ตําแหน่ง Row 5 ตดักบั Column 2 จะไดค้า่จากเซลล ์B5 

ถา้อยากจะตามไปดวูา่เซลล ์B5 อยูท่ีไ่หนโดยไมต่อ้งน่ังแกะสตูรวา่ Row 5 ตดักบั Column 2 

คอืเซลลใ์ด ใหห้ยบิเมาสค์ลกิลากทบัสตูร =INDEX(A1:B10,5,2) ทีแ่สดงบน Formula Bar 

จากนัน้กดปุ่ ม F5 แลว้กดปุ่ ม Enter จะพบวา่สตูร =INDEX(A1:B10,5,2) เปลีย่นไปเป็น =B5 

ใหท้นัท ีพอเห็นดงันีแ้ลว้ใหก้ดปุ่ ม Esc เพือ่ทําใหส้ตูรคนืสูส่ภาพเดมิ 

ยิง่กวา่นัน้ ถา้ Copy สตูร =INDEX($A$1:$B$10,5,2) ไวก้อ่นแลว้กดปุ่ ม F5 แลว้กดปุ่ ม Ctrl+v 

เพือ่ Paste สตูรนีล้งไปในชอ่ง Reference แลว้กดปุ่ ม Enter จะพบวา่ Excel พาคณุยา้ย

ตําแหน่งไปทีเ่ซลล ์B5 ใหเ้ลย (สงัเกตวา่วธินีีต้อ้งกําหนดตําแหน่งอา้งองิเป็น Absolute คอื 

$A$1:$B$10 กอ่นดว้ย) 

ยิง่กวา่นีข้องยิง่กวา่นัน้อกี ถา้นําสตูร INDEX(A1:B10,5,2) ไปซอ้นในสตูรอืน่ เชน่ สตูร Offset 

จะทําใหส้ตูร INDEX(A1:B10,5,2) ทําหนา้ทีช่ ีตํ้าแหน่งตอ่ใหก้บั Offset 

ขอใหส้รา้งสตูร =OFFSET(INDEX(A1:B10,5,2),2,3) แลว้ลองใชว้ธิขีา้งตน้คน้หาวา่หมายถงึ

เซลลใ์ด จะพบวา่เป็นเซลล ์E7 ใชไ่หม เพราะเซลล ์E7 เป็นเซลลท์ีอ่ยูถ่ดัลงมาจากเซลล ์B5 

จํานวน 2 row และถดัไปดา้นขวาจํานวน 3 column เทยีบเทา่กบัการใชส้ตูร 

=OFFSET(B5,2,3) น่ันเอง 

แตถ่า้สรา้งสตูร =INDEX(A1:B10,5,2) ไวใ้นเซลล ์D12 แลว้ใชส้ตูร Offset อา้งถงึ D12 ใน

แบบ =OFFSET(D12,2,3) จะพบวา่ D12 ไมไ่ดช้ว่ยบอกตําแหน่งตอ่ใหก้บัสตูร Offset เพราะ

สตูร Index ในเซลล ์D12 ทําหนา้ทีห่าคา่จากเซลล ์B5 มาแสดงเสร็จก็จบหนา้ทีไ่ปแลว้ 
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สตูรทีส่ามารถหาคา่ทีเ่ก็บไวจ้ากตารางไดโ้ดยตรง ซึง่ทํางานไดแ้บบทีอ่ธบิายนี ้ไดแ้ก ่If, 

Choose, Index, Offset, Indirect (แตไ่มร่วมสตูร VLookup เพราะมนัไมไ่ดห้าคา่ไดโ้ดยตรง) 

ซึง่ไมจํ่าเป็นตอ้งคนืคา่เพยีงคา่เดยีวเป็นตําแหน่งเซลลเ์ดยีว โดยสามารถคนืคา่เป็นตารางเพือ่

ใชบ้อกตําแหน่งตารางทัง้ตารางก็ยงัได ้

ดตูวัอยา่งประกอบบทความนีไ้ดจ้าก 

"www.excelexperttraining.com/forums/content.php?r=191-สตูร-ตําแหน่งอา้งองิ" 

จํานวนเซลลส์ตูรเดยีว   

ผูส้รา้งสตูร Excel ทัว่ไป คุน้เคยกบัการสรา้งสตูรหนึง่ทีค่นืคา่เพยีงหนึง่คา่ หรอือกีนัยหนึง่

เรยีกวา่ สตูรเดยีวคนืคา่เดยีว ซึง่สรา้งลงไปในเซลลเ์ดยีว แตน่อ้ยคนนักทีจ่ะทราบวา่ สตูร Excel 

สตูรหนึง่ๆสามารถคนืคา่เป็นคําตอบไดห้ลายคา่ก็เป็นไปไดเ้หมอืนกนั สตูรพวกหลงันีเ้รยีกวา่ 

สตูร Array 

การทีเ่ราเลอืกเซลลเ์ดยีว แลว้พมิพส์ตูรลงไปในเซลลเ์ดยีวนัน้ มสีาเหตเุนือ่งจากสตูรนัน้คนืคา่

ไดคํ้าตอบเพยีงคา่เดยีว 

ถา้สตูรหนึง่ๆคนืคา่เป็นคําตอบไดห้ลายคา่ หากสรา้งสตูรนัน้ลงไปในเซลลเ์ดยีว ยอ่มไมถ่กูตอ้ง 

แมจ้ะเห็นคําตอบแสดงขึน้มาก็ตาม เพราะคําตอบทีแ่สดงขึน้มาใหเ้ห็นนัน้เป็นเพยีงคําตอบแรก

คําตอบเดยีว เราหมดโอกาสทราบคําตอบคา่อืน่ๆ 

พออา่นถงึตรงนี ้คนทีไ่มรู่จั้กกบัสตูร Array คงเริม่สงสยัวา่ สตูรแบบไหนกนัทีม่คํีาตอบไดห้ลาย

คา่ในสตูรเดยีว มาทดลองโดยเริม่จากพมิพค์า่ใดๆก็ไดล้งไปในเซลล ์A1:A3 สมมตวิา่พมิพ ์11, 

22, 33 ตามลําดบั  
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แลว้สรา้งสตูร =A1:A3 ลงไปในเซลล ์B1 จะเห็นคําตอบเป็นเลข 11 คา่เดยีวใชไ่หม 

จากนัน้ใหแ้กะดคูา่ทีแ่ทจ้รงิในสตูร โดยกดปุ่ ม F2 ตามดว้ยปุ่ ม F9 จะพบวา่สตูร =A1:A3 

เปลีย่นเป็น ={11;22;33} 

ขอใหส้งัเกตวา่เครือ่งหมายวงเล็บ { ทีเ่กดิขึน้นัน้อยูห่ลงัจากเครือ่งหมายเทา่กบั ซึง่แสดงคา่

แบบ Array และระหวา่งตวัเลขจะมเีครือ่งหมาย semi-colon ; คัน่ ซึง่แสดงวา่คา่ถดัไปอยูใ่น 

Row ถดัไป (หรอืขึน้ Row ใหม)่ 

พอเห็นคา่แลว้วา่สตูรนีม้ ี3 คา่และแตล่ะคา่อยูต่ามแนวตัง้ ก็ใหก้ดปุ่ ม Esc เพือ่ยอ้นกลับไปเป็น

สตูร =A1:A3 ตามเดมิ 

คราวนีถ้งึขัน้ตอนสําคญั หากตอ้งการกระจายคา่แตล่ะคา่ในสตูร Array ลงไปในเซลล ์ใหเ้ริม่

จากเลอืกเซลล ์3 เซลลต์ามแนวตัง้ (เพราะเราทราบจากการแกะสตูรมากอ่นแลว้วา่มคีา่ 3 คา่

ตามแนวตัง้) โดยจะเลอืกทีตํ่าแหน่งใดก็ไดใ้นชที จากนัน้สรา้งสตูร =A1:A3 ลงไปแลว้กดปุ่ ม 

Ctrl+Shift+Enter พรอ้มกนั จะพบวา่ Excel กระจายคา่ในสตูรลงไปในเซลลแ์ตล่ะเซลลใ์หเ้ห็น

จนครบ และตวัสตูรเปลีย่นเป็น {=A1:A3} โดยสงัเกตวา่คราวนีเ้ครือ่งหมาย { ตวัแรกวางไว ้

กอ่นเครือ่งหมายเทา่กบั แสดงวา่เป็นวงเล็บปีกกาทีเ่กดิจากการกดปุ่ ม Ctrl+Shift+Enter 

(ไมใ่ชว่งเล็บปีกกาทีใ่ชกํ้ากบัลําดบัของคา่ทีต่อ้งอยูห่ลงัเครือ่งหมายเทา่กบั) 

ประโยชนข์องการเลอืกจํานวนเซลลใ์หค้รบเหมาะกบัจํานวนและแนวของคา่ทีต่อ้งการนี ้จะชว่ย

ใหเ้ราเห็นคา่ทกุคา่กระจายตวัลงไปในเซลลแ์ตล่ะเซลล ์ทําใหป้ระหยดัเวลาไมต่อ้งคอยกดปุ่ ม 

F2 ตามดว้ย F9 เพือ่แกะสตูรเป็นครัง้ๆไป อกีทัง้สตูรทีส่รา้งขึน้พรอ้มกนัทเีดยีวหลายเซลล ์จะ

ทําให ้Excel เสยีเวลาในการคํานวณเพยีงครัง้เดยีว 

วธิแีก ้error #VALUE! ดว้ย Lotus 1-2-3   

เมือ่นําเซลลท์ีม่คีา่เป็นตวัเลขมาบวกดว้ยเซลลท์ีม่คีา่เป็นตวัอกัษรโดยการสรา้งสตูรบวกทีนํ่า

เซลลม์าบวกกนั เชน่ =A1+A2 จะพบวา่ไดคํ้าตอบเป็น #VALUE! นัน้ เราสามารถสัง่ให ้Excel 

คํานวณหาคําตอบเป็นยอดรวมเฉพาะตวัเลขไดโ้ดยใชส้ัง่ให ้Excel คํานวณแบบ Lotus 1-2-3 

ใน Excel 2010 เริม่จากสัง่ File > Options > Advanced > แลว้เลือ่นจอไปดา้นลา่งสดุจะพบ 

Lotus compatibility Settings for: ชือ่ชทีทีต่อ้งการใหคํ้านวณแบบ Lotus 1-2-3 โดยใหก้า
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ชอ่ง Transition formula evaluation (Excel 2007 ใหค้ลกิปุ่ ม Office แทน File หรอื Excel 

2003 สัง่ Tools > Options > Transition > กาชอ่ง Transition formula evaluation) 

 

คําสัง่ Transition formula evaluation นีเ้กดิขึน้ในสมยัทีค่นทัง้โลกยงันยิมใช ้Lotus 1-2-3 กนั 

ดงันัน้เพือ่ชว่ยทําใหค้นเปลีย่นใจมาใช ้Excel ไดง้า่ยขึน้ ทางไมโครซอฟทจ์งึสรา้งคําสัง่นีข้ ึน้

เพือ่ใหพ้วกเราสามารถนําแฟ้มทีส่รา้งจาก Lotus 1-2-3 มาเปิดใชใ้น Excel ตอ่ไดท้นัทโีดย 

Excel จะเปลีย่นระบบการคํานวณในชทีทีเ่ลอืกไวใ้หคํ้านวณตามแบบที ่Lotus 1-2-3 ใชน่ั้นคอื

ใน Lotus 1-2-3 ถอืวา่ตวัอกัษรมคีา่เทา่กบั 0 (สว่น Excel ถอืวา่ตวัอกัษรมคีา่มากกวา่เลขทัง้

ปวง) 

นอกจากนัน้หากกาชอ่ง Transition formula entry จะชว่ยทําใหส้ตูรทีส่รา้งจาก Lotus 1-2-3 

release 2.2 ถกูเปลีย่นเป็นสตูรของ Excel ใหท้นัทเีมือ่เปิดแฟ้มทีใ่ชส้ตูรนัน้ดว้ย Excel 

สว่นชอ่ง Transition navigation keys จะเปลีย่นพฤตกิรรมของปุ่ มลกูศร ปุ่ ม Tab หรอืปุ่ มใดๆที่

ทําหนา้ทีเ่คลือ่นยา้ยตําแหน่งเซลลท์ีเ่ลอืก ใหทํ้าตามที ่Lotus 1-2-3 ใช ้ซึง่ชว่งแรกกวา่ผมจะ

หนัมาใช ้Excel อยา่งเต็มตวั ตอ้งอาศยักาชอ่งนีอ้ยูน่านเพราะมอืยงัไมคุ่น้กบัปุ่ มทีเ่คยเลือ่นไป

เลือ่นมาตามแบบทีต่วัเองเคยชนิ 
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ตวัอกัษรมไิดม้คีา่เทา่กบั 0 

กอ่นจะจบบทความนี ้ทราบไหมวา่ ตวัอกัษร a หรอืตวัอกัษรใดๆก็ตามทีบ่นัทกึลงไปในเซลล ์

มไิดถ้อืวา่มคีา่เทา่กบั 0 หรอกนะ ถา้ไมเ่ชือ่ สมมตวิา่เซลล ์A1 มคีา่เป็น a ขอใหล้องสรา้งสตูร 

=A1=0 ดกู็ไดจ้ะพบวา่ไดคํ้าตอบเป็น FALSE สว่นสตูร =A1>999999999 จะไดคํ้าตอบเป็น 

TRUE 

Excel ถอืวา่ตวัอกัษรใดๆมคีา่มากกวา่เลขทัง้ปวง อกีนัยหนึง่มคีา่เป็น Infinity หากสรา้งสตูร 

=Sum(A1,123) แลว้ไดคํ้าตอบเทา่กบั 123 เป็นเพราะ Excel จะละเลยไมนํ่าตวัอกัษรมา

คํานวณในสตูร Sum นีแ่หละเป็นเรือ่งทีห่ลายๆคนชอบเขา้ใจผดิกนัวา่ ตวัอกัษรมคีา่เป็น 0 

ถา้สรา้งสตูร =A1+123 จะไดคํ้าตอบเป็น #VALUE! เพราะ Excel จะไมย่อมรับการนําตวัอกัษร

มาบวกกบัตวัเลข แตเ่ราสามารถเปลีย่นพฤตกิรรมของ Excel ใหค้ดิแบบ Lotus 1-2-3 ไดต้าม

คําอธบิายขา้งตน้ 

ถา้ถามวา่ระหวา่งสตูรบวกกบัสตูร Sum เราจะเลอืกใชก้ารบวกเลขวธิใีดกบังานสําคญั 

คําตอบก็คอื ตอ้งเลอืกใชส้ตูรบวก เพราะหากมกีารบนัทกึตวัเลขผดิ กลายเป็นบนัทกึตวัอกัษร

ลงไปแทน จะพบวา่ Excel ไมย่อมคํานวณให ้โดยไดคํ้าตอบเป็น #VALUE! ซึง่เทา่กบัชว่ย

เตอืนเราใหท้ราบวา่เกดิขอ้ผดิพลาดขึน้มาในระหวา่งการบนัทกึขอ้มลูน่ันเอง 
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การแบง่ขอบเขตพืน้ทีต่าราง 

ในชทีของ Excel 2007 เป็นตน้มามพีืน้ทีต่ารางใหญก่วา่รุน่กอ่นอยา่งมาก จากเดมิมเีพยีง 

65,536 row และ 256 column ไดป้รับเพิม่เป็น 1,048,576 row และ 16,384 column ซึง่ถา้

คณุพมิพค์า่ลงไปแลว้พยายาม paste ใหค้รบทกุเซลลใ์นชที จะพบวา่ Excel ตอ้งใชเ้วลานาน

แสนนานทเีดยีวกวา่จะไดข้อ้มลูเต็มทัง้ชที และเมือ่สัง่ save จะไมม่ ีhard disk เครือ่งไหนที่

สามารถเก็บแฟ้มขอ้มลูนัน้ได ้เพราะแฟ้มจะมขีนาดใหญเ่กนิกวา่จะรับได ้(ขออยา่พยายาม

ทดลองทําตามนีเ้ด็ดขาด เพราะคณุจะรอไมไ่หวแลว้ตอ้งหนัไปปิดเครือ่งคอมพวิเตอรไ์ปกอ่นที่

จะ save เสร็จ) 

สาเหตทุี ่Excel ขยายขนาดตารางใหใ้หญข่ึน้จนดเูหมอืนใหญก่วา่ความจําเป็น มไิดมุ้ง่ใหค้ณุ

จําเป็นตอ้งใชใ้หค้รบทกุเซลล ์เพยีงแตจ่ะชว่ยใหส้ามารถรับขอ้มลูจากโปรแกรมอืน่เขา้มาเก็บไว ้

ในชทีไดส้ะดวกขึน้ และเมือ่คณุหนัมาใช ้Excel 2007 แลว้ก็มไิดห้มายความวา่จากนีไ้ปคณุไม่

จําเป็นตอ้งใชโ้ปรแกรมฐานขอ้มลูอืน่อกีตอ่ไป เพราะในทีส่ดุแลว้เมือ่ขอ้มลูมปีรมิาณมากขึน้และ

มคีวามสมัพันธใ์นตวัฐานขอ้มลูซบัซอ้นตามขึน้ไปแลว้ โปรแกรมทีส่รา้งขึน้มาเพือ่จัดการ

ฐานขอ้มลูโดยเฉพาะยอ่มเหมาะกวา่อยูด่ ี

อยา่วา่แตข่นาดของตารางทีม่ขีนาดใหญส่ามารถรับขอ้มลูไดม้ากขึน้นีเ้ลย ตอ่ใหใ้ช ้Excel 2003 

ทีม่ขีนาดตารางเล็กกวา่ หากผูใ้ช ้Excel ไมเ่ป็น พอนําขอ้มลูมาเก็บไวใ้นชทีอยา่งไมม่หีลกัการ 

แลว้เมือ่ถงึเวลาจะตอ้งแยกขอ้มลูออกจากกนัเป็นสว่นๆก็จะทําไดย้าก จงึขอเสนอใหใ้ชห้ลกั 

ICO แบง่ขอบเขตพืน้ทีต่าราง กลา่วคอื 

1. ใหแ้บง่แยกตารางขอ้มลูออกเป็น 3 ประเภท คอื ตาราง Input, ตาราง Calculate, และ 

ตาราง Output (หรอืใชต้ัวยอ่วา่ ICO) 

2. ตาราง Input คอื ตารางทีใ่ชเ้ก็บขอ้มลูทีพ่มิพล์งไปหรอืเป็นขอ้มลูทีรั่บมาจากโปรแกรม

อืน่ หรอือกีนัยหนึง่เป็นตารางฐานขอ้มลูน่ันเอง ตาราง Input นีต้อ้งออกแบบใหโ้ครงสรา้ง

ของตารางมลีกัษณะดงันี ้

2.1. หวัตารางดา้นบน ตอ้งเป็น row เดยีว ซึง่อาจแตง่ขอ้ความในเซลลใ์หแ้สดงเป็นหลาย

บรรทดัได ้โดยกดปุ่ ม Alt+Enter เพือ่ขึน้ขอ้ความในบรรทดัใหมใ่นเซลลเ์ดมิ 

2.2. ตอ้งบนัทกึขอ้มลูใน column ใด column หนึง่ตดิตอ่กนัไปตลอด หา้มเวน้ชอ่งวา่ง ซึง่

โดยทัว่ไป column ซา้ยสดุมกัจะมขีอ้มลูตดิตอ่กนัไปอยูแ่ลว้เนือ่งจากเป็นขอ้มลูของ

เลขทีร่ายการ หรอืขอ้มลูรหสั หรอืขอ้มลูวนัทีซ่ ึง่เรยีงไปตามลําดบัรายการทีเ่กดิขึน้ 
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2.3. ตอ้งเวน้ขอบตารางไมว่า่จะเป็นขอบดา้นบนลา่งซา้ยขวาอยา่งนอ้ยขา้งละ 1 เซลล ์หา้ม

นําตาราง Input ไปตดิกบัเซลลข์อ้มลูอืน่ซึง่ไมใ่ชข่อ้มลูเรือ่งเดยีวกบัตารางขอ้มลูนัน้ 

3. ตาราง Calculate คอื ตารางทีใ่ชส้รา้งสตูรคํานวณ ไมจํ่าเป็นตอ้งมโีครงสรา้งตามแบบ

ของตาราง Input แตใ่นตาราง Calculate นีค้ณุตอ้งหาทางสรา้งสตูรทีเ่ซลลห์วัมมุเป็นสตูร

ฉลาดทีส่ามารถปรับตําแหน่งอา้งองิไดเ้อง และในขณะทีส่รา้งสตูรตอ้งใชปุ้่ ม F4 เพือ่ใส่

เครือ่งหมาย $ เพือ่ควบคมุตําแหน่งอา้งองิในสตูรไปยงัเซลลท์ีบ่นัทกึคา่ตัวแปรทีใ่ชคํ้านวณ

ไว ้ซึง่โดยทัว่ไปเซลลค์า่ตวัแปรจะวางไวต้ามแนวคูข่นานกบัแนวของตาราง Calculate เพือ่

ชว่ยใหเ้ครือ่งหมาย $ ทีใ่สไ่วใ้นสตูร ทําหนา้ทีค่วบคมุตําแหน่งของแนวของเซลลต์วัแปรไว ้

เพือ่นําคา่มาใชคํ้านวณน่ันเอง 

4. ตาราง Output คอื ตารางแสดงผลลพัธท์ีต่อ้งการ โดยตารางนีจ้ะออกแบบใหม้หีนา้ตา

อยา่งไรก็ไดต้ามแตว่า่จะนําไปแสดงผลบนจอภาพหรอืในหนา้กระดาษทีส่ัง่พมิพ ์

สาเหตทุีต่อ้งใชห้ลกั ICO แยกขอ้มลูแตล่ะประเภทออกจากกนั เพือ่ชว่ยทําใหเ้ราสามารถใช ้

Excel รองรับกบัขอ้มลูทีม่ปีรมิาณมากขึน้ไปเรือ่ยๆไดต้ลอด ซึง่ในชว่งแรกทีย่งัมขีอ้มลูไมม่าก

นัก อาจใชช้ทีเดยีวเก็บขอ้มลูทัง้ I C และ O ไวด้ว้ยกนั จากนัน้เมือ่มปีรมิาณขอ้มลูมากขึน้หรอื

ขอ้มลูมคีวามสลบัซบัซอ้นมากขึน้จงึคอ่ยยา้ยตารางแยกไปเก็บในชทีอืน่หรอืแฟ้มอืน่ไดท้นัที

โดยไมก่ระทบกบัสตูรคํานวณทีส่รา้งไว ้

ขอ้ผดิพลาดทีพ่บเห็นบอ่ยครัง้เกดิจากการออกแบบตารางตามแบบรายงานทีต่อ้งพมิพ ์เชน่ 

หากมรีายงานยาว 100 หนา้ ก็มกัออกแบบตารางใน Excel ใหย้าวเหยยีดตอ่ๆกนัลงมาทัง้ 100 

หนา้แลว้จงึสัง่พมิพอ์อกไปทลีะหนา้ ซึง่วธินีีทํ้าใหแ้ฟ้มมขีนาดใหญแ่ละยากตอ่การแกไ้ขเพราะ

จําเป็นตอ้งยอ้นกลบัไปไลแ่กไ้ขในตารางแตล่ะหนา้ 

แตห่ากออกแบบตารางแบบ ICO เป็น ใหเ้ริม่จากแยกตารางขอ้มลูทีเ่ป็น Input ออกไป แลว้ใช ้

สตูรดงึคา่จากตาราง Input มาคํานวณในตาราง Calculate จากนัน้จงึดงึผลลพัธท์ีคํ่านวณเสร็จ

แลว้ไปสรา้งตาราง Output ซึง่จดุสําคญัอยูท่ีต่าราง Output นีแ่หละ โดยเราตอ้งหาทางสรา้ง

ตาราง Output ไวเ้พยีงหนา้เดยีว จากนัน้ตอ้งสรา้งสตูรดงึขอ้มลูแตล่ะหนา้มาแสดงในตาราง 

Output หนา้เดยีวนีใ้หไ้ด ้ชว่ยใหแ้ฟ้มมขีนาดเล็กและแกไ้ขไดง้า่ยกวา่มาก 

สมมตวิา่หนา้กระดาษทีพ่มิพม์ ี30 บรรทดัตอ่หนา้ ดงันัน้พอพมิพเ์ลขหนา้ที ่1 ลงไป ตอ้งสรา้ง

สตูรดงึผลลัพธบ์รรทดัที ่1 - 30 มาแสดงในหนา้นี ้จากนัน้พอเปลีย่นเลขหนา้เป็นเลข 2 ก็จะได ้

บรรทดัที ่31 – 60 มาแสดง พอเป็นหนา้ 3 ก็ไดบ้รรทดัที ่61 - 90 มาแสดง ซึง่สตูรทีด่งึขอ้มลู

เชน่นีไ้ดก้็คอืสตูร VLookup, Match, Index เป็นตน้ 
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การจดัเตรยีมพืน้ที ่ICO เพือ่รบัขอ้มลูและป้องกนัการแกไ้ข 

แฟ้มทีส่รา้งเสร็จพรอ้มใชง้าน ตอ้งมรีะบบแยกแยะตําแหน่งตารางทีเ่ปิดใหรั้บคา่ใหมไ่ดพ้รอ้มทัง้

หาทางป้องกนัตารางทีไ่มต่อ้งการใหใ้ครเขา้ไปแกไ้ข โดยตอ้งพจิารณาจากพืน้ทีต่ารางแตล่ะ

สว่น กลา่วคอื 

1. ตาราง Input เป็นพืน้ทีส่ว่นทีเ่ปิดใหผู้ใ้ชง้านสามารถพมิพค์า่ใหมล่งไปได ้โดยมขีัน้ตอน

ในการจัดเตรยีมพืน้ทีด่งันี ้

1.1. คลกิเลอืกพืน้ทีต่ารางสว่นทีเ่ป็น Input (หากมหีลายพืน้ทีไ่มต่ดิตอ่กนั ใหก้ดปุ่ ม Ctrl 

คา้งไวก้อ่นแลว้คลกิเลอืกพืน้ทีแ่ตล่ะสว่น แลว้อาจกําหนดส ีFont ใหแ้ตกตา่งจากสว่น

อืน่ ซึง่ผมเองชอบใชส้ชีมพเูพือ่บอกผูใ้ชว้า่เป็นเซลล ์Input) 

1.2. คลกิขวา สัง่ Format Cells > Protection > แลว้ตดักาชอ่ง Locked ทิง้ไป 

 

1.3. สัง่ Review > Protect Sheet (Excel 2003 ใชคํ้าสัง่ Tools > Protection > Protect 

Sheet) 

1.4. หลงัจากที ่Protect Sheet เสร็จ เมือ่พมิพข์อ้มลูใหมล่งไปในเซลลท์ีเ่ป็น Input แลว้ 

ใหก้ดปุ่ ม Tab ซึง่จะพบวา่ Excel จะกระโดดไปเลอืกเซลล ์Input ตอ่ไปใหเ้อง 

2. ตาราง Calculate และตาราง Output เป็นพืน้ทีซ่ ึง่มเีซลลส์ว่นใหญเ่ป็นสตูรซึง่เมือ่สรา้ง

เสร็จแลว้ ควรป้องกนัไมใ่หใ้ครเขา้ไปดสูตูร แกไ้ขสตูร หรอืลบสตูรทิง้ไดอ้กี โดยมขีัน้ตอน

ในการจัดเตรยีมพืน้ทีด่งันี ้(ถา้ชทีถกู Protect อยูต่อ้ง Unprotect Sheet กอ่น) 

2.1. คลกิเลอืกพืน้ทีต่ารางสว่นทีเ่ป็นตาราง Calculate และตาราง Output 

2.2. คลกิขวา สัง่ Format Cells > Protection > แลว้กาชอ่ง Hidden เพือ่ซอ่นการ

แสดงสตูรทีจ่ะเห็นบน Formula Bar และยงัป้องกนัไมใ่ห ้Copy สตูรออกไปไดด้ว้ย 

โดยจะ Copy เฉพาะคา่ผลลพัธอ์อกไปไดเ้ทา่นัน้ (หา้มตดักาชอ่ง Locked ทิง้อยา่ง

เด็ดขาด) และตอ้งทําขัน้ตอนตอ่ไปกอ่นดว้ยจงึจะเห็นผล 

 

2.3. สัง่ Review > Protect Sheet (Excel 2003 ใชคํ้าสัง่ Tools > Protection > Protect 

Sheet) 
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การกาํหนดตาํแหนง่อา้งองิ 

ขา้มชทีหรอืขา้มแฟ้ม 

ผมเริม่ตน้ใชโ้ปรแกรม Excel ตัง้แตย่คุทีใ่นแฟ้มหนึง่ๆยงัมชีทีใหใ้ชง้านไดเ้พยีงชทีเดยีวและยงั

ไมส่ามารถใชส้ตูรเชือ่มขอ้มลูจากแฟ้มอืน่มาใชง้านรว่มกนั ในยคุนัน้ตอ้งออกแบบตารางทัง้หมด

ลงไปในชทีเดยีว ตอ่มา Excel ถกูพัฒนาใหส้ามารถสง่ขอ้มลูจากแฟ้มหนึง่ออกไปยงัแฟ้มอืน่ได ้

แตก่็ยงัไมส่ามารถทําหนา้ทีท่ัง้รับทัง้สง่ขอ้มลูกลบัไปกลบัมาระหวา่งแฟ้มเชน่ที ่Excel ในรุน่

ปัจจบุนัทําได ้ซึง่ถา้ดใูหด้จีะพบวา่สิง่ที ่Excel สามารถสง่ขอ้มลูกลบัไปกลับมาไดนั้น้เป็นเพราะ

เราถกู Excel หลอกใหด้เูหมอืนวา่มหีลายชทีหรอืมหีลายแฟ้ม...แคนั่น้เอง 

ขอใหจํ้าไวว้า่ ไมว่า่จะเป็นตา่งชทีหรอืตา่งแฟ้ม พอเปิดแฟ้มขึน้มาใชง้านพรอ้มกนั มนัก็

คอืชทีเดยีวกนัน่ันแหละ 

การทีเ่ราเห็นวา่ในแฟ้มหนึง่ๆมหีลายชทีนัน้ เป็นภาพลวงตาทีช่ว่ยใหผู้ใ้ชง้านสามารถแยกเก็บ

ขอ้มลูตา่งเรือ่งไวใ้นชทีตา่งกนัไป สว่นขอ้มลูที ่link ขา้มแฟ้มไดนั้น้ ถา้คณุใช ้Excel รุน่แรกๆมา

กอ่นอยา่งผม พอสัง่ Unhide Sheet จะพบวา่ในแฟ้มปลายทางมชีทีหนึง่ถกูซอ่นไว ้โดยชทีนีใ้ช ้

เก็บขอ้มลูจากชทีตน้ทางไวท้ัง้หมด ดงันัน้ขอ้มลูทีไ่ดม้าจากสตูร link ขา้มแฟ้ม ถา้วา่กนัให ้

ถกูตอ้ง ไมไ่ดเ้ป็นผลจากสตูรที ่link มาจากแฟ้มตน้ทางโดยตรง แตเ่ป็นขอ้มลูทีไ่ดม้าจากชทีที่

ซอ่นไวภ้ายในชทีปลายทางในแฟ้มเดยีวกนักบัแฟ้มทีม่สีตูร link น่ันเอง โดยเรยีกขอ้มลูทีเ่ก็บ

ในชทีนีว้า่ Cache Data ซึง่สง่ผลใหแ้ฟ้มปลายทางมขีนาดแฟ้มใหญก่วา่ปกตติามไปดว้ย 

(ตอ่มา Microsoft ไดป้รับปรงุให ้Excel ซอ่นชทีนีไ้วโ้ดยไมส่ามารถคน้หาพบเชน่แตก่อ่น)  

ถา้คณุสามารถสรา้งสตูร link ขอ้มลูภายในชทีเดยีวกนั ก็ขอใหใ้ชว้ธิเีดยีวกนัในการ link ขอ้มลู

ขา้มชทีหรอืแมแ้ตข่า้มแฟ้ม ขอเพยีงอยา่กลวัภาพลวงตาทีทํ่าใหเ้ห็นวา่เป็นตา่งชทีหรอืตา่งแฟ้ม

กนัเพราะความจรงิมนัก็คอืชทีเดยีวกนัน่ันเอง ซึง่กอ่นทีจ่ะใชว้ธิสีรา้งสตูร link ทีน่ยิมใชก้นั

ตอ่ไปนี ้ขอใหเ้ปิดแฟ้มทกุแฟ้มทีต่อ้งการสรา้งสตูร link ขอ้มลูระหวา่งกนัขึน้มากอ่นทัง้แฟ้มตน้

ทางและแฟ้มปลายทางแลว้จะชว่ยใหส้รา้งสตูร link ไดง้า่ยมาก 

1. วธิยีอ้นปลายกลบัมาหาตน้  

1.1. ใหเ้ริม่จากพมิพเ์ครือ่งหมายเทา่กบั = ทีเ่ซลลป์ลายทาง  
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1.2. (หากไมต่อ้งการ link ขา้มชทีหรอืขา้มแฟ้มใหข้า้มขัน้ตอนนี)้ คลกิเลอืกชือ่ชทีตน้ทาง 

หรอืคลกิชือ่แฟ้มตน้ทางทีเ่ปิดไวก้อ่นแลว้จากคําสัง่ View > Switch Windows 

(Excel 2003 ใชคํ้าสัง่ Windows เพือ่ไปทีแ่ฟ้มตน้ทาง) 

1.3. แลว้คลกิเลอืกเซลลต์น้ทาง  

1.4. จากนัน้กดปุ่ ม Enter เพือ่รับสตูร link ตําแหน่งเซลลต์น้ทางกลบัไปบนัทกึไวท้ีเ่ซลล์

ปลายทาง (วธินีีโ้ดยทัว่ไปจะทําไดท้ลีะเซลล ์เวน้แตจ่ะสรา้งสตูรแบบ Array จงึจะสรา้ง

พรอ้มกนัหลายเซลลท์ัง้ตาราง และขอใหส้งัเกตวา่ถา้เป็นสตูร link ขา้มแฟ้มจะได ้

ตําแหน่งอา้งองิแบบ Absolute เสมอ) 

2. วธิ ีCopy จากตน้ แลว้มา Paste Special แบบ Paste Link ทีป่ลาย  

2.1. ใหเ้ริม่จากเลอืกพืน้ทีต่ารางตน้ทางทัง้ตารางพรอ้มกนั 

2.2. สัง่ Copy 

2.3. (หากไมต่อ้งการ link ขา้มชทีหรอืขา้มแฟ้มใหข้า้มขัน้ตอนนี)้ คลกิเลอืกชือ่ชที

ปลายทาง หรอืคลกิชือ่แฟ้มปลายทางทีเ่ปิดไวก้อ่นแลว้จากคําสัง่ View > Switch 

Windows (Excel 2003 ใชคํ้าสัง่ Windows เพือ่ไปทีแ่ฟ้มปลายทาง) 

2.4. จากนัน้ใหเ้ลอืกเซลลห์วัมมุตารางปลายทางเพยีงเซลลเ์ดยีวแลว้คลกิขวา สัง่ Paste 

Special > กดปุ่ ม Paste Link จะไดส้ตูร link พรอ้มกนัทเีดยีวทัง้ตาราง 

 

3. วธิ ีCut จากตน้ แลว้ไป Paste ทีป่ลาย โดยวธินีีว้า่ไปแลว้ไมไ่ดเ้ป็นการสรา้งสตูร link 

แตใ่หเ้ริม่จากสรา้งสตูร link ไวใ้นชทีเดยีวกนัตามวธิขีา้งตน้ใหเ้สร็จกอ่น จากนัน้จงึสัง่ Cut 

ตารางสตูรจากชทีตน้ทางไป Paste ทีตํ่าแหน่งปลายทางในชทีอืน่หรอืแฟ้มอืน่ ซึง่ Excel 

จะปรับโครงสรา้งตําแหน่งอา้งองิในสตูรใหก้ลายเป็นตําแหน่งอา้งองิขา้มชทีหรอืขา้มแฟ้มให ้

เองทนัท ี 

วธิทีี ่3 นีเ้ป็นเคล็ดลบัสําคญัในการสรา้งสตูร link ขา้มแฟ้ม โดยเริม่จากสรา้งสตูร link 

ทัง้หมดในชทีเดยีวกนัใหเ้สร็จกอ่น จากนัน้เมือ่ Cut เซลลส์ตูรไปทีช่ทีอืน่จะไดส้ตูร link 
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ขา้มชที หรอืถา้ Cut เซลลส์ตูรไปทีแ่ฟ้มอืน่จะไดส้ตูร link ขา้มแฟ้ม ชว่ยใหไ้มต่อ้งเสยีแรง

เสยีเวลาสรา้งสตูร link ขา้มชทีหรอืขา้มแฟ้มตัง้แตแ่รกแมแ้ตน่อ้ย เชน่  

• จากเดมิสรา้งสตูร link ในชทีเดยีวกนัเป็น =A1  

• พอ Cut ไปทีช่ทีอืน่ สตูรนีจ้ะปรับตวัใหมเ่ป็น =Sheet1!A1 

• พอ Cut ตอ่ไปทีแ่ฟ้มอืน่ สตูรนีจ้ะปรับตวัใหมเ่ป็น =[Source.xlsx]Sheet1!A1 โดย

คําวา่ Source ก็คอืชือ่แฟ้มตน้ทาง และคําวา่ Sheet1 คอืชือ่ชทีตน้ทาง 

• ตอ่มาถา้ปิดแฟ้มตน้ทางทีช่ ือ่ Source ทิง้ สตูรนีจ้ะปรับตวัใหมเ่ป็น 

='D:\Dummy\[Source.xlsx]Sheet1'!A1 

ซึง่การทีม่ชี ือ่ Drive D และชือ่โฟลเดอรว์า่ Dummy แสดงไวด้า้นหนา้สตูร แสดงวา่

แฟ้มตน้ทางทีช่ ือ่ Source นัน้ ในขณะนัน้ถกูจัดเก็บไวท้ีใ่ดแตย่งัไมไ่ดถ้กูเปิดขึน้มา 

ขอ้ควรระวงัในการรกัษาสตูร link ขา้มแฟ้มใหใ้ชง้านไดถ้กูตอ้งตลอดไป 

1. หากตอ้งการทาํการแกไ้ขใดๆในแฟ้มที ่link กนั ตอ้งเปิดแฟ้มที ่link กนัทกุแฟ้มขึน้มา

ทัง้แฟ้มตน้ทางและแฟ้มปลายทางกอ่นทีจ่ะเริม่ทําการแกไ้ขเสมอ เพือ่ทําใหก้ารแกไ้ขที่

เกดิขึน้ เชน่ การยา้ยตําแหน่งเซลล ์การเปลีย่นชือ่ชทีหรอืแมแ้ตช่ือ่แฟ้ม สง่ผลให ้Excel ไล่

แกตํ้าแหน่งอา้งองิในสตูร link ขา้มแฟ้มใหเ้อง (ถา้ตอ้งการให ้Excel ชว่ยจําวา่ตอ้งเปิด

แฟ้มใดบา้งพรอ้มกนั ใหใ้ชก้ารเปิดแฟ้ม Workspace ชว่ย ซึง่จะอธบิายในภายหลงั) 

2. หากตอ้งการ Save as เพือ่เปลีย่นชือ่แฟ้มหรอืยา้ยโฟลเดอรท์ ีเ่ก็บ ใหทํ้าการ Save 

แฟ้มตน้ทางกอ่นแลว้จงึ Save แฟ้มปลายทางตามทหีลงั โดยการ Save ทีว่า่นีใ้หใ้ช ้

โปรแกรม Excel เปิดแฟ้มแลว้ Save จากโปรแกรม Excel เทา่นัน้ เพือ่ทําให ้Excel ปรับ

ตําแหน่งอา้งองิในสตูรตามตําแหน่งของโฟลเดอรแ์ละชือ่แฟ้มทีเ่ปลีย่นไป (ตา่งจากการใช ้

Windows Explorer ในการยา้ยโฟลเดอรห์รอืเปลีย่นชือ่แฟ้ม ซึง่จะไมช่ว่ยใหส้ตูรมกีาร

แกไ้ขตําแหน่งอา้งองิตามแมแ้ตน่อ้ย) 

3. หากตอ้งการแกไ้ขตาํแหนง่อา้งองิเนือ่งจาก Excel เตอืนวา่คน้หา link ไมพ่บ อาจ

เป็นเพราะคณุพลัง้เผลอไมไ่ดป้ฏบิตัติามขอ้ควรระวงั 2 ขอ้ขา้งตน้ ก็ยงัสามารถแกไ้ขให ้link 

ทํางานตามเดมิไดต้ามขัน้ตอนตอ่ไปนี ้โดย Excel จะไลแ่กไ้ขชือ่แฟ้มตน้ทางในเซลลส์ตูร 

link ทกุเซลลใ์หเ้องไมว่า่อยูใ่นชทีใด 

3.1. ใหเ้ปิดแฟ้มปลายทางขึน้มากอ่นโดยไมต่อ้งเปิดแฟ้มตน้ทาง (แฟ้มปลายทางนีก้็คอื

แฟ้มทีเ่ปิดขึน้มาแลว้พบวา่ Excel มคํีาเตอืนวา่หา link ไมพ่บ) 
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3.2. ตรวจสอบวา่ไมม่ชีทีใดถกูสัง่ Protect Sheet เอาไว ้(เพราะถา้ชทีใดถกู Protect จะไม่

สามารถแกไ้ขสตูร link ทีม่อียูใ่นชทีนัน้ไดเ้ลย แมจ้ะสัง่ผา่น Excel ก็ตาม) 

3.3. จากนัน้ใหใ้ชคํ้าสัง่ Data > Edit Links (Excel 2003 ใชคํ้าสัง่ Edit > Links)  

3.4. คลกิเลอืกชือ่แฟ้มตน้ทางทีแ่สดงในชอ่งรายชือ่ Source  

3.5. กดปุ่ ม Change Source แลว้คลกิไลห่าแฟ้มตน้ทางทีเ่ก็บไวใ้นโฟลเดอรท์ีต่อ้งการ 

 

4. เคล็ดอืน่ๆซึง่สามารถนํามาใชร้ว่มกบัคําสัง่ Edit Links จากรปูขา้งตน้ 

4.1. ปุ่ ม Update Values ทําหนา้ที ่update ขอ้มลูจากแฟ้มตน้ทางทีเ่ลอืกชือ่ไวจ้ากชอ่ง 

Source ชว่ยทําใหส้ามารถเปิดแฟ้มขึน้มาโดยไมต่อ้ง update ในตอนเปิดแฟ้มก็ได ้

(เพราะหากสัง่ update ตอนเปิดแฟ้ม จะทําให ้Excel เสยีเวลาอยา่งมากในการไล ่

update แฟ้มตน้ทางทีม่ทีกุแฟ้ม) แลว้ตอ่เมือ่ตอ้งการดงึขอ้มลูใหมจ่ากแฟ้มตน้ทาง

เมือ่ใด จงึคอ่ยคลกิปุ่ ม Update Values นีท้ลีะแฟ้มทีต่อ้งการ 

4.2. ปุ่ ม Open Source ทําหนา้ทีเ่ปิดแฟ้มตน้ทาง ตามชือ่แฟ้มทีเ่ลอืกไวจ้ากชอ่ง Source  

4.3. ปุ่ ม Break Link ทําหนา้ทีทํ่าลายสตูรทัง้หมดในเซลลท์กุเซลลท์ีม่สีตูร link ขา้มแฟ้ม

ใหก้ลายเป็นคา่ value หรอืผลลพัธ ์ซึง่ไมแ่นะนําใหใ้ชว้ธินีีเ้พราะ Excel จะทําลายสตูร 

link ในแฟ้มนัน้ทัง้หมดโดยเราไมม่ทีางทราบไดเ้ลยวา่เป็นเซลลใ์ดบา้งและยงัไม่

สามารถ Undo ดงันัน้หากตอ้งการทําลายสตูร link ในเซลลใ์ด ใหค้น้หาตําแหน่งเซลล์

ทีม่สีตูร link โดยใชช้ือ่แฟ้มทีแ่สดงในชอ่ง Source สําหรับคน้หาตําแหน่งเซลลนั์น้ 

เพือ่ Copy แลว้ Paste Special แบบ Value ทบัเฉพาะเซลลนั์น้ๆจะเหมาะกวา่ 
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ระบบการรกัษาความปลอดภยั 

ในการ Link File ของ Excel 2010 

แมว้า่ขนาดตารางในชทีของ Excel 2010 มจํีานวน 1,048,576 rows และ 16,384 columns 

ชว่ยรองรับกบัขอ้มลูจํานวนมหาศาลมากขึน้กวา่ Excel รุน่กอ่นก็ตาม แตม่ไิดทํ้าใหว้ธิบีันทกึ

ขอ้มลูทีถ่กูตอ้งตา่งไปจากทีค่วร กลา่วคอื ในแฟ้มหนึง่ๆควรเลอืกบนัทกึเฉพาะขอ้มลูที่

จาํเป็นตอ้งใชง้านเรือ่งทีเ่ก ีย่วขอ้งกนัไวด้ว้ยกนัในชทีเดยีวกนัเทา่น ัน้ เชน่ แยกแฟ้มเก็บ

ขอ้มลูการขายในชว่งแตล่ะไตรมาสไวด้ว้ยกนั แฟ้มแรกเก็บขอ้มลูเดอืน 1-3 แฟ้มทสีองเก็บ

ขอ้มลูเดอืน 4-6 แฟ้มทีส่ามเก็บขอ้มลูเดอืน 7-9 และแฟ้มทีส่ีเ่ก็บขอ้มลูเดอืน 10-12 จากนัน้

เมือ่ตอ้งการดงึขอ้มลูของไตรมาสใดมาใช ้ใหส้รา้งสตูร link ขา้มแฟ้มนําขอ้มลูมาคํานวณ และ

ใชคํ้าสัง่ Change Sources เพือ่เปลีย่นการ link จากแฟ้มเดมิไปยงัแฟ้มอืน่เพือ่นําขอ้มลูชว่ง

ไตรมาสทีต่อ้งการมาคํานวณโดยไมต่อ้งเสยีเวลาสรา้งสตูร link ใหมแ่ตอ่ยา่งใด 

ใน Excel 2010 ไมไ่ดม้วีธิกีารสรา้งสตูร link หรอืมรีะบบการ Change Sources ตา่งไปจาก 

Excel รุน่กอ่น แตใ่น Excel 2010 มรีะบบการรักษาความปลอดภยัในการใชข้อ้มลูทีเ่ครง่ครัดกวา่

รุน่กอ่นและสง่ผลทําให ้Excel 2010 แสดงอาการและมคํีาเตอืนตา่งไปจากเดมิเมือ่มกีารเปิด

แฟ้มที ่link กนั บทความนีจ้ะทดสอบระบบการ link file ของ Excel 2010 โดยจําลอง

สถานการณ์ในแตล่ะขัน้ตอนมาใหศ้กึษาตัง้แตเ่ริม่ตน้ยงัไมม่ขีอ้มลู จวบจนสรา้งสตูร link และ

ทดลองปรับระบบการรักษาความปลอดภยัวา่จะสง่ผลตอ่คําเตอืนเรือ่งการ link อยา่งใดบา้ง 

ระบบความปลอดภยัใน Excel 2010 ทีจ่ะนํามาทดสอบกบัระบบการ link เชน่ Trusted 

Location และ Trusted Document (เชญิ Download แฟ้มทีใ่ชใ้นการทดสอบนีไ้ดจ้าก 

www.ExcelExpertTraining.com/download/testlink.zip) 

1. เริม่ตน้จากทดสอบขนาดแฟ้มทีเ่ปิดขึน้มาโดยยงัไมม่ขีอ้มลูอะไรเลย สัง่ Save แฟ้มตัง้

ชือ่วา่ Target.xlsx พบวา่มขีนาดแฟ้ม 8.18 KB 

2. ในแฟ้มชือ่ Target นี ้ทดลองพมิพคํ์าวา่ Operations ลงไปในเซลล ์B2 พบวา่ จากแฟ้ม

วา่งๆซึง่มขีนาด 8.18 KBแฟ้มมขีนาดใหญข่ึน้เล็กนอ้ยเป็น 8.55 KB พอพมิพต์วัเลข 

20496 ลงไปในเซลล ์C2 แฟ้มมขีนาดใหญเ่พิม่ขึน้เป็น 8.57 KB (แสดงวา่ขอ้มลูตวัเลข

ทําใหแ้ฟ้มมขีนาดใหญข่ึน้ชา้กวา่ขอ้มลูทีเ่ป็นตวัอกัษร) 
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หลกัการต ัง้ชือ่และใชช้ือ่ใน Excel 

การตัง้ชือ่และใชช้ือ่เป็นหัวใจสําคญัของการนําตําแหน่งอา้งองิไปใชซ้ํ้า เนือ่งจากหากปราศจาก

การตัง้ชือ่ทีด่ขี ึน้มาใชแ้ทนตําแหน่งอา้งองิของเซลลแ์ลว้ สตูรสัน้ๆทีด่ไูมม่พีษิภยัอะไร จะกลบั

กลายเป็นปัญหาอยา่งมาก ยิง่ใน Excel 2007 มพีืน้ทีต่ารางกวา่หมืน่ Column และลา้นกวา่ 

Row จะทําให ้สตูร =JAN2009 ซึง่เป็นสตูรทีนํ่าคา่มาจากเซลลใ์น Column JAN ตดักบั Row 

2009 สามารถดผูาดๆและถกูตคีวามวา่เป็นคา่ของเดอืน Jan ปีค.ศ.2009 แทนก็เป็นได ้

หากสงัเกตขนาดของตวัอกัษรแตล่ะตวัในคําแตล่ะคําทีป่รากฏในตาราง Excel จะพบวา่ ชือ่ใดๆ

ก็ตามทีเ่ป็นชือ่มาตรฐานของโปรแกรม Excel ซึง่เราไมส่ามารถเขา้ไปแกไ้ขเปลีย่นแปลงใหเ้ป็น

ชือ่อืน่ ไดถ้กูจัดใหใ้ชต้วัอกัษรตวัใหญท่ัง้หมด (เวน้ชือ่คําสัง่บน Ribbon หรอืเมนู) เชน่ ชือ่

ตําแหน่ง Column A B C D จนถงึ XFD (Excel 2003 ม ีColumn สดุทา้ยชือ่ IV) และสตูร

สําเร็จรปูของ Excel ทกุสตูร เชน่สตูร SUM, MAX, MIN, VLOOKUP ลว้นใชต้วัอกัษรตวัใหญ่

ทัง้หมด ดงันัน้แทนทีจ่ะพรอ้มใจกนัตัง้ชือ่แลว้ใชช้ือ่ทีเ่ป็นตวัใหญท่ัง้หมดตามแบบของชือ่ของ 

Excel เราควรกําหนดหลกัการตัง้ชือ่และใชช้ือ่ทีส่ ือ่ความหมายไดด้ขี ึน้กวา่เดมิ ดงันี ้

1. หากแฟ้มใดจะถกูใชซ้ํ้า ขอใหต้ัง้ใจตัง้ชือ่ใหด้ ีเพือ่ทําใหไ้มว่า่ผูท้ีนํ่าแฟ้มงานไปใชซ้ํ้านัน้จะ

เป็นตวัคณุซึง่เป็นผูส้รา้งแฟ้มนัน้เองหรอืจะเป็นเพือ่นทีเ่พิง่เปิดใชแ้ฟ้มนัน้เป็นครัง้แรกก็ตาม 

จะไดส้ามารถเปิดแฟ้มดแูลว้สามารถไลท่ีไ่ปทีม่าของสตูรในเซลลไ์ดท้นัท ีแตถ่า้แฟ้มใดถกู

สรา้งขึน้มาเพือ่ใชง้านงา่ยๆเพยีงครัง้เดยีวแลว้ทิง้ ไมต่อ้งนํากลบัมาใชอ้กี ก็ไมจํ่าเป็นตอ้งตัง้

ชือ่ใหด้กี็ได ้

2. ชือ่ใดทีค่ณุตัง้ขึน้มาไมว่า่จะเป็นชือ่ชที ชือ่แฟ้ม ชือ่โฟลเดอร ์ชือ่ตําแหน่งเซลล ์(Range 

Name) ชือ่สตูร (Formula Name) หรอืชือ่ทีต่ัง้ใหก้บัคา่คงที ่(Constant Name) ใหต้ัง้ชือ่

โดยใชต้วัอกัษรตวัใหญผ่สมกบัตวัเล็กเสมอ 

3. เมือ่ใดทีต่อ้งการสรา้งสตูรหรอือา้งถงึชือ่ใดๆก็ตาม ใหใ้ชต้วัอกัษรตวัเล็กทัง้หมดเทา่นัน้ 

เพราะเมือ่พมิพล์งไปในเซลลแ์ลว้กดปุ่ ม Enter จะเกดิขอ้สงัเกตในตวัอกัษรของแตล่ะชือ่

ขึน้มาทนัทกีลา่วคอื 

3.1. ตวัอกัษรทีก่ลายเป็นตวัใหญท่ัง้หมด แสดงวา่เป็นชือ่เฉพาะของ Excel 

3.2. ตวัอกัษรทีก่ลายเป็นตวัใหญผ่สมตวัเล็ก แสดงวา่เป็นชือ่ทีค่ณุตัง้ไว ้

3.3. ตวัอกัษรทีย่งัคงเป็นตวัเล็กทัง้หมด แสดงวา่สะกดชือ่ผดิ ดงันัน้ Excel จงึไมย่อมรับชือ่

นัน้ ทําใหข้นาดตวัอกัษรไมเ่ปลีย่นแปลงตาม 
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4. ชือ่ทีต่ัง้ขึน้ควรใชต้วัอกัษรตัง้แต ่4 ตวัขึน้ไปเพือ่มใิหซ้ํ้ากบัชือ่ของ Column แตถ่า้

จําเป็นตอ้งตัง้ชือ่ทีม่ตีวัอกัษร 2-3 ตวัก็ทําได ้เพราะการตัง้ชือ่ทีใ่ชต้วัอกัษรตวัใหญผ่สมตวั

เล็กจะชว่ยในการแยกแยะใหเ้ห็นไดช้ดัอยูแ่ลว้วา่ Jan2009 มไิดม้คีวามหมายเดยีวกบั 

JAN2009 ทีเ่ป็นเซลลใ์น Column JAN ตดักบั Row 2009 (ถา้ตอ้งการตัง้ชือ่ทีเ่ป็นตวัอกัษร

ตวัเดยีว ขอใหห้ลกีเลีย่งตวั C และ R เพราะซํ้ากบัตวัยอ่ของ Row และ Column) 

5. Excel จะไมย่อมรับชือ่ Range Name ทีม่กีารเวน้วรรค โดยหากสัง่ให ้Excel ใชข้อ้ความใน

เซลลต์ามขอบตารางมาเป็นชือ่โดยอตัโนมตั ิจะถกูแกไ้ขเครือ่งหมายวรรคเป็นเครือ่งหมาย

ขดีลา่ง _ (Underscore) ใหเ้อง และ Excel จะไมย่อมรับชือ่ Range Name ทีเ่ป็นตวัเลข

ลว้นหรอืเป็นตวัเลขนําหนา้ตวัอกัษร 

6. แมจ้ะไมม่ขีอ้หา้มในการตัง้ชือ่เป็นภาษาไทย แตก่็แนะนําใหต้ัง้ชือ่เป็นภาษาองักฤษจะ

เหมาะสมกวา่ เพราะหากใช ้Excel version ภาษาองักฤษ เปิดแฟ้มทีม่กีารใชช้ือ่ภาษาไทย 

จะอา่นชือ่ภาษาไทยไมอ่อก 

7. ในการตัง้ชือ่ชที หา้มตัง้ชือ่วา่ History เนือ่งจากเป็นชือ่ที ่Excel สํารองไวใ้ชภ้ายใน 

8. ในการตัง้ชือ่ Range Name หา้มตัง้ชือ่วา่ Criteria หรอื Extract เพราะชือ่ Criteria นีจ้ะถกู

ลบทิง้หรอืเปลีย่นแปลงตําแหน่ง Extract จากเดมิไดเ้องทันททีีใ่ชคํ้าสัง่ Advanced Filter 

9. หากตอ้งการไดรั้บความสะดวกจากคําสัง่ Data Form ใหต้ัง้ชือ่ตารางฐานขอ้มลูวา่ 

Database เพือ่ทําให ้Excel ดงึขอ้มลูมาใชใ้น Data Form ไดเ้องโดยทีค่ณุไมต่อ้งเลอืก

ตารางฐานขอ้มลูนัน้ไวก้อ่น 

10. โปรดเขา้ใจเพิม่เตมิวา่ ในการเขยีนชือ่สตูรและชือ่ตา่งๆทีใ่ชใ้นการอบรมตลอดจนขอ้มลูบน

เว็บ www.ExcelExpertTraining.com นัน้ ใชว้ธิเีขยีนชือ่โดยใชอ้กัษรตวัใหญผ่สมตวัเล็ก

เสมอ เพือ่ชว่ยในการอา่นใหส้ามารถแยกแตล่ะสว่นของคําไดง้า่ยขึน้ เชน่ VLookup, 

SumIF, SumProduct เป็นตน้ ซึง่เมือ่ใดทีต่อ้งการนําชือ่ไปใช ้ใหพ้มิพต์วัเล็กตลอดตาม

หลกัการขา้งตน้ 

ใน Excel 2003 มรีะบบการตัง้ชือ่ Range Name, Formula Name, และ Constant Name ทีไ่ม่

ซบัซอ้นนัก เพยีงสัง่ Insert > Name > Define ก็สามารถ Add ตัง้ชือ่หลายๆชือ่ไดโ้ดยใช ้

คําสัง่นีเ้พยีงครัง้เดยีว สว่นใน Excel 2007 มคํีาสัง่ในการตัง้ชือ่ใหเ้ลอืกได ้2 วธิ ีคอื 

1. หากตอ้งการตัง้ชือ่เดยีว ใหส้ัง่ Formulas > Define Name 
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2. หากตอ้งการตัง้ชือ่หลายชือ่และสามารถยอ้นกลบัมาแกไ้ขหรอืตัง้ชือ่อืน่ใหมอ่กีไดใ้นทันท ี

ใหส้ัง่ผา่น Formulas > Name Manager  

 

2.1. กดปุ่ ม New เพือ่ตัง้ชือ่ใหม ่หรอื 

2.2. กดปุ่ ม Edit เพือ่แกไ้ขตําแหน่งอา้งองิในชือ่ หรอื 

2.3. กดปุ่ ม Delete เพือ่ลบชือ่ทิง้ 

นอกจากนัน้ Excel 2007 เป็นตน้มา ไดป้รับปรงุระบบการตัง้ชือ่ใหส้นองตอบตอ่การใชง้านใน

ระดบั File Level หรอื Sheet Level ไดส้ะดวกกวา่แตก่อ่นมาก กลา่วคอื 

 

• การต ัง้ชือ่เพือ่ใชใ้นระดบั File Level เป็นระบบมาตรฐานที ่Excel เลอืก Scope เป็น 

Workbook ไวใ้หต้ัง้แตต่น้ เพือ่ทําใหช้ือ่ทีต่ัง้ขึน้ในระดบันีส้ามารถนําไปใชร้ว่มกนัไดท้กุ

ชที 

• การต ัง้ชือ่เพือ่ใชใ้นระดบั Sheet Level โดยคลกิเปลีย่น Scope เป็นชือ่ชทีที่

ตอ้งการ ทําใหช้ือ่ทีต่ัง้ขึน้ในระดบัชทีเป็นชือ่ทีใ่ชใ้นชทีนัน้และเป็นอสิระจากชทีอืน่ 

สง่ผลใหส้ามารถตัง้ชือ่ซํ้ากนัไดใ้นแฟ้มเดยีวกนั (น่าสงัเกตวา่เราสามารถกําหนด Scope 

ใหอ้ยูต่า่งชทีกบัชทีที ่Refers to ก็ยงัได)้ 
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การต ัง้ชือ่ Constant Name 

Constant Name เป็นชือ่ทีต่ัง้ใหก้บัคา่คงที ่ซึง่ตามปกตใินการดําเนนิธรุกจิตอ้งเกีย่วขอ้งกบั

คา่คงทีม่ากมาย นับตัง้แต ่ชือ่บรษัิท ทีอ่ยู ่ชือ่ผูบ้รหิาร รหสัทีเ่ป็นความลบั หมายเลขบญัช ี

ตวัเลขทางการเงนิตา่งๆ เชน่ อตัราดอกเบีย้ คา่เสือ่มราคา ตวัเลขเงนิเดอืน ดงันัน้แทนทีจ่ะตอ้ง

บนัทกึคา่เหลา่นีซ้ํ้าลงไปในเซลลโ์ดยตรง นอกจากจะเสยีเวลาพมิพเ์องใหมท่กุครัง้แลว้ ยงัอาจ

พลัง้เผลอบันทกึขอ้มลูตา่งไปจากเดมิ จงึขอแนะนําใหต้ัง้ชือ่ใหก้บัคา่คงทีท่ัง้หมดทีม่ ีแทนที่

จะตอ้งพมิพช์ือ่ยากๆยาวๆ ก็เพยีงพมิพช์ือ่สัน้ๆทีจํ่างา่ยกวา่ และภายหลงัหากมกีารเปลีย่นแปลง

คา่ทีเ่คยคดิวา่คงที ่ก็ใหทํ้าการแกไ้ขคา่ทีกํ่าหนดใหก้บัชือ่ทีเ่ป็น Constant Name นีเ้พยีงครัง้

เดยีว ก็จะสง่ผลใหท้กุเซลลท์ีนํ่า Constant Name ไปใชม้คีา่ใหมต่ามการแกไ้ขนัน้ไดท้ันท ี

สมมตวิา่ ตอ้งการตัง้ชือ่ Constant Name วา่ “MyKey1” ใหม้คีา่เทา่กบัชือ่ “Excel Expert 

Training” ใหเ้ริม่จากพมิพช์ือ่ทีต่อ้งการตัง้ลงไปในชอ่ง Name (โดยไมต่อ้งใสเ่ครือ่งหมาย

คําพดูปิดหวัทา้ยชือ่) จากนัน้พมิพค์า่ทีต่อ้งการลงไปในชอ่ง Refers to โดยตอ้งมเีครือ่งหมาย

เทา่กบันําหนา้เสมอและถา้มคีา่เป็นตัวอกัษรก็ตอ้งใสข่อ้ความไวร้ะหวา่งเครือ่งหมายคําพดูดว้ย

ตามนี ้

Name: MyKey1 

Refers to: =”Excel Expert Training” 

แตถ่า้ตอ้งการตัง้ชือ่ Constant Name ใหม้คีา่เป็น

ตวัเลข ก็ไมต่อ้งใสเ่ครือ่งหมายคําพดู แตต่อ้งใส่

เครือ่งหมายเทา่กบันําหนา้เชน่กนัตามนี ้

Name: MyKey2 

Refers to: =23187021 

จากนัน้เมือ่ตอ้งการนําชือ่ Constant Name นีไ้ปใชใ้นเซลล ์ใหพ้มิพ ์=mykey1 (สงัเกตวา่ถา้

พมิพเ์องใหพ้มิพด์ว้ยตวัเล็กตลอด) หรอืกดปุ่ ม F3 เพือ่เปิดรายชือ่ทีต่ัง้ไวใ้นแฟ้มนัน้ขึน้มาแสดง

บนจอ แลว้ใหด้บัเบิล้คลกิทีช่ ือ่ทีต่อ้งการ (หรอืคลกิปุ่ ม OK) แลว้กดปุ่ ม Enter เพือ่รับสตูร 

=MyKey1 ลงไปในเซลล ์จะไดคํ้าวา่ Excel Expert Training แสดงในเซลลนั์น้ 
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หมายเหต ุชือ่ทีเ่ป็น Range Name หรอื Formula Name มขีัน้ตอนการใชช้ือ่เหมอืนกบั

Constant Name เชน่กนั 

การต ัง้ชือ่ Range Name 

Range Name เป็นชือ่ทีต่ัง้ใหก้บัเซลลเ์ดยีวหรอืพืน้ทีต่าราง (ทีม่พีืน้ทีต่ดิกนัหรอืไมต่ดิกนัก็ได)้ 

ซึง่มวีธิตีัง้ชือ่ไดห้ลายวธิ ีดงันี ้

1. วธิใีช ้Name Box เป็นชอ่งดา้นซา้ยมอืของ Formula Bar วธินีีเ้ป็นวธิตีัง้ชือ่ทีง่า่ยทีส่ดุ แต่

ใชก้บัการตัง้ชือ่ไดอ้ยา่งเดยีว ไมส่ามารถใช ้Name Box เพือ่แกไ้ขหรอืลบชือ่ทิง้ 

 

1.1. เริม่จากคลกิเลอืกเซลลห์รอืตารางทีต่อ้งการ (หากตอ้งการเลอืกเซลลท์ีไ่มต่ดิตอ่กนั ให ้

กดปุ่ ม Ctrl แลว้คลกิเลอืกพืน้ทีต่ารางทีต่อ้งการไปเรือ่ยๆ) 

1.2. คลกิลกูศรดา้นขวาของชอ่ง Name Box แลว้พมิพช์ือ่ Range Name ทีต่อ้งการลงไป

ในชอ่ง Name Box ขอใหส้งัเกตวา่ พอพมิพต์วัอกัษรทลีะตวัของชือ่ลงไป ชอ่ง Name 

Box จะเลือ่นไปหาชือ่เกา่ทีต่ัง้ไวก้อ่นแลว้เพือ่คณุจะไดต้ัง้ชือ่ใหมท่ีไ่มซ่ํ้ากบัชือ่เดมิทีม่ี

อยูแ่ลว้ 

1.3. กดปุ่ ม Enter เพือ่รับชือ่ลงไปในชอ่ง Name Box 

2. วธิใีชค้าํส ัง่ Formulas > Define Name หรอื Formulas > Name Manager 

(Excel 2003 ใชค้าํส ัง่ Insert > Name > Define) โดยกรอกชือ่ทีต่อ้งการตัง้ลงไป

ในชอ่ง Name: แลว้คลกิลงไปในชอ่ง Refers to (โดยใหค้ลกิตอ่ทา้ยตําแหน่งเดมิทีแ่สดง
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ไวใ้นชอ่ง Refers to: นี)้ จากนัน้ใหเ้ลอืกพืน้ทีต่ารางทีต่อ้งการแลว้กดปุ่ ม OK เพือ่รับชือ่ 

 

3. วธิใีชค้าํส ัง่ Formulas > Create from selection (Excel 2003 ใชค้าํส ัง่ Insert 

> Name > Create) วธินีีช้ว่ยนําขอ้ความทีอ่ยูข่อบตารางมาตัง้เป็นชือ่ใหก้บัพืน้ทีต่าราง

ในฝ่ังตรงขา้มกบัขอ้ความนัน้ เริม่จากคลกิเลอืกพืน้ทีต่ารางทีต่อ้งการตัง้ชือ่โดยใหเ้ลอืก

รวมทัง้พืน้ทีห่วัตารางไวด้ว้ย จากนัน้ใชคํ้าสัง่ Formulas > Create from Selection จะพบ

หนา้จอตอ่ไปนีเ้ปิดขึน้มา ใหด้วูา่ตรงตามตอ้งการแลว้กดปุ่ ม OK เพือ่รับชือ่ 

 

Excel เลอืกชอ่ง Left column ไวใ้ห ้เนือ่งจาก Column ซา้ยสดุของพืน้ทีต่ารางทีเ่ลอืกนัน้

มตีวัอกัษรบนัทกึไว ้โดย Excel จะตัง้ชือ่พืน้ทีต่าราง C2:E2 วา่ Income และตัง้ชือ่พืน้ที่

ตาราง C3:E3 วา่ Cost ตามขอ้ความใน Column ซา้ยสดุใหท้นัท ีทัง้นีข้อใหเ้ขา้ใจดว้ยวา่ 

ชือ่ Income และ Cost เป็นชือ่ที ่Excel ชว่ยตัง้ใหเ้พยีงครัง้เดยีวตอนทีใ่ชคํ้าสัง่ Create 

from selection นีเ้ทา่นัน้ และจะยงัคงใชช้ือ่นีอ้ยูโ่ดยไมเ่ปลีย่นแปลงตามขอ้ความใน 

Column ซา้ยทีอ่าจมขีอ้ความตา่งไปจากเดมิแตอ่ยา่งใด 

หากตอ้งการขยายขอบเขตของ Range Name ใหใ้ชว้ธิกีาร Insert Row หรอื Insert Column 

หรอืใชว้ธิทีี ่2 หรอืวธิทีี ่3 ขา้งตน้เพือ่เขา้ไปกําหนดขอบเขตพืน้ทีต่ารางใหมใ่หม้ขีนาดใหญข่ึน้

ตามตอ้งการ 
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Range Name ทีต่ัง้ขึน้ สามารถนําไปใชอ้า้งองิผา่นสตูรสําเร็จรปูของ Excel ไดท้นัท ีเชน่ หาก

ตอ้งการหายอดรวมของตวัเลขใน Range Name ชือ่ Income ใหเ้ริม่สรา้งสตูรตามลําดบั

ตอ่ไปนี ้

1. พมิพ ์=sum( 

2. กดปุ่ ม F3 เพือ่แสดงรายชือ่ทีต่ัง้ไวใ้นแฟ้ม (ในกรณีทีต่อ้งการนําชือ่มาจากแฟ้มอืน่ ใหย้า้ย

ไปอยูใ่นแฟ้มทีม่ชี ือ่ Range Name ทีต่อ้งการนัน้กอ่นแลว้จงึกดปุ่ ม F3) 

3. ดบัเบิล้คลกิทีช่ ือ่ Income จะไดส้ตูร =sum(Income 

4. กดปุ่ ม Enter จะไดส้ตูร =SUM(Income)  

แตถ่า้นํา Range Name ไปใชอ้า้งองิโดยตรงโดยไมไ่ดใ้ชอ้า้งองิผา่นสตูรสําเร็จรปูของ Excel 

จะพบวา่หากตัง้ชือ่ใหก้บัตารางทีม่เีซลลต์ัง้แต ่2 เซลลข์ึน้ไป ชือ่นัน้จะนํามาใชไ้ดเ้ฉพาะในแนว

คูข่นานกบัแนวพืน้ทีต่ารางทีต่ัง้ชือ่ไวเ้ทา่นัน้ เชน่ หากตัง้ชือ่ตัวเลขหวัตารางในตําแหน่งจาก 

C2:F2 วา่ Top และตัง้ชือ่ตวัเลขขา้งตารางตําแหน่งจาก B3:B5 วา่ Left จะสง่ผลใหใ้ชส้ตูร 

=Top*Left คํานวณหาคําตอบไดเ้ฉพาะในขอบเขตตารางทีแ่นวคูข่นานของ Top ตดักบั Left 

คอืพืน้ทีต่ารางตัง้แต ่C3:F5 โดยสตูรนอกแนวคูข่นานจะไมคํ่านวณแตค่นืคา่เป็น Error 

#VALUE! 

 

วธิตี ัง้ชือ่ตาํแหนง่อา้งองิแบบไรข้อบเขตจํากดั 

ขอยอ้นนําตวัอยา่งการคํานวณทีต่ัง้ชือ่หวัตารางดา้นบนวา่ Top มาคณูกบัหวัตารางดา้นซา้ยทีต่ัง้

ชือ่วา่ Left โดยใชส้ตูร =Top*Left มาวเิคราะหอ์ยา่งละเอยีดวา่ ดว้ยเหตใุดสตูร =Top*Left 

จงึสามารถคํานวณหาคําตอบไดเ้ฉพาะพืน้ทีต่ารางในสว่นทีต่ดักนัของแนวคูข่นานของ Top ตดั

กบั Left เทา่นัน้ สว่นพืน้ทีต่ารางนอกขอบเขตแนวทีต่ดักนัจะใหคํ้าตอบเป็น Error 
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เมือ่ใชคํ้าสัง่ Formulas > Name Manager ยอ้นไปตรวจสอบตําแหน่งอา้งองิที ่Excel 

กําหนดใหก้บัตําแหน่งอา้งองิทีม่ชี ือ่วา่ Top กบั Left จะพบวา่ เป็นตําแหน่งอา้งองิแบบ 

Absolute โดยมเีครือ่งหมาย $ ควบคมุตําแหน่งทัง้แนว Row และ Column ตามรปูตอ่ไปนี ้

 

• ตําแหน่งอา้งองิชือ่ Top มตํีาแหน่งอา้งองิ Refers to: =Sheet1!$C$2:$F$2 

• ตําแหน่งอา้งองิชือ่ Left มตํีาแหน่งอา้งองิ Refers to: =Sheet1!$B$3:$B$5 

ดว้ยสาเหตทุีตํ่าแหน่งอา้งองิถกูควบคมุดว้ยเครือ่งหมาย $ ทัง้แนว Row และ Column นีเ่องที่

ทําใหเ้กดิการจํากดัขอบเขตใหใ้ชส้ตูรอา้งองิถงึชือ่ Top กบั Left ไดเ้ฉพาะในแนวคูข่นาน 

ดงันัน้หากคณุเขา้ใจถงึเหตแุละผลตามทีไ่ปทีม่าดงักลา่วขา้งตน้ จะสามารถเลอืกใชเ้ครือ่งหมาย 

$ ในการกําหนดขอบเขตแบบไมจํ่ากดัได ้โดยปรับตําแหน่งเครือ่งหมาย $ ตามหลกัตอ่ไปนี ้

• หากตอ้งการใหกํ้าหนดตําแหน่งอา้งองิใหห้มายถงึ ทกุเซลลใ์นแนวนอน ใหใ้ช ้

ตําแหน่งอา้งองิจากเซลลเ์ดยีวตามแนวคูข่นานกบัเซลลท์ีจ่ะใชช้ือ่นัน้ และใส่

เครือ่งหมาย $ ควบคมุตาํแหนง่เฉพาะ Row เชน่ C$2 

• หากตอ้งการใหกํ้าหนดตําแหน่งอา้งองิใหห้มายถงึ ทกุเซลลใ์นแนวต ัง้ ใหใ้ชตํ้าแหน่ง

อา้งองิจากเซลลเ์ดยีวตามแนวคูข่นานกบัเซลลท์ีจ่ะใชช้ือ่นัน้ และใสเ่ครือ่งหมาย $ 

ควบคมุตาํแหนง่เฉพาะ Column เชน่ $B3 

• หากตอ้งการใหกํ้าหนดตําแหน่งอา้งองิใหห้มายถงึ ทกุแนว ใหใ้ชตํ้าแหน่งอา้งองิจาก

เซลลเ์ดยีวตามแนวคูข่นานกบัเซลลท์ีจ่ะใชช้ือ่นัน้ และไมใ่สเ่ครือ่งหมาย $  
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• หากตอ้งการใหตํ้าแหน่งอา้งองิใชไ้ดก้บัทกุชที กไ็มต่อ้งระบชุือ่ชทีนําหนา้ตําแหน่ง

อา้งองิแตต่อ้งทิง้เครือ่งหมาย ! ไวด้ว้ยเพือ่หมายถงึทกุชที เชน่ !I5 

เนือ่งจากตําแหน่งอา้งองิแบบทีไ่มไ่ดใ้ส ่$ แบบ Absolute นี ้จะยา้ยตําแหน่งไปตามแนวคูข่นาน

กบัตําแหน่งเซลลส์ตูรทีใ่ช ้ดงันัน้กอ่นทีจ่ะใชคํ้าสัง่ Formulas > Name Manager เขา้ไป

กําหนดตําแหน่ง คณุจะตอ้งเลอืกเซลลใ์นแนวเดยีวกบัเซลลท์ีอ่า้งถงึในชอ่ง Refers to: ไว ้

ลว่งหนา้เสมอ ตามรปูตวัอยา่งตอ่ไปนี ้

 

1. หากตอ้งการตัง้ชือ่ TopRow และ LeftColumn (หรอืชือ่ใดก็ไดต้ามใจชอบ) ใหม้ี

ตําแหน่งอา้งองิทีห่มายถงึทกุเซลลใ์น Row 2 และทกุเซลลใ์น Column B ตามลําดบั 

1.1. ใหค้ลกิเลอืกเซลล ์C3 ไวก้อ่นแลว้จงึสัง่ Formulas > Name Manager 

1.2. ตัง้ชือ่ TopRow ใหม้ตํีาแหน่งอา้งองิ Refers to: =Sheet1!C$2 

1.3. ตัง้ชือ่ LeftColumn ใหม้ตํีาแหน่งอา้งองิ Refers to: =Sheet1!$B3 

2. หากตอ้งการตัง้ชือ่ Sum3Above (หรอืชือ่ใดก็ไดต้ามใจชอบ) ใหทํ้าหนา้ทีห่ายอดรวม

ของเซลล ์3 เซลลท์ีอ่ยูเ่หนอืขึน้ไปจากเซลลท์ีใ่ชช้ือ่นีอ้ยูโ่ดยเวน้เซลลท์ีต่ดิกบัเซลลส์ตูร 

2.1. ใหค้ลกิเลอืกเซลล ์C13 ไวก้อ่นแลว้จงึสัง่ Formulas > Name Manager 

2.2. ตัง้ชือ่ Sum3Above ใหม้ตํีาแหน่งอา้งองิ Refers to: =SUM(Sheet1!C9:C11) 

3. หากตอ้งการตัง้ชือ่ Left2 (หรอืชือ่ใดก็ไดต้ามใจชอบ) ใหทํ้าหนา้ทีห่าคา่จากเซลลท์ีอ่ยู่

ดา้นซา้ยถดัไป 2 เซลลจ์ากเซลลท์ีใ่ชช้ือ่นีอ้ยูแ่ละใหใ้ชก้บัทกุชทีไดด้ว้ย 

3.1. ใหค้ลกิเลอืกเซลล ์G10 ไวก้อ่นแลว้จงึสัง่ Formulas > Name Manager 

3.2. ตัง้ชือ่ Left2 ใหม้ตํีาแหน่งอา้งองิ Refers to: =!E10 
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การต ัง้ชือ่ Formula Name 

ในความเป็นจรงินัน้ทัง้ Constant Name หรอื Range Name ตา่งก็คอื Formula Name น่ันเอง

เพราะในชอ่ง Refers to: ตอ้งใสเ่ครือ่งหมายเทา่กบัไวด้า้นหนา้คา่คงทีห่รอืตําแหน่งอา้งองิไว ้

เสมอ จงึเทา่กบัวา่เป็นการตัง้ชือ่ใหก้บัสตูร เพยีงแตว่า่สตูรทีเ่ป็น Constant Name กําหนดใหม้ี

คา่เป็นคา่คงที ่สว่น Range Name ไดกํ้าหนดใหม้คีา่เทา่กบัคา่ทีเ่ก็บไวใ้นตารางตามทีร่ะบไุวใ้น

ชอ่ง Refers to: ซึง่นอกจากจะอา้งถงึคา่คงทีห่รอืตําแหน่งอา้งองิตามทีอ่ธบิายผา่นไปแลว้ เรา

ยงัสามารถใชช้อ่ง Refers to: ไดอ้กีหลายแบบ กลา่วคอื 

• ใชผ้สมกนัระหวา่งคา่คงทีแ่ละตําแหน่งอา้งองิ เชน่ =5*Top*Left โดยเลข 5 ถอืเป็น

คา่คงที ่สว่น Top กบั Left เป็นตําแหน่งอา้งองิ 

• ใชร้ว่มกบัสตูรสําเร็จรปูของ Excel เชน่ =SUM(Income) 

• ใชย้อ่สตูรยากๆยาวๆใหเ้ป็นชือ่สัน้ๆเพยีงชือ่เดยีว โดยทยอยนําชือ่ทีต่ัง้ไวม้าคํานวณใน

สตูรยาวๆทีค่ณุสรา้งขึน้ เชน่ แทนทีจ่ะตัง้ชือ่เดยีวใหก้บัสตูร 

=(5*Top*Left)+Sum(Income) ก็สามารถตัง้ชือ่ใหก้บัสตูรแตล่ะสว่นกอ่นแลว้จงึนําชือ่

มาใชต้อ่เป็น =MyVar1+MyVar2 โดยกําหนดใหต้ัง้ชือ่ MyVar1 มคีา่ =5*Top*Left 

และตัง้ชือ่ MyVar2 มคีา่ =SUM(Income) ไวก้อ่น 

• ใชกํ้าหนดตําแหน่งอา้งองิแบบ Dynamic Range โดยใชส้ตูร Offset ชว่ยกําหนดขนาด

ตารางใหย้อ่หรอืขยายไดโ้ดยอตัโนมัตติามขนาดของขอ้มลู 

การเปลีย่นตาํแหนง่อา้งองิในสตูรทีม่อียูก่อ่นใหก้ลายเป็นชือ่ทีต่ ัง้ข ึน้ใน

ภายหลงั 
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สมมตวิา่สรา้งสตูร =C2-C3 เอาไวใ้นเซลล ์C4 เป็นตวัเลขกําไรขัน้ตน้ แลว้ Copy สตูรนีไ้ปใช ้

ในเซลลต์ัง้แต ่C4:E4 จากนัน้ตอ่มาไดต้ัง้ชือ่ Income และ Cost เป็น Range Name ใหก้บั

พืน้ทีต่ารางตัง้แต ่C2:E2 และ C3:E3 ตามลําดบั หากตอ้งการใหส้ตูรในเซลล ์C4:E4 เปลีย่นไป

เป็นสตูร =Income-Cost ตามชือ่ทีต่ัง้ขึน้ในภายหลงั ใหเ้ลอืกพืน้ที ่C4:E4 แลว้สัง่ Formulas 

> Define Name > Apply Names (Excel 2003 สัง่ Insert > Name > Apply) แลว้

เลอืกชือ่ Income และ Cost (ซึง่ Excel มกัจะเลอืกชือ่ทีเ่กีย่วขอ้งกบัสตูรในพืน้ที ่C4:E4 ให ้

เอง) จากนัน้กดปุ่ ม OK 

เคล็ดลบัอืน่ๆทีค่วรทราบเกีย่วกบัชือ่ทีบ่อกตาํแหนง่ 

1. ชอ่ง Name Box แสดงไดเ้ฉพาะชือ่ Range Name ทีอ่ยูใ่นแฟ้มนัน้เทา่นัน้  

2. การคน้หาตําแหน่งเซลลห์รอืตารางทีต่ัง้ชือ่ไว ้ใหใ้ช ้Name Box หรอืกดปุ่ ม F5 เพือ่เลอืก

ชือ่ทีแ่สดงไวห้รอืพมิพช์ือ่ทีท่ราบลงไปเองก็ได ้

3. หากตอ้งการ Copy ชือ่ตําแหน่งอา้งองิไปใชท้ีแ่ฟ้มอืน่ใหม้ชีือ่แบบเดยีวกนั ใหเ้ลอืก Copy 

พืน้ทีต่ารางทัง้หมดทีเ่กีย่วขอ้งและสตูรไปดว้ยกนั (ซึง่หมายถงึ พืน้ทีต่ารางทีร่ะบไุวใ้น

ตําแหน่งอา้งองิ และเซลลส์ตูรทีอ่า้งถงึชือ่ตําแหน่งอา้งองิซึง่อยูใ่นพืน้ทีท่ีเ่ลอืกนัน้ดว้ย) 

จากนัน้ให ้Paste ลงไปในแฟ้มใหมต่ามตาํแหนง่เดมิของพืน้ทีต่ารางที ่Copy มา แลว้จงึ

สัง่ยา้ยไปทีอ่ืน่ในภายหลงัตามตอ้งการ 

4. เซลลเ์ดยีวมชีือ่ไดห้ลายชือ่ แตช่อ่ง Name Box แสดงชือ่แรกทีต่ัง้ตามลําดบัตวัอกัษร เชน่ 

เซลล ์A1 ตัง้ชือ่ Range Name ไวห้ลายชือ่ทัง้ Income, Sales, และ Revenue จะพบวา่

เมือ่คลกิเขา้ไปทีเ่ซลล ์A1 ในชอ่ง Name Box จะแสดงวา่มชีือ่วา่ Income เพราะตวัอกัษร I 

มากอ่นตวัอกัษร R หรอื S แตถ่า้ไลด่รูายชือ่ใน Name Box จะพบชือ่อืน่แสดงไวด้ว้ย 

5. ตวัชือ่ Range Name กบัตําแหน่งอา้งองิในชอ่ง Refers to: ไมจํ่าเป็นตอ้งอยูใ่นแฟ้ม

เดยีวกนัก็ได ้โดยเราสามารถตัง้ชือ่ไวใ้นแฟ้มหนึง่ แตกํ่าหนดใหตํ้าแหน่ง Refers to: ไปอยู่

ในแฟ้มอืน่ได ้โดยใช ้Mouse คลกิเลอืกตําแหน่งตารางในแฟ้มอืน่ก็จะไดตํ้าแหน่งทีต่อ้งการ

มาใสใ่นชอ่ง Refers to: ใหเ้อง 

6. หาก Cut ตารางทีต่ัง้ชือ่ Range Name เอาไวไ้ปวางไวใ้นแฟ้มอืน่ จะทําใหต้วัชือ่ Range 

Name ยงัอยูใ่นแฟ้มเดมิ แตตํ่าแหน่งอา้งองิในชอ่ง Refers to: จะยา้ยตามไปทีแ่ฟ้มอืน่ 

และยงัสง่ผลใหช้อ่ง Name Box ไมแ่สดงชือ่ Range Name นัน้อกีตอ่ไป (โดยยงัคงดชูือ่

ทกุประเภทไดจ้ากคําสัง่ Formulas > Name Manager) 
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7. หากตอ้งการหาคา่ ณ ตําแหน่งเซลลท์ีต่ดักนัของตารางทีต่ัง้ชือ่ไว ้(Intersection) ใหใ้ช ้

สตูรทีม่เีครือ่งหมายวรรคคัน่ระหวา่งชือ่ เชน่ =Top Left จะไดค้า่จากเซลลท์ีท่ีตํ่าแหน่งตดั

กนัของ Top ตดักบั Left 

8. หากตอ้งการสรา้งสตูรทีอ่า้งถงึตําแหน่งอา้งองิในตารางโดยตรง โดยไมต่อ้งการใหส้ตูรที่

เกดิขึน้ใชช้ือ่ Range Name ใหเ้ริม่จากเลอืกเซลลต์ัง้แต ่2 เซลลข์ึน้ไปไวก้อ่นแลว้จงึพมิพ ์

= แลว้คลกิเลอืกเซลล ์จะไดส้ตูรทีม่ตํีาแหน่งอา้งองิโดยไมอ่า้งถงึชือ่ Range Name 

9. Formula Name ทีใ่ชตํ้าแหน่งอา้งองิทีไ่มใ่ช ่Absolute Reference ในบางกรณีจะไม่

คํานวณตามคา่ตวัแปรทีเ่ปลีย่นไป ซึง่แกไ้ขไดโ้ดยปรับสตูรใหคํ้านวณรว่มกบัสตูร Now() 

หรอื Today() เชน่ Sum3Above ใช ้Refers to: =SUM(Sheet1!C9:C11)*Now()/Now() 

10. ชือ่ทีต่ัง้ไวจ้ะถกูเก็บไวใ้นแฟ้มทีใ่ชต้ัง้ชือ่เทา่นัน้ หากตอ้งการทําใหแ้ฟ้มใหมม่ชีือ่ทีต่ัง้ไว ้

แบบเดยีวกบัแฟ้มเดมิ ให ้Copy เซลลส์ตูรทีใ่ชช้ือ่ในการอา้งองิถงึตําแหน่งเซลลไ์ปพรอ้ม

กบัเซลลท์ีถ่กูตัง้ชือ่ไวไ้ปดว้ยกนั และในการสัง่ Paste ในแฟ้มใหม ่ตอ้ง Paste ลงไปใน

ตําแหน่งเดมิดว้ย จงึจะทําใหแ้ฟ้มใหมเ่กดิชือ่และมตํีาแหน่งอา้งองิถกูตอ้งตามแฟ้มเดมิ 
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การใชส้ตูรปรบัตาํแหนง่อา้งองิ 

คําอธบิายจากนีไ้ปจะมปีระโยชนต์อ่เมือ่คณุมพีืน้ฐานมากอ่นแลว้วา่ตําแหน่งอา้งองิมปีระโยชน์

อยา่งไรและจะนําตําแหน่งอา้งองิไปใชซ้ํ้าโดยการ Copy หรอืโดยการตัง้ชือ่ตําแหน่งอา้งองิได ้

อยา่งไร ซึง่การนําตําแหน่งอา้งองิไปใชซ้ํ้าตามวธิทีีใ่ชก้นัโดยทัว่ไป คณุตอ้งเสยีแรงเสยีเวลา 

Copy หรอืตอ้งสรา้งสตูรใหมท่กุครัง้ จงึเป็นเรือ่งน่าคดิวา่จะมวีธิใีดบา้งทีจ่ะทําใหตํ้าแหน่ง

อา้งองิเดมิทีม่อียูป่รับตําแหน่งไดเ้องโดยคณุไมต่อ้งเขา้ไปยุง่เกีย่วแกไ้ขสตูรใหมอ่กีเลย 

วธิที ี ่1 : ใชส้ตูร Indirect(“Text บอกตาํแหนง่”) แบบเซลลเ์ดยีว 

ลองนกึดซูวิา่ ถา้เดมิคณุสรา้งสตูรเพือ่ดงึคา่จากเซลล ์A1 มาใชด้ว้ยสตูร =A1 จากนัน้หาก

ตอ้งการทําใหส้ตูรในเซลลเ์ดมิน่ันแหละ ดงึคา่จากเซลล ์A2 มาแทน จะทําไดอ้ยา่งไรโดยไม่

ตอ้งยอ้นกลับไปแกไ้ขสตูรใหเ้ปลีย่นเป็น =A2 แตอ่ยา่งใด 

 

แทนทีจ่ะสรา้งสตูรตรงๆลงไปวา่ =A1 คราวนีใ้หย้อมเปลอืงเซลลห์น่อย เริม่จากใชเ้ซลล ์C4 

และ C5 เป็นเซลลรั์บตวัอกัษร a และเลข 1 ลงไปตามลําดบั จากนัน้นําตวัอกัษรกบัตวัเลขมาตอ่

กนัในเซลล ์C6 โดยใชส้ตูร =C4&C5 จะไดคํ้าวา่ a1 ซึง่เป็น Text ทีบ่อกตําแหน่งตามแบบ

มาตรฐานของตําแหน่งอา้งองิใน Excel (ถา้อยากลดัขัน้ตอน จะใชเ้ซลล ์C6 สําหรับพมิพ์

ตําแหน่งเซลล ์a1 ลงไปเลยก็ได ้โดยไมต่อ้งเสยีเซลล ์C4 และ C5 เพือ่แยกตําแหน่งแตล่ะสว่น

ไวก้อ่น) 

จากนัน้เซลล ์C7 ใชส้ตูร =Indirect(C6) จะไดค้า่เป็นตวัเลข 11 ซึง่เป็นคา่จากเซลล ์A1 น่ันเอง 

ทนีีห้ากตอ้งการคา่จากเซลลใ์ด ใหใ้ชตํ้าแหน่งอา้งองิตามคา่ในเซลล ์C6 ซึง่อาจเกดิจากการ

พมิพแ์ยกสว่นของตวัอกัษรและตวัเลขทีบ่อกตําแหน่ง Column และตําแหน่ง Row ลงไปใน
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เซลล ์C4 และ C5 หรอืจะใชว้ธิพีมิพตํ์าแหน่งเซลลท์ีต่อ้งการลงไปเองโดยตรงในเซลล ์C6 เลย

ก็ได ้เชน่  

• ถา้พมิพคํ์าวา่ a2 ลงไปในเซลล ์C6 ก็จะไดคํ้าตอบในเซลล ์C7 เทา่กบัคา่จากเซลล ์a2 

• ถา้พมิพคํ์าวา่ a3 ลงไปในเซลล ์C6 ก็จะไดคํ้าตอบในเซลล ์C7 เทา่กบัคา่จากเซลล ์a3 

• ถา้พมิพคํ์าวา่ sheet3!a2 ลงไปในเซลล ์C6 ก็จะไดคํ้าตอบในเซลล ์C7 เทา่กบัคา่จาก

เซลล ์a2 แตค่ราวนีม้าจากชทีชือ่ Sheet3 เป็นสตูรดงึคา่ขา้มชทีตามชือ่ชทีทีต่อ้งการ 

วธิที ี ่2 : ใชส้ตูร Indirect(“Text บอกตาํแหนง่”) แบบใชต้าํแหนง่

ขอบเขตตาราง 

วธินีีม้หีลกัการคลา้ยกบัวธิแีรกทีใ่ชตํ้าแหน่งอา้งองิจากเซลลเ์ดยีว เพยีงแตตํ่าแหน่งอา้งองิแบบ

ขอบเขตตารางตอ้งอยูใ่นโครงสรา้งของ ตาํแหนง่เซลลต์น้ทาง:ตาํแหนง่เซลลป์ลายทาง 

เชน่ A1:A3 จากนัน้จงึนําตําแหน่งอา้งองิทีไ่ดไ้ปใชก้บัสตูร Indirect 

 

สมมตวิา่คณุตอ้งการหาผลรวมของตวัเลขในเซลล ์A1:A3 ซึง่ปกตติอ้งใชส้ตูร =Sum(A1:A3) 

ซึง่สตูรนีย้งัไงๆก็จะหาผลรวมจากเซลล ์A1:A3 ไปตลอด แตถ่า้ตอ้งการใหห้ายอดรวมจากเซลล์

ใดก็ไดถ้งึเซลลใ์ดก็ไดล้ะ่ จะสรา้งสตูรอยา่งไรครัง้เดยีวแลว้ไมต่อ้งแกไ้ขสตูรอกีเลยในภายหลงั 

จากภาพขา้งตน้ ม ีText ทีบ่อกตําแหน่งเซลลต์น้ทาง a1 ในเซลล ์C6 ตรงกบัตวัอยา่ง Indirect 

แบบเซลลเ์ดยีว เพยีงแตค่ราวนีใ้หใ้ชเ้ซลล ์E4, E5, และ E6 สําหรับสรา้ง Text ทีบ่อกตําแหน่ง

ของเซลลป์ลายทาง a3 

จากนัน้ใชเ้ซลล ์D8 นําตําแหน่งเซลลต์น้ทางมาเชือ่มตอ่กบัเครือ่งหมาย : แลว้เชือ่มตอ่กบั

ตําแหน่งเซลลป์ลายทางดว้ยสตูร =C6&”:”&E6 จะไดค้า่ a1:a3 
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หากตอ้งการหายอดรวมก็สามารถนํา Text ทีบ่อกตําแหน่งในเซลล ์D8 ไปใชร้ว่มกบัสตูร Sum 

และ Indirect เชน่ เซลล ์D9 ใชส้ตูร =Sum(Indirect(D8)) จะหายอดรวมตวัเลขจากตารางใน

ขอบเขตทีต่อ้งการ 

นอกจากนีแ้ทนทีจ่ะนําคา่ในเซลล ์D8 ซึง่มสีตูรเป็น =C6&”:”&E6 ไปใชต้อ่ในสตูร Sum เพือ่

หาผลรวม เรายงัสามารถนําขอบเขตตําแหน่งอา้งองิทีไ่ดน้ีไ้ปใชใ้นสตูรอืน่ไดเ้ชน่เดยีวกนั 

เพยีงแตต่อ้งใชส้ตูร Indirect นําหนา้ตําแหน่งอา้งองิไวเ้สมอ เชน่ =Max(Indirect(D8)), 

=Min(Indirect(D8)), =Average(Indirect(D8)), =Index(Indirect(D8),2,1) เป็นตน้ 

ยิง่กวา่นัน้หากนําสตูร =$C$6&”:”&$E$6 หรอื =Indirect($C$6&”:”&$E$6) ไปตัง้ชือ่เป็น 

Formula Name วา่ MyRange1 และ MyRange2 ตามลําดบั (หรอืชือ่อืน่ใดก็ได ้โดยตําแหน่ง

อา้งองิทีใ่ชใ้น Formula Name ตอ้งกําหนดตําแหน่งแบบ Absolute จงึจะหาคา่ไดถ้กูตอ้ง) จะ

ชว่ยใหก้ารนําตําแหน่งอา้งองิไปใชต้อ่ไดส้ะดวกขึน้ เชน่ จากเดมิตอ้งใชส้ตูร 

=Sum(Indirect(D8)) ก็จะเทยีบเทา่กบัสตูร =Sum(Indirect(MyRange1)) หรอื 

=Sum(MyRange2) ซึง่นอกเหนอืจากจะเป็นสตูรทีด่ดูกีวา่มากแลว้ยงัไมข่ึน้กบัคา่ในเซลล ์D8 

ทีอ่าจถกูแกไ้ขอยา่งพลัง้เผลอใหผ้ดิเพีย้นไปในภายหลงัไดอ้กีดว้ย 

วธิที ี ่3 : ใชส้ตูร Indirect(“Text บอกตาํแหนง่”) แบบใชช้ือ่ Range 

Name 

 

ตวัอยา่งนีต้า่งจากตวัอยา่งทีผ่า่นมาเพยีงแคนํ่าชือ่ Range Name มาใชแ้ทนตําแหน่งอา้งองิ

โดยตรง เชน่ หากตัง้ชือ่พืน้ทีต่าราง D3:D6 วา่ Chonburi และตัง้ชือ่พืน้ทีต่าราง C4:E4 วา่ 

Year2 (ใหใ้ชคํ้าสัง่ Formulas > Create from selection เพือ่ตัง้ชือ่พืน้ทีต่ามคําทีอ่ยูบ่น

ของตารางรวดเดยีว) 
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จากนัน้ใชเ้ซลล ์C9 และ C10 สําหรับพมิพช์ือ่ Range Name ลงไป เชน่ พมิพคํ์าวา่ Chonburi 

และ Year2 ลงไปตามลําดบั 

• เซลล ์D9 หายอดรวมของ Chonburi ไดโ้ดยใชส้ตูร =Sum(Indirect(C9)) 

• เซลล ์D10 หายอดรวมของ Year2 ไดโ้ดยใชส้ตูร =Sum(Indirect(C10)) 

• เซลล ์E9 หาคา่ของ Chonburi ในปี Year2 ไดโ้ดยใชส้ตูรหาคา่แบบ Intersection 

=Indirect(C9) Indirect(C10) 

ขอ้ควรระวงัในการใชส้ตูร Indirect 

สตูรทกุสตูรของ Excel มทีัง้ขอ้ดแีละขอ้ดอ้ย สตูรบางสตูรทีพ่วกเราชอบใชเ้พราะเป็นสตูรที่

เขยีนสัน้ๆ แตก่ลบัทําให ้Excel ทํางานชา้ลงก็ม ี(เชน่ สตูร VLookup เป็นตน้) ซึง่สตูร Indirect 

ก็มขีอ้ควรระวงัอยูด่ว้ยกลา่วคอื สตูร Indirect สามารถ link ขอ้มลูขา้มแฟ้มได ้แตแ่ฟ้มตน้ทาง

ตอ้งเปิดขึน้พรอ้มกบัแฟ้มปลายทางทีใ่ชส้ตูรนีอ้ยู ่และเป็นสตูรหนึง่ทีถ่อืเป็น Volatile Function 

Volatile Function เป็นชือ่เรยีกประเภทของสตูร ทีจ่ะทําการคํานวณใหมท่กุครัง้ตามการคํานวณ

ทีเ่กดิขึน้ในแฟ้ม ทัง้ๆทีเ่ซลลส์ตูรนัน้ไมไ่ดม้ตํีาแหน่งอา้งองิทีส่มัพันธก์บัเซลลอ์ืน่มกีารคํานวณ

แมแ้ตน่อ้ย (ตามปกตสิตูรจะคํานวณใหมต่ามตอ่เมือ่มเีซลลอ์ืน่ทีม่ตํีาแหน่งอา้งองิเกีย่วขอ้งเกดิ

การคํานวณเทา่นัน้) ดงันัน้หากใชส้ตูรทีทํ่าหนา้ทีแ่บบ Volatile นีม้ากไปจะทําใหแ้ฟ้มคํานวณ

ชา้ลง แตถ่า้มกีารใชส้ตูรเพยีงไมก่ีเ่ซลลก์็ไมส่ง่ผลเทา่ใดนัก 

สตูรทีจั่ดเป็นประเภท Volatile Function ไดแ้ก ่สตูร Areas, Cell, Column, Columns, 

Indirect, Info, Now, Offset, Rand, Row, Rows, Today 

วธิที ี ่4 : ใชส้ตูรเพือ่ยา้ยตาํแหนง่อา้งองิโดยอตัโนมตั ิ

แมส้ตูร  Indirect ชว่ยทําใหส้ามารถเปลีย่นตําแหน่งอา้งองิไดก้็ตาม แตค่ณุยงัคงตอ้งเป็นผู ้

กําหนดตําแหน่งใหมล่งไปเองทกุครัง้ ซึง่ Excel ยงัมสีตูรอืน่อกีมากมายทีทํ่าหนา้ทีเ่ปลีย่นยา้ย

ตําแหน่งอา้งองิไดเ้ชน่ทีส่ตูร Indirect ทําได ้แถมยงัมคีวามสามารถเหนอืกวา่เพราะสามารถ

เปลีย่นยา้ยตําแหน่งอา้งองิตามเงือ่นไขทีกํ่าหนดหรอืจะกําหนดใหเ้ปลีย่นยา้ยตําแหน่งโดย

อตัโนมตัไิดอ้กีดว้ย 
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• สตูรทีส่ามารถเปลีย่นยา้ยตําแหน่งอา้งองิตามเงือ่นไขทีกํ่าหนด เชน่ IF, Choose, 

Index, Offset 

• สตูรทีส่ามารถเปลีย่นยา้ยตําแหน่งอา้งองิโดยอตัโนมตั ิเชน่ VLookup, Match ที่

นํามาใชร้ว่มกบัสตูร Index หรอื Offset, Address ทีนํ่ามาใชร้ว่มกบัสตูร Indirect 
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การกาํหนดตาํแหนง่อา้งองิแบบวงกลม 

(Circular Reference) 

เมือ่แรกเห็นชือ่การกําหนดตําแหน่งอา้งองิแบบวงกลมน่าจะทําใหค้ดิไปวา่เป็นชือ่เรยีกทีน่่ารักด ี

แตเ่มือ่ใดทีเ่กดิการกําหนดตําแหน่งอา้งองิแบบวงกลมขึน้ เมือ่นัน้แฟ้มงานของคณุจะเขา้ขา่ย

เสีย่งทเีดยีววา่จะใชแ้ฟ้มนัน้ตอ่ไปไดห้รอืไม ่เพราะตําแหน่งอา้งองิแบบวงกลมอาจเกดิขึน้โดย

ไมต่ัง้ใจโดยไมรู่ต้วั หรอืเกดิขึน้อยา่งเจตนาใหม้นัเกดิขึน้ก็ได ้ซึง่ถา้ใครทีใ่ช ้Excel เป็นประจํา

ทกุวนั น่าจะเคยเจอคําเตอืนตอ่ไปนีแ้สดงขึน้บนหนา้จอมาแลว้บา้ง 

 

“การกําหนดตําแหน่งอา้งองิแบบวงกลมอาจจะทําให ้Excel คํานวณผดิพลาด” นีเ่ป็นประเด็น

สําคญัของคําเตอืนทีแ่สดงขึน้บนจอ  

ทีน่่ากลวัทีส่ดุก็คอืคนบางคนทีใ่ช ้Excel มานาน แตอ่าจไมเ่คยพบคําเตอืนตามหนา้จอขา้งบนนี้

เปิดขึน้มาแสดงสกัครัง้เดยีว ซึง่เป็นไปไดน้อ้ยมากทีผู่ใ้ช ้Excel ไมเ่คยพลัง้เผลอสรา้งสตูรผดิ

แบบ Circular มากอ่น แตอ่าจเป็นไปไดว้า่ตวัเองไดส้รา้งสตูรแบบ Circular Reference นีม้า

กอ่นแลว้ เพยีงแตว่า่เขาเหลา่นัน้สัง่ให ้Excel เลกิเตอืน โดยเฉพาะแฟ้มงานทีเ่ป็นมรดกตกทอด

ใชต้อ่กนัมาหลายตอ่หลายรุน่ พอเปิดแฟ้มเขา้ไปแกไ้ขสตูรหรอืโยกยา้ยเซลลท์ีรุ่น่พีเ่ขาสรา้งไว ้

โดยไมรู่จั้กทีไ่ปทีม่าของสตูรในเซลลเ์หลา่นัน้ ก็อาจทําใหเ้กดิ Circular Reference ไดท้นัท ี

ตวัอยา่งการสรา้งสตูรทีม่ตํีาแหน่งอา้งองิแบบวงกลมทีง่า่ยทีส่ดุ เชน่ ในเซลล ์A1 สรา้งสตูร 

=A1 ลงไป หรอืในเซลล ์B3 สรา้งสตูร = B1+B2+B3 ลงไป หรอืสงัเกตงา่ยๆวา่สตูรในเซลล์

ใดมตํีาแหน่งอา้งองิทีร่ะบถุงึเซลลนั์น้เองอยูด่ว้ย ซึง่นอกจากนีห้ากมสีตูรที ่link ตอ่ๆกนัไป

หลายๆเซลลแ์ลว้กลบัสง่คา่กลบัมาในเซลลใ์ดเซลลห์นึง่ในวงจรของเซลลท์ี ่link กนั เชน่ 

เซลล ์A1 มสีตูร =A3 และเซลล ์A2 มสีตูร =A1 แลว้เซลล ์A3 มสีตูร =A2 ยอ่มทําใหเ้กดิ 

ตําแหน่งอา้งองิแบบวงกลมไดเ้ชน่กนั ซึง่เรยีกอกีแบบหนึง่วา่เกดิการคํานวณแบบวงกลม 

(Circular Calculation) 
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ในการดําเนนิงานทางธรุกจิ มงีานหลายประเภทซึง่อาจมเีงือ่นไขทีจํ่าเป็นตอ้งสรา้งสตูรทีม่กีาร

กําหนดตําแหน่งอา้งองิแบบวงกลม อาทเิชน่ 

• ในเงือ่นไขการคํานวณตน้ทนุสนิคา้ ซึง่นําคา่ใชจ้า่ยทัง้ทางตรงและทางออ้มมา allocate 

เป็นตน้ทนุของสนิคา้ จากนัน้หากสนิคา้นัน้กลบัไปใชเ้ป็นวตัถดุบิใหก้บัสนิคา้อืน่ แลว้

สดุทา้ยก็นําสนิคา้อืน่นัน้มาใชเ้ป็นองคป์ระกอบรว่มกบัสนิคา้เดมิอกี 

• หากบรษัิทรับจา่ยภาษีเงนิไดบ้คุคลธรรมดาแทนพนักงาน ซึง่ตามกฎเกณฑท์างภาษี

อากรกําหนดใหนํ้าภาษีทีจ่า่ยแทนนัน้นํามาบวกเป็นเงนิไดเ้พิม่ แลว้เงนิไดร้วมทีเ่พิม่ขึน้นี้

ก็ตอ้งนํากลับไปยอ้นคดิภาษีเงนิไดอ้กี 

• คา่ใชจ้า่ยบางรายการ อาจมขีอ้กําหนดทางภาษีวา่หา้มนํามาหกัภาษีซํ้าอกี แตค่า่ใชจ้า่ย

นัน้กลบัมฐีานการคํานวณทีเ่กดิขึน้จากกําไรสทุธ ิ

• ในกรณีของการกูเ้งนิ ถา้บรษัิทนําดอกเบีย้จา่ยเงนิกูไ้ปเพิม่ยอดเงนิทีต่อ้งกูเ้พิม่ ยอ่มทํา

ใหต้อ้งจา่ยดอกเบีย้เพิม่และทําใหต้อ้งกูเ้พิม่ 

• การของบประมาณคา่ใชจ้า่ยทีกํ่าหนดวา่จะใหต้ามอตัรารอ้ยละของกําไร ซึง่ถา้กําไรเพิม่

ก็จะทําใหไ้ดง้บประมาณคา่ใชจ้า่ยเพิม่ แตค่า่ใชจ้า่ยทีเ่พิม่ขึน้ ยอ่มสง่ผลใหกํ้าไรลด 

และทําใหไ้ดง้บประมาณคา่ใชจ้า่ยลดลงตาม ซึง่กลบัทําใหกํ้าไรเพิม่ขึน้ 

• งานคํานวณอืน่ๆ เชน่ การควบคมุให ้Excel เพิม่คา่ตวัเลขครัง้ละเทา่ๆกนั โดยสรา้งสตูร 

=Number+A1 ลงไปในเซลล ์A1 หรอืการบนัทกึประวตัติวัเลขสงูสดุ โดยสรา้งสตูร 

=Max(A1,NumberRange) ลงไปในเซลล ์A1 

หมายเหต ุแทนทีจ่ะใชส้ตูรทีม่ตํีาแหน่งอา้งองิแบบวงกลม ซึง่ทําใหแ้ฟ้มนัน้มรีะบบการคํานวณ

แบบพเิศษทีต่อ้งสัง่ให ้Excel ยอมรับกอ่นจงึจะคํานวณไดคํ้าตอบถกูตอ้ง เราสามารถใชคํ้าสัง่

อืน่ทีทํ่าหนา้ทีส่ัง่ให ้Excel คํานวณซํ้าได ้เชน่ Goal Seek หรอืใช ้Solver Add-in หรอืใชคํ้าสัง่

จาก Visual Basic ควบคมุการคํานวณแทน 
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ข ัน้ตอนการสรา้งสตูรคาํนวณแบบ Circular Reference 

1. ใหเ้ลอืกสรา้งสตูรอืน่ๆทีคํ่านวณตามปกตทิกุสตูร (ทีไ่มต่อ้งใชก้ารคํานวณแบบ Circular 

Reference) ใหเ้สร็จกอ่น แลว้จงึสรา้งสตูรทีต่อ้งคํานวณแบบ Circular Reference เป็นสตูร

สดุทา้ย เนือ่งจากหากตอ้งการให ้Excel คํานวณแบบ Circular เมือ่ใด คณุจะตอ้งสัง่ให ้

Excel เลกิเปิดคําเตอืน ซึง่หากมกีารสรา้งสตูรผดิพลาดเผลอไปสรา้งสตูร Circular 

Reference ขึน้โดยไมเ่จตนา ก็ยอ่มไมม่กีารเตอืนใหท้ราบ 

2. เมือ่สรา้งสตูรคํานวณแบบ Circular Reference แลว้กดปุ่ ม Cancel เพือ่ปิดคําเตอืนบน

หนา้จอตามรปูขา้งตน้แลว้ จะพบคําวา่ Circular References: ตอ่ดว้ยตําแหน่งเซลลแ์สดง

ขึน้ตรงขอบดา้นลา่งซา้ยของจอ พรอ้มทัง้ในพืน้ทีต่ารางก็จะมเีสน้ลกูศรสน้ํีาเงนิชีตํ้าแหน่ง

เซลลท์ีทํ่าใหเ้กดิการอา้งองิแบบวงกลม ซึง่หากตอ้งการให ้Excel แสดงชือ่ตําแหน่งเซลลท์ี่

เกีย่วขอ้งกบัการอา้งองิแบบวงกลมดว้ย ใหส้ัง่ Formulas > Error Checking > 

Circular References แลว้จะพบตําแหน่งเซลลท์ีเ่กีย่วขอ้งปรากฏตอ่ทา้ยคําสัง่นี ้

 

3. เมือ่ตอ้งการให ้Excel ยอมรับการคํานวณแบบ Circular Reference ใหส้ัง่ File > Options 

> Formulas > กาชอ่ง Enable iterative calculation (Excel 2003 สัง่ Tools > Options 
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> Calculation > กาชอ่ง Iteration) 

 

4. ชอ่ง Maximum Iterations และชอ่ง Maximum Change นัน้ไมจํ่าเป็นตอ้งเขา้ไปแกไ้ข

ตวัเลขใดๆ ซึง่ 2 ชอ่งนีทํ้าหนา้ทีส่ัง่ให ้Excel คํานวณสงูสดุถงึ 100 ครัง้ หรอือาจไมถ่งึ 100 

ครัง้ก็ไดโ้ดยใหคํ้านวณจนกวา่จะพบวา่ คําตอบทีคํ่านวณไดใ้นแตล่ะรอบใหค้า่แตกตา่งกนั

นอ้ยกวา่ .001 ก็จะหยดุคํานวณ ซึง่การคํานวณเป็นรอบดงักลา่วนีจ้ะเกดิขึน้ทันททีีม่กีาร

สรา้งสตูรนัน้เสร็จแลว้กดปุ่ ม Enter รับสตูรลงไปหรอืเมือ่มกีารกดปุ่ ม F9 

เพือ่สัง่ให ้Excel คํานวณ 

4.1. ใหเ้พิม่ตวัเลขจํานวนรอบสงูสดุในชอ่ง Maximum Iterations เมือ่

พบวา่ทกุครัง้ทีก่ดปุ่ ม F9 เพือ่สัง่คํานวณ จะไดต้วัเลขคําตอบตา่งจาก

เดมิไปเสมอ ซึง่หากเพิม่ตวัเลขในชอ่งนีแ้ลว้กดปุ่ ม F9 พบวา่ตวัเลขผลจากการคํานวณ

ไมเ่ปลีย่นแปลงตอ่ไปอกี ยอ่มแสดงวา่ไดคํ้าตอบสดุทา้ยแลว้ 

4.2. ใหป้รับตวัเลขคา่ความละเอยีดในชอ่ง Maximum Change ตอ่เมือ่ตอ้งการให ้Excel 

คํานวณละเอยีดขึน้ ซึง่ยอ่มทําใหต้อ้งใชจํ้านวนครัง้ในชอ่ง Maximum Iterations 

เพิม่ขึน้ตามไปดว้ย 

5. หลงัจากสัง่คําสัง่ตามขอ้ 3 แลว้ จะไมพ่บขอ้ความหรอืตําแหน่งเซลลท์ีแ่สดงบนหนา้จอตาม

ตําแหน่งตา่งๆทีเ่คยแสดงไวต้ามขอ้ 2 อกีตอ่ไป แตจ่ะพบคําวา่ Calculate แสดงคา้งอยูต่รง

ขอบจอดา้นลา่งซา้ยของโปรแกรม Excel แทน และขอใหส้งัเกตวา่ทกุครัง้ทีก่ดปุ่ ม F9 จะ

ทําใหคํ้าวา่ Calculate นีห้ายไปชัว่ขณะหนึง่แลว้กลบัมาแสดงใหม ่(โดยไมเ่กีย่วขอ้งกบัการ

สัง่ใหคํ้านวณแบบ Manual ทีจ่ะมคํีาวา่ Calculate แสดงขึน้มาเชน่กนั แตเ่มือ่กดปุ่ ม F9 

เพือ่สัง่คํานวณแบบ Manual จะทําใหคํ้าวา่ Calculate หายไปโดยไมก่ลบัมาใหมอ่กี) 

6. ในกรณีทีต่อ้งการตรวจสอบทีไ่ปทีม่าของสตูรทีม่กีารใชตํ้าแหน่งอา้งองิแบบวงกลมวา่มี

เซลลใ์ดทีเ่กีย่วขอ้งบา้ง ใหย้อ้นกลบัไปตดักาชอ่ง Enable iterative calculation ทิง้

ไป จากนัน้ Excel จะแสดงตําแหน่งเซลลท์ีเ่กีย่วขอ้งไวท้ีคํ่าสัง่ Formulas > Error 

Checking > Circular References ซึง่เซลลเ์หลา่นัน้อาจจะเป็นเซลลส์ตูรทีส่รา้งไว ้

อยา่งตัง้ใจหรอืเผลอแกไ้ขสตูรใหต้า่งจากเดมิไปจนทําใหเ้กดิ Circular reference ขึน้ก็ได ้
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จากนัน้ใหท้ยอยลบสตูรในเซลลด์งักลา่วทิง้ไปทลีะเซลล ์จนกวา่จะพบวา่เมือ่ลบสตูรใน

เซลลใ์ดเสร็จแลว้ ทําใหไ้มเ่กดิคําเตอืน Circular ตอ่ไปอกี หลงัจากนัน้จงึไลส่รา้งสตูรใหม่

ขึน้มาแทน ซึง่หลายๆครัง้จะพบวา่ตอ้งไลล่บสตูรในเซลลท์ิง้แลว้ตอ้งสรา้งสตูรใหมนั่บรอ้ย

นับพันเซลลท์เีดยีว โดยเฉพาะตารางคํานวณทีต่อ้งคํานวณรายการรายวนัหรอืรายเดอืนตอ่

กนัไปเป็นตารางขนาดใหญ ่ดงันัน้ผูใ้ช ้Excel ทกุคนตอ้งรูต้วัทนัทเีมือ่ตวัเองเผลอสรา้งสตูร

ทีม่ตํีาแหน่งอา้งองิแบบวงกลมขึน้มาเป็นครัง้แรก หากปลอ่ยไวก้็จะตอ้งเสยีแรงเสยีเวลาไล่

ยอ้นมาแกไ้ขกนัใหมท่ลีะเซลล ์

7. เซลลท์ีทํ่าใหเ้กดิ Circular นี ้ควรใสส่ใีหต้า่งจากเซลลอ์ืน่ หรอืทําเครือ่งหมายพเิศษ หรอื

เขยีนอธบิายกํากบัไวด้ว้ยเพือ่เตอืนผูใ้ชง้านใหแ้กไ้ขสตูรอยา่งระมดัระวงั 

8. ควรตัง้ชือ่แฟ้มทีม่สีตูรทีม่ตํีาแหน่งอา้งองิแบบวงกลมใหม้ชีือ่ทีส่ะดดุตา จะไดไ้มเ่ผลอเปิด

แฟ้มทีต่อ้งคํานวณแบบ Iterations นีข้ ึน้มาใชง้านพรอ้มกบัแฟ้มอืน่ เพราะแฟ้มอืน่ๆจะรับ

คําสัง่ Iterations นีต้ามไปดว้ยโดยไมจํ่าเป็น 

9. หากปิดโปรแกรม Excel แลว้เปิด Excel ขึน้มาใหม ่จะพบวา่ Excel ตดักาชอ่ง Enable 

iterative calculation ทิง้ไปใหเ้สมอ 

เคล็ดลบัอืน่ๆเกีย่วกบัการใชต้ําแหนง่อา้งองิ 

1. ในกรณีตอ้งการหายอดรวมทกุชทีจากตําแหน่งเซลลเ์ดยีวกนั ใหส้รา้งสตูรหายอดรวมแบบ 

3 มติ ิซึง่จะอยูใ่นโครงสรา้งสตูร =SUM(ชือ่ชทีแรก:ชือ่ชทีสดุทา้ย!ตําแหน่งเซลล)์ เชน่ 

=SUM(Sheet1:Sheet3!A1) ทําหนา้ทีห่ายอดรวมของเซลล ์A1 ทีอ่ยูใ่นชที Sheet1 ถงึ 

Sheet3 ดงันัน้หากตอ้งการใหร้วมขอ้มลูจากชทีใด ใหย้า้ยชทีนัน้ไปวางไวร้ะหวา่ง Sheet1 

ถงึ Sheet3 

1.1. ใหเ้ลอืกเซลลคํ์าตอบ พมิพ ์=sum( 

1.2. คลกิเซลลใ์นชทีแรกทีต่อ้งการ 

1.3. กดปุ่ ม Shift คา้งไวแ้ลว้คลกิชทีสดุทา้ยทีต่อ้งการ 

1.4. กดปุ่ ม Enter 

2. หากตอ้งการหายอดรวมจากทกุชทีเวน้ชทีทีส่รา้งสตูรนีล้งไป ใหพ้มิพส์ตูร =SUM('*'!

ตําแหน่งเซลล)์ เชน่ เมือ่สรา้งสตูร =SUM('*'!A1) ลงไปในชที Sheet1 จะไดส้ตูร 

=SUM(Sheet2:Sheet3!A1) 
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3. ในกรณีทีต่อ้งการปรับโครงสรา้งของตารางในชทีหนึง่ๆใหเ้ป็นหลายแบบ โดยไมจํ่าเป็นตอ้ง

สรา้งชทีใหมสํ่าหรับโครงสรา้งตารางแตล่ะแบบ แตใ่หป้รับโครงสรา้งในชทีเดมิชทีเดยีวนัน้

แลว้สัง่ให ้Excel จดจําโครงสรา้งหนา้ตาตารางโดยสัง่ View > Custom Views > Add 

จากนัน้ใหต้ัง้ชือ่หนา้ตาโครงสรา้งตารางนัน้ลงไป แลว้เมือ่ใดทีต่อ้งการแสดงหนา้ตาตาราง

ชือ่ใดใหส้ัง่ View > Custom Views แลว้เลอืกชือ่ View ทีเ่คยตัง้ชือ่ไว ้(วธินีีส้ามารถตัง้

ชือ่ View ขา้มชทีไดด้ว้ย ทําใหไ้มต่อ้งพึง่ชือ่ชที แถมยงัชว่ยปรับ Print settings และ Filter 

settings ตามแบบทีกํ่าหนดไวใ้นขณะทีต่ัง้ชือ่ใหท้นัท)ี 

4. ขอใหอ้อกแบบชทีทกุชทีทีเ่ก็บขอ้มลูประเภทเดยีวกนัไวใ้หใ้ชตํ้าแหน่งเซลลเ์ดยีวกนัของ

ทกุชที โดยไมต่อ้งคํานงึวา่บางชทีจะมขีอ้มลูครบหรอืไม ่จากนัน้ใหส้ัง่ Hide รายการทีไ่มม่ี

ขอ้มลูนัน้ออกไป และใหใ้ช ้Custom View ชว่ยบนัทกึแบบโครงสรา้งตารางทัง้กอ่นและ

หลงัการ Hide ไวด้ว้ย 

5. พยายามหลกีเลีย่งการใชเ้ซลลใ์ดๆใน Column A และ Row 1 ทัง้นีเ้พือ่ทําใหภ้าพตารางที่

แสดงบนจอดไูมอ่ดึอดั และยงัสามารถปรับขนาดความสงูความกวา้งของ Column A และ 

Row 1 เพือ่ชว่ยปรับตําแหน่งตารางในหนา้กระดาษพมิพไ์ดด้กีวา่การกําหนด Margin แต่

เพยีงอยา่งเดยีว 

6. หา้ม Merge เซลลท์ีเ่กีย่วขอ้งกบัการคํานวณ เพราะตําแหน่งอา้งองิในสตูรทีอ่า้งถงึเซลลท์ี ่

Merge กนัไวนั้น้อาจใหตํ้าแหน่งอา้งองิทีค่ลาดเคลือ่นจากความเป็นจรงิเมือ่มกีาร Copy 

สตูรทีอ่า้งองิถงึตําแหน่งเซลลท์ี ่Merge ไปใชท้ีเ่ซลลอ์ืน่ ดงันัน้หากตอ้งการปรับการแสดง

ขอ้มลูใหเ้ห็นวา่อยูก่ลางชว่งเซลลเ์ชน่เดยีวกบั Merge แตว่า่เซลลแ์ตล่ะเซลลย์งัคงเป็น

เซลลข์องมนัเองโดยมไิดร้วมเป็นเซลลเ์ดยีวอยา่ง Merge แตอ่ยา่งใด ใหเ้ลอืกชว่งเซลลนั์น้

แลว้คลกิขวา สัง่ Format Cells > Alignment > Center Across Selection  

 

7. ในกรณีทีต่อ้งการ Cut ตารางจากชทีหนึง่ไปยงัชทีอืน่

หรอืแฟ้มอืน่ ใหเ้ริม่จากเลอืกพืน้ทีต่ารางทีต่อ้งการจะ 

Cut ไปทัง้หมด (โดยตอ้งตรวจสอบวา่เป็นพืน้ทีต่าราง

ทัง้หมดทีม่สีตูรทีเ่กีย่วขอ้งกนั มฉิะนัน้จะมเีซลลส์ตูรบางเซลลท์ีก่ลายเป็นสตูร link ขา้ม
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แฟ้ม) จากนัน้เมือ่ตอ้งการ Paste สามารถเลอืก Paste ทีเ่ซลลใ์ดในชทีใหมก่็ได ้โดย Excel 

จะปรับตําแหน่งอา้งองิตามตําแหน่งในชทีใหมใ่หเ้อง 

8. ในกรณีทีต่อ้งการ Copy ตารางจากชทีหนึง่ไปยงัชทีอืน่หรอืแฟ้มอืน่ ใหเ้ริม่จากเลอืกพืน้ที่

ตารางทีต่อ้งการจะ Copy จากนัน้เมือ่ตอ้งการ Paste ใหเ้ลอืกเซลลใ์นชทีใหมท่ีเ่ป็นเซลล์

เดยีวกบัเซลลแ์รกของตารางที ่Copy ไวก้อ่น แลว้จงึสัง่ Paste  

9. หากตอ้งการป้องกนัไมใ่หผู้อ้ ืน่นําแฟ้มไปแกไ้ขสตูร ไมจํ่าเป็นตอ้ง Protect Sheet ก็ได ้แต่

ใหส้ัง่ตดัเครือ่งหมาย $ ออกจากเซลลส์ตูรทกุเซลลโ์ดยใชคํ้าสัง่ Replace เพือ่ทําใหส้ตูร

ทัง้หมดถกูแกไ้ขหรอืสรา้งใหมไ่ดย้ากมาก (น่าสงัเกตวา่พอตดัเครือ่งหมาย $ ทิง้ไป แฟ้มจะ

มขีนาดใหญข่ึน้) 

10. หากตอ้งการป้องกนัการ Insert Row หรอื Insert Column ในพืน้ทีช่ว่งใด ใหส้รา้งสตูร 

Array ลงไปพรอ้มกนัเป็นรัว้ขอบเขตนัน้ เชน่ เลอืกเซลล ์A1:A10 แลว้พมิพส์ตูร =0 หรอื 

=”” (=”” นี ้จะกลายเป็นรัว้ไฟฟ้าทีม่องไมเ่ห็นขอ้มลูในเซลลรั์ว้นัน้ดว้ย)แลว้กดปุ่ ม 

Ctrl+Shift+Enter ลงไป จะไดรั้ว้ป้องกนัการ Insert Row ในชว่ง Row 1 ถงึ Row 10 

11. หากตอ้งการใช ้Windows Explorer ในการ copy แฟ้ม Excel ที ่link กนัหลายๆแฟ้มไปเก็บ

ที ่drive อืน่หรอืโฟลเดอรอ์ืน่ ให ้Copy ทัง้โฟลเดอรท์ีเ่ก็บแฟ้มที ่link กนันัน้ไปพรอ้มกนั

ทัง้หมด เชน่ ใน ถา้เก็บแฟ้มที ่link กนัไวใ้นโฟลเดอรช์ือ่ MyExcelFile ก็ให ้Copy ตวั

โฟลเดอร ์MyExcelFile ซึง่มแีฟ้มที ่link กนัอยูภ่ายในนัน้ไปทัง้ชดุ โดยในโฟลเดอรช์ือ่ 

MyExcelFile อาจมโีฟลเดอรย์อ่ยสรา้งไวด้ว้ยก็ได ้เมือ่ Copy ไปไวท้ี ่drive อืน่แลว้ คณุจะ

เปลีย่นชือ่โฟลเดอร ์MyExcelFile เป็นชือ่อืน่ก็ได ้แตห่า้มเปลีย่นชือ่โฟลเดอรย์อ่ยเพราะสตูร 

link ในแฟ้ม Excel จะจําชือ่โฟลเดอรย์อ่ยไวใ้นสตูร (แตไ่มจํ่าชือ่โฟลเดอร ์MyExcelFile) 

12. แทนทีจ่ะจัดเก็บแฟ้มไวใ้นชือ่เดมิ ขอใหจั้ดเก็บแฟ้มในชือ่อืน่ทกุครัง้ทีม่กีารแกไ้ขใดๆใน

แฟ้มนัน้ ทัง้นีเ้พือ่ทําใหม้แีฟ้มเกา่เก็บไวห้ลายๆรุน่ ดกีวา่การมแีฟ้มรุน่เดยีวแฟ้มเดยีว ซึง่

เสีย่งหากแฟ้มนัน้อาจเสยีหายจนเปิดไมไ่ด ้
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แป้นพมิพล์ดัทีเ่ก ีย่วขอ้งกบัตําแหนง่อา้งองิและขอบเขตพืน้ทีต่าราง 

F2 ใชแ้กไ้ขขอ้มลูหรอืสตูรในเซลล ์

F3 ใชใ้สช่ือ่ตําแหน่งเซลลห์รอืชือ่สตูรทีต่ัง้ไวใ้นแฟ้มนัน้ๆลงไปในสตูร  

หรอืสัง่ Paste List ตอ่ จะสรปุชือ่ทีต่ัง้ไวทั้ง้หมดลงไปในตาราง 

F4 ใชใ้สเ่ครือ่งหมาย $ กํากบัตําแหน่งอา้งองิ  

หรอืสัง่ทวนคําสัง่สดุทา้ยซ้ํา 

F5 ใชห้าเซลล ์ตามตําแหน่งหรอืชือ่ตําแหน่งเซลลท์ีท่ราบ 

หรอืสัง่ Special ตอ่ จะคน้หาตําแหน่งเซลลไ์ดอ้กีหลายแบบ 

F8 ใชค้วบคมุตําแหน่งเซลลแ์รกไวไ้มใ่หข้ยับเพือ่ขยายตาราง (Extend)  

F9 ใชส้ัง่คํานวณทกุชทีทกุแฟ้มทีเ่ปิดขึน้ 

Shift + F9 ใชส้ัง่คํานวณเฉพาะชทีทีเ่ลอืกอยูช่ทีเดยีวเทา่นัน้ 

F2 ตามดว้ย F9 ใชแ้กะสตูรในเซลลเ์พือ่ดวูา่มคีา่ทีแ่ทจ้รงิเป็นอยา่งไร แลว้กด Esc 

Ctrl + * หรอื Ctrl+a ใชเ้ลอืกพืน้ทีต่ารางซึง่มขีอ้มลูตดิตอ่กนัไป (Current Region) 

Ctrl + . ใชย้า้ย Active Cell ไปตามเซลลห์วัมมุของตารางทีเ่ลอืกไว ้

Ctrl + Shift +  

Shift + End  

ใชเ้ลอืกพืน้ทีต่ารางจากเซลลท์ีเ่ลอืกไวไ้ปจนสดุทางดา้นขวา  

หรอืตามทศิทางของลกูศรทีก่ด 

Ctrl + PgUp ใชเ้ลอืกชทีถัดไป 

Ctrl + PgDn ใชเ้ลอืกชทีกอ่นหนา้ 

Ctrl + Tab ใชเ้ลอืกแฟ้มถัดไปทีเ่ปิดอยู ่

Ctrl + Shift + Tab ใชเ้ลอืกแฟ้มกอ่นหนา้ทีเ่ปิดอยู ่

Ctrl + Shift + Enter ใชส้รา้งสตูร Array ซึง่จะมเีครือ่งหมาย { } ปิดหวัทา้ยสตูร 
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หลกัการแยกตวัแปร 

1. ตวัแปร คอื คา่ทีม่นุษยส์ามารถกําหนดใหม้คีา่เปลีย่นแปลงตา่งไปจากเดมิ ตวัแปรอาจ

เป็นไดท้ัง้คา่ทีเ่ป็นตวัเลข ตวัอกัษร หรอืแมแ้ตส่ตูร 

2. เซลลรั์บตวัแปรอาจใชเ้ซลลเ์ดยีวหรอืหลายเซลล ์ขึน้กบัประเภทของตวัแปรนัน้ๆวา่มกีาร

เปลีย่นแปลงไปตามระยะเวลาหรอืเงือ่นไขอืน่ใดหรอืไม ่ถา้เป็นคา่คงทีซ่ ึง่ใชค้า่เดยีวไป

ตลอด ก็สามารถใชเ้ซลลรั์บคา่เพยีงคา่เดยีวเซลลเ์ดยีวในแฟ้มหนึง่ แตถ่า้เป็นคา่ทีม่ี

ความผันผวนเปลีย่นแปลงไปตามระยะเวลาก็จําเป็นตอ้งใชห้ลายเซลล ์เชน่ ตวัแปร

ประเภทราคาสนิคา้ ควรกําหนดใหแ้ตล่ะชว่งเวลามรีาคาสนิคา้แตกตา่งกนัไปเพือ่ใหเ้กดิ

ความยดืหยุน่ในการคํานวณ ก็จําเป็นตอ้งใชห้ลายเซลลเ์พือ่รับตวัแปรประเภทราคา

สนิคา้ทีม่ยีอดตา่งกนัไปในแตล่ะชว่งเวลา 

3. ควรคดิเผือ่ไวต้ัง้แตต่น้เสมอวา่ คา่คงทีท่กุคา่เป็นตวัแปรทีค่า่อาจเปลีย่นแปลง เพราะ

คา่คงทีใ่ดๆทีค่ดิวา่คงทีใ่นวนันี ้อาจเป็นไปไดว้า่ไมใ่ชค่า่ทีจ่ะคงทีไ่ปตลอด ดงันัน้หาก

ไมม่ัน่ใจวา่จะคงทีไ่ปตลอดหรอืไม ่ควรออกแบบตารางตัง้แตแ่รกเผือ่ไวใ้หส้ามารถ

เปลีย่นแปลงตวัแปรตามระยะเวลาไดด้ว้ย เชน่ อตัราภาษีธรุกจิเฉพาะ ซึง่อาจถกู

ปรับเปลีย่นใหต้า่งไปจากเดมิในอนาคต 

4. ลกูเลน่ทางธรุกจิเป็นตวัแปรไดเ้หมอืนกนั อยา่คดิวา่วธิดํีาเนนิการทางธรุกจิตอ้งเป็นแบบ

ปัจจบุนัไปตลอด คณุตอ้งเผือ่เซลลรั์บตวัแปรทีอ่าจเกดิขึน้หรอืไมเ่กดิขึน้ไวก้อ่นตัง้แต่

แรก ดกีวา่ทีจ่ะยอ้นกลบัไปแกไ้ขตารางแทรกตวัแปรเพิม่ในภายหลงั ขอใหอ้อกแบบ

โครงสรา้งตารางเผือ่ไวก้อ่นดกีวา่ขาด 

5. ในกรณีทีต่วัแปรมเีงือ่นไขซบัซอ้น ควรแยกตวัแปรประเภทนัน้ไปเก็บเป็นตารางเฉพาะ

หรอืเป็นชทีเฉพาะหรอืแมแ้ตเ่ป็นแฟ้มเฉพาะสําหรับตวัแปรนัน้ๆ โดยใหอ้อกแบบตาราง

ตามแบบโครงสรา้งฐานขอ้มลูทีด่ดีว้ย 

6. ควรใสส่สีรรคใ์หเ้ห็นเซลลรั์บตวัแปรแยกชดัเจนแตกตา่งจากเซลลส์ตูรคํานวณและ

กําหนดให ้Excel เปิดรับคา่ใหมไ่ด ้โดยคลกิขวาลงไปในเซลลต์วัแปรนัน้ สัง่ Format 

Cells > Protection แลว้ตดักาชอ่ง Locked ทิง้ไป จากนัน้สัง่ Review > Protect 

Sheet (Excel 2003 สัง่ Tools > Protection > Protect Sheet) แลว้จะพบวา่เมือ่กด

ปุ่ ม Tab จะยา้ยตําแหน่งเซลลไ์ปตามเซลลท์ีเ่ป็นตัวแปรใหเ้อง 
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วธิใีช ้Goal Seek 

เลขอะไรเอย่นําไปคณูกบัเลข 3 แลว้ไดผ้ลลพัธเ์ป็นเลข 30 คณุก็ตอ้งตอบวา่เลข 10 เพราะคณุ

คดิสตูรคณูในใจออกมาไดท้นัทเีลยใชไ่หมวา่ 10*3 = 30 แตถ่า้เปลีย่นโจทยใ์หมว่า่ เลขอะไร

เอย่นําไปคณูกบัเลข 3 แลว้ไดผ้ลลัพธเ์ป็นเลข 77.77 คราวนีส้มองของคณุก็จะคดิในใจอยา่ง

รวดเร็ววา่ “ไมไ่หว คดิไมไ่หว” ถา้ตอ้งเสยีเวลากดเครือ่งคดิเลขหรอืสรา้งสตูรเอาเลข 77.77 ตัง้

แลว้หารดว้ย 3 เพือ่หาเลขอะไรเอย่ตวันัน้ก็ได ้ยอ่มแสดงวา่คณุใช ้Goal Seek ไมเ่ป็น 

Goal Seek เป็นเครือ่งมอืทีช่ว่ยคดิยอ้นโดยคณุไมต่อ้งเสยีเวลาสรา้งสตูรใหมเ่พือ่คดิยอ้นเอง

แมแ้ตน่อ้ย เพยีงแตว่า่ Goal Seek จะทํางานไดต้อ่เมือ่มเีซลลรั์บตวัแปรทีส่ามารถถกู Excel ทํา

หนา้ทีเ่ปลีย่นแปลงเป็นเลขใหมต่ามตอ้งการ แตห่ากเป็นเซลลส์ตูรจะไมส่ามารถใช ้Goal Seek 

เขา้ไปแกไ้ขสตูรใดๆในเซลลใ์หเ้ป็นคา่ใหมไ่ด ้

จากโจทยเ์ดมิ เลขอะไรเอย่นําไปคณูกบัเลข 3 แลว้ไดผ้ลลพัธเ์ป็นเลข 77.77 

1. สรา้งตวัอยา่ง 2*3 ได ้6 ตามตวัอยา่งทีผ่า่นมา 

2. สัง่ Data > What-If Analysis > Goal Seek (Excel 2003 สัง่ Tools > Goal Seek) 

 

3. คลกิในชอ่ง Set cell: แลว้ใหค้ลกิตอ่ไปทีเ่ซลล ์D2 โดยเซลลน์ีต้อ้งเป็นเซลลส์ตูร

คํานวณ สว่นชอ่ง To value: ใหพ้มิพเ์ลข 77.77 ลงไป แลว้ใหค้ลกิในชอ่ง By 

changing cell: แลว้คลกิตอ่ไปทีเ่ซลล ์B2 โดยเซลล ์B2 นีต้อ้งเป็นเซลลรั์บตวัแปรที่

กําลงัตอ้งการหา ถอืเป็นตวัเลขคําตอบใหมท่ีต่อ้งการ 
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4. กดปุ่ ม OK จะพบวา่ Excel เปลีย่นตวัเลข 2 ในเซลล ์B2 เป็นตวัเลข 25.92333 ซึง่ทํา

ใหเ้กดิผลลัพธท์ีเ่ซลล ์C2 เป็นเลข 77.77 ตามตอ้งการ แลว้ใหก้ดปุ่ ม OK เพือ่ยอมรับ

คําตอบที ่Goal Seek หาให ้

 

5. หากตอ้งการหาตวัเลขคําตอบทีต่า่งจากเดมิ ตอ้งสัง่ Data > What-If Analysis > Goal 

Seek ซํ้าเองใหม ่

คราวนีม้าลองใช ้Goal Seek กบัปัญหาทีย่ากขึน้ โดยใหห้าวา่ตวัเลขคา่โฆษณาในเซลล ์G18 

ตอ้งเป็นเทา่ใด จงึจะคดิเป็น 15% ของกําไรขัน้ตน้ 

 

จากภาพตารางขา้งบนนี ้เซลล ์G16 และเซลล ์H17 เป็นเซลลรั์บตวัแปร ซึง่มคีา่เป็นตวัเลข

ยอดขาย 1,000 บาทและตวัเลขเปอรเ์ซน็ตต์น้ทนุขายเทา่กบั 20% ตามลําดบั สว่นเซลลส์ตูร

คํานวณมใีนเซลล ์G17 มสีตูร =H17*G16 เพือ่หายอดตน้ทนุขายเทา่กบั 200 บาท (คดิเป็น 

20% ของยอดขาย) สว่นเซลล ์G19 เป็นเซลลส์ตูรคํานวณหากําไรขัน้ตน้มสีตูร =G16-G17-

G18 มาจากยอดขายหกัตน้ทนุขายและหกัคา่โฆษณา เซลลท์ีเ่วน้วา่งไวค้อืเซลล ์G18 ใหใ้ชห้า

คา่โฆษณา ซึง่ตอนเริม่ตน้นีเ้วน้วา่งไว ้จงึทําใหเ้ซลล ์H18 ซึง่มสีตูรคํานวณหาสดัสว่นรอ้ยละ

ของคา่โฆษณาตอ่กําไรขัน้ตน้ =G18/G19 ซึง่ขณะนีค้นืคา่เทา่กบั 0 

ตวัอยา่งนีไ้มส่ามารถใชว้ธิคีดิงา่ยๆวา่ ในเมือ่ตอ้งการคา่โฆษณาเป็น 15% ของกําไรขัน้ตน้ ก็ให ้

สรา้งสตูร =.15*G19 ลงในในเซลล ์G18 ก็สิน้เรือ่ง เพราะหากสรา้งสตูร =.15*G19 ลงไปใน

เซลล ์G18 จะพบวา่เกดิการอา้งองิแบบวงกลม (ตอ้งหนัไปใชก้ารคํานวณแบบ Iteration เขา้มา

ชว่ย ซึง่เป็นอกีวธิหีนึง่ในการแกปั้ญหานี)้ เพราะหากคา่โฆษณาเพิม่ จะทําใหกํ้าไรลด แลว้พอ
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กําไรลด ยอ่มสง่ผลใหค้า่โฆษณาลดตาม พอคา่โฆษณาลดลง กําไรก็ตอ้งเพิม่ กลายเป็นการ

คํานวณแบบวงกลมทีไ่มส่ามารถหาคําตอบสดุทา้ยไดโ้ดยวธิธีรรมดาทัว่ไป 

คณุสามารถแกปั้ญหานีโ้ดยใช ้Goal Seek โดยเริม่ตน้จากสัง่ สัง่ Data > What-If Analysis > 

Goal Seek 

 

1. คลกิในชอ่ง Set cell: แลว้ใหค้ลกิตอ่ไปทีเ่ซลล ์H18 โดยเซลลน์ีเ้ป็นเซลลส์ตูร

คํานวณหาวา่คา่โฆษณาเป็นรอ้ยละเทา่ใดของกําไรขัน้ตน้ =G18/G19 

2. ชอ่ง To value: ใหพ้มิพเ์ลข .15 ซึง่เป็นตวัเลขคําตอบทีต่อ้งการ 

3. คลกิในชอ่ง By changing cell: แลว้คลกิตอ่ไปทีเ่ซลล ์G18 เพือ่ใหห้าตวัเลขคา่

โฆษณา 

4. กดปุ่ ม OK > OK จะไดต้วัเลขคําตอบคา่โฆษณาเทา่กบั 104.50377964375 ที ่Goal 

Seek คดิให ้

 

Goal Seek เป็นเครือ่งมอืพสิดารทีเ่หมาะในการวางแผนงบประมาณ ชว่ยตัง้ราคาขายสนิคา้เพือ่

ทําใหไ้ดกํ้าไรตามตอ้งการ หรอืชว่ยในการคํานวณยอ้นกลบัในงานทีค่นเราคดิเองไมไ่หวได ้
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อยา่งไมน่่าเชือ่ ซึง่ในงานวางแผนตัดสนิใจนัน้ แทบเป็นไปไมไ่ดเ้ลยทีเ่ราจะมคีวามเชือ่มัน่ 

100% ตอ่คําตอบทีม่อียูเ่สมอไป ดงันัน้แทนทีจ่ะเสีย่งกบัการใชต้วัเลขเพยีงตวัเดยีว ขอแนะนํา

ใหใ้ช ้Goal Seek คดิยอ้นหาชว่งคา่ทีเ่ป็นไปไดว้า่อยูใ่นชว่งตัวเลขระหวา่งคา่ใด เพือ่ทําให ้

สามารถวางแผนไดอ้ยา่งยดืหยุน่มากขึน้ เชน่ เดมิเคยถามวา่ ตวัเลขคา่โฆษณาในเซลล ์G18 

ตอ้งเป็นเทา่ใด จงึจะคดิเป็น 15% ของกําไรขัน้ตน้ ก็ใหใ้ช ้Goal Seek คน้หาคําตอบทีย่ดืหยุน่

กวา่เดมิวา่ ตวัเลขคา่โฆษณาในเซลล ์G18 ตอ้งเป็นคา่ระหวา่งเลขใด จงึจะคดิเป็น 15% - 

20% ของกําไรขัน้ตน้ 

ขอ้จํากดัของ Goal Seek และวธิแีกไ้ข 

ขอ้จํากดัทีสํ่าคญัของ Goal Seek เกดิจากทกุครัง้ทีต่อ้งการคดิยอ้นครัง้ใหม ่คณุตอ้งเป็นผูส้ัง่ให ้

Goal Seek ทํางานซํ้าดว้ยตนเอง และ Goal Seek จะยอมใหเ้ปลีย่นแปลงตวัเลขตวัแปรไดเ้พยีง

เซลลเ์ดยีว นอกจากนีส้ว่นทีไ่มย่ดืหยุน่ทีส่ดุก็คอื คณุตอ้งกรอกตวัเลขทีต่อ้งการลงไปในชอ่ง 

To value เองเสมอ โดยไมส่ามารถ link คา่ตวัเลขเป้าหมายทีต่อ้งการจากเซลลเ์ขา้ไปใชใ้น 

Goal Seek จงึเป็นเครือ่งมอืทีไ่มเ่หมาะสําหรับผูท้ีไ่มเ่คยใช ้Goal Seek มากอ่น 

เราสามารถแกไ้ขจดุออ่นของ Goal Seek ใหส้ามารถรับคา่จากเซลลไ์ดโ้ดยตรง และหาทาง

ปรับปรงุให ้Goal Seek ทํางานหาคําตอบใหเ้องทันทอียา่งอตัโนมตั ิโดยเริม่จากใช ้Macro 

Recorder บนัทกึการสัง่ Data > What-If Analysis > Goal Seek แลว้ใชง้านตามตวัอยา่งการ

คํานวณหาคา่โฆษณาในตวัอยา่งทีผ่า่นมา จะไดร้หสั VBA ตามนี ้

Sub SetGoal() 

    Range("H18").GoalSeek Goal:=0.15, ChangingCell:=Range("G18") 

End Sub 

จากนัน้ใหแ้กไ้ขตําแหน่งอา้งองิและคา่คงทีใ่นตวัรหสัใหอ้า้งถงึชือ่ Range Name ทีต่ัง้ไวใ้น

ตารางกลายเป็นรหสัใหมด่งันี ้

Sub SetGoal() 

    [MyTarget].GoalSeek Goal:=[TargetValue], ChangingCell:=[ChangeCell] 

End Sub 
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โดยกําหนดใหต้ัง้ชือ่ Range Name ชือ่วา่ MyTarget ใหก้บัเซลล ์H18 และชือ่ ChangeCell 

ใหก้บัเซลล ์G18 และเมือ่ใดทีต่อ้งการตวัเลขตวัใหม ่ใหก้รอกตวัเลขลงไปในเซลลท์ีต่ัง้ชือ่วา่ 

TargetValue  

หากตอ้งการความสะดวกมากขึน้ ควรสัง่ให ้Goal Seek ทํางานเองโดยใช ้Event ก็จะได ้

ผลลพัธท์นัทโีดยไมต่อ้งเสยีเวลามาเปิด Goal Seek ขึน้เพือ่กรอกคา่เองอกีตอ่ไป เชน่ หากใช ้

Calculation Event ก็จะไดผ้ลลพัธต์ามการคํานวณใดๆทีเ่กดิขึน้ในชทีนัน้ 

Private Sub Worksheet_Calculate() 

    [MyTarget].GoalSeek Goal:=[TargetValue], ChangingCell:=[ChangeCell] 

End Sub 
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วธิใีช ้Data Table 

ถา้ถามวา่ตอนเริม่ตน้ใชส้ตูรคํานวณใน Excel แรกเริม่นัน้คณุตอ้งรูจั้กใชอ้ะไรใหเ้ป็น ก็ตอบวา่

ตอ้งรูจั้กการกําหนดตําแหน่งอา้งองิโดยการใชเ้ครือ่งหมาย $ ควบคมุแนวของคา่ทีใ่ชใ้นการ

คํานวณ แลว้ถา้ถามตอ่ไปวา่ ตอนสรา้งแฟ้มงานเสร็จแลว้ละ่ตอ้งใชอ้ะไรใหเ้ป็น คําตอบก็คอื

ตอ้งใช ้Data Table สรปุคําตอบทีเ่ป็นไปไดเ้พือ่ใชต้ดัสนิใจ 

Data Table เป็นคําสัง่ทีม่มีานานแลว้แตม่กัถกูละเลยไมส่นใจใชก้นันัก คงเป็นเพราะคําสัง่นีถ้กู

ออกแบบมาใหอ้ยูก่นัเมนู Data จงึทําใหน้กึไปวา่เป็นคําสัง่ทีไ่มเ่กีย่วขอ้งกบัการคํานวณ อกี

ทัง้ตวัอยา่งและคําอธบิายใน Help ก็มไิดใ้หร้ายละเอยีดชดัเจนนัก ผูท้ีจ่ะเขา้ใจ Data Table ได ้

ก็ตอ้งลองใชคํ้าสัง่นีด้แูลว้จงึจะซึง้ถงึประโยชนข์องมนั 

Data Table อาศยัการออกแบบตารางแบบพเิศษทีจ่ะชว่ยให ้Excel นําคา่ทีว่างไวบ้นหวัตาราง

หรอืขา้งตารางดา้นใดดา้นหนึง่หรอืทัง้สองดา้น สง่ตอ่ไปแทนทีค่า่หรอืสตูรทีบ่นัทกึไวใ้นเซลล ์

เมือ่คา่ในเซลลเ์หลา่นัน้เปลีย่นไปตามคําสัง่ Data Table ก็จะทําใหเ้ซลลส์ตูรทีเ่กีย่วขอ้ง

คํานวณหาคําตอบใหม ่เพยีงแตก่ารเปลีย่นแปลงคา่ในเซลลแ์ละคําตอบใหมท่ีเ่กดิขึน้นัน้ เราจะ

ไมเ่ห็นมกีารเปลีย่นแปลงใดๆเกดิขึน้ในตาราง แตจ่ะพบวา่ Excel นําคําตอบมาสรปุไวใ้นตาราง 

Data Table ใหเ้อง 

สําหรับผูท้ีคุ่น้เคยกบัการเขยีนโปรแกรมสําเร็จรปู การทํางานของ Data Table เปรยีบเทยีบได ้

กบัการใชร้หสัโปรแกรมสัง่ให ้Excel ทํางานซํ้าหลายครัง้เป็น loop โดย Excel จะสง่คา่ไปที่

เซลลท์ีเ่รากําหนดใหใ้นแตล่ะ loop ทัง้นี ้Data Table จะทํางานเป็น loop ใหอ้ตัโนมตัโิดยเรา

ไมต่อ้งเสยีเวลาเขยีนโปรแกรมแมแ้ตน่อ้ย 

Data Table ม ี3 แบบตามจํานวนตวัแปรทีเ่กีย่วขอ้ง ไดแ้ก ่

• Data Table แบบ 1 ตวัแปร  

• Data Table แบบ 2 ตวัแปร 

• Data Table แบบไมจํ่ากดัตวัแปร โดยใชร้ว่มกบัสตูร Index (กลายเป็นวธิทีีฉ่ลาดกวา่

การใช ้Scenarios) 

โครงสรา้งตาราง Data Table แบง่เป็น 4 สว่น ตามรปู 
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Data Table แบบ 1 ตวัแปร 

จากตวัอยา่งการหาคา่โฆษณา หากกําหนดใหค้า่โฆษณาเป็นตวัเลขในชว่ง 100 ถงึ 400 บาท 

ใหห้าวา่จะสง่ผลตอ่กําไรขัน้ตน้อยา่งไร 

ทางออกในการแกปั้ญหานี ้หากคณุไมรู่จั้ก Data Table มากอ่น ก็คงตอ้งสรา้งตารางคํานวณซํ้า

กนัหลายๆตารางเพือ่ทดลองใสต่วัเลขคา่โฆษณาลงไปเพือ่หาผลลพัธท์ีต่อ้งการ 

แทนทีจ่ะเสยีแรงเสยีเวลาสรา้งตารางคํานวณซํ้า ใหอ้อกแบบโครงสรา้งตาราง Data Table 

ขึน้มากอ่น โดยในปัญหานีส้งัเกตวา่ตอ้งการเปลีย่นคา่โฆษณาเพยีงคา่เดยีว ดงันัน้จงึเขา้ขา่ย 

Data Table แบบ 1 ตวัแปร ซึง่มโีครงสรา้งแยกแยะออกไปอกี 2 แบบยอ่ยตามแตว่า่คณุ

ตอ้งการดตูวัแปรตามแนวใด ไดแ้ก ่

• Data Table แบบวางตวัแปรไวใ้นหวัตารางดา้นขา้งตามแนวตัง้ สว่นหวัตารางดา้นบน

เป็นสตูรคําตอบที ่link มา และเมือ่สัง่ Data Table ใหเ้ลอืกใชช้อ่ง Column Input Cell 

• Data Table แบบวางตวัแปรไวใ้นหวัตารางดา้นบนตามแนวนอน สว่นหวัตารางดา้นขา้ง

เป็นสตูรคําตอบที ่link มา และเมือ่สัง่ Data Table ใหเ้ลอืกใชช้อ่ง Row Input Cell 

ตวัอยา่งการใช ้Data Table แบบวางตวัแปรไวใ้นหวัตารางดา้นขา้งตามแนวตัง้ 
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1. นําตวัเลขคา่โฆษณามาพมิพล์งในเซลล ์E23:E27 โดยจะกําหนดใหเ้ป็นตวัเลขใด

กอ่นหลงัก็ได ้ไมจํ่าเป็นตอ้งเรยีงลําดบัมากนอ้ย 

2. เซลล ์F22 และ G22 สรา้งสตูร link ผลลพัธข์องสตูรคํานวณมาจากเซลล ์G19 และ 

H18 ตามลําดบั 

3. ใหเ้ลอืกพืน้ที ่E22:G27 แลว้สัง่ Data > What-If Analysis > Data Table (Excel 

2003 สัง่ Data > Table) 

4. คลกิลงในชอ่ง Column input cell แลว้คลกิตอ่ไปทีเ่ซลล ์G18 (เพือ่กําหนดให ้Data 

Table ยงิตวัเลขคา่โฆษณาทีว่างไวต้ามแนวตัง้ไปทีเ่ซลล ์G18) แลว้กดปุ่ ม OK 

5. จะพบคําตอบปรากฏในตาราง F23:G27 และเมือ่คลกิดจูะพบสตูร {=TABLE(,G18)} 

ซึง่สตูรนีเ้ราไมส่ามารถสรา้งเอง ตอ้งใชคํ้าสัง่ Data Table เทา่นัน้จงึจะเกดิสตูรนีข้ ึน้ 

และเมือ่ดใูนสตูรจะพบ (,G18) แสดงถงึการไมใ่ช ้Row Input แตใ่ช ้Column Input มี

เซลล ์G18 เป็นเซลลรั์บคา่ 

หากใชต้าราง Data Table แบบวางตวัแปรไวใ้นหัวตารางดา้นบนตามแนวนอน ตอ้งออกแบบ

ตารางตามรปูตอ่ไปนี ้

 

ขอ้สงัเกต 

1. Data Table แบบ 1 ตวัแปร สามารถหาคําตอบมาแสดงในตารางไดห้ลายเรือ่ง ตามแต่

วา่จะ link สตูรคําตอบเรือ่งใดมาแสดงในหวัตารางอกีขา้งหนึง่ จงึใหผ้ลลพัธไ์ดม้ากกวา่ 

Data Table แบบ 2 ตวัแปร ซึง่แมจ้ะใชต้วัแปรได ้2 ตวั แตจ่ะแสดงคําตอบในตารางได ้

เพยีงเรือ่งเดยีวเพราะมเีซลลห์วัมมุเพยีงเซลลเ์ดยีว  

2. ถา้ตอ้งการใชต้วัแปรมากกวา่ 2 ตวั หรอืตอ้งการคําตอบหลายเรือ่ง สามารถใชส้ตูร If, 

Choose หรอื Index ชว่ยทําให ้Data Table ทํางานไดไ้มจํ่ากดั 
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3. สตูรที ่Excel สรา้งใหเ้มือ่สรา้ง Data table เป็นสตูรทีถ่กูสรา้งขึน้แบบ Array พรอ้มกนั

ทกุเซลล ์โดยมโีครงสรา้งสตูรดงันี ้

 

=Table(Row Input Cell, Column Input Cell) 

 

Data Table แบบ 1 ตวัแปร จะเกดิสตูร =Table(Row Input Cell,) เมือ่เป็นตารางทีใ่ช ้

Row Input และจะเกดิสตูร =Table(, Column Input Cell) เมือ่เป็นตารางทีใ่ช ้

Column Input สว่น Data Table แบบ 2 ตวัแปรจะเกดิสตูรทีใ่ชโ้ครงสรา้งแบบเต็ม 

=Table(Row Input Cell, Column Input Cell) 

4. การอา่นผลลัพธจ์ากตาราง Data Table ตอ้งอธบิายใหช้ดัเจนวา่ ในขณะทีค่า่โฆษณา

เปลีย่นแปลงไปนัน้ ตวัเลขตวัแปรอืน่ ไดแ้ก ่ยอดขาย และ %ตน้ทนุขาย ถอืวา่คงที ่

5. คา่โฆษณาในเซลล ์G18 จะเวน้วา่งไวห้รอืจะใสต่วัเลขใดๆแมจ้ะสรา้งสตูรคํานวณไวก้อ่น

หรอืหลงัการสัง่ Data Table ก็ได ้เพราะไมม่ผีลตอ่การคํานวณใน Data Table 

6. ตาราง Data Table ไมส่ามารถถกู Copy ออกไปใชท้ีอ่ ืน่ เพราะเมือ่ Paste จะพบวา่สตูร 

Table ในตารางถกูเปลีย่นเป็นตวัเลขคา่คําตอบแทนทกุเซลล ์

7. เราไมส่ามารถ Insert แทรกเซลลส์ตูร Table และหากตอ้งการลบสตูร Table ทิง้ ตอ้ง

เลอืกพืน้ทีต่ารางทัง้หมดทีม่สีตูร Table แลว้จงึจะสามารถลบสตูรทิง้พรอ้มกนัทกุเซลล ์

Data Table แบบ 2 ตวัแปร 

ในตวัอยา่งเดมิ หากตอ้งการวเิคราะหว์า่ถา้เราเปลีย่นแปลงตน้ทนุขายและคา่โฆษณาจะมผีล

อยา่งไรบา้งตอ่ยอดกําไรขัน้ตน้ 
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1. พมิพต์วัแปรตน้ทนุขายไวใ้นเซลล ์F22:H22 ซึง่ถอืเป็น Row Input 

2. พมิพต์วัแปรตน้คา่โฆษณาไวใ้นเซลล ์E23:E27 ซึง่ถอืเป็น Column Input 

3. ในเซลลห์วัมมุตาราง E22 สรา้งสตูร =G19 เพือ่ link สตูรคํานวณหากําไรขัน้ตน้มาใช ้

4. จากนัน้ใหเ้ลอืกพืน้ทีต่ัง้แต ่E22:H27 แลว้สัง่ Data > What-If Analysis > Data 

Table (Excel 2003 สัง่ Data > Table) 

5. คลกิลงไปในชอ่ง Row Input Cell แลว้คลกิตอ่ไปยงัเซลล ์G17 ซึง่เป็นเซลลต์น้ทนุ

ขาย 

6. คลกิลงไปในชอ่ง Column Input Cell แลว้คลกิตอ่ไปยงัเซลล ์G18 ซึง่เป็นเซลลค์า่

โฆษณา แลว้กดปุ่ ม OK จะพบคําตอบของกําไรขัน้ตน้ แสดงในตาราง F23:H27 

เมือ่นํา Data Table มาเปรยีบเทยีบกบั Goal Seek มขีอ้สงัเกตดงันี ้

1. Data Table สามารถสง่คา่ตวัแปรใหมค่รัง้ละหลายตวัไปแทนทีเ่ซลลท์ีม่สีตูรสรา้งไว ้ซึง่ 

Excel จะคํานวณใหต้ามคา่ตวัแปรใหมนั่น้ โดยถอืวา่ไมไ่ดใ้ชส้ตูรทีส่รา้งไวก้อ่นแลว้ในเซลล์

นัน้มาใชคํ้านวณรว่มดว้ยแตอ่ยา่งใด สว่น Goal Seek สามารถสง่ตวัแปรใหมไ่ปไดค้รัง้ละ 1 

ตวัและไมส่ามารถสง่ตวัแปรไปแทนเซลลท์ีเ่ป็นสตูร 

2. Data Table เหมาะกบัการใชว้างแผนระยะยาว โดยกําหนดคา่ตวัแปรบนหวัตารางให ้

ครอบคลมุชว่งคา่ทีเ่ป็นไปไดเ้พือ่ดผูลลพัธท์ีเ่กดิขึน้ในชว่งคา่นัน้ๆซึง่อาจไมไ่ดคํ้าตอบตรง

กบัคา่เป้าหมายทีต่อ้งการ สว่น Goal Seek เหมาะสําหรับการวเิคราะหห์าตวัเลขเฉพาะกจิ 

ซึง่จะคดิยอ้นกลบัจนไดต้วัเลขตามตอ้งการ 

3. เราสามารถสัง่ Formulas > Calculation Options > Automatic Except for Data Tables 

(Excel 2003 สัง่ Tools > Options > Calculation > Automatic except tables) เพือ่

กําหนดใหใ้ชก้ารกดปุ่ ม F9 เพือ่สัง่ให ้Data Table คํานวณเฉพาะเมือ่ตอ้งการเทา่นัน้ สว่น 

Goal Seek แมว้า่จะพบวา่ใชก้บัการคํานวณแบบ Automatic หรอื Manual ก็ได ้แตเ่ราควร

ใช ้Goal Seek รว่มกบัการคํานวณแบบ Automatic ไวก้อ่น เพือ่ชว่ยทําใหม้ัน่ใจวา่เซลล์

สตูรทีเ่กีย่วขอ้งถกูคํานวณตามกนัไปครบทัง้หมดดว้ย 

4. เนือ่งจากเราเป็นผูกํ้าหนดคา่ตวัแปรใหใ้ชก้บั Data Table ดงันัน้ Excel จะถกูสัง่ใหคํ้านวณ

ตามคา่ตวัแปรเหลา่นัน้จนครบทกุตวั สว่น Goal Seek จะคํานวณยอ้นกลบัใหเ้องแตอ่าจได ้

คําตอบเฉพาะในชว่งคา่ที ่Excel คน้หาใหเ้ทา่นัน้  

5. หาก Data Table ไมส่ามารถหาคําตอบทีต่อ้งการ ก็สามารถใช ้Goal Seek ทํางานตอ่บน

ตาราง Data Table โดยใหใ้ช ้Goal Seek คดิยอ้นหาคา่ตวัแปรบนหวัตาราง Data Table 

จนกวา่จะคํานวณไดคํ้าตอบมาปรากฏขึน้ในพืน้ทีส่ว่นของคําตอบในตาราง Data table
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หลากหลายแนวทางการใชส้ตูร IF 

ในบรรดาสตูรสําเร็จรปูของ Excel นัน้ สตูรทีใ่ชม้ากทีส่ดุและมปีระโยชนม์ากทีส่ดุรองจากสตูร 

SUM เห็นจะหนไีมพ่น้สตูร IF ซึง่แปลวา่ "ถา้" นีแ้หละ โดยเฉพาะคนทีม่ตํีาแหน่งขึน้ชือ่วา่เป็น

หวัหนา้ ถา้ใชส้ตูร IF ไมเ่ป็น ก็ไมส่มควรเป็นหวัหนา้หรอกนะ เปลีย่นตําแหน่งใหไ้ดช้ือ่ตรงขา้ม

กบัคําวา่หวักบัหนา้ ใหก้ลายเป็นตําแหน่งเทา้หลงัแทนจะเหมาะสมกวา่ 

ถา้นําเงือ่นไขขา้งตน้เกีย่วกบัหวัหนา้มาเขยีนดว้ยสตูร IF จะไดส้ตูรตามนี ้

=IF ( หวัหนา้ใชส้ตูร IF เป็นหรอืไม ่, ถา้ใชเ้ป็น ใหเ้ป็นหวัหนา้ตอ่ไป , ถา้ใชไ้มเ่ป็น ให ้

เป็นเทา้หลังแทน ) 

หรอืถา้คดิเขยีนสตูร IF ตามหลกักฎแหง่กรรมของการทําดตีอ้งไดด้ ีทําชัว่ไดช้ัว่ จะไดส้ตูรตาม

นี ้

=IF ( คณุทําดใีชไ่หม , ถา้ทําด ีตอ้งไดด้ ี, ถา้ไมทํ่าด ีตอ้งไดรั้บผลอืน่ๆ ) 

สงัเกตวา่ในสตูร IF ของการตรวจสอบวา่ทําดหีรอืไมนั่น้ ถา้ไมไ่ดทํ้าด ีไมใ่ชว่า่จะไดช้ัว่ เพราะ

เงือ่นไขทีใ่ชเ้ป็นเพยีงตรวจสอบวา่ทําดอียา่งเดยีวเทา่นัน้ คนทีไ่มไ่ดทํ้าด ีไมใ่ชว่า่ตอ้งทําชัว่ก็

ได ้อาจอยูเ่ฉยๆไมไ่ดทํ้าดไีมไ่ดทํ้าชัว่ ดงันัน้กรณีทีไ่มไ่ดทํ้าด ีจงึตอ้งไดรั้บผลอยา่งอืน่ซึง่ไมใ่ช่

ผลจากการทําด ี

ถา้คณุเขา้ใจวธิคีดิเงือ่นไขในใจของตัวคณุเอง ก็จะพบวา่บรษัิทไมโครซอฟทไ์ดส้รา้ง Excel 

ขึน้มาโดยใชส้ตูร IF ทีม่โีครงสรา้งของสตูรตามหลกัการเดยีวกนักบัทีค่ณุคดิไดน่ั้นเอง 

โครงสรา้งสตูร IF 

=IF(การตรวจสอบเงือ่นไข, ผลลพัธก์รณีทีต่รวจสอบเงือ่นไขวา่ใช,่ ผลลพัธก์รณีที่

ตรวจสอบเงือ่นไขวา่ไมใ่ช)่ 

ในสว่นของการตรวจสอบเงือ่นไข ใหใ้สส่มการทีต่อ้งการลงไป โดยใชเ้ครือ่งหมาย =, >, <, 

>=, <=, หรอืไมเ่ทา่กบั <> หรอืในสว่นของการตรวจสอบเงือ่นไขนี ้อาจใชส้ตูรอืน่ซึง่คนืคา่
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เป็น TRUE หรอื FALSE อยา่งใดอยา่งหนึง่ เชน่ AND, OR, TRUE, FALSE, ISNUMBER เป็น

ตน้ 

ตวัอยา่งการใช ้IF แบบงา่ยๆ 

=IF(SaleChoice="n", 1000, 2000) 

สตูรนีจ้ะคนืคา่เป็นตวัเลข 1000 ตอ่เมือ่เซลลท์ีต่ัง้ชือ่วา่ SaleChoice มคีา่เป็นตวัอกัษร n 

เทา่นัน้ แตถ่า้ SaleChoice มคีา่อืน่ จะคนืคา่เป็นตวัเลข 2000 แทน 

เนือ่งจากตวัอกัษร n เป็นตวัอกัษรที ่Excel ไมรู่จั้ก จงึจําเป็นตอ้งใส ่"n" ไวร้ะหวา่งเครือ่งหมาย

คําพดู สว่นคําวา่ IF และ SaleChoice นัน้แมว้า่เป็นตวัอกัษรแตไ่มต่อ้งใสร่ะหวา่งเครือ่งหมาย

คําพดูเพราะเป็นตวัอกัษรที ่Excel รูจั้กแลว้วา่คําวา่ IF คอืสตูรชือ่ IF และคําวา่ SaleChoice เป็น 

Range Name ทีต่ัง้ชือ่ไว ้สว่นตวัเลข 1000 และ 2000 เป็นตวัเลขที ่Excel รับทราบอยูแ่ลว้วา่

เป็นตวัเลขจงึไมต่อ้งใสร่ะหวา่งเครือ่งหมายคําพดูแตอ่ยา่งใด 

=IF(MyMargin>0, MyMargin*0.3, 0) 

สตูรนีใ้ชก้บัการคํานวณหายอดภาษี ถา้ MyMargin หรอืเซลลกํ์าไรขัน้ตน้มคีา่มากกวา่ 0 ยอ่ม

แสดงวา่มกํีาไรเกดิขึน้ จงึนํายอดกําไรขัน้ตน้ไปคณูดว้ยอตัราภาษี 30% แตถ่า้ไมม่กํีาไรก็ไม่

ตอ้งจา่ยภาษี  

แนวทางการใชส้ตูร IF 

1.ใชเ้ปลีย่นเสน้ทางการรับคา่ 

2.ใชใ้นการตัดสนิใจ 

3.ใชใ้นการเปลีย่นคา่หรอืแสดงคา่ 

4.ใชเ้ปลีย่นเสน้ทางการสง่คา่ 
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การใชส้ตูร IF ในการเปลีย่นเสน้ทางการรบัคา่   

การสรา้งสตูรลงิคเ์พือ่เชือ่มโยงคา่โดยทัว่ไปเป็นการเชือ่มโยงกนัแบบ 1 ตอ่ 1 เชน่ เมือ่ตอ้งการ

ทําใหเ้ซลล ์A2 มคีา่เทา่กบัเซลล ์A1 ก็จะสรา้งสตูร =A1 ลงไปในเซลล ์A2 ทําใหเ้ซลล ์A2 

แสดงคา่เปลีย่นแปลงตามคา่ในเซลล ์A1 ซึง่การลงิคแ์บบนีเ้ซลล ์A1 เรยีกวา่เป็นเซลลต์น้ทาง 

และเซลล ์A2 เรยีกวา่เป็นเซลลป์ลายทาง 

แตถ่า้เซลลต์น้ทางมมีากกวา่ 1 เซลล ์เชน่กําหนดใหเ้ซลล ์C2 และ C3 สามารถเป็นเซลลต์น้

ทางไดท้ัง้คู ่โดยกําหนดใหเ้ซลล ์E3 เป็นเซลลป์ลายทางเพยีงเซลลเ์ดยีว โดยเลอืกทีจ่ะรับคา่

จากเซลล ์C2 หรอื C3 ก็ไดแ้ลว้แตเ่งือ่นไขทีเ่รากําหนดวา่จะใหเ้ลอืกรับคา่มาจากเซลลใ์ด 

 

จากภาพกําหนดใหเ้ซลล ์E2 เป็นเซลลสํ์าหรับใสค่า่เงือ่นไขลงไปวา่จะเป็นตวัอกัษร A หรอื B 

(หรอืคา่อืน่ใดก็ได)้ สว่นเซลล ์E3 ซึง่เป็นเซลลป์ลายทาง ใหส้รา้งสตูรตอ่ไปนี ้

=IF( E2="A", C2, C3) 

ดงันัน้เมือ่เซลล ์E2 มคีา่เป็น A จงึทําใหเ้ซลล ์E3 รับคา่ 100 มาจากเซลล ์C2 แตถ่า้เซลล ์E2 

ไมไ่ดม้คีา่เป็น A ก็จะทําใหเ้ซลล ์E3 เปลีย่นเสน้ทางการรับคา่ 200 มาจากเซลล ์C3 แทน 

แตถ่า้กําหนดใหม้จํีานวนเซลลต์น้ทางมากมายหลายเซลล ์เชน่ ตามรปูตอ่ไปนีใ้ชเ้ซลลต์น้ทาง

ถงึ 14 เซลล ์
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สตูรลงิคเ์พือ่เลอืกรับคา่ในเซลล ์F9 จะกลายเป็นสตูรซบัซอ้นมากขึน้ 

=IF(E9="A",C2,IF(E9="B",C5,IF(E9="C",C8,IF(E9="D",C11,IF(E9="E",C14,IF(

E9="F",C17,IF(E9="G",F2,IF(E9="H",F17,IF(E9="I",I2,IF(E9="J",I5,IF(E9="

K",I8,IF(E9="L",I11,IF(E9="M",I14,I17))))))))))))) 

ซึง่เซลล ์E9 มคีา่เป็น K จงึทําใหส้ตูร IF ในเซลล ์F9 เลอืกรับคา่มาจากเซลล ์I8 

แตถ่า้โครงสรา้งตารางไมไ่ดจั้ดใหเ้ป็นระเบยีบ แมส้ตูร IF จะยงัคงทํางานไดต้ามเดมิก็ตาม แต่

จะพบวา่การแกะสตูรเพือ่ตรวจสอบความถกูตอ้งทําไดย้ากขึน้มาก 

 

 

สตูรในเซลล ์F9 
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=IF(E9="A",C2,IF(E9="B",I3,IF(E9="C",J11,IF(E9="D",F2,IF(E9="E",I9,IF(E9

="F",J16,IF(E9="G",H14,IF(E9="H",E14,IF(E9="I",G17,IF(E9="J",H7,IF(E9=

"K",C8,IF(E9="L",D6,IF(E9="M",D12,C17))))))))))))) 

แตช่ว่ยตรวจสอบวา่ แมว้า่ E9 มคีา่เทา่กบั K ทําใหเ้ซลล ์F9 รับคา่ 1100 มาจากเซลล ์C8 ได ้

ถกูตอ้งตามตอ้งการก็ตาม แตค่า่ 1100 ทีไ่ดรั้บมานัน้ ไมใ่ชต่ัวเลขของคา่ K แตเ่ป็นของคา่ X 

มใิชห่รอื 

ตัง้แต ่Excel 2007 เป็นตน้มา ในวงเล็บของแตล่ะสตูร เราสามารถซอ้นสตูรเขา้ไปไดถ้งึ 64 สตูร 

(Excel 2003 และรุน่กอ่นนัน้จะซอ้นไดเ้พยีง 7 สตูร) ซึง่จากตวัอยา่งขา้งตน้น่าจะทําใหเ้ราได ้

เรยีนรูว้า่ ถงึแมว้า่เราสามารถใชส้ตูร IF ซอ้น IF เพือ่หาคา่ทีก่ระจายกนัอยูต่า่งทีต่า่งชทีตา่ง

แฟ้มไดก้็ตาม แตก่ารกระจายกนัของคา่นีเ่อง หากกระจายอยา่งขาดระเบยีบ ยอ่มเพิม่ความเสีย่ง

ทีจ่ะหาคําตอบผดิพลาดไดโ้ดยไมรู่ต้ัว และเมือ่จะตรวจสอบแกไ้ขก็จะทําใหทํ้าไดย้าก 

ดงันัน้โปรดจําไวว้า่ ขอใหเ้ลอืกใชส้ตูร IF กบัปัญหางา่ยๆ แตเ่มือ่ปัญหาซบัซอ้นมากขึน้ เราควร

ปรับเปลีย่นโครงสรา้งตารางหรอืเลอืกใชส้ตูรอืน่ซึง่ทํางานไดเ้ชน่เดยีวกนักบัสตูร IF จะ

เหมาะสมกวา่ 
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การใชส้ตูร IF ในการตดัสนิใจ   

โครงสรา้งสตูร IF แบบงา่ยๆ =IF(เงือ่นไข,ผลกรณีใช,่ผลกรณีไมใ่ช)่ มพีืน้ฐานของตวัสตูรทํา

หนา้ทีต่ดัสนิใจตามเงือ่นไขทีเ่รากําหนดลงไปในสตูรอยูแ่ลว้ ไมว่า่จะใชส้ตูร IF ในการเปลีย่น

เสน้ทางการรับคา่หรอืใชใ้นการปรับเปลีย่นคา่ก็ตาม ยอ่มถอืวา่เป็นการใชส้ตูร IF ในการ

ตดัสนิใจน่ันเอง เพยีงแตห่วัขอ้นีจ้ะแยกแยะประเภทของการตดัสนิใจใหเ้ห็นชดัขึน้  

การใชส้ตูร IF ในการตดัสนิใจม ี2 แบบ ขึน้กบัวา่เงือ่นไขถดัไปกําหนดวา่ตอ้งผา่นเงือ่นไขกอ่น

หนา้อยา่งไร 

1. การใช ้IF แบบกําหนดเงือ่นไขแตกตอ่กรณีทีไ่มใ่ช ่

2. การใช ้IF แบบกําหนดเงือ่นไขแตกตอ่กรณีทีใ่ช ่

การใช ้IF แบบกาํหนดเงือ่นไขแตกตอ่กรณีทีไ่มใ่ช ่ 

เป็นเงือ่นไขทีพ่บเห็นกนัทัว่ไป เชน่ สตูร IF ในตัวอยา่งทีใ่ชสํ้าหรับเปลีย่นเสน้ทางในการรับคา่

น่ันเอง เมือ่เงือ่นไขการรับคา่แรกผา่นไปแลว้ ไดคํ้าตอบแรกตามเงือ่นไขแรกเมือ่ตดัสนิวา่ใชไ่ป

แลว้ก็จะไดคํ้าตอบกรณีทีใ่ชเ่รยีบรอ้ย แตห่ากเงือ่นไขแรกไมผ่า่น ก็จะตอ้งพจิารณาเงือ่นไขใน

ลําดบัถดัไป ซึง่แสดงเป็นโครงสรา้งสตูร IF จากแบบงา่ยๆกลายเป็นแบบซอ้นกนัดงันี ้ 

สําหรับการตดัสนิใจในเงือ่นไขแรก 

=IF(เงือ่นไขที ่1, ผลกรณีใชข่องเงือ่นไขที ่1, ผลกรณีไมใ่ชข่องเงือ่นไขที ่1) 

ถา้เงือ่นไขที ่1 ยงัไมผ่า่น ใหแ้ตกผลกรณีไมใ่ชข่องเงือ่นไขที ่1 ตอ่เป็น IF สตูรทีส่องเพือ่คดิ

ตามเงือ่นไขที ่2 

=IF(เงือ่นไขที ่2, ผลกรณีใชข่องเงือ่นไขที ่2, ผลกรณีไมใ่ชข่องเงือ่นไขที ่2) 

เมือ่นําสตูรทัง้สองเงือ่นไขมาซอ้นเป็นสตูรในเซลลเ์ดยีว จะไดส้ตูรตามนี ้

=IF(เง ือ่นไขที ่1, ผลกรณีใชข่องเงือ่นไขที ่1, IF(เงือ่นไขที ่2, ผลกรณีใชข่อง

เงือ่นไขที ่2, ผลกรณีไมใ่ชข่องเงือ่นไขที ่2) ) 
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ตวัอยา่งการใช ้IF แบบกําหนดเงือ่นไขแตกตอ่กรณีทีไ่มใ่ชใ่นการตดัเกรด 

 

กําหนดใหเ้ซลล ์B3:C5 เป็นตารางคะแนน-เกรด  

• ถา้สอบไดต้ัง้แต ่90 คะแนนขึน้ไปใหไ้ดเ้กรด A 

• ถา้สอบไดต้ัง้แต ่70 คะแนนขึน้ไปใหไ้ดเ้กรด B 

• ถา้สอบไดต้ัง้แต ่0 คะแนนขึน้ไปใหไ้ดเ้กรด C 

สมมตวิา่เซลล ์E3 มคีา่เป็น 75 เป็นคะแนนทีส่อบได ้เซลล ์F3 หาคําตอบเป็นเกรด B โดยใช ้

สตูร IF ซอ้นกนัดงันี ้

=IF( E3>=B3, C3, IF(E3>=B4,C4,C5) ) 

ซึง่แปลสตูรออกมาตามเงือ่นไขทีกํ่าหนดไดเ้ป็น 

=IF( คะแนนทีส่อบได ้>=90, "A", IF(คะแนนทีส่อบได ้>=70,"B","C") ) 

ขอ้สงัเกต 

1. การเขยีนสตูร IF ซอ้น IF มหีลกัการสําคญั คอื ตอ้งจดัลําดบัของเงือ่นไขทีเ่ปิด

โอกาสให ้IF ทกุตวัในสตูรมโีอกาสไดท้าํงาน ดงันัน้จงึตอ้งใชเ้งือ่นไข คะแนนที่

สอบได ้>=90 ขึน้กอ่นเป็นเงือ่นไขแรก หากเงือ่นไขนีไ้มผ่า่นจงึปลอ่ยใหเ้งือ่นไขถดัไป

ทํางาน (แตถ่า้สรา้งผดิโดยใชเ้งือ่นไข >=70 ขึน้กอ่น จะปิดโอกาสของเงือ่นไขเกรด A 

เพราะ >=70 ยอ่มหมายถงึ >=90 อยูแ่ลว้) 

2. แมต้อ้งการเกรด A, B, C แตเ่ราใช ้IF ซอ้นกนัเพยีง 2 IF เทา่นัน้ เพราะถา้ไมใ่ชท่ัง้สอง

เงือ่นไข ก็ตอ้งเป็นเกรด C น่ันเอง 



97 

 

Copyright of www.ExcelExpertTraining.com 

การใช ้IF แบบกาํหนดเงือ่นไขแตกตอ่กรณีทีใ่ช ่ 

เป็นเงือ่นไขทีกํ่าหนดซอ้นเขา้ไปเพือ่ตดัสนิใจในทกุเงือ่นไขพรอ้มกนัไป เกดิเป็นโครงสรา้งสตูร

ตามนี ้

=IF(เงือ่นไขที ่1, IF(เงือ่นไขที ่2, ผลกรณีใชข่องเงือ่นไขที ่1 และ 2, ผลกรณีไมใ่ช่

ของเงือ่นไขที ่2), ผลกรณีไมใ่ชข่องเงือ่นไขที ่1) 

หากผลกรณีทีใ่ชข่องทกุเงือ่นไขเป็นคา่เดยีวกนั สว่นผลกรณีทีไ่มใ่ชข่องเงือ่นไขที ่1 และผล

กรณีทีไ่มใ่ชข่องเงือ่นไขที ่2 เป็นคา่เดยีวกนั แทนทีจ่ะใชส้ตูร IF ซอ้นกนัหลายสตูร ใหใ้ชส้ตูร 

And หรอื Or มาชว่ยในสตูร IF เพยีงสตูรเดยีวไดด้งันี ้

=IF( And( เง ือ่นไขที ่1,เง ือ่นไขที ่2), ผลกรณีใช,่ ผลกรณีไมใ่ช)่ 

=IF( OR( เง ือ่นไขที ่1,เง ือ่นไขที ่2), ผลกรณีใช,่ ผลกรณีไมใ่ช)่ 

หมายเหต ุ

1. สตูร And จะคนืคา่เป็นจรงิตอ่เมือ่ทกุเงือ่นไขเป็นจรงิพรอ้มกนั หากเงือ่นไขใดเงือ่นไข

หนึง่เป็นเท็จ จะคนืคา่เป็นเท็จ (จําวา่ False เป็นลักษณะเดน่) 

2. สตูร OR จะคนืคา่เป็นเท็จตอ่เมือ่ทกุเงือ่นไขเป็นเท็จพรอ้มกนั หากเงือ่นไขใดเงือ่นไข

หนึง่เป็นจรงิ จะคนืคา่เป็นจรงิ (จําวา่ True เป็นลักษณะเดน่) 
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ตวัอยา่งการใช ้IF แบบกาํหนดเงือ่นไขแตกตอ่กรณีทีใ่ชใ่นการป้องกนั

สตูรลบั  

 

สมมตวิา่เราตอ้งการบวกเลข 1 กบัเลข 2 ในเซลล ์B2 และ C2 เขา้ดว้ยกนั แตก่อ่นจะยอมให ้

สตูร B2+C2 ทํางานไดต้ามปกต ิตอ้งผา่นการกรอกรหสัลงไปในเซลล ์B4 และ B5 เป็นเลข 

123 และ 999 ตามลําดบัใหถ้กูตอ้งเรยีบรอ้ยกอ่น 

ถา้สรา้งสตูร IF ซอ้น IF จะไดส้ตูรตามเซลล ์D2 

=IF( B4=123, IF(B5=999, B2+C2, 0), 0) 

หรอืใชส้ตูร And มาใชง้านรว่มดว้ย กลายเป็นสตูร IF เพยีงสตูรเดยีวดงันี ้

=IF( AND(B4=123,B5=999), B2+C2, 0) 
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ตวัอยา่งการใช ้IF แบบกาํหนดเงือ่นไขแตกตอ่กรณีทีใ่ชใ่นการรบัเงนิ

ในชว่งวนัทีก่าํหนด 

 

หากตอ้งการรับเงนิ 100 บาท ระหวา่งวนัที ่2-5 กําหนดใหใ้ช ้Range Name ในตารางตอ่ไปนี ้

• B3:B8 ชือ่ From 

• C3:C8 ชือ่ To 

• D3:D8 ชือ่ Amount 

• E2:K2 ชือ่ Date 

เซลล ์E3 เป็นสตูรรับเงนิในชว่งวนัทีต่อ้งการตามนี ้

=IF( Date>=From, IF(Date<=To,Amount,0), 0) 

หรอื 

=IF( AND(Date>=From,Date<=To), Amount, 0) 

ขอ้สงัเกต 

ตวัอยา่งนีใ้ชส้ตูร And มาชว่ยเพราะตอ้งการใหค้นืคา่เป็น True เฉพาะในชว่งวนัที ่2-5 เทา่นัน้ 

(ดเูซลล ์E8:K8) 
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การใชส้ตูร IF ในการเปลีย่นคา่หรอืแสดงคา่   

ในกรณีทีผ่ลลพัธจ์ากการคํานวณหรอืคา่ทีไ่ดจ้ากการลงิคต์อ่มาจากเซลลอ์ืน่ อาจไมใ่ชค่า่ที่

ตอ้งการแสดงใหผู้ใ้ชเ้ห็นเสมอไป เราสามารถนําสตูร IF มาชว่ยเปลีย่นคา่เดมินัน้ใหก้ลายเป็น

คา่ใหมห่รอืเปลีย่นจากตัวเลขหรอืคําเตอืน Error ใหก้ลายเป็นตวัอกัษรทีส่ือ่ความหมายได ้

ชดัเจนกวา่แทน 

 

โปรดดตูวัอยา่งจาก Row 2 ขา้งตน้ ในการนําเลขมาหารกนันัน้ หากเป็นตวัเลขทีนํ่ามาหารกนั

ได ้ก็ยอ่มคนืคา่ทีต่อ้งการออกมาไดท้นัท ีเชน่ เมือ่นําเลข 100 จากเซลล ์B2 มาหารดว้ยเลข 5 

จากเซลล ์C2 โดยสรา้งสตูร = B2/C2 ลงไปในเซลล ์D2 จะไดคํ้าตอบเป็นตวัเลข 20 

ใน Row 5 ถา้เปลีย่นเลข 5 ทีเ่ป็นตวัหาร ใหเ้ป็นเลข 0 แทน จะพบวา่สตูร =B5/C5 ไมส่ามารถ

คํานวณได ้โดยแสดง Error #DIV/0! ออกมาแทน (#DIV/0! ยอ่มาจากคําวา่ Error from 

Divided by Zero หรอื Error เนือ่งจากการถกูหารดว้ยเลข 0) 

เราสามารถเปลีย่นการแสดง Error ใหเ้ป็นเลข 0 แทน โดยใชส้ตูรตามตวัอยา่งใน Row 8 ดงันี ้

=IF(C8=0, 0, B8/C8) 

หรอือา่นสตูรเป็นคําแปลวา่ ถา้เซลลต์วัหารมคีา่เทา่กบั 0 ใหผ้ลลพัธแ์สดงเลข 0 แทนการแสดง 

Error แตถ่า้ตวัหารไมใ่ชเ่ลข 0 ก็ใหคํ้านวณหารกนัตอ่ไปตามปกต ิ

ถา้ตวัหารไมใ่ชเ่ลข 0 แตก่ลบักลายเป็นตวัอกัษร o จะพบวา่สตูร IF ขา้งตน้นีค้อืคา่ออกมาเป็น 

#VALUE! แทน เพราะ Excel ไมย่อมรับการนําตวัอกัษรไปหารตวัเลข 

ใน Row 11 กรณีทีต่วัหารเป็นตวัอกัษร o (หรอืตวัอกัษรอืน่ใด) เราสามารถป้องกนัการเกดิ 

Error จากการหารโดยใชส้ตูร IsError มาชว่ยตรวจสอบการคํานวณวา่จะเกดิ Error หรอืไม ่
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=IF( ISERROR(B11/C11), 0, B11/C11) 

หรอืตัง้แต ่Excel 2007 เป็นตน้มาม ีIfError เป็นสตูรใหมท่ีส่ัน้ลง 

=IFERROR(B11/C11,0) 

หมายเหต ุ

1. กอ่นทีจ่ะใชส้ตูร IsError ควรหาทางตรวจสอบสตูรคํานวณทีส่รา้งกอ่นวา่สามารถ

คํานวณไดคํ้าตอบทีต่อ้งการหรอืไม ่เพราะหากใชส้ตูร IsError เขา้มาชว่ยรว่มกบัสตูร IF 

แลว้ เราจะไมเ่ห็น Error เกดิขึน้อกีเลย 

2. ควรเลอืกนําเฉพาะบางสว่นของการคํานวณจากสตูรทีจ่ะนํามาตรวจสอบดว้ยสตูร 

IsError โดยไมจํ่าเป็นตอ้งนําสตูรยาวๆทัง้หมดมาใสล่งไปในวงเล็บของสตูร IsError 

3. ในกรณีทีเ่กดิ Error ขึน้ ในกรณีทีผ่ลลพัธเ์ดมิเป็น Text ควรเปลีย่น Error เป็นคําเตอืน 

หรอืกรณีผลลพัธเ์ดมิเป็นเลข ควรเปลีย่น Error เป็นเลข 0 แทน จากนัน้ใหใ้ช ้Format 

0;-0; ซอ่นเลข 0 ใหด้เูหมอืนเป็นชอ่งวา่ง 

4. ในการเปลีย่นการแสดง Error ใหแ้สดงเป็นชอ่งวา่ง พยายามหลกีเลีย่งการใช ้Null Text 

หรอื "" (แทนการใชเ้ลข 0) เพราะ "" มสีภาพเป็น Text ซึง่หากนําคา่นีไ้ปบวกลบคณู

หารตอ่จะเกดิ Error ตอ่ไปอกี กลายเป็นภาระใหเ้ราตอ้งสรา้งสตูร =IF(Cell="", "", 

Cell) ตอ่ไปอกี ซึง่ทําใหแ้ฟ้มคํานวณชา้ลงและมขีนาดใหญข่ึน้โดยไมจํ่าเป็น 

5. ในกรณีทีต่อ้งการแสดง #N/A ใหใ้ชส้ตูร NA() 

6. นอกเหนอืจากการใชส้ตูร IF ชว่ยในการเปลีย่น Error ใหเ้ป็นคา่อืน่แลว้ ในหนา้กระดาษ

ทีถ่กูพมิพ ์สามารถใชคํ้าสัง่ Page Setup > Sheet > Print > Cells error as เพือ่

เปลีย่นเซลลท์ีม่คีา่เป็น Error ใหแ้สดงเป็นชอ่งวา่ง, --, #N/A แทนไดอ้กีดว้ย 

สตูรกลุม่ Is ทีใ่ชช้ว่ยในการตรวจสอบ  

• IsNA ตรวจสอบ Error #N/A "Not Available" ซึง่เกดิจากสตูรกลุม่ Lookup ในกรณีที่

หาคา่ทีต่อ้งการไมพ่บ 

• IsError ตรวจสอบ Error ทกุประเภท 

• IsErr ตรวจสอบ Error เกอืบทกุประเภท เวน้ NA 

• IsBlank ตรวจสอบเซลลว์า่ง 



102 

 

Copyright of www.ExcelExpertTraining.com 

• IsText ตรวจสอบเซลลม์คีา่เป็น Text หรอืคา่ทีจ่ะชดิซา้ยใหเ้องเมือ่พมิพล์งไป เชน่ 

'123 ถอืวา่เป็น Text 

• IsNumber ตรวจสอบเซลลม์คีา่เป็น Number หรอืคา่ทีจ่ะชดิขวาใหเ้องเมือ่พมิพล์งไป 

เชน่ 10/4/2010 จะชดิขวาเพราะถอืวา่เป็น Number 

การใชส้ตูร IF ในการเปลีย่นเสน้ทางการสง่คา่   

ตามปกตสิตูรทีส่รา้งลงไปในเซลลจ์ะทําหนา้ทีคํ่านวณหรอืรับคา่ทีล่งิคม์าจากเซลลต์น้ทาง สว่น

การสง่คา่จากเซลลต์น้ทางไปยงัเซลลป์ลายทางโดยไมต่อ้งสรา้งสตูรลงไปในเซลลนั์น้ไม่

สามารถทําไดโ้ดยวธิปีกตทิัว่ไป แตต่อ้งเขยีนรหสั VBA เขา้มาชว่ย 

 

ตวัอยา่ง กําหนดใหส้ง่คา่จากเซลล ์Source ไปยงัเซลล ์Target1 หรอื Target2 ตามเงือ่นไข

ตอ่ไปนี ้

• หาก Source มคีา่นอ้ยกวา่ 0 เชน่มคีา่เป็นเลข -111 ใหส้ง่คา่ -111 ไปยงัเซลล ์

Target1 

• หาก Source มคีา่มากกวา่หรอืเทา่กบั 0 เชน่มคีา่เป็นเลข 222 ใหส้ง่คา่ 222 ไปยงั

เซลล ์Target2 

เริม่ตน้จากใหต้ัง้ชือ่ Source, Target1, Target2 ใหก้บัเซลล ์C2, C5 ,C6 ตามลําดบัและตัง้ชือ่ 

Target เป็น Formula Name มคีา่เป็นสตูร 

=IF( Source<0, Target1, Target2) 

จากนัน้ใหส้รา้งชดุคําสัง่นีล้งไปใน Visual Basic Editor 

Sub SendData() 
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MyVar = [Source] 

[Target] = MyVar 

End Sub 

 

1. ชดุคําสัง่นีจ้ะรับคา่ทีเ่ก็บไวใ้นเซลลท์ีต่ัง้ชือ่ไวว้า่ Source ไปเก็บไวท้ีต่วัแปรทีม่ชี ือ่วา่ 

MyVar 

2. จากนัน้คา่ทีเ่ก็บไวใ้น MyVar จะถกูสง่ตอ่ไปยงั Formula Name ทีต่ัง้ชือ่ไวว้า่ Target 

3. เนือ่งจาก Target เป็นสตูร =IF( Source<0, Target1, Target2) จงึทําหนา้ที่

ตรวจสอบคา่ทีรั่บมาจาก Source กอ่นแลว้จงึเลอืกสง่คา่ไปยงัเซลลท์ีต่ัง้ชือ่วา่ Target1 

หรอื Target2 ตามเงือ่นไขทีกํ่าหนดไวข้า้งตน้ตอ่ไป 
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หลบรอ้นหนสีตูร IF ไปหาทางออกอืน่ 

สตูร IF เป็นสตูรทีม่คีวามยดืหยุน่อยา่งมาก เราสามารถใชท้ัง้ตวัเลข ตวัอกัษร สตูรอืน่ หรอื

ตําแหน่งอา้งองิเพือ่ใชใ้นการกําหนดเงือ่นไข และสามารถใชเ้งือ่นไขเปรยีบเทยีบคา่ไดท้ัง้

เทา่กบั มากกวา่ นอ้ยกวา่ หรอืไมเ่ทา่กบั ซึง่ใน Excel ตัง้แตรุ่น่ 2007 เป็นตน้มาไดป้รับปรงุให ้

สามารถนําสตูรมาซอ้นเขา้ไปไดถ้งึ 64 สตูร ทําใหใ้ชส้ตูร IF ไดก้วา้งขวางกวา่ Excel 2003 

หรอืรุน่เกา่กอ่นนัน้ทีซ่อ้นสตูรไดอ้กีเพยีง 7 สตูรเทา่นัน้ 

ไมว่า่จะใชส้ตูร IF ใหเ้ต็มทีต่ามความสามารถของ Excel รุน่เกา่หรอืรุน่ใหม ่ถา้เขยีนสตูร IF 

ซอ้นกนัจนกลายเป็นสตูรยาวเหยยีดตามสตูรในเซลล ์D9 ตอ่ไปนี ้คณุคดิวา่อยากจะใชส้ตูร IF 

ตอ่ไปอกีหรอื 

 

=IF(F9>C9,1,IF(SUM(F9:G9)>C9,2,IF(SUM(F9:H9)>C9,3,IF(SUM(F9:I9)>C9,4,IF(SU

M(F9:J9)>C9,5,IF(SUM(F9:K9)>C9,6,IF(SUM(F9:L9)>C9,7,0))))))) 

+IF(SUM(F9:L9)>C9,0,IF(SUM(F9:M9)>C9,8,IF(SUM(F9:N9)>C9,9,IF(SUM(F9:O9)>

C9,10,IF(SUM(F9:P9)>C9,11,IF(SUM(F9:Q9)>C9,12,IF(SUM(F9:R9)>C9,13,0))))))) 

+IF(SUM(F9:R9)>C9,0,IF(SUM(F9:S9)>C9,14,IF(SUM(F9:T9)>C9,15,IF(SUM(F9:U9)

>C9,16,IF(SUM(F9:V9)>C9,17,IF(SUM(F9:W9)>C9,18,IF(SUM(F9:X9)>C9,19,0)))))

)) 

+IF(SUM(F9:X9)>C9,0,IF(SUM(F9:Y9)>C9,20,IF(SUM(F9:Z9)>C9,21,IF(SUM(F9:AA9

)>C9,22,IF(SUM(F9:AB9)>C9,23,IF(SUM(F9:AC9)>C9,24,IF(SUM(F9:AD9)>C9,25,0)

)))))) 
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+IF(SUM(F9:AD9)>C9,0,IF(SUM(F9:AE9)>C9,26,IF(SUM(F9:AF9)>C9,27,IF(SUM(F9:

AG9)>C9,28,IF(SUM(F9:AH9)>C9,29,IF(SUM(F9:AI9)>C9,30,IF(SUM(F9:AJ9)>C9,31

,0))))))) 

สตูรขา้งตน้เป็นสตูรคํานวณหาวนัทีใ่ดในแตล่ะเดอืนซึง่สนิคา้ทีเ่ก็บไวใ้น Stock จะเริม่ไม่

เพยีงพอตอ่การเบกิใช ้โดยตอ้งนําสตูร IF มาซอ้นกนัเพือ่ตรวจสอบยอดเบกิใชส้ะสมตัง้แตว่นั

แรกไปจนถงึสิน้เดอืน เริม่จากยอดเบกิวนัแรกในเซลล ์F9 กลายเป็นยอดเบกิสะสม 2 วนัจาก

เซลล ์F9:G9 หรอืยอดเบกิสะสม 3 วนัจากเซลล ์F9:H9 เรือ่ยไปจนถงึ F9:AJ9 ซึง่เป็นยอดเบกิ

ใชส้ะสมถงึ 31 ครัง้ตามจํานวนวนัในแตล่ะเดอืนมาเทยีบกบัปรมิาณ Stock ในเซลล ์C9  

ถา้ใช ้Excel 2003 หรอืรุน่กอ่นนัน้ ตอ้งแยกสตูรทีซ่อ้นกนัชดุละ 7 วนั โดยกําหนดเงือ่นไขในแต่

ละชดุวา่ หากไมเ่ป็นจรงิใหค้นืคา่เทา่กบั 0 โปรดสงัเกตวา่ในวงเล็บของ IF ทีซ่อ้นกนัแตล่ะชดุ

นัน้จะลงทา้ยดว้ย ,0))))))) แลว้จงึนําสตูร IF ทีซ่อ้นกนัมาบวกเขา้ดว้ยกนั 

โจทยเ์ดยีวกนันี ้หากใช ้Excel 2007 เป็นตน้มา เราสามารถซอ้น IF ลงไปในวงเล็บของสตูร IF 

รว่มกนัไดส้งูสดุถงึ 64 สตูรไดเ้ลย ทําใหส้ตูรสัน้ลงบา้งเหลอืสตูรตามนี ้

=IF(F9>C9,1,IF(SUM(F9:G9)>C9,2,IF(SUM(F9:H9)>C9,3,IF(SUM(F9:I9)>C9,4,IF(SU

M(F9:J9)>C9,5,IF(SUM(F9:K9)>C9,6,IF(SUM(F9:L9)>C9,7,IF(SUM(F9:M9)>C9,8,IF(

SUM(F9:N9)>C9,9,IF(SUM(F9:O9)>C9,10,IF(SUM(F9:P9)>C9,11,IF(SUM(F9:Q9)>C9

,12,IF(SUM(F9:R9)>C9,13,IF(SUM(F9:S9)>C9,14,IF(SUM(F9:T9)>C9,15,IF(SUM(F9:

U9)>C9,16,IF(SUM(F9:V9)>C9,17,IF(SUM(F9:W9)>C9,18,IF(SUM(F9:X9)>C9,19,IF(

SUM(F9:Y9)>C9,20,IF(SUM(F9:Z9)>C9,21,IF(SUM(F9:AA9)>C9,22,IF(SUM(F9:AB9)

>C9,23,IF(SUM(F9:AC9)>C9,24,IF(SUM(F9:AD9)>C9,25,IF(SUM(F9:AE9)>C9,26,IF(

SUM(F9:AF9)>C9,27,IF(SUM(F9:AG9)>C9,28,IF(SUM(F9:AH9)>C9,29,IF(SUM(F9:AI

9)>C9,30,IF(SUM(F9:AJ9)>C9,31,0))))))))))))))))))))))))))))))) 

แมส้ตูร IF สามารถคํานวณหาคําตอบไดต้ามตอ้งการ แตจ่ากโครงสรา้งยาวเหยยีดนอกจากจะ

ทําใหแ้ฟ้มมขีนาดใหญข่ึน้แลว้ ยงัเพิม่ความเสีย่งในการตดิตามแกไ้ขหรอืตรวจสอบอกีดว้ย 

ดงันัน้แทนทีจ่ะใชส้ตูร IF เราสามารถใชส้ตูรตอ่ไปนีแ้ทน 

=(F9<=C9)+(SUM(F9:G9)<=C9)+(SUM(F9:H9)<=C9)+(SUM(F9:I9)<=C9)+(SUM(F

9:J9)<=C9)+(SUM(F9:K9)<=C9)+(SUM(F9:L9)<=C9)+(SUM(F9:M9)<=C9)+(SUM(F

9:N9)<=C9)+(SUM(F9:O9)<=C9)+(SUM(F9:P9)<=C9)+(SUM(F9:Q9)<=C9)+(SUM(
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F9:R9)<=C9)+(SUM(F9:S9)<=C9)+(SUM(F9:T9)<=C9)+(SUM(F9:U9)<=C9)+(SUM

(F9:V9)<=C9)+(SUM(F9:W9)<=C9)+(SUM(F9:X9)<=C9)+(SUM(F9:Y9)<=C9)+(SU

M(F9:Z9)<=C9)+(SUM(F9:AA9)<=C9)+(SUM(F9:AB9)<=C9)+(SUM(F9:AC9)<=C9)

+(SUM(F9:AD9)<=C9)+(SUM(F9:AE9)<=C9)+(SUM(F9:AF9)<=C9)+(SUM(F9:AG9)

<=C9)+(SUM(F9:AH9)<=C9)+(SUM(F9:AI9)<=C9)+(SUM(F9:AJ9)<=C9)+1 

ถา้ยงัยาวเกนิไปอกี ก็ตอ้งหนัมาใชส้ตูร Array กนัตามนี ้

{=SUM((SUBTOTAL(9,INDIRECT(ADDRESS(ROW(F9),COLUMN(F9))&":"&ADDRESS(

ROW(F9),ROW(INDIRECT(COLUMN(F9)&":"&COLUMN(AJ9))))))<=C9)*1)+1} 

หนสีตูร IF ไปใชส้ตูร Choose หรอื Index   

Choose เป็นสตูรซึง่ทําหนา้ทีเ่ลอืกคา่ทีใ่สไ่วใ้นวงเล็บของตวัสตูร Choose เองตามเลขลําดบัที่

เรากําหนด โดยใชเ้ลขลําดบัตัง้แตเ่ลข 1 - 254 (Excel 2003 ตอ้งใชเ้ลข 1 - 29) ตาม

โครงสรา้งสตูร ดงันี ้

=CHOOSE(เลขลําดบั, คา่ที1่, คา่ที2่, .... คา่ที ่254) 

สตูร Choose กบัสตูร IF มคีวามเหมอืนกนัตรงที ่2 สตูรนีเ้หมาะกบัการหาคา่คําตอบจากคา่ที่

กระจายตวัโดยไมจํ่าเป็นตอ้งอยูใ่นตารางทีเ่ป็นพืน้ทีต่อ่เนือ่งกนัไป เพยีงแตส่ตูร Choose ตอ้ง

ใชต้วัเลขลําดบัเป็นเลขจํานวนเต็มตัง้แตเ่ลข 1 - 254 เป็นเงือ่นไขในการเลอืกคําตอบ สว่นสตูร 

IF สามารถรับเงือ่นไขเปรยีบเทยีบไดท้ัง้ตวัเลขและตวัอกัษรและไมจํ่ากดัวา่ตอ้งใชเ้งือ่นไขกรณี

เทา่กนัเพยีงอยา่งเดยีวเชน่ทีส่ตูร Choose กําหนดไว ้

สมมตวิา่สตูร IF ทีใ่ชอ้ยูเ่ป็นสตูรตามนี ้ 

=IF(E9="A",C2,IF(E9="B",C5,IF(E9="C",C8,IF(E9="D",C11,IF(E9="E",C14,IF(

E9="F",C17,IF(E9="G",F2,IF(E9="H",F17,IF(E9="I",I2,IF(E9="J",I5,IF(E9="K

",I8,IF(E9="L",I11,IF(E9="M",I14,I17))))))))))))) 

สตูรขา้งตน้ใชค้า่ในเซลล ์E9 เป็นเงือ่นไขในการเปรยีบเทยีบกบัตวัอกัษร A - M เชน่ ถา้เซลล ์

E9 มคีา่เป็นตวัอกัษร A จะคนืคา่เป็นคา่จากเซลล ์C2 แตถ่า้เซลล ์E9 มคีา่เป็นตวัอกัษร B จะคนื

คา่เป็นคา่จากเซลล ์C5 เป็นตน้ 
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เนือ่งจากเงือ่นไขทีใ่ชใ้นสตูร IF ใชเ้ทยีบกบัตวัอกัษร จงึไมม่ทีางทีจ่ะนําสตูร Choose มาใช ้

แทน แตห่ากเราสามารถเปลีย่นเงือ่นไขจากตวัอกัษรทีใ่ชเ้ดมิ หนัมาใชเ้ปรยีบเทยีบกบัตวัเลข

แทน กลายเป็นสตูรตามนี ้

=IF(E9=1,C2,IF(E9=2,C5,IF(E9=3,C8,IF(E9=4,C11,IF(E9=5,C14,IF(E9=6,C1

7,IF(E9=7,F2,IF(E9=8,F17,IF(E9=9,I2,IF(E9=10,I5,IF(E9=11,I8,IF(E9=12,I

11,IF(E9=13,I14,I17))))))))))))) 

สตูร IF ทีแ่กไ้ขใหมน่ี ้ใชค้า่ในเซลล ์E9 เป็นเงือ่นไขในการเปรยีบเทยีบกบัตวัเลข 1 - 13 เชน่ 

ถา้เซลล ์E9 มคีา่เป็นตวัเลข 1 จะคนืคา่เป็นคา่จากเซลล ์C2 แตถ่า้เซลล ์E9 มคีา่เป็นตวัเลข 2 

จะคนืคา่เป็นคา่จากเซลล ์C5 เป็นตน้ 

เนือ่งจากสตูร IF ใชเ้งือ่นไขเทยีบกบัตวัเลข และเป็นตวัเลขจํานวนเต็มตัง้แตเ่ลข 1 - 13 ซึง่ไม่

เกนิ 254 และเป็นเงือ่นไขทีใ่ชก้ารตรวจสอบวา่เทา่กบัหรอืไมเ่ทา่นัน้ (ไมไ่ดต้รวจสอบวา่

มากกวา่นอ้ยกวา่) จงึสามารถใชส้ตูร Choose ทีส่ัน้กวา่แทนไดด้ว้ยตามนี ้

=CHOOSE(E9, C2,C5,C8,C11,C14,C17,F2,F17,I2,I5,I8,I11,I14,I17) 

ถา้เซลล ์E9 มคีา่เป็นตวัเลข 1 จะคนืคา่เป็นคา่จากเซลล ์C2 แตถ่า้เซลล ์E9 มคีา่เป็นตวัเลข 2 

จะคนืคา่เป็นคา่จากเซลล ์C5 แตถ่า้ E9 มคีา่เป็นตวัเลข 14 จะคนืคา่เป็นคา่จากเซลล ์I17 

สตูร Choose สามารถใชเ้ลอืกคา่ทีก่ระจาย ซึง่การกระจายตวันีเ่องทีจ่ะกลายเป็นหนามยอกอก

หากมกีารกระจายตวักนัมากเกนิไปเชน่สตูรตอ่ไปนี ้

=CHOOSE(E9, C2,C5,C8,C11,C14,C17,F2,F17,I2,I5,I8, 

I11,I14,I17,D3,D6,D9,D12,D15,D18,G3,G18,J3,J6,J9, 

J12,J15,J18,E4,E7,E10,E13,E16,E19,H4,H19,K4,K7, 

K10,K13,K16,K19) 

เพยีงเห็นสตูรแวบเดยีวก็รูส้กึเหนือ่ยแลว้ใชไ่หม แมว้า่สตูร Choose จะสามารถใชเ้ลอืกคา่ที่

กระจายตวักนัอยูไ่ดส้งูสดุถงึ 254 คา่ก็ตาม หากเราเผลอจัดลําดบัคา่คําตอบสลบัทีก่นัเพยีงคา่

เดยีว จะสง่ผลทําใหส้ตูร Choose คนืคา่คําตอบผดิพลาดทนัท ี
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ถา้คา่ทีต่อ้งการเลอืกนัน้ถกูนํามาจัดลําดบัใหมไ่วใ้นตารางใหเ้ป็นพืน้ทีซ่ ึง่ตอ่เนือ่งกนัไป เรา

สามารถนําสตูร Index มาใชแ้ทน Choose เพราะสตูร Index มโีครงสรา้งสตูรตามนี ้

=INDEX(พืน้ทีต่ารางทีเ่ป็น Single Row, เลขลําดบั) 

หรอื 

=INDEX(พืน้ทีต่ารางทีเ่ป็น Single Column, เลขลําดบั) 

Single Row หรอื Single Column หมายถงึพืน้ทีต่ารางทีม่คีวามสงูหรอืความกวา้งเป็นเซลล์

เดยีวตามแนวนอนหรอืแนวตัง้ 

ดงันัน้แทนทีจ่ะใชส้ตูร IF หรอืสตูร Choose ตามตวัอยา่งทีก่ลา่วไปแลว้นัน้ หากเราสามารถจัด

โครงสรา้งตารางใหมใ่หอ้ยูใ่นแนวนอนหรอืแนวตัง้ และใชต้ัวเลขจํานวนเต็มตัง้แตเ่ลข 1 เป็นตน้

ไปเป็นตวัชีตํ้าแหน่ง ก็ควรหนัมาใชส้ตูร Index แทนดกีวา่ กลายเป็นสตูรตามนี ้

=INDEX(A1:A10000, E9) 

ถา้เซลล ์E9 มคีา่เป็นตวัเลข 1 จะคนืคา่เป็นคา่จากเซลล ์A1 แตถ่า้เซลล ์E9 มคีา่เป็นตวัเลข 2 

จะคนืคา่เป็นคา่จากเซลล ์A2 แตถ่า้ E9 มคีา่เป็นตวัเลข 10000 จะคนืคา่เป็นคา่จากเซลล ์

A10000 ซึง่การนําคา่ทีต่อ้งการมาจัดไวใ้นพืน้ทีเ่ซลล ์A1:A10000 ทําใหง้า่ยในการคน้หา

ตําแหน่งเซลลเ์พือ่บนัทกึหรอืเปลีย่นแปลงคา่ใหมใ่นอนาคต 

การเลอืกใชส้ตูรไดอ้ยา่งเหมาะสม สตูรนัน้ตอ้งสามารถรองรับกบัเงือ่นไขทีอ่าจเปลีย่นแปลงได ้

ในอนาคตโดยเราไมต่อ้งยอ้นกลบัมาแกไ้ขสตูรเกา่ทีเ่คยสรา้งไวอ้กีเลย ดงันัน้จะเลอืกใชส้ตูร IF 

หรอื Choose หรอื Index ก็ตอ้งคดิพจิารณาใหเ้หมาะสมดว้ยวา่โครงสรา้งตารางและคา่ทีใ่ชเ้ป็น

เงือ่นไขนัน้เป็นอยา่งไร  

แทนทีจ่ะปลอ่ยใหบ้นัทกึคา่อยา่งตามใจหรอืไมไ่ดใ้สใ่จวา่จะใชตํ้าแหน่งเซลลท์ีใ่ดในการบนัทกึ

คา่ หากรูจั้กออกแบบตารางใหเ้หมาะสมจะชว่ยใหเ้ราสามารถเลอืกใชส้ตูรไดย้ดืหยุน่มากขึน้ 
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หนสีตูร IF ไปใชส้ตูร VLookup   

VLookup ยอ่มาจากคําวา่ Vertical Lookup ทําหนา้ทีต่รงตามคําแปลทีห่มายถงึการมองตาม

แนวตัง้ โดยเริม่จากใชค้า่ทีต่อ้งการคน้หา นําไปเปรยีบเทยีบกบัคา่ทีเ่ก็บไวใ้นตารางจาก 

Column ซา้ยสดุวา่ คา่ทีใ่ชค้น้หานัน้อยูใ่นแนวของคา่ใดใน Column ซา้ยสดุนัน้ แลว้คนืคา่เป็น

คําตอบจาก Column ตามเลขทีเ่ราตอ้งการ โดย VLookup มโีครงสรา้งสตูร 2 แบบ 

โครงสรา้งสตูรแบบ Approaching Match  

เหมาะกบัตารางขอ้มลูที ่Column ซา้ยสดุเป็นตวัเลขตอ่เนือ่งทีเ่รยีงคา่จากนอ้ยไปมาก 

โครงสรา้งนีทํ้างานตามเงือ่นไขแบบนอ้ยกวา่หรอืเทา่กบั 

=VLOOKUP(คา่ทีใ่ชห้า, ตารางทีเ่ก็บคา่, เลขที ่Column ของคําตอบ) 

โครงสรา้งสตูรแบบ Exact Match  

เหมาะกบัตารางขอ้มลูที ่Column ซา้ยสดุเป็นรหสั ซึง่ไมจํ่าเป็นตอ้งเรยีงคา่ โครงสรา้งนี้

ทํางานแบบเงือ่นไขเทา่กบั 

=VLOOKUP(คา่ทีใ่ชห้า, ตารางทีเ่ก็บคา่, เลขที ่Column ของคําตอบ,  

   FALSE หรอื 0) 

ในกรณีทีใ่ชส้ตูร IF หาคําตอบเป็นเกรด A B หรอื C โดยใชส้ตูร =IF( E3>=B3, C3, 

IF(E3>=B4,C4,C5) ) 

 

หากตอ้งการเปลีย่นมาใชส้ตูร VLookup ตอ้งเรยีงคะแนนในตารางจากนอ้ยไปมาก ตามรปู

ตอ่ไปนีแ้ทน 
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เซลล ์F3 สรา้งสตูร =VLOOKUP(E3,B3:C5,2) ซึง่เป็นสตูร VLookup แบบ Approaching 

Match เนือ่งจากคา่ทีใ่ชห้าเป็นตวัเลข และตวัเลขนีส้ามารถเป็นตวัเลขทีต่อ่เนือ่งกนัไป และคนื

คา่ไดคํ้าตอบเป็นเกรด B โดยมลํีาดบัการทํางานของสตูร ดงันี ้

1. VLookup นําคะแนนทีส่อบได ้75 คะแนน ไปตรวจสอบกบัตารางขอ้มลู B3:C5 

2. ใน Column ซา้ยสดุทีเ่รยีงเลขจากนอ้ยไปมากนัน้ พบวา่เลขคะแนน 70 เป็นเลขทีม่าก

ทีส่ดุทีย่งันอ้ยกวา่หรอืเทา่กบัเลข 75 ซึง่เป็นคะแนนทีส่อบได ้แสดงวา่คําตอบทีต่อ้งการ 

อยูใ่นแนวเดยีวกบัเลขคะแนน 70 แน่นอน 

3. เลข 2 ทีใ่สล่งไปในวงเล็บของสตูร VLookup เป็นตวัเลขแทน Column ทีส่องในพืน้ที่

ตาราง B3:C5 ซึง่เป็น Column เรือ่งเกรดทีเ่ป็นคําตอบ จงึคนืคา่ออกมาเป็นเกรด B 

หากเลอืกใชส้ตูรแบบ Exact Match =VLOOKUP(E3,B3:C5,2,0) ซึง่เพิม่เลข 0 ตอ่ทา้ยลงไป

ในวงเล็บ จะไดคํ้าตอบเป็น #N/A เนือ่งจาก Column ซา้ยสดุทีเ่ป็นตวัเลขคะแนน ไมม่เีลข 75 

แสดงไว ้จงึคนืคา่คําตอบออกมาวา่ Not Available แสดงวา่หาคา่ทีต่อ้งการไมพ่บ 

แมก้ารใชส้ตูร VLookup จะชว่ยใหไ้ดส้ตูรทีส่ัน้ลงก็ตาม แตจ่ะทําให ้Excel คํานวณชา้กวา่ใน

กรณีทีใ่ชส้ตูร IF หากตารางทีใ่ชเ้ก็บขอ้มลูมขีนาดใหญข่ึน้ ก็จะสง่ผลใหส้ตูร VLookup คํานวณ

ชา้ลง เราจงึตอ้งพงึระวงัไวเ้สมอวา่ทกุอยา่งมทีัง้ขอ้ดขีอ้เสยี ไดอ้ยา่งก็จําเป็นตอ้งเสยีอยา่ง

เชน่กนั 
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หนสีตูร IF ไปใชส้ตูร Max Min หรอืแคใ่ชว้งเล็บชว่ย   

ในบรรดาเงือ่นไขทีใ่ชก้นัมากทีส่ดุในชวีติประจําวนัเห็นจะหนไีมพ่น้เงือ่นไขเกีย่วกบัการตดัสนิใจ

ในเรือ่งหา้มเกนิกวา่หรอืหา้มตํา่กวา่ ยกตวัอยา่งทีใ่กลต้วั เชน่ เกณฑก์ารคํานวณภาษีเงนิได ้

บคุคลธรรมดา มหีลกัคํานวณภาษีจากเงนิไดว้า่ เงนิไดช้ว่งทีไ่มเ่กนิกวา่ยอดนัน้ยอดนีใ้หใ้ชอ้ตัรา

ภาษีเทา่นัน้เทา่นี ้หรอืภาษีเงนิไดข้องบรษัิทตอ้งคํานวณจากยอดกําไร แตถ่า้ขาดทนุก็ไม่

จําเป็นตอ้งจา่ยภาษี เทยีบไดก้บัเงือ่นไขทีห่า้มคดิภาษีถา้มตีวัเลขตํา่กวา่ 0 น่ันเอง 

ถา้มตีวัเลขใดๆทีอ่าจเป็นไปไดท้ัง้คา่บวกลบและศนูย ์แลว้กําหนดใหใ้ชส้ตูร IF ปรับคา่นีใ้หเ้ป็น

คา่ใหมท่ีห่า้มตํา่กวา่ 0 แตถ่า้ตวัเลขนัน้มคีา่มากกวา่ 0 อยูแ่ลว้ ก็ขอใหค้งคา่เดมิ จะตอ้งสรา้ง

สตูรตามนี ้

=IF(เซลลต์วัเลข<0, 0, เซลลต์วัเลข) 

หรอื 

=IF(เซลลต์วัเลข>=0, เซลลต์วัเลข, 0) 

แทนทีจ่ะใชส้ตูร IF ในเงือ่นไขทีเ่กีย่วขอ้งกบัขอ้กําหนดหา้มตํา่กวา่หรอืหา้มเกนิกวา่ เรา

สามารถนําสตูร Max หรอื Min มาใชแ้ทนโดยใชห้ลกัชว่ยจํา ดงันี ้

• สตูร Max หรอื Min นีทํ้างานตรงขา้มกบัความเขา้ใจ 

• ปกตสิตูร Max ทําหนา้ทีห่าคา่สงูสดุ แตใ่หใ้ชก้บัเงือ่นไขหา้มตํา่กวา่ โดยใชส้ตูร 

=MAX(ตวัเลขตามเกณฑต์ํา่สดุทีเ่ป็นไปได,้ ตวัเลขทีต่อ้งการเทยีบ) 

• ปกตสิตูร Min ทําหนา้ทีห่าคา่ตํา่สดุ แตใ่หใ้ชก้บัเงือ่นไขหา้มเกนิกวา่ โดยใชส้ตูร 

=MIN(ตวัเลขตามเกณฑส์งูสดุทีเ่ป็นไปได,้ ตวัเลขทีต่อ้งการเทยีบ) 

ตามตวัอยา่งขา้งตน้ทีใ่ชส้ตูร IF ปรับตวัเลขไมใ่หตํ้า่กวา่ 0 นัน้ สามารถเปลีย่นมาใชส้ตูร Max 

ตอ่ไปนีแ้ทน 

=MAX(0, เซลลต์วัเลข) 

สว่นในกรณีทีต่อ้งการสรา้งสตูรควบคมุตวัเลขไมใ่หเ้กนิเลข 100 สามารถใชส้ตูร IF หรอื Min 

ไดต้ามนี ้
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=IF(เซลลต์วัเลข>100, 100, เซลลต์วัเลข) 

หรอื 

=IF(เซลลต์วัเลข<=100, เซลลต์วัเลข, 100) 

หรอื 

=MIN(100, เซลลต์วัเลข) 

นอกจากนีเ้รายงัสามารถใชว้งเล็บชว่ยในการตดัสนิใจโดยไมจํ่าเป็นตอ้งพึง่พาสตูรใดๆ เชน่ 

กรณีทีต่อ้งการเปลีย่นตวัเลขใหไ้มตํ่า่กวา่ 0 ตามตวัอยา่งขา้งตน้ ใหใ้ชส้ตูรทีใ่ชว้งเล็บชว่ย

ตอ่ไปนีไ้ดเ้ลย 

=(เซลลต์วัเลข<=0)*0 + (เซลลต์วัเลข>0)*เซลลต์วัเลข 

การใชว้งเล็บชว่ยในการตดัสนิใจ มหีลกัการดงันี ้

1. สามารถใชไ้ดเ้ฉพาะเมือ่ผลลพัธท์ีต่อ้งการเป็นตวัเลขเทา่นัน้ เนือ่งจากตอ้งนําตวัเลขมา

คํานวณตอ่กนัไปเรือ่ยๆ 

2. หากมหีลายวงเล็บ ตอ้งมเีงือ่นไขเดยีวในวงเล็บหนึง่เทา่นัน้ทีเ่ป็นจรงิ และเงือ่นไขใน

วงเล็บอืน่ตอ้งเป็นเท็จทัง้หมด 

3. เงือ่นไขทีใ่ชต้รวจสอบนัน้ ถา้คนืคา่เป็นเท็จ ถอืวา่มคีา่เทา่กบัเลข 0 แตถ่า้คนืคา่เป็นจรงิ 

ถอืวา่มคีา่เทา่กบัเลข 1 

4. ใหนํ้าเงือ่นไขมาบวกกนัในกรณีทีกํ่าหนดใหเ้งือ่นไขเดยีวเทา่นัน้เป็นจรงิ หรอืนําเงือ่นไข

มาคณูกนัในกรณีทีต่อ้งการตรวจสอบวา่ทกุเงือ่นไขเป็นจรงิพรอ้มกนั 

จากตวัอยา่งขา้งตน้ในกรณีทีห่า้มตํา่กวา่ 0 เชน่ เซลลต์วัเลขมคีา่เทา่กบั -5 เมือ่นํามาแทนคา่ลง

ไปในสตูร =(เซลลต์วัเลข<=0)*0 + (เซลลต์วัเลข>0)*เซลลต์วัเลข แลว้ Excel จะคดิทลีะขัน้

ตามนี ้

1. แทนคา่ตวัเลขลงไปในสตูรเป็น =(-5<=0)*0 + (-5>0)*-5 

2. วงเล็บของ (-5<=0) จะคนืคา่ TRUE หรอืเทยีบเทา่กบั 1 

3. วงเล็บของ (-5>0) จะคนืคา่ FALSE หรอืเทยีบเทา่กบั 0 

4. จะไดส้ตูร =1*0 + 0*-5 

5. จะไดส้ตูร =0 + 0 



113 

 

Copyright of www.ExcelExpertTraining.com 

6. ซึง่ปรับคา่ -5 ออกมาเป็น 0 

แตถ่า้เซลลต์วัเลขมคีา่เทา่กบั 5 เมือ่นํามาแทนคา่ลงไปในสตูร =(เซลลต์วัเลข<=0)*0 + 

(เซลลต์วัเลข>0)*เซลลต์วัเลข แลว้ Excel จะคดิทลีะขัน้ตามนี ้

1. แทนคา่ตวัเลขลงไปในสตูรเป็น =(5<=0)*0 + (5>0)*5 

2. วงเล็บของ (5<=0) จะคนืคา่ FALSE หรอืเทยีบเทา่กบั 0 

3. วงเล็บของ (5>0) จะคนืคา่ TRUE หรอืเทยีบเทา่กบั 1 

4. จะไดส้ตูร =0*0 + 1*5 

5. จะไดส้ตูร =0 + 5 

6. ซึง่ปรับคา่ 5 ออกมาเป็น 5 เทา่กบัคา่บวกตามคา่เดมิน่ันเอง 

แมก้ารใชว้งเล็บชว่ยในการตดัสนิใจจะเกดิสตูรทีม่คีวามยาวซึง่ดเูหมอืนไมจํ่าเป็นก็ตาม แต่

โครงสรา้งสตูรภายในวงเล็บทกุวงเล็บมคีวามคลา้ยคลงึกนั จงึสามารถตรวจสอบแกไ้ขไดง้า่ย 

และยงัเป็นพืน้ฐานของการคํานวณแบบ Array อกีดว้ย 
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หนสีตูร IF ไปใชค้าํส ัง่ Format   

สมยัทีผ่มใช ้Excel รุน่แรกๆ Excel ไมไ่ดม้คํีาสัง่บนเมนูใหเ้ลอืกใชไ้ดม้ากมายอยา่งเชน่ทกุวนันี ้

แตก่็ไดพ้ึง่สตูร IF นีแ่หละชว่ยในการตรวจสอบคา่ตา่งๆ อยา่งเชน่ถา้ตอ้งการตรวจสอบคา่ที่

พมิพล์งไปวา่เป็นตวัเลขอยา่งเดยีวเทา่นัน้ ก็ตอ้งใชส้ตูร IF มาผสมกบัสตูร IsNumber เพือ่

ตรวจสอบคา่ทีพ่มิพว์า่ ถา้ไมใ่ชต่วัเลข ใหแ้สดงคําเตอืนออกมาวา่ Input is Wrong ตามสตูร

ตอ่ไปนี ้

=IF(ISNUMBER(Cell), "OK", "Input is Wrong") 

การใชส้ตูรดงักลา่วจําเป็นตอ้งสรา้งสตูรลงไปในอกีเซลลห์นึง่เพือ่เป็นเซลลท์ีแ่สดงคําเตอืน

ออกมาใหเ้ห็น นอกจากสตูร IF ก็มแีตร่ปูแบบจากคําสัง่ Format เป็นอกีเครือ่งมอืหนึง่ทีกํ่าหนด

ลงไปในเซลล ์เชน่ ถา้หากตอ้งการเตอืนวา่ Input is Wrong ในเซลลท์ีค่วบคมุวา่ตอ้งเป็น

ตวัเลขเทา่นัน้ ก็สามารถกําหนด Format ตามนี ้

0;-0;0;"Input is Wrong" 

แม ้Format จะแสดงคําวา่ Input is Wrong ใหเ้ห็นในเซลลท์ีบ่นัทกึคา่ลงไปก็ตาม แตก่็ถอืวา่

ไดเ้กดิคา่ทีผ่ดิพลาดขึน้มาแลว้ ตา่งจาก Excel รุน่ใหมท่ีม่คํีาสัง่บนเมนู Data Validation กบั 

Conditional Formatting ใหเ้ลอืกใช ้ซึง่สามารถแสดงคําเตอืนหรอืเปลีย่นสใีหเ้ห็นชดัในเซลล์

นัน้ๆเลย 
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วธิใีช ้Data Validation 

สมมตวิา่ตอ้งการพมิพช์ือ่เดอืนลงไปในเซลล ์ซึง่ทีผ่า่นมาเคยพมิพผ์ดิซํ้าแลว้ซํ้าอกี จงึตอ้งการ

สัง่ให ้Excel แสดงคําเตอืนขึน้มาเมือ่พมิพช์ือ่เดอืนผดิ  

 

1. ตัง้ชือ่ Range Name ใหก้บัเซลลท์ีเ่ก็บชือ่เดอืนในเซลล ์B2:B7 ใหม้ชีือ่วา่ Choice 

2. เลอืกเซลล ์D2 ทีเ่ป็นเซลลซ์ึง่ตอ้งการพมิพช์ือ่เดอืนทีต่อ้งการแลว้สัง่ Data > Data 

Validation (Excel 2003 สัง่ Data > Validation) 

3. ในชอ่ง Allow คลกิเลอืก List (ในชอ่ง Allow นีเ้องทีเ่ราสามารถเลอืกประเภทของ

ขอ้มลูทีย่อมรับไดอ้กีหลายอยา่งตามแตจ่ะกําหนด หรอืเลอืก Allow แบบ Custom เพือ่

ใชส้ตูรตรวจสอบการบนัทกึคา่) 

4. ใหค้ลกิลงไปในชอ่ง Source แลว้กดปุ่ ม F3 เพือ่เปิดรายชือ่ Range Name ทีม่อียูข่ ึน้มา 

5. ใหเ้ลือ่นหาชือ่ Choice เพือ่เลอืกแลว้กดปุ่ ม OK 2 ครัง้ 

6. จะพบวา่เซลล ์D2 มปีุ่ มลกูศรแสดงขึน้มาทางขอบดา้นขวา และเมือ่คลกิปุ่ มลกูศรนีก้็จะมี

รายชือ่เดอืนแสดงใหค้ลกิเลอืกก็ได ้หรอื

หากทดลองพมิพช์ือ่เดอืนลงไปในเซลล ์

D2 เอง ถา้เราพมิพช์ือ่เดอืนผดิ พอกด

ปุ่ ม Enter เพือ่รับชือ่เดอืนลงไป จะมคํีา

เตอืนแสดงขึน้มาใหเ้ห็นวา่ The value you entered is not valid. 
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วธิใีช ้Conditional Formatting 

สมมตวิา่พอคลกิเลอืกชือ่เดอืน May ในเซลล ์D2 แลว้ ตอ้งการเปลีย่นสเีซลลใ์นตารางทีต่ัง้ชือ่

วา่ Choice ในเซลลท์ีม่คํีาวา่ May ตรงตามทีเ่ลอืก ใหทํ้าดงันี ้ 

 

1. เลอืกพืน้ทีต่ารางทีต่ัง้ชือ่วา่ Choice 

2. สัง่ Home > Conditional Formatting > New Rules > Use a formula to 

determine which cells to format (Excel 2003 สัง่ Format > Conditional 

Formatting) 

3. สรา้งสตูร =B2=$D$2 ลงไปในชอ่ง Edit the Rule Description 

4. กดปุ่ ม Format แลว้กําหนดรปูแบบทีแ่ตกตา่งไปจากเดมิตามตอ้งการ 

5. Data Validation กบั Conditional Formatting ถอืเป็นเครือ่งมอืซึง่ควรนํามาใชพ้รอ้ม

กนัเสมอ โดย Validation จะทําหนา้ทีเ่สมอืนยามเฝ้าประตตูรวจสอบแขกทีจ่ะยอมให ้

ผา่นประตเูขา้มา แตถ่า้มแีขกเดนิผา่นประตเูขา้มาแลว้ก็ตอ้งใช ้Conditional 

Formatting เปลีย่นสแีสดงตวัแขกผูนั้น้ขึน้มา  
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การใช ้Validation และ Conditional Formatting ควบคมุตาํแหนง่ของ

เซลลท์ีจ่ะเปิดใหพ้มิพค์า่  

จากรปูตอ่ไปนี ้หากตอ้งการควบคมุใหเ้ปิดบนัทกึคา่ไดต้ามตําแหน่งตวัชีบ้นหวัตารางทีเ่ป็น Y 

และตามตําแหน่งขา้งตารางทีเ่ป็น B และใหเ้ปลีย่นสบีอกตําแหน่งอกีดว้ย จะพบวา่เซลล ์D4 

เปลีย่นสแีละเป็นเซลลเ์ดยีวเทา่นัน้ทีจ่ะเปิดใหพ้มิพค์า่ใหมล่งไปได ้

 

1. คลกิเลอืกพืน้ทีเ่ซลล ์C3:E4 ซึง่เป็นพืน้ทีใ่นตาราง 

2. จากนัน้ใชคํ้าสัง่ Conditional Formatting ในทํานองเดยีวกบัตวัอยา่งขา้งตน้ ตา่งกนั

เพยีงใชส้ตูร =C$2&$B3=$C$6&$C$7 

3. ตามดว้ยคําสัง่ Data Validation โดยใช ้Allow แบบ Custom โดยกําหนดใหใ้ชส้ตูร 

=C$2&$B3=$C$6&$C$7 ซึง่เป็นสตูรเดยีวกนักนัทีใ่ชก้บั Conditional 

Formatting น่ันเอง (หรอืจะใชส้ตูร =And(C$2=$C$6,$B3=$C$7) 
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สตูร Array 

เรือ่งสตูร Array เป็นเรือ่งทีผ่มเคยเขยีนมาแลว้หลายครัง้ เคยอธบิายมาแลว้หลายรอบ ทกุครัง้ที่

จัดอบรมก็พดูเรือ่งสตูร Array อยูเ่สมอ คนทีฟั่งเรือ่งสตูร Array แลว้เขา้ใจก็จะเขา้ใจในทนัท ี

แลว้ก็ตอ้งมาน่ังเบือ่น่ังทนฟังผมอธบิายเรือ่งสตูร Array นีซ้ํ้าแลว้ซํ้าอกี เพราะคนสว่นใหญเ่ขา

ฟังกีท่กีีท่กี็ไมเ่ขา้ใจเรือ่งสตูร Array นีส้กัท ีไมใ่ชว่า่ฟังแบบเขา้หซูา้ยแลว้ทะลหุขูวาหรอก แต่

แยย่ิง่กวา่นัน้อกี พออธบิายเรือ่งสตูร Array ทไีร ปรากฏวา่เสยีงพดูอธบิายของผมมนัเดนิทางไป

ไมถ่งึหคูนฟังเสยีดว้ยซํ้า เพราะคนฟังพอฟังแลว้ไมรู่เ้รือ่งก็จะมอีาการหนังตาหนักขึน้เรือ่ยๆแลว้

หลบัหหูลบัตาไมไ่ดฟั้งทกุครัง้ไป 

"ถา้คณุใชส้ตูร Array เป็น จะแกปั้ญหาอะไรไดบ้า้ง" ผมคดิวา่ตอ้งเริม่อธบิายใหพ้วกเราเห็น

คณุประโยชนข์องสตูร Array กนักอ่น ถา้เห็นประโยชนข์องสตูร Array วา่จะชว่ยแกปั้ญหาของ

ตวัเองไดม้ากมายขนาดไหน จะไดเ้กดิความอยากใชแ้ลว้จะไดม้คีวามตัง้หนา้ตัง้ตาตัง้ใจมา

เรยีนรูส้ตูร Array 

ประโยชนข์องสตูร Array  

สตูร Array จะชว่ยทําใหค้ณุสามารถทําสิง่ทีไ่มน่กึไมฝั่นวา่ Excel จะทําไดม้ากอ่น ไดแ้ก ่

1. ทําใหแ้ฟ้มมขีนาดเล็กลง เนือ่งจากแทนทีจ่ะตอ้งสรา้งตารางหลายๆตารางเพือ่แยก

คํานวณทลีะขัน้ เราสามารถสรา้งสตูร Array ลงไปในเซลลเ์พยีงเซลลเ์ดยีวก็ไดคํ้าตอบ

ทีต่อ้งการแลว้ 

2. ทําใหเ้ก็บขอ้มลูไวใ้นตารางเดยีวชทีเดยีว โดยไมต่อ้งแยกตารางฐานขอ้มลูออกเป็น

หลายตารางหรอืหลายชทีเพยีงเพือ่ตอ้งการหายอดรวมแยกประเภทตามขอ้มลูทีจั่ดแยก

ไว ้

3. ทําให ้Excel ทํางานแบบคอมพวิเตอรไ์ดอ้ยา่งแทจ้รงิ พอกรอกคา่ลงไปก็จะไดคํ้าตอบที่

ตอ้งการทนัท ีไมต่อ้งเสยีแรงและเสยีเวลาคลกิเลอืกใชคํ้าสัง่บนเมนู เชน่ ไมต่อ้งสัง่ 

Sort ตารางก็จัดเรยีงใหเ้องแลว้ หรอืไมต่อ้งสัง่ AutoFilter ก็สามารถหายอดรวมแยก

ประเภทไดแ้ลว้ 

4. ทําใหส้ตูรสําเร็จรปูของ Excel มคีวามสามารถเหนอืชัน้ขึน้กวา่เดมิ สามารถใชส้ตูรใน

เซลลเ์ดยีวลัดหาคําตอบ 
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ในการอบรมครัง้หนึง่มผีูเ้ขา้อบรมคนหนึง่มทีา่ทไีมส่นใจเรยีนรูส้ตูร Array โดยอา้งวา่ ทําไมตอ้ง

ใชส้ตูร Array ดว้ยในเมือ่ Excel ก็มสีตูรและคําสัง่บนเมนูอยูแ่ลว้ ถา้อยากไดอ้ะไรก็แคค่ลกิ

คําสัง่บนเมนู ก็จะไดคํ้าตอบทีต่อ้งการแลว้มใิชห่รอื 

ผมจงึเรยีนถามกลบัวา่ แลว้มอืทีใ่ชค้ลกิคําสัง่บนเมนูทีว่า่นัน้น่ะเป็นมอืของใคร ถา้คณุสง่แฟ้มไป

ใหห้วัหนา้ทีใ่ช ้Excel ไมเ่ป็น หวัหนา้จะรูว้ธิเีลอืกคลกิเมนูนัน้เมนูนีด้ว้ยหรอื เห็นทหีวัหนา้ตอ้ง

พึง่พามอืของคณุไปชัว่ชวีติหรอืไม ่แตถ่า้คณุสรา้งสตูร Array เป็น แฟ้มนัน้ๆจะทํางานตอ่เอง

อยา่งอตัโนมัตโิดยไมต่อ้งหว่งวา่ใครจะเป็นผูใ้ชแ้ฟ้มของคณุ 

อยา่งเรือ่งการใช ้Pivot Table เหมอืนกนัทีห่วัหนา้มกัชอบใชเ้ป็นชวีติจติใจแลว้ผลกัดนัให ้

ลกูนอ้งใช ้Pivot Table ตามกนัไปทัง้บรษัิท โดยหารูไ้มว่า่ถา้ใช ้Array เป็นก็แทบไมจํ่าเป็นตอ้ง

ใช ้Pivot Table เสยีดว้ยซํ้า  

ขอ้เสยีของสตูร Array 

1. ทําใหแ้ฟ้มคํานวณชา้ลง แตเ่นือ่งจากการใชส้ตูร Array จะชว่ยทําใหแ้ฟ้มมขีนาดเล็กลง

ซึง่โดยทัว่ไปยอ่มสง่ผลใหแ้ฟ้มเล็กคํานวณเร็วกวา่แฟ้มใหญ ่ถา้คณุออกแบบโครงสรา้ง

ตารางใหเ้หมาะกบัสตูร Array ดว้ย ปัญหาเรือ่งนีก้็จะชดเชยกนัไป 

2. ทําใหแ้กไ้ขสตูรยากขึน้ เพราะคนทัว่ไปมกัไมเ่ขา้ใจเรือ่งสตูร Array เป็นพืน้อยูแ่ลว้และ

ไมท่ราบวา่ขัน้ตอนการสรา้งสตูร Array ตอ้งกดปุ่ ม Ctrl+Shift+Enter พรอ้มกนัแทนที่

จะกดปุ่ ม Enter 

3. คนทีต่ดินสิยัชอบสรา้งสตูร Array มกัหลงลมืมองขา้มสตูรสําเร็จรปูอืน่ทีม่อียูแ่ลว้ใน

โปรแกรม Excel ซึง่สตูรสําเร็จรปูจะใชเ้วลาคํานวณเร็วกวา่สตูร Array 

เบือ้งตน้ของ Array 

ขนาดผมใชส้ตูร Array มานานนับสบิปี สรา้งสตูร Array เพือ่ใชก้บังานมาสารพัดชนดิ ตอบ

คําถามเรือ่ง Array ใน Excel Expert Forum ซํ้าแลว้ซํ้าอกีนับเป็นพันๆครัง้ แตก่็ยงัมสีตูร Array 

อกีเยอะทีผ่มเห็นแลว้ตอ้งถอนหายใจ ไมส่ามารถแกะทีไ่ปทีม่าของลําดบัการคํานวณทีใ่ชใ้น

สตูร Array เหลา่นัน้ เพราะเป็นสตูรทีค่นอืน่สรา้งขึน้ ถา้คนทีส่รา้งสตูร เขาไมไ่ดเ้ขยีนอธบิาย

แนวคดิประกอบสตูรไวด้ว้ย ยอ่มทําใหผู้อ้ ืน่คดิถามในใจวา่ “เขาสรา้งสตูรยากๆยาวๆแบบนีข้ ึน้มา

ไดอ้ยา่งไรกนั” แลว้ถา้เราไดแ้ตล่อกเอาสตูรของคนอืน่มาใช ้ก็ไดแ้ตใ่ช ้ไมส่ามารถดดัแปลง
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แกไ้ขสตูรทีล่อกมาเพือ่ปรับใหเ้ขา้กบัเงือ่นไขในงาน วนัหนึง่เราก็จะหนา้แตก เมือ่ถกูจับไดว้า่

ไมไ่ดเ้กง่จรงิ “ออ้ ลอกสตูรเขามานีเ่อง” ดงันัน้ถา้จะคดิใชส้ตูร Array ตอ้งหาทางสรา้งสตูรเอง

ใหเ้ป็น แมส้ตูร Array ทีส่รา้งขึน้เองเป็นสตูรยาวกวา่สตูรของคนอืน่ก็ตาม 

สตูร Array สตูรแรกๆทีทํ่าใหผ้มเกดิความประทบัใจแลว้เกดิแรงบนัดาลใจใหอ้ยากเรยีนรูเ้รือ่ง

สตูร Array มากขึน้ เป็นสตูรทีใ่ชคํ้านวณหาจํานวน Unique Items หรอืนับจํานวนชือ่รายการที่

ไมซ่ํ้ากนั 

{=SUM(1/CountIF(DataRange,DataRange))} 

สมมตวิา่ใน DataRange บนัทกึชือ่ลกูคา้ไวต้ามนี ้aa, bb, aa, cc, bb สตูรนีจ้ะหาคําตอบเป็น

เลข 3 ซึง่หมายถงึการนับชือ่ลกูคา้วา่มอียู ่3 คน คอื aa, bb, และ cc แตก่วา่จะหาทางสรา้งสตูร

ใหทํ้างานไดก้็ตอ้งทราบกอ่นวา่เครือ่งหมายวงเล็บปีกกา { } ทีเ่ห็นอยูด่า้นหนา้สดุและดา้น

ทา้ยสดุของสตูรนัน้ ไมใ่ชเ่ครือ่งหมายวงเล็บปีกกาทีพ่มิพเ์อง แตเ่กดิจากการกดปุ่ ม 

Ctrl+Shift+Enter พรอ้มกนัและหา้มมชีอ่งวา่งใน DataRange ดว้ย 

ตอนทีผ่มเห็นสตูรนีก้็คดิไมอ่อกวา่มนัใชห้ลกัการใดในการคํานวณ แตพ่ออา่นคําอธบิายทีม่ากบั

สตูรจงึเขา้ใจ สตูรนีเ้ป็นการหายอดรวมของคา่เฉลีย่ตอ่ตวัของแตล่ะรายการใน 

DataRange กลา่วคอื ถา้นับจํานวนชือ่แตล่ะชือ่ใน DataRange aa, bb, aa, cc, bb จะพบ

จํานวนของการซํ้ากนัดงันี ้

• ม ีaa ซํ้ากนัอยู ่2 ตวั ดงันัน้คา่เฉลีย่ตอ่ตวัของ aa แตล่ะตวัคอื 1/2 

• ม ีbb ซํ้ากนัอยู ่2 ตวั ดงันัน้คา่เฉลีย่ตอ่ตวัของ bb แตล่ะตวัคอื 1/2 

• ม ีcc อยู ่1 ตวั ดงันัน้คา่เฉลีย่ตอ่ตวัคอื 1 

เมือ่รวมคา่เฉลีย่ตอ่ตวัเขา้ดว้ยกนั จาก DataRange aa, bb, aa, cc, bb 

=1/2+1/2+1/2+1+1/2 จะไดคํ้าตอบเป็นจํานวนของ Unique Items เทา่กบั 3 

จวบจนปัจจบุนันีย้งัตามหาคนทีค่ดิสรา้งสตูรยอดเยีย่มนีข้ ึน้มาเป็นครัง้แรกไมพ่บวา่เป็นใคร ยงัดี

ทีม่คํีาอธบิายประกอบสตูรนีไ้วด้ว้ย 
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อยากเกง่สตูร Array ตอ้งสรา้งไปแกะไป 

จากคําอธบิายทีเ่ขยีนไวเ้กีย่วกบัทีไ่ปทีม่าของสตูรคํานวณหาจํานวน Unique Items วา่ เป็นการ

หายอดรวมของคา่เฉลีย่ตอ่ตวัของแตล่ะรายการใน DataRange ยอ่มทําใหค้นสว่นใหญท่ีเ่พิง่

รูจั้กสตูร Array เป็นครัง้แรกคงยงัไมเ่ขา้ใจลําดบัในการคํานวณทีใ่ชใ้นสตูรนีช้ดัเจนนัก ถา้

อยากจะเขา้ใจอยา่งถอ่งแทว้า่สตูร Array ทํางานไดอ้ยา่งไร ตอ้งเรยีนรูจ้ากการปฏบิตัเิทา่นัน้ 

โดยใชว้ธิทีดลองสรา้งสตูรไปแกะไปซึง่มอียู ่2 วธิ ี

1. สรา้งสตูร Array ลงไปในเซลลเ์ดยีวแลว้แกะคา่ในแตล่ะสว่นของสตูร โดยการกดปุ่ ม F9 

เพือ่ดใูนชอ่ง Formula Bar หรอื 

2. สรา้งสตูร Array ลงไปในตารางพรอ้มกนัทเีดยีวหลายๆเซลลห์รอืใชต้ารางแยกคํานวณ

ทลีะขัน้ เพือ่ดผูลลพัธก์ระจายออกมาใหเ้ห็นในตาราง 

โดยทัว่ไปจะใชว้ธิแีรกสําหรับแกะสตูรทีไ่มซ่บัซอ้นหรอืไมย่าวนัก พอแกะสตูรโดยการกดปุ่ ม F9 

แลว้ตอ้งอยา่ลมืกดปุ่ ม Esc เพือ่ยอ้นหลงักลบัคนืสูส่ภาพเดมิกอ่นแกะ (ถา้แกะสตูรแลว้เผลอกด 

Enter ลงไปจะทําลายสตูรใหก้ลายเป็นคา่คงทีแ่ทน) 

วธิทีีส่อง เหมาะสําหรับคนทีเ่พิง่เรยีนรูเ้รือ่ง Array หรอืใชแ้กะสตูรยากๆยาวๆ หรอืใชท้ดลอง

สรา้งสตูร Array ขึน้ใหมต่ัง้แตแ่รก เพราะวธินีีจ้ะเห็นผลลพัธแ์ตล่ะขัน้ของการคํานวณแสดง

กระจายใหเ้ห็นในเซลลแ์ตล่ะเซลลใ์นตาราง จากนัน้พอซอ้นสตูรตอ่ๆกนัไปจนไดคํ้าตอบที่

ตอ้งการแลว้จงึนําสตูรแตล่ะขัน้มาซอ้นตอ่กนัเป็นสตูรเดยีวเพือ่นําไปใชง้านตอ่ไป 

วธิแีกะสตูร Array วธิที ี ่1 

 

DataRange คอื ตารางชว่ง B3:B7 
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เซลล ์D3 มสีตูร Array {=SUM(1/COUNTIF(DataRange,DataRange))} โดย

เครือ่งหมายวงเล็บปีกกาเกดิจากการกดปุ่ ม Ctrl+Shift+Enter พรอ้มกนั (ไมไ่ดพ้มิพ ์{} เอง) 

1. เริม่จากคลกิลงไปในชอ่ง Formula Bar คลกิลากทบัสว่นของสตูร 

COUNTIF(DataRange,DataRange) 

2. กดปุ่ ม F9 จะพบวา่สตูร CountIF นับจํานวนซํ้าของคา่แตล่ะตัว ทําใหส้ตูรทัง้หมด

เปลีย่นเป็นสตูร =SUM(1/{2;2;2;1;2}) 

3. ตวัเลข  {2;2;2;1;2} หมายถงึ จํานวนซํ้าของแตล่ะคา่ กลา่วคอื aa ม ี2 คา่, bb ม ี2 คา่

, aa ม ี2 คา่, cc ม ี1 คา่, และ bb ม ี2 คา่ 

4. คลกิลากทบัสว่นของสตูร 1/{2;2;2;1;2} 

5. กดปุ่ ม F9 จะพบวา่สตูร 1/{2;2;2;1;2} หาคา่เฉลีย่จากจํานวนซํ้าของคา่แตล่ะตวั ทําให ้

สตูรทัง้หมดเปลีย่นเป็นสตูร =SUM({0.5;0.5;0.5;1;0.5}) 

6. ตวัเลข {0.5;0.5;0.5;1;0.5} เกดิจากสว่นของหารหาคา่เฉลีย่โดย 1/2 ทําใหเ้กดิเลข 

0.5 และ 1/1 ทําใหเ้กดิเลข 1 

7. คลกิลากทบัสตูร SUM({0.5;0.5;0.5;1;0.5}) แลว้กดปุ่ ม F9 จะไดคํ้าตอบเป็นสตูร =3 

8. กดปุ่ ม Esc เพือ่ทําใหส้ตูรแปลงกลบัไปเป็นสตูรแรกเริม่ตามเดมิ 

หมายเหต ุการคลกิแลว้ลากทบัสว่นของสตูรทีแ่สดงในชอ่ง Formula Bar นี ้ตอ้งคลกิแลว้ลาก

ทบัสว่นของสตูรทีค่รบและพรอ้มจะคํานวณได ้เชน่ COUNTIF(DataRange,DataRange) แต่

ถา้ลากทบัขาดหรอืเกนิ เชน่ ลากทบั /COUNTIF(DataRange,DataRange) ซึง่มเีครือ่งหมาย

หารเกนิเขา้มาดว้ย จะทําใหเ้มือ่กดปุ่ ม F9 จะพบวา่ไมส่ามารถแกะสตูรสว่นนัน้ได ้

วธิแีกะสตูร Array วธิที ี ่2 

วธินีีใ้ชต้ารางเป็นตวัชว่ยหาผลลพัธข์องการคํานวณทลีะขัน้แสดงใหเ้ห็นไดท้นัทวีา่ หลงัจาก

คํานวณขัน้แรกเสร็จแลว้ สง่ผลไปคํานวณตอ่ในการคํานวณขัน้ถดัไปอยา่งไรและเกดิผลลพัธ์

อยา่งไร ซึง่พอคํานวณตอ่กนัไปจนเกดิผลลพัธไ์ดถ้กูตอ้งตามทีต่อ้งการแลว้ จงึนําสตูรแตล่ะขัน้

มาซอ้นกนัเป็นสตูร Array เพยีงสตูรเดยีว 
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ใหเ้ริม่จากแยกสตูร =SUM(1/COUNTIF(DataRange,DataRange)) ออกเป็นสว่นๆตามลําดบั

การคํานวณ โดยไลจ่ากสตูรทีอ่ยูภ่ายในวงเล็บในสดุออกมา 

1. Step1 เซลล ์D3 สรา้งสตูร =COUNTIF(DataRange,B3) แลว้ copy ลงมาตลอดแนว

จนถงึ เซลล ์D7 

2. ตวัเลขทีไ่ดจ้ากเซลล ์D3:D7 เป็นตวัเลขการนับวา่ขอ้มลูแตล่ะตวัมบีนัทกึไวซ้ํ้ากนักีค่รัง้

ภายใน DataRange 

3. Step2 เซลล ์E3 สรา้งสตูร =1/D3 แลว้ copy ลงมาตลอดแนวจนถงึ เซลล ์E7 

4. ตวัเลขทีไ่ดจ้ากเซลล ์E3:E7 เป็นตวัเลขคา่เฉลีย่ตอ่ตวัจากการนับวา่ขอ้มลูแตล่ะตวัมี

บนัทกึไวซ้ํ้ากนักีค่รัง้ภายใน DataRange 

5. Step3 เซลล ์F3 สรา้งสตูร =SUM(E3:E7) เพือ่หายอดรวมของคา่เฉลีย่ ไดคํ้าตอบเป็น

จํานวนของ Unique Items 

หมายเหต ุใน Step1 และ Step2 แทนทีจ่ะสรา้งสตูรลงไปในเซลล ์D3 และ E3 เพยีงเซลล์

เดยีว ใหท้ดลองสรา้งสตูรคํานวณแบบ Array ลงไปในตารางหลายเซลลพ์รอ้มกนัแทนก็ได ้

• Step1 ใหเ้ลอืกเซลล ์D3:D7 แลว้พมิพส์ตูร =COUNTIF(DataRange,DataRange) 

แลว้กดปุ่ ม Ctrl+Shift+Enter เพือ่สรา้งสตูรนีล้งไปพรอ้มกนัทเีดยีว จะพบวา่ไดคํ้าตอบ

เป็นการนับคา่ซํ้าเชน่เดยีวกนั เนือ่งจากสตูร CountIF จะใชแ้ตล่ะคา่ใน DataRange 

ตรวจสอบจํานวนการบนัทกึซํ้าจากพืน้ที ่DataRange ทัง้หมดเชน่เดยีวกบัสตูรทีนั่บแต่

ละตวั 

• Step2 ใหเ้ลอืกเซลล ์E3:E7 แลว้พมิพส์ตูร =1/D3:D7 แลว้กดปุ่ ม Ctrl+Shift+Enter 

เพือ่สรา้งสตูรนีล้งไปพรอ้มกนัทเีดยีว จะพบวา่ไดคํ้าตอบเป็นคา่เฉลีย่เชน่เดยีวกนั 
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Array คอือะไร 

บทความนีย้กความหมายของ Array มาไวต้อนหลงั เพือ่ใหเ้ห็นตวัอยา่งการใชส้ตูร Array ไว ้

กอ่นบา้ง ทําใหไ้ดเ้ห็นวา่ เรานําสตูร Array ไปใชง้านกนัอยา่งไร แลว้มนัคํานวณหาอะไร พอได ้

ผา่นการลองทํากบัมอืมาแลว้ คงพอเดากนัไดบ้า้งวา่ Array คอือะไร 

Array คอื คา่ตัง้แตส่องคา่ขึน้ไป แทนทีจ่ะใชเ้ซลลเ์ดยีวรับคา่เดยีวตามวธิปีกตทิัว่ไป เรา

สามารถใชเ้ซลลเ์ดยีวรับคา่หลายคา่ลงไปก็ได ้แทนทีจ่ะใชพ้ืน้ทีต่ารางของจรงินับรอ้ยนับพัน

เซลลเ์พือ่กรอกคา่หรอืสรา้งสตูรใหคํ้านวณตอ่ๆกนัไปทลีะขัน้ ดว้ยการใช ้Array จะชว่ยใหเ้รา

สามารถใชเ้ซลลเ์พยีงเซลลเ์ดยีวแทนพืน้ทีต่ารางขนาดใหญ ่กลายเป็นเซลลท์ีทํ่าหนา้ทีแ่ทน

ตารางของจรงิซึง่เรยีกวา่เป็นตารางในอดุมคตกิ็ได ้

คา่ตัง้แตส่องคา่ขึน้ไปจะเรยีงตามแนวนอน หรอืแนวตัง้ หรอืเรยีงตอ่กนัไปเป็นพืน้ทีต่ารางทีม่ี

ความสงูความกวา้งหลาย row หลาย column ก็ได ้โดย Excel กําหนดใหใ้ชเ้ครือ่งหมายในการ

แบง่ลําดบัของคา่ ดงันี ้

• ถา้เป็น Array ในแนวนอน ใหใ้ชเ้ครือ่งหมาย comma , คัน่ระหวา่งคา่แตล่ะคา่ เชน่ 

11,22,33 

• ถา้เป็น Array ในแนวตัง้ ใหใ้ชเ้ครือ่งหมาย semi-colon ; คัน่ระหวา่งคา่แตล่ะคา่ เชน่ 

11;22;33 

• ถา้เป็น Array ทีม่ขีนาดความสงู 2 row และมคีวามกวา้ง 3 column จะแสดงคา่ทีม่ี

เครือ่งหมาย comma และ semi-colon ผสมกนั เชน่ 1,2,3;11,22,33 โดย Array จะไล่

ลําดบัจากแนวนอน 1,2,3 กอ่นแลว้จงึใช ้; ขึน้แนวนอนถดัไปเป็น 11,22,33 

การนําคา่แบบ Array ไปใชใ้นเซลล ์ตา่งจากการใชว้ธิพีมิพ ์1,2,3 ลงไปในเซลลต์ามปกต ิโดย

ตอ้งใช ้Array แบบสตูรทีม่เีครือ่งหมายเทา่กบันําหนา้สดุเทา่นัน้ ดงันี ้

1. การใชแ้บบสตูร Array Constant เชน่ พมิพ ์={1,2,3} ลงไปในเซลลใ์ดๆ จะพบวา่

ในเซลลแ์สดงคา่แรกคอืเลข 1 เพยีงคา่เดยีว ซึง่ถา้ตอ้งการแสดงใหค้รบทกุคา่ ตอ้ง

เลอืกเซลล ์3 เซลลต์ดิกนัตามแนวนอนแลว้พมิพ ์={1,2,3} แลว้กดปุ่ ม 

Ctrl+Shift+Enter เพือ่บนัทกึ จะพบวา่สตูร ={1,2,3} ซึง่มวีงเล็บปีกกาอยูด่า้นหลงั

เครือ่งหมายเทา่กบั จะมวีงเล็บปีกกาเพิม่ดา้นหนา้เครือ่งหมายเทา่กบัอกีชัน้หนึง่เป็น {=

{1,2,3}} 
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2. การใชแ้บบสตูร Array ซึง่รบัคา่มาจากการอา้งองิกบัพืน้ทีใ่นตาราง เชน่ รับคา่ 

Array มาจากเซลลต์ามแนวนอน {=A1:C1} หรอืรับคา่ Array มาจากเซลลต์ามแนวตัง้ 

{=A1:A3} หรอืรับคา่ Array มาจากตารางขนาดความสงู 2 row และมคีวามกวา้ง 3 

column {=A1:C2} ทัง้นีโ้ปรดสงัเกตวา่วธินีีจ้ะมเีครือ่งหมายวงเล็บปีกกาแสดงไวห้นา้

เครือ่งหมายเทา่กบั แสดงวา่เป็นวงเล็บปีกกาทีเ่กดิจากการกดปุ่ ม Ctrl+Shift+Enter 

3. การใชแ้บบสตูร Array ซึง่รบัคา่มาจากสตูรทีค่นืคา่แบบ Array เชน่ 

{=Offset(A1,0,0,2,3)} ซึง่เทยีบเทา่กบัการอา้งองิมาจากเซลล ์A1:C2 เป็นตน้ 

การนําคา่แบบ Array ทัง้ 3 แบบไปใช ้ขอใหเ้ลอืกพืน้ทีต่ารางใหม้ขีนาดพอดบิพอดกีบัจํานวน

ของคา่ทีม่อียูใ่น Array หรอืใหม้ขีนาดตารางเทา่กบัจํานวนผลลพัธท์ีต่อ้งการไวก้อ่นทีจ่ะสรา้ง

สตูรลงไป กลา่วคอื ถา้ในสตูร Array คนืคา่สดุทา้ยเพยีงคา่เดยีวก็ใหส้รา้งสตูรลงไปในเซลล์

เพยีงเซลลเ์ดยีว แตถ่า้สตูร Array คนืคา่ผลลพัธท์ีม่จํีานวนคา่มากกวา่คา่เดยีว ก็ตอ้งเลอืกพืน้ที่

ตารางใหม้ขีนาดความสงูและความกวา้งเทา่กนักบัจํานวนและลําดบัคา่ทีม่อียู ่จากนัน้ใหก้ดปุ่ ม 

Ctrl+Shift+Enter ในการรับสตูร Array ลงไป จะพบวา่ Excel กระจายคา่ทีม่อียูล่งไปในพืน้ที่

ตารางทีเ่ตรยีมไวใ้หเ้ห็นไดค้รบทกุคา่ 

ตวัอยา่งการสรา้งตารางสตูรคณูแบบ Array 

 

เมือ่ตัง้ชือ่ Range Name ใหก้บัตวัเลขบนหวัตารางและขา้งตารางวา่ Top และ Left เสร็จแลว้ 

ใหท้ดลองเลอืกพืน้ทีเ่ซลล ์C3:H7 ซึง่เกนิกวา่แนวขอบเขตตารางตวัเลขทีม่ ีแลว้สรา้งสตูร 

=Top*Left แลว้กดปุ่ ม Ctrl+Shift+Enter จะไดส้ตูร Array {=Top*Left} 
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สงัเกตวา่เฉพาะพืน้ทีต่าราง C3:F5 ซึง่อยูภ่ายในขอบเขตของ Top กบั Left เทา่นัน้สามารถ

คํานวณหาผลคณูเป็นตารางสตูรคณูทีต่อ้งการ สว่นพืน้ทีน่อกเหนอืจาก C3:F5 ทีม่สีตูร Array 

จะคนืคา่เป็น Error #N/A 

จากนัน้ใหค้ลกิเซลลใ์ดก็ไดท้ีม่สีตูร {=Top*Left} แลว้กดปุ่ ม F2 ตามดว้ยปุ่ ม F9 จะแสดง

ผลลพัธเ์ป็น Array Constant {20,30,40,50;40,60,80,100;60,90,120,150} โดยผลลพัธน์ีม้ี

เครือ่งหมาย ; คัน่อยู ่2 ตวั แสดงวา่ม ี3 row เพราะมกีารขึน้ row ใหม ่2 ครัง้ และในชว่งทีค่ัน่

ดว้ย ; นัน้ มเีครือ่งหมาย , คัน่อยูช่ว่งละ 3 ตวั แสดงวา่ในแตล่ะ row มคีา่อยู ่4 column หรอือกี

นัยหนึง่แสดงวา่ พืน้ทีต่ารางทีเ่หมาะจะสรา้งสตูร {=Top*Left} ลงไปนัน้ ตอ้งมคีวามสงู 3 row 

และกวา้ง 4 column ดงันัน้หากเลอืกพืน้ทีเ่กนิกวา่ทีจํ่าเป็นก็จะไดคํ้าตอบเป็น Error #N/A 

แตถ่า้ตอ้งการหายอดรวมของผลคณูของ =Top*Left ในเซลล ์C9 ใหส้รา้งสตูร 

=SUM(Top*Left) แลว้กดปุ่ ม Ctrl+Shift+Enter จะไดส้ตูร Array {=SUM(Top*Left)} ซึง่

สาเหตทุีค่ราวนีส้รา้งสตูรลงไปในเซลล ์C9 เพยีงเซลลเ์ดยีว เพราะคําตอบของการหายอดรวมมี

เพยีงคา่เดยีวเทา่นัน้ 

เร ือ่งอืน่ๆเกีย่วกบั Array ทีค่วรทราบ 

1. ใน Excel Help เรยีกพืน้ทีใ่ดๆทีม่จํีานวนตัง้แต ่2 เซลลข์ึน้ไปวา่ Array 

2. การแกะดคูา่ทีคํ่านวณไดจ้ากสตูร Array ใหเ้ริม่จากคลกิลงไปในเซลลส์ตูรแลว้กดปุ่ ม 

F2 แลว้ตามดว้ยปุ่ ม F9 เมือ่เห็นคา่ทีคํ่านวณไดแ้ลว้ใหก้ดปุ่ ม Esc เพือ่กลับเป็นสตูร

ตามเดมิ ทัง้นีถ้า้คา่ทีแ่กะไดจ้ากสตูร Array คนืคา่หลายคา่จนเกนิกวา่ทีเ่ซลลห์นึง่จะรับ

ได ้จะพบวา่ Excel ไมย่อมแสดงคา่ใหเ้ห็น 

3. วธิคีน้หาพืน้ทีข่องสตูร Array ทีเ่กดิจากการสรา้ง

ขึน้หลายเซลลพ์รอ้มกนั ใหเ้ริม่จากคลกิเลอืก

เซลลใ์ดเซลลห์นึง่ซึง่ใชส้ตูร Array แลว้กดปุ่ ม 

F5 > Special > กาชอ่ง Current array 

 

4. บางคนกดปุ่ ม Ctrl+Shift+Enter แตไ่มไ่ด ้

เครือ่งหมายวงเล็บปีกกา เพราะไมไ่ดก้ดทัง้สาม

ปุ่ มพรอ้มกนัจรงิ ถา้อยากใหไ้ด ้{ } อยา่งแน่นอน 

ใหใ้ชม้อืซา้ยกดปุ่ ม Ctrl+Shift แชค่า้งไวก้อ่น จากนัน้ใชม้อืขวากดปุ่ ม Enter ลงไป 
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5. สตูร Array ทีเ่กดิจากการสรา้งขึน้หลายเซลลพ์รอ้มกนัโดยการกดปุ่ ม 

Ctrl+Shift+Enter จะไมส่ามารถ Insert หรอื Delete เฉพาะบางเซลล ์หากตอ้งการ

แกไ้ขหรอืลบทิง้ ตอ้งเลอืกพืน้ทีท่ัง้หมดทีใ่ชส้ตูร Array นัน้กอ่นแลว้จงึแกไ้ขสตูรหรอื

ลบสตูรทิง้ (ดงันัน้หากสามารถลบสตูร Array เพยีงเซลลเ์ดยีวได ้ยอ่มแสดงวา่เป็นสตูร 

Array ทีส่รา้งทลีะเซลล)์ 

6. สตูร Array ทีเ่ราสรา้งขึน้โดยการกดปุ่ ม 

Ctrl+Shift+Enter จะไมส่ามารถสรา้งลงไปใน

เซลลท์ีถ่กู Merge ไวก้อ่นแลว้ จะถกูเตอืนวา่ 

Array formulas are not valid in merged 

cells (แตเ่ราสามารถ Merge เซลลท์ีส่รา้งสตูร Array ไวก้อ่น) 

 

7. สตูร Array ทีเ่กดิจากการสรา้งขึน้หลายเซลลพ์รอ้มกนัโดยการกดปุ่ ม 

Ctrl+Shift+Enter จะใชเ้วลาคํานวณเร็วกวา่การสรา้งสตูรคํานวณเพือ่หาคําตอบทลีะ

เซลลแ์ยกจากกนั 

8. สตูร Array ทีเ่ราสรา้งขึน้โดยการกดปุ่ ม Ctrl+Shift+Enter ทัง้ทีส่รา้งในเซลลเ์ดยีวหรอื

หลายเซลลพ์รอ้มกนั จะใชเ้วลาคํานวณชา้กวา่สตูรสําเร็จรปูทีม่อียูใ่น Excel ดงันัน้จงึ

แนะนําใหใ้ชส้ตูร Array ตอ่เมือ่ไมม่สีตูรสําเร็จรปูอืน่ซึง่สามารถคํานวณหาคําตอบที่

ตอ้งการไดแ้ลว้เทา่นัน้ 

9. ใน Excel รุน่ 2003 และรุน่เกา่กอ่นนัน้ สตูร Array ทีเ่ราสรา้งขึน้โดยการกดปุ่ ม 

Ctrl+Shift+Enter จะไมย่อมรับการอา้งองิพืน้ทีต่ารางทีม่ขีนาดใหญเ่ต็มความสงูทัง้ 

65,536 row ของตาราง เชน่  

{=MIN(IF(A:A<>0,ROW(A:A)))} หรอื  

{=MIN(IF(A1:A65536<>0,ROW(A1:A65536)))}  

แตถ่า้แกเ้ป็น {=MIN(IF(A1:A65535<>0,ROW(A1:A65535)))} จะใชไ้ด ้

10. นอกจากสตูร Array ทีเ่ราสรา้งขึน้โดยการกดปุ่ ม Ctrl+Shift+Enter แลว้ ใน Excel ยงัมี

สตูรสําเร็จรปูอืน่อกีทีทํ่างานแบบ Array โดยไมต่อ้งกดปุ่ ม Ctrl+Shift+Enter เชน่ สตูร 

SumIF, CountIF, SumIFs, CountIFs, AverageIfs, SumProduct ซึง่ถา้พจิารณาตาม

หลกัการแลว้สตูรใดก็ตามซึง่รับคา่จากเซลลต์ัง้แต ่2 เซลลข์ึน้ไปได ้ยอ่มเป็นสตูรที่

ทํางานแบบ Array จงึยงัมสีตูรอกีมากทีส่ามารถทํางานแบบ Array ได ้เชน่ สตูร Sum, 

Max, Min, And, Or, Index, หรอื Offset เป็นตน้ 
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11. SumIFs, CountIFs, AverageIfs เป็นสตูรทีเ่กดิขึน้ใน Excel 2007 เป็นตน้มา ดงันัน้

หากยงัจําเป็นตอ้งใช ้Excel 2003 หรอืรุน่เกา่กวา่นีอ้ยูอ่กี แนะนําใหห้ลกีเลีย่งสตูร 

SumIFs, CountIFs, AverageIfs ไปกอ่น โดยหนัไปใชส้ตูร Sum-IF-Array, Count-

IF-Array, Average-If-Array ซึง่สามารถใชง้านใน Excel ไดท้กุรุน่ แตจํ่าเป็นตอ้งสรา้ง

โดยการกดปุ่ ม Ctrl+Shift+Enter 

12. Max, Min, And, Or เมือ่นํามาใชแ้บบ Array จะไมส่ามารถคนืคา่หลายคา่แบบ Array 

เชน่ ถา้สรา้ง {=Max(RangeA,RangeB)} จะไมไ่ดคํ้าตอบเป็นคา่สงูสดุของแตล่ะ

ตําแหน่งใน RangeA เมือ่นํามาเทยีบกบัแตล่ะตําแหน่งใน RangeB แตจ่ะไดคํ้าตอบเป็น

คา่สงูสดุเพยีงคา่เดยีวจากคา่ทัง้หมดใน RangeA และ RangeB 

13. สตูร Array บางสตูรไมส่ามารถหาคําตอบมาแสดงใหเ้ห็นในเซลล ์แตถ่า้นําสตูรนัน้ไป

ซอ้นในสตูรอืน่จะสามารถทํางานรว่มกบัสตูรอืน่ได ้

14. สตูร Array ทีค่นืคา่คําตอบหลายคา่ ไมค่วรสรา้งสตูรนัน้ลงไปในเซลลเ์ดยีวเพราะจะได ้

คําตอบไมค่รบทัง้หมดหรอืไดคํ้าตอบ error  

15. ถา้สรา้งสตูร Array ทีค่นืคา่คําตอบหลายคา่ ลงไปในเซลลเ์ดยีวในแนวเดยีวกบัคําตอบ

จากตารางฐานขอ้มลู จะไดคํ้าตอบจากเซลลใ์นแนวคูข่นานกบัตําแหน่งเซลลท์ีส่รา้งสตูร

ลงไป ซึง่ถอืเป็นความบงัเอญิเทา่นัน้ ถา้ยา้ยสตูรไปนอกแนวคูข่นานจะไดคํ้าตอบ error 

 

16. ถา้สรา้งสตูร Array ลงไปในตารางหลายเซลลพ์รอ้มกนั จะพบวา่ในการสรา้งสตูรตอนที่

คลกิเลอืกพืน้ทีเ่ซลลท์ีเ่คยตัง้ชือ่ Range Name ไวก้อ่นนัน้ Excel จะไมย่อมนําชือ่ 

Range Name มาใสใ่หใ้นสตูร เชน่ เดมิตัง้ชือ่เซลล ์B4:B8 วา่ DataRange จากนัน้เมือ่

เลอืกเซลลอ์ืน่ใดเพือ่จะสรา้งสตูรลงไปพรอ้มกนั พอพมิพ ์= แลว้คลกิเลอืกเซลล ์B4:B8 

จะไมไ่ดช้ือ่ DataRange มาใสใ่นสตูร แตจ่ะไดตํ้าแหน่งเซลล ์B4:B8 แสดงในสตูร

เหมอืนวา่ไมเ่คยมชีือ่ DataRange ตัง้ไวก้อ่นแตอ่ยา่งใด หากตอ้งการนําชือ่ Range 

Name มาใสใ่นสตูร ใหก้ดปุ่ ม F3 เพือ่เลอืกชือ่ทีต่อ้งการมาใชแ้ทนการคลกิเลอืกเซลล ์
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17. ถา้อยากจะเกง่ Excel ใหท้ดลองสรา้งสตูรกบัตารางขนาดเล็กใหผ้า่นกอ่น แลว้ใหล้อง

กดปุ่ ม Enter ตามธรรมดาบา้ง หรอืกดปุ่ ม Ctrl+Shift+Enter บา้ง เพราะบางครัง้จะได ้

คําตอบตา่งไปจากเดมิ 

18. ไมค่วรปลอ่ยใหค้นทีไ่มรู่จั้กวธิสีรา้งสตูร Array ทีส่รา้งขึน้โดยการกดปุ่ ม 

Ctrl+Shift+Enter มาแกไ้ขแฟ้มทีม่สีตูร Array เพราะเขาจะกดปุ่ ม Enter แทนแลว้อาจ

ทําใหไ้ดคํ้าตอบผดิเพีย้นไปหรอืไดคํ้าตอบ error ขึน้มาแทน 
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สตูร Array IF  

เพือ่ใชห้ายอดรวมแยกประเภท 

สตูร Array IF เพือ่ใชห้ายอดรวมแยกประเภท ถอืเป็นสตูรทีสํ่าคญัเป็นอยา่งยิง่และเป็นสตูรทีใ่ช ้

บอ่ยทีส่ดุสตูรหนึง่ทเีดยีว จนใน Excel 2007 เป็นตน้มาบรษัิทไมโครซอฟทไ์ดเ้พิม่สตูร 

SumIFs, CountIFs, และ AverageIFs เพือ่ตอบสนองตอ่ความตอ้งการของผูใ้ช ้เพราะใน 

Excel รุน่กอ่นนัน้มเีพยีงสตูร SumIF และ CountIF ซึง่ไมส่ามารถรับเงือ่นไขในการคํานวณเกนิ

กวา่ 1 เงือ่นไข 

แตถ่า้คณุนําแฟ้มทีใ่ชส้ตูร SumIFs, CountIFs, และ AverageIFs ไปเปิดดว้ย Excel 2003 

หรอืรุน่เกา่กวา่ จะพบวา่สตูรใหมเ่หลา่นีไ้มทํ่างานเพราะ Excel รุน่ทีจ่ะใชส้ตูรใหมไ่ดก้็ตอ้งเป็น 

Excel รุน่ใหมเ่ชน่กนั 

บทความนีจ้ะแนะนําแนวทางการสรา้งสตูร Array IF วา่มทีีไ่ปทีม่าอยา่งไร เพือ่ชว่ยใหส้ามารถ

สรา้งสตูรหายอดรวมแยกประเภทไดโ้ดยไมจํ่าเป็นตอ้งอาศยัสตูร SumIFs, CountIFs, และ 

AverageIFs แตอ่ยา่งใด แลว้เมือ่คณุทราบหลกัการทํางานของการใช ้Array IF หรอื Array 

แบบเงือ่นไข ยงัจะชว่ยใหส้ามารถนําไปพัฒนาสรา้งสตูรหาคําตอบประเภทอืน่ๆไดไ้มย่าก 

สตูร Array IF คอือะไร 

สตูร Array IF คอื สตูร IF ทีทํ่าหนา้ทีต่รวจสอบคา่หลายคา่วา่ตรงตามเงือ่นไขทีกํ่าหนดหรอืไม ่

โดยจะไดผ้ลลพัธจ์ากการตรวจสอบเป็น True หรอื False หลายคา่ตามลําดบัตําแหน่งของคา่ที่

ใช ้ซึง่ตา่งจากสตูร IF ธรรมดาทีม่กีารตรวจสอบคา่เพยีงคา่เดยีวและเกดิผลลพัธเ์ป็น True หรอื 

False อยา่งใดอยา่งหนึง่เพยีงคา่เดยีว 

โดยลําพังของสตูร Array IF จะไมส่ามารถหายอดรวมแยกประเภทได ้แตเ่มือ่นําผลลพัธ ์True 

หรอื False ทีไ่ดนั้น้ไปเทยีบกบั Array ของตวัเลขคําตอบทีต่อ้งการ จะทําใหเ้ราสามารถเลอืก

เก็บตวัเลขเฉพาะตําแหน่งคา่ทีต่รงกบัตําแหน่งของ True แลว้จงึนําผลทีไ่ดไ้ปหายอดรว่มกบั

สตูรอืน่ๆก็จะกลายเป็นสตูร Array เพือ่หาคา่ตามสตูรนัน้ๆ เชน่ เมือ่นําผลทีไ่ดห้ลงัจากการเทยีบ

ตําแหน่ง True/False ไปซอ้นในสตูร Sum ก็จะกลายเป็นสตูร Array Sum IF ซึง่หายอดรวม
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แยกประเภท หรอืถา้ซอ้นในสตูร Average ก็จะกลายเป็นสตูร Array Average IF ซึง่หาคา่เฉลีย่

แยกประเภท 

โครงสรา้งของสตูร Array IF ประกอบดว้ย 2 สว่นใหญ่ๆ  ซึง่โดยทัว่ไปทัง้ 2 สว่นตอ้งมขีนาด

ความสงูความกวา้งของ Array เทา่กนั กลา่วคอื 

1. สว่นของ Array ทีทํ่าหนา้ทีค่นืคา่ True หรอื False 

2. สว่นของ Array ทีเ่ป็นตวัเลขหรอืคา่คําตอบเรือ่งทีต่อ้งการ 

(ในเบือ้งตน้ขอใหจํ้าไวว้า่ขนาด Array ทัง้สองสว่นนีต้อ้งมขีนาดเทา่กนั ซึง่ทีจ่รงิแลว้ขอเพยีงวา่

มขีนาดความสงูหรอืขนาดความกวา้งดา้นใดดา้นหนึง่เทา่กนัก็ใชไ้ดแ้ลว้) 

การใชส้ตูร Array IF แบบเงือ่นไขเดยีว 

 

โปรดสงัเกตวา่ใน Range ID มรีหสั a001 และ a002 เป็นรายการทีบ่นัทกึซํ้า ซึง่ถา้มรีหสัไมซ่ํ้า

แลว้ตอ้งการหายอด Amount ของ a001 จะสามารถหาคําตอบโดยใชส้ตูร Vlookup ไดท้นัท ี

แตเ่มือ่มรีายการซํ้า ถา้ใชส้ตูร Vlookup ก็จะไดย้อดของ a001 รายการแรกเพยีงรายการเดยีว 

หากตอ้งการหายอดรวม Amount ของ a001 หรอืจะแยกหายอดแตล่ะรายการทีซ่ํ้าของ a001 

ก็ตอ้งอาศยัสตูรคํานวณแบบ Array มาชว่ย 

ถา้ไมใ่ชส้ตูร Array IF จะหายอดรวม Amount ของรหสั a001 จากการคํานวณทลีะขัน้ได ้

อยา่งไร 
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1. เพือ่ทําใหต้ารางแสดงเฉพาะพืน้ทีซ่ ึง่เกีย่วขอ้งกบัการคํานวณเทา่นัน้ จงึขอลบพืน้ทีส่ว่น

ของ Num และ Name ทิง้ไป แลว้ Insert เพิม่ column C และ E มาใชคํ้านวณทลีะขัน้ 

2. ตัง้ชือ่ Check ใหก้บัเซลล ์C3:C7 แลว้สรา้งสตูร =Id=$G$3 จะพบวา่ไดคํ้าตอบเป็น 

TRUE; FALSE; TRUE; FALSE; FALSE ตามลําดบั โดยตําแหน่งทีเ่ป็น True คอื

ตําแหน่งของรหสั a001 น่ันเอง 

3. เซลล ์E3:E7 สรา้งสตูร =IF(Check,Amount,0) จะพบวา่ถา้ตําแหน่งใดใน Check มคีา่

เทา่กบั True สตูร IF นีจ้ะเก็บคา่ Amount มาใชต้ามเดมิ แตถ่า้ไมใ่ชจ่ะใสค่า่ 0 แทน 

4. เซลล ์E8 สรา้งสตูร =SUM(E3:E7) ไดคํ้าตอบเทา่กบั 40 ซึง่เป็นยอดรวมแยกประเภท

ของรหสั a001 ตามตอ้งการ 

แทนทีจ่ะตอ้งสรา้งตารางเพิม่เตมิเพือ่คํานวณทลีะขัน้ เราสามารถลดัหาคําตอบยอดรวมแยก

ประเภทของรหสั a001 ทีต่อ้งการโดยพจิารณาแยกพืน้ทีต่ารางเป็น 2 สว่น 
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1. Id เป็นสว่นของ Array ทีทํ่าหนา้ทีค่นืคา่ True หรอื False จากการนําไปเปรยีบเทยีบคา่

กบัรหสัทีต่อ้งการ 

2. Amount เป็นสว่นของ Array ทีเ่ป็นตัวเลขหรอืคา่คําตอบเรือ่งทีต่อ้งการ 

จากนัน้เราสามารถหาคําตอบยอดรวมแยกประเภทของรหสั a001 ซึง่บนัทกึไวใ้นเซลล ์G3 เป็น

เซลลสํ์าหรับใสร่หสัทีต่อ้งการ แลว้ใชส้ตูรตอ่ไปนีห้าผลลพัธท์ีต่อ้งการ 

1. สตูร SUMIF โดยใชส้ตูร =SUMIF(Id,$G$3,Amount) หรอื 

2. สตูร Array SumIF โดยใชส้ตูร { =SUM(IF(Id=$G$3,Amount))} โดยตอ้งกดปุ่ ม 

Ctrl+Shift+Enter ดว้ยจงึจะเกดิวงเล็บปีกกา { } ปิดหวัทา้ยสตูร หรอื 

3. สตูร SumArray โดยใชส้ตูร { =SUM((Id=$G$3)*Amount)} โดยตอ้งกดปุ่ ม 

Ctrl+Shift+Enter ดว้ยจงึจะเกดิวงเล็บปีกกา { } ปิดหวัทา้ยสตูร หรอื 

4. สตูร SumProduct โดยใชส้ตูร =SUMPRODUCT((Id=$G$3)*Amount) โดยไม่

ตอ้งกดปุ่ ม Ctrl+Shift+Enter ดว้ยแตอ่ยา่งใด 

สตูรทัง้สีแ่บบใชห้ลกัการคํานวณแบบเดยีวกนั คอื 

1. Id เป็นสว่นของ Array ทีทํ่าหนา้ทีค่นืคา่ True หรอื False จากการนําไปเปรยีบเทยีบคา่

กบัรหสั a001 ทีต่อ้งการ จะคนืคา่ออกมาเป็น Array  

{TRUE;FALSE;TRUE;FALSE;FALSE} 

2. Amount เป็นสว่นของ Array ทีเ่ป็นตัวเลขหรอืคา่คําตอบเรือ่งทีต่อ้งการ 

{10;20;30;40;50} 

3. เมือ่นํา Array {TRUE;FALSE;TRUE;FALSE;FALSE} มาเทยีบตําแหน่งกบั Array 

{10;20;30;40;50} จะได ้Array ตวัเลขเฉพาะตวัเลขคําตอบทีต่อ้งการออกมาเป็น  

{10;FALSE;30;FALSE;FALSE} 

4. จากนัน้เมือ่นําผล {10;FALSE;30;FALSE;FALSE} ไปหายอดรวมดว้ยสตูร Sum จงึหา

คําตอบเป็น 40 ตามตอ้งการ 

แมว้า่สตูรทัง้สีแ่บบนีจ้ะหาผลลพัธท์ีต่อ้งการไดเ้ชน่เดยีวกนัก็ตาม แตข่อใหพ้จิารณาเลอืกใชใ้ห ้

เหมาะสมกบังาน กลา่วคอื 

1. สตูร SUMIF ใหใ้ชก้บัโจทยท์ีง่า่ยไปตลอดเพราะสตูรนีรั้บเงือ่นไขไดเ้พยีงเงือ่นไข

เดยีว และสตูรนีใ้ชเ้วลาคํานวณเร็วทีส่ดุในบรรดาสีส่ตูรทีก่ลา่วถงึอยูน่ี ้
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2. สตูร Array SumIF สตูรนีเ้ป็นสตูรพเิศษ เพราะเราสามารถเปลีย่นสตูร Sum ดา้นหนา้

ไปเป็นสตูร Average, Count, Max, Min, หรอื Small เพือ่หายอดอืน่ๆตามสตูรทีใ่ช ้

แทนนัน้ และถา้มหีลายเงือ่นก็สามารถซอ้น IF เขา้ไปไดอ้กี 

 

{ =SUM(IF(Id=$G$3,Amount))} หายอดรวมของ a001 ไดเ้ทา่กบั 40 

{ =AVERAGE(IF(Id=$G$3,Amount))} หาคา่เฉลีย่ของ a001 ไดเ้ทา่กบั 20 

{ =COUNT(IF(Id=$G$3,Amount))} นับยอดของ a001 ไดเ้ทา่กบั 2 

{ =MAX(IF(Id=$G$3,Amount))} หายอดสงูสดุของ a001 ไดเ้ทา่กบั 30 

{ =MIN(IF(Id=$G$3,Amount))} หายอดตํา่สดุของ a001 ไดเ้ทา่กบั 10 

3. สตูร SumArray เป็นสตูรทีผ่มนยิมใชเ้พราะใชม้านานและพบวา่สามารถหาคําตอบที่

ตอ้งการไดเ้สมอแมจ้ะลงิคข์า้มแฟ้มมาจากแฟ้มทีไ่มไ่ดเ้ปิดก็ยังทํางานได ้และถา้มี

หลายเงือ่นไข การใชว้งเล็บหลายๆชดุชว่ยตรวจสอบเงือ่นไขยังงา่ยกวา่ทีจ่ะใชส้ตูร IF 

ซอ้นกนัเขา้ไป 

4. สตูร SumProduct เป็นสตูรยอดนยิมของคนทัว่ไปเพราะไมจํ่าเป็นตอ้งกดปุ่ ม 

Ctrl+Shift+Enter ดว้ยแตอ่ยา่งใด ซึง่แทจ้รงิแลว้โครงสรา้งภายในวงเล็บของสตูรนีก้็

เหมอืนกบัของสตูร SumArray น่ันเอง 

เร ือ่งแปลกของ True กบั False 

คณุควรทราบลกัษณะสําคญัของคา่ True หรอื False เพิม่เตมิกอ่นทีจ่ะเรยีนรูว้ธิใีชส้ตูร Array 

IF แบบหลายเงือ่นไข กลา่วคอื Excel ถอืวา่คา่ True มคีา่เทา่กบั 1 และคา่ False มคีา่เทา่กบั 

0 ซึง่เราจะเห็นคา่เหลา่นีไ้ดช้ดั ตอ่เมือ่นําคา่ True หรอื False มาคาํนวณตอ่  

แตถ่า้นําคา่ True ทีไ่ดไ้ปเทยีบตรงๆกบัเลข 1 วา่เทา่กนัหรอืไม ่จะพบวา่ True ไมเ่ทา่กบั 1 

และถา้นําคา่ False ทีไ่ดไ้ปเทยีบตรงๆกบัเลข 0 วา่เทา่กนัหรอืไม ่จะพบวา่ False ไมเ่ทา่กบั 0 
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จากภาพตวัอยา่งนี ้เซลล ์B2 มคีา่ =TRUE() จากนัน้เรามาทดสอบคา่ของ B2 กนั จะพบวา่ใน

เซลล ์C2 เมือ่นํามาเทยีบคา่กนัโดยตรง ซึง่มสีตูร =B2=1 บอกเราวา่ False แสดงวา่ True 

ไมไ่ดเ้ทา่กบั 1 แตเ่มือ่นําคา่จาก B2 ไปคํานวณตอ่ในเซลล ์C3:C8 ไมว่า่จะนํา B2 ไป *1, /1, 

+0, -0, หรอืใสเ่ครือ่งหมายลบลบไวข้า้งหนา้ หรอืนําไปคณูกบั TRUE() จะกระตุน้ใหแ้สดงคา่

เทา่กบัเลข 1 ออกมาใหเ้ห็น 

ทํานองเดยีวกนั เซลล ์G2 มคีา่ =FALSE() จากนัน้เรามาทดสอบคา่ของ G2 กนั จะพบวา่ใน

เซลล ์H2 เมือ่นํามาเทยีบคา่กนัโดยตรง ซึง่มสีตูร =G2=0 บอกเราวา่ False แสดงวา่ False 

ไมไ่ดเ้ทา่กบั 0 แตเ่มือ่นําคา่จาก G2 ไปคํานวณตอ่ในเซลล ์H3:H8 ไมว่า่จะนํา G2 ไป *1, /1, 

+0, -0, หรอืใสเ่ครือ่งหมายลบลบไวข้า้งหนา้ หรอืนําไปคณูกบั TRUE() จะกระตุน้ใหแ้สดงคา่

เทา่กบัเลข 0 ออกมาใหเ้ห็น 

ดงันัน้ถา้เราม ีArray ซึง่มคีา่ True หรอื False แลว้นําไปบวกหรอืคณูกบั Array อืน่ทีม่คีา่เป็น

ตวัเลขหรอืมคีา่เป็น True หรอื False ก็ตาม ยอ่มเหมอืนกบันําเลข 1 หรอืเลข 0 ไปบวกหรอืคณู

กบัคา่อืน่น่ันเอง โปรดดขูอ้พสิจูนจ์ากรปูตอ่ไปนี ้

 

Array ทีม่เีลข 1 และ 0 จากการบวกหรอืคณูนีแ่หละทีช่ว่ยทําใหเ้ราหายอดรวมแยกประเภท

ตอ่ไปได ้
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การใชส้ตูร Array IF แบบหลายเงือ่นไข 

กรณี Range ทีใ่ชต้รวจสอบเงือ่นไขมาจากเรือ่งเดยีวกนั ใหใ้ชบ้วก 

 

ใหห้ายอดรวม Amount ของรหสั Id a001 กบั a002 (ทัง้นีท้ีเ่รยีกวา่ เป็นเรือ่งเดยีวกนัเพราะ

เงือ่นไขเป็นเรือ่งของรหสัเชน่กนัทัง้คู)่ โดยบนัทกึรหสัทีต่อ้งการใหใ้ชเ้ป็นรหสัทีค่น้หาไวท้ี่

เซลล ์G3 และ H3 ตามลําดบั ซึง่สามารถใชส้ตูรหาคําตอบเป็นยอดรวม 110 ไดห้ลายวธิ ีดงันี ้

1. ใชส้ตูร {=SUM(IF(Id=G3, Amount, IF(Id=H3,Amount,0) ))} 

 

โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพือ่สรา้งเครือ่งหมายวงเล็บปีกกา { } ปิดหวัทา้ย

สตูร ถา้แกะสตูร IF(Id=G3, Amount, IF(Id=H3,Amount,0) ) โดยการคลกิลากทบั

สว่นของสตูรนีแ้ลว้กดปุ่ ม F9 จะได ้Array {10;20;30;0;50} ซึง่เปลีย่นคา่ Amount 

ของรหสัอืน่ทีไ่มเ่ทา่กบั a001 หรอื a002 ใหเ้ทา่กบั 0 แทน 

2. ใชส้ตูร { =SUM(  ((Id=G3)+(Id=H3))  *Amount) } 

 

โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพือ่สรา้งเครือ่งหมายวงเล็บปีกกา { } ปิดหวัทา้ย

สตูร ถา้แกะสตูร ((Id=G3)+(Id=H3)) โดยการคลกิลากทบัสว่นของสตูรนีแ้ลว้กดปุ่ ม 

F9 จะได ้Array {1;1;1;0;1} โดยมเีลข 1 ตรงกบัตําแหน่งของรหสัทีต่อ้งการ  

ถา้แกะทีม่าของเงือ่นไข (Id=G3) จะได ้Array ของ 

{TRUE;FALSE;TRUE;FALSE;FALSE} ทีนํ่ามาบวกกบั (Id=H3) ซึง่เป็น Array ของ 

{FALSE;TRUE;FALSE;FALSE;TRUE} ทําใหไ้ด ้Array  

{1;1;1;0;1}  
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และเมือ่นํา {1;1;1;0;1} คณูกบั Array ของ Amount {10;20;30;40;50} 

จะได ้Array {10;20;30;0;50} ซึง่รวมคา่ทัง้หมดไดเ้ทา่กบั 110 ตามตอ้งการ 

3. ใชส้ตูร =SUMPRODUCT(  ((Id=G3)+(Id=H3))  *Amount) 

 

โดยมหีลกัการคํานวณแบบเดยีวกบัวธิทีีส่อง แตไ่มต่อ้งอาศยั { } 

เพือ่ชว่ยทําใหม้องเห็นลําดบัการคํานวณไดช้ดัเจนขึน้ ขอใหด้ภูาพตอ่ไปนีแ้ลว้ดหูลกัการ

คํานวณทลีะขัน้จาก column ซา้ยไปขวา 

 

• Column ที ่1 เป็นรหสั Id จะพบวา่มรีหสั a001 กบั a002 อยู ่4 รายการ 

• Column ที ่2 ตรวจสอบรหสั Id a001 จะพบวา่มรีหสั a001 อยู ่2 รายการ โดยถา้มอง

ตําแหน่งทีเ่ป็นรหสัทีต่อ้งการเป็นเลข 1 และตําแหน่งทีไ่มใ่ชเ่ป็นเลข 0  

จะไดเ้ลข 1, 0, 1, 0, 0 ตามลําดบัจากบนมาลา่ง 

• Column ที ่3 ตรวจสอบรหสั Id a002 จะพบวา่มรีหสั a002 อยู ่2 รายการ โดยถา้มอง

ตําแหน่งทีเ่ป็นรหสัทีต่อ้งการเป็นเลข 1 และตําแหน่งทีไ่มใ่ชเ่ป็นเลข 0  

จะไดเ้ลข 0, 1, 0, 0, 1 ตามลําดบัจากบนมาลา่ง 

• Column ที ่4 เป็นผลรวมเมือ่นํา Column ที ่2 มารวมกบั Column ที ่3  

จะไดเ้ลข 1, 1, 1, 0, 1 ตามลําดบัจากบนมาลา่ง แสดงตําแหน่งของรหสั a001 กบั 

a002 ณ ตําแหน่งทีต่รงกบัเลข 1 

• Column ที ่5 เป็นตวัเลข Amount ทัง้หมด 

• Column ที ่6 เป็นผลคณูเมือ่นํา Column ที ่4 มารวมกบั Column ที ่5 

จะไดเ้ลข 10, 20, 30, 0, 50 ตามลําดบัจากบนมาลา่ง ซึง่รวมเทา่กบั 110 
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การใชส้ตูร Array IF แบบหลายเงือ่นไข 

กรณี Range ทีใ่ชต้รวจสอบเงือ่นไขมาจากตา่งเรือ่งกนั ใหใ้ชค้ณู 

 

ใหห้ายอดรวม Amount ของรหสั Id a001 เฉพาะรายการทีม่ ีName เทา่กบั c (ทัง้นีท้ีเ่รยีกวา่ 

เป็นตา่งเรือ่งกนั เพราะเงือ่นไขรหสัตา่งจากเงือ่นไขชือ่) โดยบนัทกึรหสัทีต่อ้งการใหใ้ชเ้ป็นรหสั

และชือ่ทีค่น้หาไวท้ีเ่ซลล ์G3 และ H3 ตามลําดบั ซึง่สามารถใชส้ตูรหาคําตอบเป็นยอดรวม 30 

ไดห้ลายวธิ ีดงันี ้

1. ใชส้ตูร { =SUM(IF(Id=G3, IF(Name=H3,Amount,0), 0 ))} 

 

โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพือ่สรา้งเครือ่งหมายวงเล็บปีกกา { } ปิดหวัทา้ย

สตูร ถา้แกะสตูร IF(Id=G3, IF(Name=H3,Amount,0), 0 ) โดยการคลกิลากทบัสว่น

ของสตูรนีแ้ลว้กดปุ่ ม F9 จะได ้Array {0;0;30;0;0} ซึง่เปลีย่นคา่ Amount ของรหสั

อืน่ทีไ่มเ่ทา่กบั a001 และชือ่ไมใ่ช ่c ใหเ้ทา่กบั 0 แทน 

2. ใชส้ตูร { =SUM(  (Id=G3)*(Name=H3)  *Amount) } 

 

โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพือ่สรา้งเครือ่งหมายวงเล็บปีกกา { } ปิดหวัทา้ย

สตูร ถา้แกะสตูร (Id=G3)*(Name=H3) โดยการคลกิลากทบัสว่นของสตูรนีแ้ลว้กดปุ่ ม 

F9 จะได ้Array {0;0;1;0;0} โดยมเีลข 1 ตรงกบัตําแหน่งรายการทีต่อ้งการ  
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ถา้แกะทีม่าของเงือ่นไข (Id=G3) จะได ้Array ของ 

{TRUE;FALSE;TRUE;FALSE;FALSE} นํามาคณูกบั (Name=H3) ซึง่เป็น Array ของ 

{FALSE;FALSE;TRUE;FALSE;FALSE} ทําใหไ้ด ้Array  

{0;0;1;0;0} 

และเมือ่นํา {0;0;1;0;0} คณูกบั Array ของ Amount {10;20;30;40;50} 

จะได ้Array {0;0;30;0;0} ซึง่รวมคา่ทัง้หมดไดเ้ทา่กบั 30 ตามตอ้งการ 

3. ใชส้ตูร =SUMPRODUCT(  (Id=G3)*(Name=H3)  *Amount) 

 

โดยมหีลกัการคํานวณแบบเดยีวกบัวธิทีีส่อง แตไ่มต่อ้งอาศยั { } 

4. ใชส้ตูร =SUMIFS(Amount,Id,G3,Name,H3) เป็นสตูรทีเ่กดิขึน้ใน Excel 2007 

เป็นตน้มา 

เพือ่ชว่ยทําใหม้องเห็นลําดบัการคํานวณไดช้ดัเจนขึน้ ขอใหด้ภูาพตอ่ไปนีแ้ลว้ดหูลกัการ

คํานวณทลีะขัน้จาก column ซา้ยไปขวา 

 

• Column ที ่1 เป็นรหสั Id จะพบวา่มรีหสั a001 อยู ่2 รายการ 

• Column ที ่2 ตรวจสอบรหสั Id a001 จะพบวา่มรีหสั a001 อยู ่2 รายการ โดยถา้มอง

ตําแหน่งทีเ่ป็นรหสัทีต่อ้งการเป็นเลข 1 และตําแหน่งทีไ่มใ่ชเ่ป็นเลข 0  

จะไดเ้ลข 1, 0, 1, 0, 0 ตามลําดบัจากบนมาลา่ง 

• Column ที ่3 เป็นชือ่ Name จะพบวา่มชีือ่ c อยู ่1 รายการ 

• Column ที ่4 ตรวจสอบชือ่ Name c จะพบวา่มชีือ่ Name c อยู ่1 รายการ โดยถา้มอง

ตําแหน่งทีเ่ป็นรหสัทีต่อ้งการเป็นเลข 1 และตําแหน่งทีไ่มใ่ชเ่ป็นเลข 0  

จะไดเ้ลข 0, 0, 1, 0, 0 ตามลําดบัจากบนมาลา่ง 
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• Column ที ่5 เป็นผลคณูเมือ่นํา Column ที ่2 มาคณูกบั Column ที ่4  

จะไดเ้ลข 0, 0, 1, 0, 0 ตามลําดบัจากบนมาลา่ง แสดงตําแหน่งของรหสั a001 มชีือ่ 

Name c ณ ตําแหน่งทีต่รงกบัเลข 1 

• Column ที ่6 เป็นตวัเลข Amount ทัง้หมด 

• Column ที ่7 เป็นผลคณูเมือ่นํา Column ที ่5 มาคณูกบั Column ที ่6 

จะไดเ้ลข 0, 0, 30, 0, 0 ตามลําดบัจากบนมาลา่ง ซึง่รวมเทา่กบั 30 

วธิพีลกิแพลงสตูร SumProduct 

สตูร SumProduct เป็นสตูรทีทํ่างานแบบ Array อยูใ่นตวั มหีนา้ทีนํ่า Range ของตวัเลขแตล่ะ

ตําแหน่งจากตารางทีม่ขีนาดเทา่กนั มาคณูกนัทลีะเซลลต์ามตําแหน่งทีต่รงกนั จากนัน้จงึบวก

รวมผลคณูทีไ่ดนั้น้เขา้ดว้ยกนั  

ตวัอยา่ง เชน่ เราตอ้งการหามลูคา่ตน้ทนุรวมของสนิคา้ โดยนําตน้ทนุตอ่หน่วยมาคณูกบัจํานวน

หน่วย ซึง่หากไมรู่จั้กสตูร SumProduct ก็ตอ้งนํา Cost*Quantity ทลีะรายการ เพือ่ใหไ้ด ้

ตวัเลข Total ตาม Column D จากนัน้จงึสรา้งสตูรในเซลล ์F2 =SUM(D3:D5) จงึจะไดย้อด

รวมตน้ทนุทัง้หมด 

 

ซึง่แทนทีจ่ะตอ้งเสยีพืน้ทีคํ่านวณหา Total ใน Column D เราสามารถใชส้ตูร SumProduct ลดั

หาตน้ทนุรวมไดโ้ดยใชส้ตูรตามนี ้

1. =SUMPRODUCT(Cost, Quantity) เป็นการใชส้ตูรตามโครงสรา้งปกต ิโดยใช ้

เครือ่งหมาย comma , คัน่แตล่ะ Range ในสตูร หรอื 

2. =SUMPRODUCT(Cost*Quantity) เป็นสตูรทีนํ่าแตล่ะ Range มาคณูกนัเลย ซึง่

การสรา้งแบบคณูกนันี ้จะชว่ยใหเ้ราสามารถคลกิลากทบัการคํานวณในวงเล็บแลว้กดปุ่ ม 

F9 เพือ่เห็นผลการคณูกนัของแตล่ะตําแหน่งไดด้ว้ย 
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จากนัน้ ขอยอ้นกลบัไปเรือ่งโครงสรา้งภายในสตูร Array IF ตามทีอ่ธบิายไวแ้ลว้วา่ โครงสรา้ง

ของสตูร Array IF ประกอบดว้ย 2 สว่นใหญ่ๆ  ซึง่โดยทัว่ไปทัง้ 2 สว่นตอ้งมขีนาดความสงูความ

กวา้งของ Array เทา่กนั กลา่วคอื 

1. สว่นของ Array ทีทํ่าหนา้ทีค่นืคา่ True หรอื False 

2. สว่นของ Array ทีเ่ป็นตวัเลขหรอืคา่คําตอบเรือ่งทีต่อ้งการ 

ขอนําสตูร =SUMPRODUCT(  (Id=G3)*(Name=H3)  *Amount) มาวเิคราะหแ์ยก

โครงสรา้งขา้งตน้ จะพบวา่ 

1. สว่นของ Array ทีทํ่าหนา้ทีค่นืคา่ True หรอื False ไดแ้ก ่สว่นของ (Id=G3) และ 

(Name=H3)  ซึง่นํามาคณูกนัเพือ่ทําใหเ้ปลีย่น True เป็นเลข 1 และเปลีย่น False เป็น

เลข 0 

2. สว่นของ Array ทีเ่ป็นตวัเลขหรอืคา่คําตอบเรือ่งทีต่อ้งการ ไดแ้กส่ว่นของ Amount 

ดงันัน้หากตอ้งการปรับสตูรใหคํ้านวณนับแทนการหายอดรวมของ Amount โดยใหนั้บวา่มคีา่

ตามเงือ่นไขทัง้สิน้กีร่ายการ ใหใ้ชส้ตูรใดสตูรหนึง่ตอ่ไปนีก้็ได ้

1. =SUMPRODUCT(  (Id=G3)*(Name=H3) ) โดยสตูร SumProduct จะทํา

หนา้ทีร่วมเลข 1 ทีไ่ดจ้ากการคณูกนัของ Array ภายในวงเล็บวา่มเีลข 1 กีต่วั น่ันคอืนับ

จํานวนรายการทีม่เีงือ่นไขตามตอ้งการน่ันเอง 

2. =SUMPRODUCT(  (Id=G3)*1, (Name=H3)*1) 

3. =SUMPRODUCT(  (Id=G3)/1, (Name=H3)/1) 

4. =SUMPRODUCT(  (Id=G3)+0, (Name=H3)+0) 

5. =SUMPRODUCT(  (Id=G3)-0, (Name=H3)-0) 

6. =SUMPRODUCT(  --(Id=G3), --(Name=H3) ) 

สตูร SumProduct แบบที ่2-6 เป็นสตูรทีใ่ชเ้ครือ่งหมาย comma , คัน่ จงึจําเป็นตอ้งกระตุน้ให ้

เปลีย่น True เป็นเลข 1 และเปลีย่น False เป็นเลข 0 โดยนํา True หรอื False ทีไ่ดจ้ากการ

ตรวจสอบเงือ่นไขไป *1, /1, +0, -0, หรอืใสเ่ครือ่งหมายลบลบไวข้า้งหนา้กอ่น 

ดงันัน้จงึขอแนะใหส้รา้งสตูร SumProduct แบบนําเงือ่นไขมาคํานวณ(คณูหรอืบวก)กนัเองกอ่น 

เพราะนอกจากจะแกะหาผลจากการคณูหรอืบวกกนัจากสว่นของเงือ่นไขทีนํ่ามาคํานวณกนัได ้
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แลว้ ยงัเป็นสตูรทีส่ัน้กวา่และมขีัน้ตอนการคํานวณนอ้ยกวา่สตูร SumProduct ทีใ่ชแ้บบ

เครือ่งหมาย comma , คัน่อยูภ่ายใน 

หมายเหต ุ

โดยทัว่ไปหากเงือ่นไขทีใ่ชใ้นสตูร Array IF เป็นการตรวจสอบวา่เทา่กนัหรอืไม ่โดยใช ้

เครือ่งหมาย = ในการเปรยีบเทยีบวา่เป็น True หรอื False เราสามารถทอ่งจําไวเ้ลยดงันี ้

• ถา้ Range ทีนํ่ามาตรวจสอบเงือ่นไขเป็น เร ือ่งเดยีวกนั ใหนํ้าผลลพัธจ์ากการ

ตรวจสอบเงือ่นไขมา บวกกนั และมวีงเล็บเปิดดา้นหนา้ 3 ตวั 

• ถา้ถา้ Range ทีนํ่ามาตรวจสอบเงือ่นไขเป็น ตา่งเรือ่งกนั ใหนํ้าผลลพัธจ์ากการ

ตรวจสอบเงือ่นไขมา คณูกนั และมวีงเล็บเปิดดา้นหนา้ 2 ตวั 

แตถ่า้เป็นการตรวจสอบเงือ่นไขประเภทมากกวา่หรอืนอ้ยกวา่หรอืผสมกนั แม ้Range ทีนํ่ามา

เป็นเงือ่นไขจะเป็นเรือ่งเดยีวกนั ก็ไมจํ่าเป็นวา่ตอ้งนําผลลพัธจ์ากการตรวจสอบเงือ่นไขมาบวก

กนัเสมอไป บางกรณีอาจใชค้ณูกนัก็ได ้ทัง้นีข้ ึน้กบัลกัษณะการเปรยีบเทยีบทีใ่ชด้ว้ย โดยขอให ้

คดิหาวธิใีดก็ไดท้ีจ่ะทําใหเ้กดิเลข 1 ชีเ้ฉพาะตําแหน่งรายการทีต่อ้งการใหไ้ด ้
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ของจรงิ ของปลอม  

ของใชไ้มไ่ดใ้น Excel 

ในเรือ่งความซือ่สตัยส์จุรติ โปรแกรม Excel ถอืวา่ไดห้นึง่รอ้ยคะแนนเต็ม ไมว่า่คณุจะบนัทกึคา่ 

สรา้งสตูร หรอืนํา Excel มาใชแ้บบใด อะไรทีค่ณุทําลงไปใน Excel ก็จะไดรั้บผลตามนัน้ แตถ่า้

คณุเขา้ใจ Excel ไดไ้มด่พีอ กอ็าจจะตโีพยตพีายเมือ่เห็นวา่ Excel ทรยศ เพราะมนัใหคํ้าตอบที่

ผดิพลาดตา่งจากคําตอบทีค่ณุตอ้งการ ทัง้ๆทีแ่ทจ้รงิแลว้คณุน่ันแหละทีเ่ขา้ใจผดิ 

ของจรงิทีท่ําใหส้ตูร IF กลายเป็นของปลอม 

เนือ้หาทีจ่ะนํามาอธบิายตอ่ไปนีจ้ะชีเ้ป็นชีต้ายใหก้บัคนทีช่อบใชส้ตูร IF หรอืสตูรใดก็ตามที่

เกีย่วขอ้งกบัการตดัสนิใจหรอืใชใ้นการคน้หาขอ้มลูวา่ แฟ้มงานทีค่ณุสรา้งขึน้นัน้มคีวาม

น่าเชือ่ถอืหรอืไม ่เพือ่พสิจูนใ์หเ้ห็นกบัตา ลองดสูตูร IF ตอ่ไปนีแ้ลว้คดิวา่จะไดคํ้าตอบออกมา

เป็นคําวา่ เทา่กนั หรอื ไมเ่ทา่กนั 

=IF( 22.3-22.2=0.1, "เทา่กนั", "ไมเ่ทา่กนั") 

เชือ่หรอืไม!่!! Excel จะใหคํ้าตอบออกมาวา่ 22.3-22.2 นัน้ไมเ่ทา่กบั 0.1 โดยคนืคา่ออกมาเป็น

คําวา่ ไมเ่ทา่กนั ซึง่ถอืเป็นคําตอบทีถ่กูตอ้ง เพราะ 22.3-22.2 ไมไ่ดคํ้านวณออกมาแลว้ใหผ้ล

ลพัธเ์ทา่กบั 0.1 ตามทีเ่ราเขา้ใจ 

ขอใหล้องสรา้งสตูร =22.3-22.2 ลงไปในเซลล ์แลว้กดปุ่ ม F2 ตามดว้ยปุ่ ม F9 จะพบวา่คา่ที่

แทจ้รงิที ่Excel คํานวณไดค้อื 0.100000000000001 ซึง่แน่นอนวา่ไมใ่ช ่0.1 

บางคนมองคา่ 0.100000000000001 แลว้ยอมรับตวัเลขทีไ่ดน้ี ้เพราะเห็นวา่มนัตา่งจาก 0.1 ที่

ตอ้งการเพยีงเล็กนอ้ย ถา้ใครคดิเชน่นีแ้สดงวา่เขา้ใจ Excel ผดิ เพราะ Excel จะไมย่อมรับวา่คา่ 

0.1 เทา่กบั0.100000000000001 ไมว่า่คา่ทีแ่ตกตา่งกนันัน้จะนอ้ยมากก็ตาม 

การที ่Excel คํานวณไดค้า่ทีเ่พีย้นตา่งจากทีค่วรนี ้ไมไ่ดถ้อืวา่เป็นการคํานวณทีผ่ดิพลาด และ

ไมไ่ดม้แีคก่รณีนีก้รณีเดยีว สตูรหรอืการคํานวณใดๆทีค่ณุใชม้โีอกาสคนืคา่เพีย้นไปจากที่

ตอ้งการไดท้ัง้นัน้ 
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Excel จะใชร้ปูแบบ (Format Number) แสดงคา่ในเซลลต์ามลกัษณะตวัเลขทีพ่มิพ ์นีค่อื

สาเหตปุระการแรกทีอ่ธบิายวา่ ทําไม Excel จงึไมแ่สดงคา่ 0.100000000000001 ในเซลล์

ออกมาใหเ้ห็นครบทกุหลัก เนือ่งจากตวัเลข 22.3-22.2 ทีพ่มิพล์งไปมทีศนยิมเพยีงหนึง่หลกั 

ดงันัน้ Excel จงึแสดงผลลพัธใ์หเ้ห็นตวัเลขทีม่ทีศนยิมเพยีงหนึง่หลกัตามไปดว้ย 

คา่ทีเ่พีย้นไปไมไ่ดถ้อืวา่เกดิจากการคํานวณทีผ่ดิพลาด แตเ่ป็นเพราะ Excel ใชห้ลกัการคํานวณ

แบบเลขฐานสองแลว้แปลงกลบัมาเป็นเลขฐานสบิ ซึง่คา่ 22.3-22.2 คํานวณแบบเลขฐานสอง 

ไดคํ้าตอบเป็นเลขทีซ่ํ้าไมรู่จ้บ (Repeating Binary Number) จากนัน้เมือ่แปลงกลบัมาเป็น

เลขฐานสบิใหพ้วกเราเขา้ใจ จงึตอ้งปรับคา่ใหเ้หลอืเพยีง 15 หลกั (Excel มคีวามละเอยีด

Precision โดยรับตวัเลขไดส้งูสดุ 15 หลกั) แลว้สง่ผลใหไ้ดผ้ลลพัธแ์ตกตา่งจากทีค่วรบา้ง

เล็กนอ้ย และมไิดเ้กดิขึน้เฉพาะกรณี 22.3-22.2 เทา่นัน้ เราไมม่ทีางคาดการณ์ไดเ้ลยวา่จะ

เพีย้นเมือ่ใดและเกดิจากการคํานวณใด 

ดงัน ัน้กอ่นทีค่ณุจะใชส้ตูรทีเ่ก ีย่วขอ้งกบัการตดัสนิใจหรอืสตูรในการคน้หาขอ้มลู เชน่ 

IF, SumIF, VLookup, หรอื Match จําเป็นตอ้งปรับคา่ใหเ้ทา่กบัคา่ทีต่อ้งการ เพือ่ใหเ้ป็นไป

ตามเงือ่นไขทีต่อ้งการกอ่นเสมอ โดยใชส้ตูรอืน่เขา้มาชว่ยปรับคา่ จากนัน้เมือ่ไดค้า่ตามที่

ตอ้งการจรงิๆแลว้คณุจะกําหนดรปูแบบ Format ใดๆใหก้บัคา่นัน้ก็ตามใจ (หา้มใชแ้ตเ่พยีงการ

กําหนดรปูแบบเทา่นัน้เพราะมนัไมไ่ดช้ว่ยปรับคา่ทีแ่ทจ้รงิแตอ่ยา่งใด) 

สตูรสําคญัซึง่ใชใ้นการปรับคา่ตวัเลขใหเ้ป็นไปตามตอ้งการ (โปรดศกึษารายละเอยีดของสตูร

ไดจ้าก Excel Help) ไดแ้ก ่

1. สตูร =Round(ตวัเลข, จาํนวนหลกั) ใชสํ้าหรับการปัดคา่ 

 

=Round(123.45,0) คนืคา่ 123 

=Round(123.45,1) คนืคา่ 123.5  

=Round(123.45,-1) คนืคา่ 120 

=Round(123.45,-2) คนืคา่ 100 

 

2. สตูร =Trunc(ตวัเลข, จาํนวนหลกั) ใชสํ้าหรับการตดัคา่ 

 

=Trunc(123.45,0) คนืคา่ 123 

=Trunc(123.45,1) คนืคา่ 123.4 ตา่งจาก Round 
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กําหนดใหม้ันชดิซา้ย แสดงวา่ขอ้มลูนัน้มคีา่เป็น Text ซึง่ไมม่ปีระโยชนใ์นการนําขอ้มลูไปใช ้

คํานวณตอ่แมแ้ตน่อ้ย อยา่งเชน่เซลล ์B2 ทีม่คํีาวา่ Jan ไมไ่ดใ้หร้ายละเอยีดวา่เป็นวนัทีใ่ดของ

เดอืนมกราคมหรอืเป็นเดอืนมกราคมของปีใด คําวา่ Jan ทีช่ดิซา้ยใหค้วามหมายแตเ่พยีงบอกวา่

เป็นเดอืนมกราคมเทา่นัน้ ซึง่หลายคนแกปั้ญหาโดยการเพิม่เซลลบ์นัทกึเลขปีลงไปอกี 

Column C เป็นการบนัทกึแบบทีถ่กูตอ้ง สงัเกตวา่ชือ่เดอืนชดิขวาของเซลล ์และแมใ้นเซลล ์

C2 แสดงคําวา่ Jan ก็ตาม แตเ่มือ่มองทีช่อ่ง Formula Bar ดา้นบน จะพบวา่มคีา่ทีแ่ทจ้รงิเป็น 

15/1/2010 ซึง่หากตอ้งการใหแ้สดงชือ่เดอืนตัง้แตเ่ซลล ์C3 ตอ่ๆกนัไป ใหส้รา้งสตูร =C2+30 

ลงไปในเซลล ์C3 แลว้ Copy สตูรนีต้อ่ลงไปในแนวตัง้ จากนัน้ใหกํ้าหนด Format Cells ใน 

Column C เป็น [$-409]mmm จะทําใหค้า่ 15/1/2010, 14/2/2010, 16/3/2010 แสดง

เฉพาะชือ่เดอืน Jan, Feb, Mar ทีช่ดิขวาของเซลล ์ 

สาเหตทุีใ่ชค้า่แรกในเซลล ์C2 เป็นวนัที ่15 นัน้เพือ่ชว่ยใหเ้ราสามารถบวกเพิม่ตอ่ไปเซลลล์ะ 

30 วนั เพือ่ทําใหไ้ดเ้ดอืนตอ่ไปเพิม่ทลีะเดอืนไดง้า่ยกวา่ทีจ่ะเริม่เซลลแ์รกเป็นวนัทีส่ ิน้เดอืน ซึง่

ตอ้งบวกเพิม่ดว้ยจํานวน 31 วนั 30 วนั 28-29 วนัแตกตา่งกนัไปในแตล่ะเดอืน 
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หลกัการใชว้นัทีแ่ละเวลา 

1. ในการบนัทกึ ใหพ้มิพใ์หค้รบทัง้วนัเดอืนปี อยา่บนัทกึเฉพาะวนัทีห่รอืเฉพาะเดอืนหรอืเฉพาะ

ปีเทา่นัน้ โดยจะพมิพส์ว่นของเวลาตอ่ทา้ยดว้ยหรอืไมก่็ได ้เชน่ 14/2/2010 12:00 

2. ใหบ้นัทกึโครงสรา้งของวนัทีล่งไปในเซลลต์ามแบบทีกํ่าหนดไวใ้น Regional Setting ของ 

Windows เชน่ ถา้กําหนดไวใ้น Regional Setting เป็น Thai ก็ตอ้งบนัทกึวนัทีต่ามแบบของ

ประเทศไทยซึง่ใชลํ้าดบัตามวนักอ่นเดอืนกอ่นปี แตถ่า้กําหนดใน Regional Setting เป็น 

USA ก็ตอ้งบันทกึตามลําดบัเดอืนกอ่นวนักอ่นปี 

3. แมจ้ะใช ้Regional Setting เป็น Thai แตใ่นการบันทกึในสว่นของเลขปีตอ้งใชปี้ค.ศ.ในการ

บนัทกึเทา่นัน้ จากนัน้ใหใ้ช ้Format ปรับการแสดงปีค.ศ.ใหเ้ป็นปีพ.ศ.ในภายหลงั เชน่ ให ้

บนัทกึ 14/2/2010 (หา้มใชปี้พ.ศ.แทนอยา่งเด็ดขาด) จากนัน้เมือ่ตอ้งการแสดงเป็น 

14/2/2553 ใหใ้ช ้Format [$-1070000]d/mm/yyyy 

4. ในโครงสรา้งของวนัทีใ่หพ้มิพเ์ครือ่งหมาย / ในการแบง่สว่นของ วนั/เดอืน/ปีค.ศ. และ

ในโครงสรา้งของเวลาใหพ้มิพเ์ครือ่งหมาย : ในการแบง่สว่นของ ช ัว่โมง:นาท:ีวนิาท ี

5. ควรพมิพเ์ลขปีค.ศ.ใหค้รบทัง้ 4 หลกัเสมอ แตถ่า้จําเป็นตอ้งพมิพแ์คส่องหลกัทา้ย พอกด

ปุ่ ม Enter เพือ่บนัทกึคา่ลงไป Excel จะเปลีย่นตัวเลขปี 2 หลกัทา้ย ดงันี ้

5.1. ตัง้แตเ่ลข 00-29 ใหเ้ป็นชว่งปีค.ศ. 2000-2029  

5.2. ตัง้แตเ่ลข 30-99 ใหย้อ้นกลบัเป็นชว่งปีค.ศ. 1930-1999 

6. เมือ่บนัทกึวันทีแ่ลว้ตอ้งชดิขวาของเซลลเ์สมอ (สาเหตทุีช่ดิขวาเพราะมคีา่เป็นตวัเลข) และ

ขอใหห้ลกีเลีย่งการใชว้ันทีแ่บบ Text ซึง่ชดิซา้ยของเซลลเ์นือ่งจาก Excel จะไมนํ่า 

Regional Setting มาชว่ยควบคมุในการแบง่สว่นของวนัเดอืนปีทีใ่ชแ้บบ Text  

7. คา่ของวนัทีแ่ละเวลามชีือ่เรยีกวา่ Date Serial Number หรอืเรยีกวา่ Serial Number (SN) 

โดย Excel ถอืวา่ 1/1/1900 0:00:00 มคีา่ SN=1 ซึง่เราสามารถแกะดคูา่ SN ไดโ้ดย

เปลีย่น Format เป็น General (โดยการกดปุ่ ม Ctrl+Shift+ ~) เชน่ 14/2/2010  

12:00:00 มคีา่ SN เทา่กบั 40223.5 

7.1. ในสว่นของตัวเลข SN สว่นทีเ่ป็นจํานวนเต็ม คอื คา่ของวนัที ่

7.2. ในสว่นของตัวเลข SN สว่นทีเ่ป็นเศษทศนยิม คอื คา่ของเวลา 

8. เวลาของ Excel เริม่จาก 0:00:00-23:59:59 และใช ้Format h:mm:ss  

9. ระยะเวลา เริม่จาก 0:00:00 ขึน้ไป โดยไมส่ิน้สดุที ่23:59:59 

9.1. ใช ้Format [h]:mm:ss เพือ่แสดงเลขตัง้แต ่24 ชัว่โมงขึน้ไปได ้
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9.2. ใช ้Format [mm]:ss เพือ่แสดงเลขตัง้แต ่60 นาทขีึน้ไปได ้

9.3. ใช ้Format [ss] เพือ่แสดงเลขตัง้แต ่60 วนิาทขีึน้ไปได ้

10. ในการแสดงเวลาหรอืระยะเวลา ถา้คา่ SN < 1 จะใช ้Format ของเวลาหรอืระยะเวลาก็ได ้

แตถ่า้ SN >=1 ตอ้งเลอืกใช ้Format ของระยะเวลาเทา่นัน้ 

11. ถา้ตอ้งการบนัทกึการทํางานขา้มคนื ไมค่วรบนัทกึเฉพาะเวลาเขา้ออกงาน แตใ่หบ้นัทกึวนั

เดอืนปีกํากบัเวลาไวด้ว้ย เชน่ 14/2/2010 20:00 เพือ่ทําให ้Excel รับรูค้า่เป็น SN ทีม่คีรบ

ทัง้สว่นของวนัทีแ่ละเวลา 

12. Format ในการแสดงวนัและเวลา 

12.1. แสดงเลขวนัที ่ใช ้d หรอื dd  

12.2. แสดงเป็นชือ่วนั แบบยอ่ใช ้ddd หรอืแบบเต็ม dddd 

12.3. แสดงเป็นเลขเดอืน ใช ้m หรอื mm 

12.4. แสดงเป็นชือ่เดอืน แบบยอ่ใช ้mmm หรอืแบบเต็ม mmmm 

12.5. แสดงเป็นเลขปี ใช ้yy หรอื yyyy 

12.6. แสดงชัว่โมง นาท ีวนิาท ีใช ้h:mm:ss หรอื hh:mm:ss 

12.7. รหสัควบคมุ Locale ใช ้[$-409] สําหรับ USA และ [$-1070000] สําหรับไทย 

การคาํนวณวนัทีแ่ละเวลา 

กอ่นทีจ่ะนําวันทีแ่ละเวลามาคํานวณได ้ตอ้งเริม่จากการตรวจสอบวา่ขอ้มลูเกีย่วขอ้งกบัวนัทีแ่ละ

เวลาซึง่ถกูบันทกึไวว้า่มโีครงสรา้งทีถ่กูตอ้งตรงกบั Regional Setting หรอืไม ่หากบนัทกึไวผ้ดิ 

เชน่ ใน Regional Setting กําหนดไวเ้ป็น USA แตค่นทีบ่นัทกึขอ้มลูพมิพว์นัทีไ่วใ้นแบบ

ประเทศไทย เชน่ พมิพ ์4/2/2001 ซึง่ตอ้งการบนัทกึแบบไทยใหห้มายถงึวนัที ่4 เดอืน 2 ปี 

2001 จะพบวา่เมือ่นําแฟ้มนัน้มาเปิดบนเครือ่งทีม่ ีRegional Setting เป็นไทย เลขทีข่องวนัจะ

สลบักบัเลขทีข่องเดอืน จะแสดงเป็น 2/4/2001 แทน ทําใหกํ้าหนดเวลาทีบ่นัทกึไวผ้ดิทัง้หมด 

ถา้ไมเ่กง่สตูรเกีย่วขอ้งกบัวนัทีแ่ละเวลาก็ตอ้งจัดการพมิพท์บัใหมท่ัง้หมด 

นอกจากนีต้อ้งตรวจสอบตอ่ไปอกีวา่ คา่ของวนัทีซ่ ึง่บนัทกึไวเ้ป็นขอ้มลูทีม่คีา่เป็นตวัเลข (Date 

Serial Number หรอื SN) หรอืไม ่โดยเริม่จากยกเลกิการจัดชดิซา้ยชดิขวาของเซลลว์นัที่

ทัง้หมด หากพบวา่ ชดิขวาก็ใชไ้ด ้แตถ่า้พบวา่ชดิซา้ยแสดงวา่มคีา่เป็น Text ซึง่ไมส่ามารถ

นํามาคํานวณตอ่ไดใ้นทันท ีจําเป็นตอ้งอาศยัสตูร Left, Right, Mid แยกตวัเลขแตล่ะสว่นทีเ่ป็น

วนัเดอืนปีออกจากกนัแลว้ใชส้ตูรวนัทีแ่ละเวลามาชว่ยแกไ้ขใหม้คีา่เป็น SN 
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หากคณุอยากจะเกง่สตูรคํานวณเรือ่งวนัทีแ่ละเวลา ตอ้งรูจั้กสตูรหา SN หรอืสตูรทีส่ามารถ

แปลงเลขทีข่องวนัเดอืนปีทีม่นุษยเ์ขา้ใจไปเป็นคา่ SN ที ่Excel รูจั้ก เชน่ สตูร Now(), 

Today(), Date(Year,Month,Day), Time(Hour,Minute,Second)  

จากนัน้ตอ้งสามารถใชส้ตูรแปลงคา่ SN กลบัมาเป็นเลขทีข่องวนัเดอืนปี เชน่ สตูร Day(SN), 

Month(SN), Year(SN), และ WeekDay(SN) หรอืหาเลขทีข่องเวลา เชน่ Hour(SN), 

Minute(SN), Second(SN) 

สตูรแปลงเลขทีข่องวนัเดอืนปีและเวลาทีม่นษุยเ์ขา้ใจ 

ไปเป็นคา่ Serial Number 

เพือ่ชว่ยใหเ้ขา้ใจสตูรไดง้า่ยขึน้ ขอสมมตวิา่ปจัจบุนั คอื วนัที ่14 เดอืนกมุภาพันธ ์ปีค.ศ. 

2010 เวลา 12 นาฬกิา 30 นาท ี45 วนิาท ี

1. =NOW() จะไดว้นัเดอืนปีและเวลาปัจจบุนั เชน่ 14/2/2010 12:30:45 

2. =Today() จะไดเ้ฉพาะวนัเดอืนปีปัจจบุนั เชน่ 14/2/2010 

3. =Date(2010,2,14) จะได ้14/2/2010 

4. =Date( Year(Today()), Month(Today())+1, 0) จะไดว้นัเดอืนปีของวนัสดุทา้ย

ของเดอืนปัจจบุนั คอื 28/2/2010 

5. =Time(12,30,45) จะไดเ้วลา 12:30:45 

6. =Time(12,30,45)+1 จะไดร้ะยะเวลา 36:30:45 ซึง่ตอ้งใช ้Format [h]:mm:ss ดว้ย 

สตูรแปลงคา่ Serial Number  

กลบัมาเป็นเลขทีข่องวนัเดอืนปีและเวลาทีม่นษุยเ์ขา้ใจ 

สมมตวิา่เซลล ์A1 มสีตูร =NOW() ซึง่แสดงออกมาเป็น 14/2/2010 12:30:45 (ถา้ตอ้งการ

แสดงคา่ออกมาเป็น SN โดยการเปลีย่น Format เป็น General จะพบวา่ เซลล ์A1 มคีา่ SN 

เทา่กบั 40223.5213541667 ซึง่เป็นตวัเลขที ่Excel รูจั้กแตเ่ราไมรู่จั้ก) 

1. =Day(A1) จะไดเ้ลขวนัที ่14 

2. =Month(A1) จะไดเ้ลขเดอืน 2 

3. =Year(A1) จะไดเ้ลขปี 2010 
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4. =WeekDay(A1) จะไดเ้ลขของวนัในสปัดาห ์1=Sunday, 2=Tuesday,…7=Saturday 

5. =Hour(A1) จะไดเ้ลขชัว่โมง 12 

6. =Minute(A1) จะไดเ้ลขนาท ี30 

7. =Second(A1) จะไดเ้ลขวนิาท ี45 
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หลกัการกาํหนด  

Format Cells > Number 

1. Excel ใชเ้ครือ่งหมาย # และ 0 แทนตําแหน่งของตวัเลข ซึง่ถา้ใชเ้ครือ่งหมาย # แลว้

ตวัเลขมคีา่ไมถ่งึก็จะไมแ่สดงเลขหลกันัน้ แตถ่า้ใช ้0 จะแสดงแทนดว้ยเลข 0 ออกมาให ้

เห็น เชน่ ถา้พมิพต์วัเลข 1.2 ลงไป ถา้ใช ้Format ##.## จะแสดง 1.2 แตถ่า้ใช ้Format 

00.00 จะแสดง 01.20 ดว้ยเหตนุีใ้น Format มาตรฐานที ่Excel เตรยีมไว ้จะพบวา่อยา่ง

นอ้ยตวัเลขหลกัหน่วยและหลกัทศนยิม จงึกําหนดใหใ้ชเ้ลข 0 ไวเ้สมอ เชน่ #,##0.00 

2. ดา้นหนา้ของ Format ทีเ่ป็นเครือ่งหมาย # หรอืเลข 0 เราสามารถกําหนดสขีอง Font ได ้

โดยพมิพช์ือ่สทีีต่อ้งการไวใ้นเครือ่งหมาย [ ] เชน่ [Red] หรอืถา้จําชือ่สไีมไ่ด ้ใหใ้ช ้

[Colorn] แทน โดย n คอืเลขของสทีีต่อ้งการ เชน่ [Color12] 

3. เครือ่งหมายวงเล็บ [ ] ยงัใชใ้นแบบเงือ่นไขเพือ่ควบคมุใหแ้สดงผลออกมาเฉพาะเมือ่ตรง

กบัเงือ่นไขทีกํ่าหนดไวใ้นเครือ่งหมาย [ ] เชน่ [>=90]00000.00 จะทําใหต้วัเลขทีพ่มิพล์ง

ไปในเซลลท์ีใ่ช ้Format นี ้เฉพาะเมือ่มคีา่มากกวา่หรอืเทา่กบั 90 ใหแ้สดงตวัเลขใน

รปูแบบ 00000.00 

4. ใน Format สามารถแทรกสญัลกัษณ์หรอืตวัอกัษรไวด้า้นหนา้ ดา้นหลงั หรอืระหวา่ง 

Format ทีเ่ป็นเครือ่งหมาย # หรอืเลข 0 

4.1. กรณีแทรกสญัลกัษณ์ ใหพ้มิพแ์ทรกไดโ้ดยตรง เชน่ (0 . 00) % มเีครือ่งหมายวงเล็บ 

เครือ่งหมายวรรค จดุทศนยิม และ % เป็นสญัลกัษณ์ 

4.2. กรณีแทรกตวัอกัษร ตอ้งพมิพต์วัอกัษรไวร้ะหวา่งเครือ่งหมายคําพดู เชน่  

“Total” 0.00 “บาท” 

5. ถา้ตอ้งการปัดตวัเลขใหเ้ป็นหลกัพันใหเ้ตมิเครือ่งหมายคอมมาตอ่ทา้ยหนึง่ตวั ถา้ตอ้งการ

ปัดเป็นหลกัลา้นใหเ้ตมิคอมมาตอ่ทา้ยสองตวั เชน่ 0.00,, จะแสดงตวัเลข 123456789 ที่

บนัทกึลงไปออกมาเป็น 123.46 โดยคา่ทีแ่ทจ้รงิยงัคงเทา่กบั 123456789 ตามเดมิ 

6. ใหใ้ชเ้ครือ่งหมาย ; ไดส้งูสดุ 3 ตวั เพือ่ควบคมุ Format ใหเ้ปลีย่นตามคา่บวก คา่ลบ คา่

ศนูย ์และคา่ทีเ่ป็นตวัอกัษร ในโครงสรา้งตามนี ้คา่บวก;คา่ลบ;คา่ศนูย;์คา่ทีเ่ป็นตวัอกัษร 

6.1. ถา้ไมใ่สเ่ครือ่งหมาย ; เลย แสดงวา่เป็น Format กลางทีใ่หต้วัเลขทกุคา่ใช ้Format 

นัน้รว่มกนั 

6.2. หลงัจากเครือ่งหมาย ; ทีเ่ตมิตอ่ทา้ยลงไป ถา้ใส ่; ตวัใด ตอ้งตามดว้ย Format ของคา่

นัน้ๆ แตถ่า้เราไมไ่ดกํ้าหนด Format ของนัน้ๆไวด้ว้ย จงึไมแ่สดงคา่น ัน้ๆ 
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ตวัอยา่งตอ่ไปนี ้สมมตวิา่คา่ทีพ่มิพล์งไปในเซลลค์อื 123, -123, 0, Hello 

• Format ;;; จะไมแ่สดงอะไรใหเ้ห็นเลย 

• Format 0.00 จะแสดง 123.00, -123.00, 0.00, Hello 

• Format 0.00; จะแสดง 123.00, คา่ลบไมแ่สดง, 0.00, Hello 

• Format 0.00;[Red](0.00) จะแสดง 123.00, (123.00) ในสแีดง, 0.00, Hello 

• Format 0.00;; จะแสดงเฉพาะคา่บวก 123.00 กบั Hello เทา่นัน้ คา่ ลบ และ 0 ไม่

แสดง 

• Format 0.00;;; จะแสดงเฉพาะคา่บวก 123.00 เทา่นัน้ 

• Format 0.00;(0.00);; จะแสดงเฉพาะคา่บวก123.00 กบัคา่ลบ (123.00) 

• Format “Yes”;”No”;”Reject”; จะแสดง Yes, No, Reject 

• Format “Total” 0 “Baht”. 00 “Satang”;;; จะแสดง Total 123 Baht. 00 Satang 

• Format 0.00_);(0.00);; จะแสดง 123.00 ไดแ้นวตรงกบัคา่ลบ (123.00) โดย

เครือ่งหมาย _) ทีเ่ตมิตอ่ทา้ย Format คา่บวก หมายถงึ ใหห้า่งจากขอบขวาของเซลล์

เทา่กบัความกวา้งของเครือ่งหมาย ) 

ตวัอยา่ง Format แปลกๆ 

• Format [>=90]”A”;[>=70]”B”;”C” จะเปลีย่นตวัเลขในเซลลต์ามเงือ่นไขวา่  

ถา้คา่มากกวา่หรอืเทา่กบั 90 ใหแ้สดงตวั A แทนตวัเลขนัน้ 

ถา้คา่มากกวา่หรอืเทา่กบั 70 ใหแ้สดงตวั B แทนตวัเลขนัน้ 

หรอืมฉิะนัน้ใหแ้สดงตวั C 

• Format [=1]”Yes”;[=0]”No”;”Reject” จะแสดงคําวา่ Yes, No, Reject แทนตวัเลขที่

มคีา่เทา่กบั 1, 0, หรอืตวัเลขอืน่ ตามลําดบั 

• Format “4”;”4”;”4”;”4” จะเปลีย่นคา่ใหเ้ป็นเลข 4 แทนไมว่า่คา่ทีแ่ทจ้รงิจะเป็นเทา่ใด 

• Format 0000 จะแสดงเลข 123 ออกมาเป็น 0123 (ซึง่ตวัเลขยงัคงมสีถานะเป็นตวัเลข

ตามเดมิ ถกูตอ้งกวา่การพมิพ ์‘0123 หรอืใชคํ้าสัง่ Format Cells > Number > Text 

ซึง่ทําใหต้วัเลขเปลีย่นสถานะมาเป็น Text ซึง่ดงูา่ยๆวา่จะชดิซา้ยของเซลล)์ 

• หากตอ้งการแทรกสญัลกัษณ์แปลกทีไ่มม่บีนแป้นพมิพล์งไปใน Format เชน่ 

เครือ่งหมายบวกลบ ± ใหก้ดปุ่ ม Alt คา้งไวแ้ลว้พมิพต์วัเลข 0177 ซึง่สามารถคน้หาตวั
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จะพบวา่ผลจากวธิแีรกไดคํ้าวา่ Profit 15.0% ชดิขวาของเซลลแ์สดงวา่สามารถนําไปคํานวณ

ตอ่ได ้แตว่ธิทีีส่องแมจ้ะไดคํ้าเดยีวกนัแตจ่ะชดิซา้ยของเซลลซ์ึง่ไมส่ามารถนําไปคํานวณตอ่ จงึ

ขอแนะนําใหใ้ชว้ธิทีีส่องกบัผลลพัธส์ดุทา้ยทีไ่มต่อ้งนําไปใชคํ้านวณตอ่เทา่นัน้ 

นอกจากนีส้ตูร Text ยงัเปรยีบไดก้บัสตูร Round โดยสตูร Text นีจ้ะปัดตวัเลขและแสดงตวัเลข

ตามรปูแบบใหด้ว้ย เชน่ =TEXT(123456789,"0.00,,") จะไดคํ้าตอบเป็น 123.46 และมคีา่ 

123.46 ดว้ย 
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วธิใีช ้Add-In 

Add-In เป็นแฟ้มทีม่นีามสกลุ .xla หรอื .xlam ซึง่แฟ้มเหลา่นีจ้ะทําให ้Excel ทีต่ดิตัง้ไวใ้นแต่

ละเครือ่งมสีตูรหรอืคําสัง่เพิม่ขึน้มากกวา่เดมิ ซึง่ทกุวนันีเ้ราสามารถนําแฟ้ม Add-in ทีแ่จกฟรี

จากอนิเตอรเ์น็ตมาใชก้นัไดท้นัท ี

1. เริม่จาก Download แฟ้ม Add-in มาเก็บไวใ้นเครือ่งคอมพวิเตอรข์องคณุกอ่น 

2. จากนัน้เปิดโปรแกรม Excel แลว้สัง่ File > Options > Add-ins แลว้คลกิทีปุ่่ ม Go 

ดา้นลา่งของหนา้ จะเปิดใหเ้ห็นรายชือ่ Add-ins Available ทีม่าพรอ้มกบัโปรกรม Excel 

(Excel 2003 ใหส้ัง่ Tools > Add-Ins) 

3. กดปุ่ ม Browse คน้หาแฟ้ม Add-in ทีค่ณุเก็บไวใ้นเครือ่งตามขอ้ 1 ใหพ้บแลว้กดปุ่ ม OK 

4. จะพบชือ่ Add-in ทีค่ณุเลอืกปรากฏเพิม่ในชอ่งรายชือ่ Add-ins Available  

ขอใหเ้ลอืกกาชือ่ Add-ins เฉพาะทีต่อ้งการนํามาใชง้านเทา่นัน้ เพราะการเปิดใช ้Add-in ก็

เหมอืนกบัการเปิดแฟ้มทัว่ไป เพยีงแตเ่มือ่เปิด Excel จะเปิดแฟ้ม Add-in ทีเ่ลอืกไวต้อ่ใหเ้อง 

แตจ่ะไมเ่ห็นตวัแฟ้มแตอ่ยา่งใด ซึง่ Add-in จะทําใหค้ณุมสีตูรเพิม่เตมิหรอืทําใหม้คํีาสัง่เพิม่ที่

จะเห็นไดบ้นเมนูก็แลว้แตแ่ฟ้ม Add-in นัน้สรา้งขึน้มาเพือ่จดุประสงคใ์ด 

ขอแนะนําใหใ้ช ้Expert2000.xla ซึง่เป็น Add-in ทีแ่จกใหใ้ชใ้นหลกัสตูรสดุยอดเคล็ดลบั 

โดยจะทําใหค้ณุไดเ้มนูชือ่ Expert และมคํีาสัง่เพิม่ขึน้ ทําหนา้ทีเ่กีย่วขอ้งกบัการปรับแตง่

หนา้จอเมือ่สรา้งงานเสร็จแลว้ และยงัทําใหม้สีตูรตอ่ไปนีเ้พิม่เตมิ  

• =Fml(cell) ทําหนา้ทีแ่สดงสตูรในเซลล ์

• =Fmt(cell) ทําหนา้ทีแ่สดง Format ในเซลล ์

ถา้เรยีกใช ้Add-in ชือ่ Money.xla จะไดส้ตูร =Money(ตวัเลข,”ชือ่หน่วยเงนิ”,”ชือ่หน่วยเศษ

สตางค”์) เชน่ =Money(1234.56,”Dollar”,”Cent”) จะอา่นตวัเลขออกมาเป็นคําวา่ One 

Thousand Two Hundred Thirty Four Dollars and Fifty Six Cents 

เนือ่งจากสตูรเหลา่นีไ้มใ่ชส่ตูรทีม่าตามปกตขิอง Excel ดงันัน้หากเปิดแฟ้มทีใ่ชส้ตูร Fml ขึน้มา

โดยทีย่งัไมไ่ดเ้รยีกใช ้Expert2000.xla จะทําใหส้ตูรเหลา่นีก้ลายเป็น Error วา่ #NAME! 

ทัง้หมด ซึง่แกไ้ขไดโ้ดยทําการตดิตัง้ Add-in Expert2000.xla กอ่นแลว้จงึตามดว้ยการเปิด
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แฟ้มทีม่สีตูรเหลา่นีต้อ่ แตถ่า้พบวา่สตูรยงัคง Error อยู ่ใหค้ลกิทีเ่ซลลส์ตูรแลว้กดปุ่ ม F2 แลว้

กดปุ่ ม Enter เพือ่กระตุน้ใหส้ตูรเริม่ทํางานตอ่ไปไดต้ามปกต ิ
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Function VBA 

แทนทีจ่ะตอ้งสรา้งสตูรซึง่มขีัน้ตอนการคํานวณยาวเหยยีดซํ้าแลว้ซํ้าอกีลงไปในตาราง  

Function VBA เป็นทางออกทีจ่ะชว่ยทําใหเ้กดิสตูรลดัขึน้มาใชง้านในแฟ้ม 

วธิสีรา้ง Function VBA 

1. เปิด Visual Basic Editor โดยกดปุ่ ม Alt+F11  

2. ใชเ้มนูคําสัง่ Insert > Module เพือ่เปิดพืน้ทีจั่ดเก็บรหสั  

3. copy รหสัทีต่อ้งการ โดยเลอืกชว่งตัง้แตบ่รรทดั Function ถงึบรรทดั End Function  

4. paste รหสัที ่copy ไวนั้น้ลงใน module ทีต่อ้งการ  

5. ใน Module หนึง่ๆ จะใชเ้กบ็ Function ไดไ้มจํ่ากดั ใหเ้รยีง Function ตอ่กนัไปเรือ่ยๆ  

6. สัง่ File > Save โดยกําหนดนามสกลุแฟ้ม xlsm 

 

วธิใีช ้Function VBA 

ใชส้ตูรเชน่เดยีวกบัสตูรทัว่ไปอืน่ๆ หากใชคํ้าสัง่ Formulas > Insert Function หรอืคลกิทีปุ่่ ม 

Fx บน Formula Bar จะพบสตูร VBA Function รวมไวใ้นกลุม่ Function category : User 

Defined และแสดงรปูแบบสตูรในจอดา้นขวาและดา้นลา่ง 



 

1 

Fu

   

En

    

 

2 

Fu

   

En

Fu

   

   

unction Ge

GetForma

nd Functio

แสดงรปู

unction Ge

GetFormu

nd Functio

unction Ge

If VarType

 GetFormu

Cop

tFormat(ce

t = cell.Nu

n 

แบบทีใ่ชใ้น

tFormula(C

la = Cell.F

n 

tFormulaI(

e(cell) = 8 

ulaI = "'" &

pyright of ww

ell) 

umberForm

นเซลล ์

Cell) 

Formula 

(cell) 

Then 

& cell.form

158 

ww.ExcelExp

mat 

ula 

pertTraining.ccom 

 

  

  

  



159 

 

Copyright of www.ExcelExpertTraining.com 

   Else 

    GetFormulaI = cell.formula 

   End If 

   If cell.HasArray Then _ 

     GetFormulaI = "{" & cell.formula & "}" 

End Function 

    แสดงสตูรทีใ่ชใ้นเซลล ์   

 

3 

Function FormulaText(cell_ref) 

    'Allow formula to be updated if changes are made on the sheet 

    Application.Volatile 

   'Test for reference style in use 

    If Application.ReferenceStyle = xlA1 Then 

        'Set the return value of the function to the A1 style formula 

        FormulaText = cell_ref.Formula 

    Else '  xlR1C1 --Set the return value of the function to the R1C1 style 

formula 

        FormulaText = cell_ref.FormulaR1C1 

    End If 

End Function 

  

    แสดงสตูรทีใ่ชใ้นเซลล ์ทัง้แบบปกตหิรอืแบบ R1C1   

 

4 Function FUNCTION_DEF(FCELL As Variant)As Variant    
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'Let's make sure the function  

'recalculates when required  

    Application.Volatile  

 

'If the argument is not a range  

'then return appropriate error.  

    If Not TypeName(FCELL) = "Range" Then  

        FUNCTION_DEF = CVErr(xlErrRef)  

        Exit Function  

    End If  

 

'If the argument is not a single  

'cell then return appropriate error.  

    If Not FCELL.Cells.Count = 1 Then  

        FUNCTION_DEF = CVErr(xlErrRef)  

        Exit Function  

    End If  

 

'If the argument cell contains no  

'formula, then just return its value  

    If Not FCELL.HasFormula Then  

        FUNCTION_DEF = FCELL.Value  

        Exit Function  

    End If  

 

'Find out the format of the formula  

'we need to return...  

    Select Case Application.ReferenceStyle  

        Case xlA1  



161 

 

Copyright of www.ExcelExpertTraining.com 

            FUNCTION_DEF = FCELL.Formula  

        Case xlR1C1  

            FUNCTION_DEF = FCELL.FormulaR1C1  

    End Select  

 

'Finally check whether we are looking at a cell  

'containing an array function.  

    If FCELL.HasArray Then _  

        FUNCTION_DEF = "{" & FUNCTION_DEF & "}" 

End Function  
 

    แสดงสตูรในเซลล ์   

 

5 

Option Explicit 

 

Function DATEDIFF(d1, d2) As Variant 

    Dim YearDiff As Integer 

    Dim MonthDiff As Integer 

    Dim DayDiff As Integer 

    Dim temp As Date 

     

'   Swap arguments, if necessary 

    If d1 > d2 Then 

        temp = d1 

        d1 = d2 

        d2 = temp 

    End If 
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'   Do the year part 

    YearDiff = Year(d2) - Year(d1) 

    If DateSerial(Year(d2), Month(d1), Day(d1)) > d2 _ 

        Then YearDiff = YearDiff - 1 

     

'   Do the month part 

    If Month(d2) > Month(d1) Then 

        If Day(d2) >= Day(d1) Then 

            MonthDiff = Month(d2) - Month(d1) 

        Else 

            MonthDiff = Month(d2) - Month(d1) - 1 

        End If 

    Else 

        If Day(d2) >= Day(d1) Then 

            MonthDiff = Month(d2) - Month(d1) + 12 

            If MonthDiff = 12 Then MonthDiff = 0 

        Else 

            MonthDiff = Month(d2) - Month(d1) + 11 

        End If 

    End If 

 

'   Do the day part 

    If Day(d2) >= Day(d1) Then 

        DayDiff = Day(d2) - Day(d1) 

    Else 

        DayDiff = Day(DateSerial(Year(d1), _ 

            Month(d1) + 1, 1) - 1) - Day(d1) + Day(d2) 

    End If 

 

'   Create the variant array to be returned 
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    DATEDIFF = Array(YearDiff, MonthDiff, DayDiff) 

End Function 

  

    
แสดงระยะเวลาระหวา่งชว่งเวลาทีกํ่าหนด  

www.j-walk.com\ss\excel\tips\tip55.htm 
  

 

6 

Function Age(TheDate As Double) As String 

Age = _ 

    CStr(Evaluate("=DATEDIF(" & TheDate & "," & CDbl(Now)  & ",""y"")")) 

& " years " & _ 

    CStr(Evaluate("=DATEDIF(" & TheDate & "," & CDbl(Now) & 

",""ym"")")) & " months " & _ 

    CStr(Evaluate("=DATEDIF(" & TheDate & "," & CDbl(Now) & 

",""md"")")) & " days" 

End Function 

  

    แสดงระยะเวลาระหวา่งชว่งเวลาทีกํ่าหนดเป็นประโยครวม   

 

7 

Function OrdDate(arg) 

    dd = Day(arg) 

    mmmm = Format(arg, "mmmm")    '*Corrected* 

    yyyy = Year(arg) 

    Select Case Day(arg) 

       Case 1, 21, 31 
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          OrdDate = dd & "st " & mmmm & ", " & yyyy 

       Case 2, 22 

          OrdDate = dd & "nd " & mmmm & ", " & yyyy 

       Case 3, 23 

          OrdDate = dd & "rd " & mmmm & ", " & yyyy 

       Case 4 To 20, 24 To 30 

          OrdDate = dd & "th " & mmmm & ", " & yyyy 

    End Select 

End Function 

    แปลงวนัทีใ่หม้คํีาตอ่ทา้ย st nd rd th   

 

8 

Function SheetName() As String 

    SheetName = Application.Caller.Parent.Name  'in XL97 

End Function 

  

    แสดงชือ่ sheet   

 

9 

Function CellType(c) 

'   Returns the cell type of the upper left 

'   cell in a range 

    Application.Volatile 
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    Set c = c.Range("A1") 

    Select Case True 

        Case IsEmpty(c): CellType = "Blank" 

        Case Application.IsText(c): CellType = "Text" 

        Case Application.IsLogical(c): CellType = "Logical" 

        Case Application.IsErr(c): CellType = "Error" 

        Case IsDate(c): CellType = "Date" 

        Case InStr(1, c.Text, ":") <> 0: CellType = "Time" 

        Case IsNumeric(c): CellType = "Value" 

    End Select 

End Function 

    แสดงประเภทของคา่ในเซลล ์   

 

10 

Function CellValue(c) As Double 

    'John Walkenbach 2001-04-25 

    '      misc returns number part 

    CellValue = Val(c) 

End Function 

  

    แสดงคา่เป็นตวัเลข   
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11 

Function HasFormula(cell) 

  HasFormula = cell.HasFormula 

End Function 

  

    ตรวจสอบวา่ มสีตูรหรอืไม ่   

 

12 

Function UseFormula(cell) 

    '-- Usage: Not recommended, see notes 

    UseFormula = Application.Evaluate(cell.formula) 

End Function 

Function UseFormula2(cell) 

   'Documented in  

http://www.geocities.com/davemcritchie/excel/formula.htm 

   ' UseFormula Jul 20, 1998,  UseFormula2 Jun 13, 2000 

   'Application.Volatile = True  -- DO NOT DO THIS 

    If Trim(cell.Value) = "" Then 

       UseFormula2 = "" 

       Exit Function 

    ElseIf Left(cell.Value, 1) = "=" Then 

       UseFormula2 = Application.Evaluate(cell.Formula) 

       Exit Function 

    Else 
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       UseFormula2 = "'#bad formula" 

    End If 

End Function 

    แปลงสตูรทีเ่ป็นตวัอกัษร ใหเ้ป็นสตูรทีใ่ชง้านได ้   

 

13 

Function fontinfo(cell As Range) As String 

  fontinfo = cell.FONT.Name & " -- " & cell.FONT.Size 

  If Left(cell.FONT.FontStyle, 7) = "Regular" Then 

     fontinfo = Trim(fontinfo & Mid(cell.FONT.FontStyle, 8, 100)) 

  Else 

     fontinfo = Trim(fontinfo & " " & cell.FONT.FontStyle) 

  End If 

End Function 

  

    แสดงรายละเอยีดของ font ทีใ่ช ้   

 

14 

Function SumByColor(InputRange As Range, ColorRange As Range) As 

Double 

Dim cl As Range, TempSum As Double, ColorIndex As Integer 

    ColorIndex = ColorRange.Cells(1, 1).Interior.ColorIndex 

    TempSum = 0 

    On Error Resume Next ' ignore cells without values 
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    For Each cl In InputRange.Cells 

        If cl.Interior.ColorIndex = ColorIndex Then TempSum = TempSum + 

cl.Value 

    Next cl 

    On Error GoTo 0 

    Set cl = Nothing 

    SumByColor = TempSum 

End Function 

    หายอดรวมตามสทีีใ่ช ้www.erlandsendata.no   

 

15 

Function CountByColor(InputRange As Range, ColorRange as Range) As 

Long 

Dim cl As Range, TempCount As Long, ColorIndex As Integer 

    ColorIndex = ColorRange.Cells(1, 1).Interior.ColorIndex 

    TempCount = 0 

    For Each cl In InputRange.Cells 

        If cl.Interior.ColorIndex = ColorIndex Then TempCount = 

TempCount + 1 

    Next cl 

    Set cl = Nothing 

    CountByColor = TempCount 

End Function 
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    นับจํานวนตามสทีีใ่ช ้   

 

16 

Function WEEKNR(InputDate As Long) As Integer 

Dim A As Integer, B As Integer, C As Long, D As Integer 

    WEEKNR = 0 

    If InputDate < 1 Then Exit Function 

    A = Weekday(InputDate, vbSunday) 

    B = Year(InputDate + ((8 - A) Mod 7) - 3) 

    C = CDate("1.1." & B) 

    D = (Weekday(C, vbSunday) + 1) Mod 7 

    WEEKNR = Int((InputDate - C - 3 + D) / 7) + 1 

End Function 

  

    คนืคา่เป็นเลขทีส่ปัดาห ์www.erlandsendata.no   

 

17 

Function UniqueItem(InputRange As Range, ItemNo As Long) As Variant 

Dim cl As Range, cUnique As New Collection, cValue As Variant 

    Application.Volatile 

    On Error Resume Next 

    For Each cl In InputRange 
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        If cl.Formula <> "" Then 

            cUnique.Add cl.Value, CStr(cl.Value) 

        End If 

    Next cl 

    UniqueItem = "" 

    If ItemNo = 0 Then 

        UniqueItem = cUnique.Count 

    Else 

        If ItemNo <= cUnique.Count Then 

            UniqueItem = cUnique(ItemNo) 

        End If 

    End If 

    On Error GoTo 0 

End Function 

    

แสดงคา่ unique values  

=UniqueItem(A1:A100,2) แสดงคา่ the 2nd unique value  

=UniqueItem(A1:A100,0) แสดงจํานวน unique values  

  

 

18 Function INDEXN(InputRange As Range, N As Integer) As Variant   
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' returns every N-th item from InputRange 

' select the desired target range for the function and 

' enter as an array function with Ctrl+Shift+Enter. 

Dim ItemList() As Variant, c As Range, i As Long, iCount As Long 

    i = 0 

    iCount = 0 

    ReDim ItemList(1 To InputRange.Cells.Count \ N) 

    For Each c In InputRange 

        i = i + 1 

        If i Mod N = 0 Then 

            iCount = iCount + 1 

            On Error Resume Next 

            ItemList(iCount) = c.Value 

            On Error GoTo 0 

        End If 

    Next c 

    INDEXN = ItemList 

    If InputRange.Rows.Count >= InputRange.Columns.Count Then 

        INDEXN = Application.WorksheetFunction.Transpose(INDEXN) 
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    End If 

    Erase ItemList 

End Function 

    แสดงคา่ทีอ่ยูใ่นลําดบัที ่n   

 

19 

Sub FindUniqueValues(SourceRange As Range, TargetCell As Range) 

    SourceRange.AdvancedFilter Action:=xlFilterCopy, 

CopyToRange:=TargetCell,  Unique:=True 

End Sub 

  

    แยก unique items ออกมาสรปุ   

 

20 

Function TimeInterval(StartTime As Double, EndTime As Double, _ 

LowerLimit As Double, UpperLimit As Double) As Double 

' returns EndTime-StartTime limited by LowerLimit and UpperLimit 

    TimeInterval = 0 

    If StartTime > EndTime Then Exit Function 

    If StartTime > UpperLimit Then Exit Function 

    If EndTime < LowerLimit Then Exit Function 

    If StartTime < LowerLimit Then StartTime = LowerLimit 

  



173 

 

Copyright of www.ExcelExpertTraining.com 

    If EndTime > UpperLimit Then EndTime = UpperLimit 

    TimeInterval = EndTime - StartTime 

End Function 

    ระยะเวลาระหวา่งชว่ง   

 

21 

Option Explicit 

 

'**************** 

' Main Function * 

'**************** 

Function BahtEng(ByVal MyNumber) 

Dim Baht, Satang, Temp 

Dim DecimalPlace, Count 

 

ReDim Place(9) As String 

Place(2) = " Thousand " 

Place(3) = " Million " 

Place(4) = " Billion " 

Place(5) = " Trillion " 

 

' String representation of amount 

MyNumber = Trim(Str(MyNumber)) 

 

' Position of decimal place 0 if none 

DecimalPlace = InStr(MyNumber, ".") 

'Convert Satang and set MyNumber to Baht amount 

If DecimalPlace > 0 Then 

  



174 

 

Copyright of www.ExcelExpertTraining.com 

Satang = GetTens(Left(Mid(MyNumber, DecimalPlace + 1) & "00", 2)) 

MyNumber = Trim(Left(MyNumber, DecimalPlace - 1)) 

End If 

 

Count = 1 

Do While MyNumber <> "" 

Temp = GetHundreds(Right(MyNumber, 3)) 

If Temp <> "" Then Baht = Temp & Place(Count) & Baht 

If Len(MyNumber) > 3 Then 

MyNumber = Left(MyNumber, Len(MyNumber) - 3) 

Else 

MyNumber = "" 

End If 

Count = Count + 1 

Loop 

 

Select Case Baht 

Case "" 

Baht = "No Baht" 

Case "One" 

Baht = "One Baht" 

Case Else 

Baht = Baht & " Baht" 

End Select 

 

Select Case Satang 

Case "" 

Satang = " and No Satang" 

Case "One" 

Satang = " and One Satang" 
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Case Else 

Satang = " and " & Satang & " Satang" 

End Select 

 

BahtEng = Baht & Satang 

End Function 

 

'******************************************* 

' Converts a number from 100-999 into text * 

'******************************************* 

Private Function GetHundreds(ByVal MyNumber) 

Dim Result As String 

 

If Val(MyNumber) = 0 Then Exit Function 

MyNumber = Right("000" & MyNumber, 3) 

 

'Convert the hundreds place 

If Mid(MyNumber, 1, 1) <> "0" Then 

Result = GetDigit(Mid(MyNumber, 1, 1)) & " Hundred " 

End If 

 

'Convert the tens and ones place 

If Mid(MyNumber, 2, 1) <> "0" Then 

Result = Result & GetTens(Mid(MyNumber, 2)) 

Else 

Result = Result & GetDigit(Mid(MyNumber, 3)) 

End If 

 

GetHundreds = Result 

End Function 
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'********************************************* 

' Converts a number from 10 to 99 into text. * 

'********************************************* 

Private Function GetTens(TensText) 

Dim Result As String 

 

Result = "" 'null out the temporary function value 

If Val(Left(TensText, 1)) = 1 Then ' If value between 10-19 

Select Case Val(TensText) 

Case 10: Result = "Ten" 

Case 11: Result = "Eleven" 

Case 12: Result = "Twelve" 

Case 13: Result = "Thirteen" 

Case 14: Result = "Fourteen" 

Case 15: Result = "Fifteen" 

Case 16: Result = "Sixteen" 

Case 17: Result = "Seventeen" 

Case 18: Result = "Eighteen" 

Case 19: Result = "Nineteen" 

Case Else 

End Select 

Else ' If value between 20-99 

Select Case Val(Left(TensText, 1)) 

Case 2: Result = "Twenty " 

Case 3: Result = "Thirty " 

Case 4: Result = "Forty " 

Case 5: Result = "Fifty " 

Case 6: Result = "Sixty " 

Case 7: Result = "Seventy " 
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Case 8: Result = "Eighty " 

Case 9: Result = "Ninety " 

Case Else 

End Select 

Result = Result & GetDigit _ 

(Right(TensText, 1)) 'Retrieve ones place 

End If 

GetTens = Result 

End Function 

 

'******************************************* 

' Converts a number from 1 to 9 into text. * 

'******************************************* 

Private Function GetDigit(Digit) 

Select Case Val(Digit) 

Case 1: GetDigit = "One" 

Case 2: GetDigit = "Two" 

Case 3: GetDigit = "Three" 

Case 4: GetDigit = "Four" 

Case 5: GetDigit = "Five" 

Case 6: GetDigit = "Six" 

Case 7: GetDigit = "Seven" 

Case 8: GetDigit = "Eight" 

Case 9: GetDigit = "Nine" 

Case Else: GetDigit = "" 

End Select 

End Function 

    สตูรแปลงตวัเลขเป็นคําอา่น   
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22 

Option Explicit 

 

'**************** 

' Main Function * 

'**************** 

Function BahtOnly(ByVal MyNumber) 

Dim Baht, Satang, Temp 

Dim DecimalPlace, Count 

 

ReDim Place(9) As String 

Place(2) = " Thousand " 

Place(3) = " Million " 

Place(4) = " Billion " 

Place(5) = " Trillion " 

 

' String representation of amount 

MyNumber = Trim(Str(MyNumber)) 

 

' Position of decimal place 0 if none 

DecimalPlace = InStr(MyNumber, ".") 

'Convert Satang and set MyNumber to Baht amount 

If DecimalPlace > 0 Then 

Satang = GetTens(Left(Mid(MyNumber, DecimalPlace + 1) & "00", 2)) 

MyNumber = Trim(Left(MyNumber, DecimalPlace - 1)) 

End If 

 

Count = 1 

Do While MyNumber <> "" 

Temp = GetHundreds(Right(MyNumber, 3)) 
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If Temp <> "" Then Baht = Temp & Place(Count) & Baht 

If Len(MyNumber) > 3 Then 

MyNumber = Left(MyNumber, Len(MyNumber) - 3) 

Else 

MyNumber = "" 

End If 

Count = Count + 1 

Loop 

 

Select Case Baht 

Case "" 

Baht = "No Baht" 

Case "One" 

Baht = "One Baht" 

Case Else 

Baht = Baht & " Baht" 

End Select 

 

Select Case Satang 

Case "" 

Satang = " Only" 

Case "One" 

Satang = " and One Satang" 

Case Else 

Satang = " and " & Satang & " Satang" 

End Select 

 

BahtOnly = Baht & Satang 

End Function 
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'******************************************* 

' Converts a number from 100-999 into text * 

'******************************************* 

Private Function GetHundreds(ByVal MyNumber) 

Dim Result As String 

 

If Val(MyNumber) = 0 Then Exit Function 

MyNumber = Right("000" & MyNumber, 3) 

 

'Convert the hundreds place 

If Mid(MyNumber, 1, 1) <> "0" Then 

Result = GetDigit(Mid(MyNumber, 1, 1)) & " Hundred " 

End If 

 

'Convert the tens and ones place 

If Mid(MyNumber, 2, 1) <> "0" Then 

Result = Result & GetTens(Mid(MyNumber, 2)) 

Else 

Result = Result & GetDigit(Mid(MyNumber, 3)) 

End If 

 

GetHundreds = Result 

End Function 

 

'********************************************* 

' Converts a number from 10 to 99 into text. * 

'********************************************* 

Private Function GetTens(TensText) 

Dim Result As String 
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Result = "" 'null out the temporary function value 

If Val(Left(TensText, 1)) = 1 Then ' If value between 10-19 

Select Case Val(TensText) 

Case 10: Result = "Ten" 

Case 11: Result = "Eleven" 

Case 12: Result = "Twelve" 

Case 13: Result = "Thirteen" 

Case 14: Result = "Fourteen" 

Case 15: Result = "Fifteen" 

Case 16: Result = "Sixteen" 

Case 17: Result = "Seventeen" 

Case 18: Result = "Eighteen" 

Case 19: Result = "Nineteen" 

Case Else 

End Select 

Else ' If value between 20-99 

Select Case Val(Left(TensText, 1)) 

Case 2: Result = "Twenty " 

Case 3: Result = "Thirty " 

Case 4: Result = "Forty " 

Case 5: Result = "Fifty " 

Case 6: Result = "Sixty " 

Case 7: Result = "Seventy " 

Case 8: Result = "Eighty " 

Case 9: Result = "Ninety " 

Case Else 

End Select 

Result = Result & GetDigit _ 

(Right(TensText, 1)) 'Retrieve ones place 

End If 
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GetTens = Result 

End Function 

 

'******************************************* 

' Converts a number from 1 to 9 into text. * 

'******************************************* 

Private Function GetDigit(Digit) 

Select Case Val(Digit) 

Case 1: GetDigit = "One" 

Case 2: GetDigit = "Two" 

Case 3: GetDigit = "Three" 

Case 4: GetDigit = "Four" 

Case 5: GetDigit = "Five" 

Case 6: GetDigit = "Six" 

Case 7: GetDigit = "Seven" 

Case 8: GetDigit = "Eight" 

Case 9: GetDigit = "Nine" 

Case Else: GetDigit = "" 

End Select 

End Function 

    สตูรแปลงตวัเลขเป็นคําอา่น   

 

23 

Option Explicit 

 

'**************** 

' Main Function * 

'**************** 

Function Money(ByVal MyNumber, UnitName1, UnitName2) 
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Dim KeyUnit1, KeyUnit2, Temp 

Dim DecimalPlace, Count 

 

ReDim Place(9) As String 

Place(2) = " Thousand " 

Place(3) = " Million " 

Place(4) = " Billion " 

Place(5) = " Trillion " 

 

' String representation of amount 

MyNumber = Trim(Str(MyNumber)) 

 

' Position of decimal place 0 if none 

DecimalPlace = InStr(MyNumber, ".") 

'Convert KeyUnit2 and set MyNumber to KeyUnit1 amount 

If DecimalPlace > 0 Then 

KeyUnit2 = GetTens(Left(Mid(MyNumber, DecimalPlace + 1) & "00", 2)) 

MyNumber = Trim(Left(MyNumber, DecimalPlace - 1)) 

End If 

 

Count = 1 

Do While MyNumber <> "" 

Temp = GetHundreds(Right(MyNumber, 3)) 

If Temp <> "" Then KeyUnit1 = Temp & Place(Count) & KeyUnit1 

If Len(MyNumber) > 3 Then 

MyNumber = Left(MyNumber, Len(MyNumber) - 3) 

Else 

MyNumber = "" 

End If 

Count = Count + 1 
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Loop 

 

Select Case KeyUnit1 

Case "" 

KeyUnit1 = "No " & UnitName1 

Case "One" 

KeyUnit1 = "One " & UnitName1 

Case Else 

KeyUnit1 = KeyUnit1 & " " & UnitName1 & "s" 

End Select 

 

Select Case KeyUnit2 

Case "" 

KeyUnit2 = " Only" 

Case "One" 

KeyUnit2 = " and One " & " " & UnitName2 

Case Else 

KeyUnit2 = " and " & KeyUnit2 & " " & UnitName2 & "s" 

End Select 

 

Money = KeyUnit1 & KeyUnit2 

End Function 

 

'******************************************* 

' Converts a number from 100-999 into text * 

'******************************************* 

Private Function GetHundreds(ByVal MyNumber) 

Dim Result As String 

 

If Val(MyNumber) = 0 Then Exit Function 
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MyNumber = Right("000" & MyNumber, 3) 

 

'Convert the hundreds place 

If Mid(MyNumber, 1, 1) <> "0" Then 

Result = GetDigit(Mid(MyNumber, 1, 1)) & " Hundred " 

End If 

 

'Convert the tens and ones place 

If Mid(MyNumber, 2, 1) <> "0" Then 

Result = Result & GetTens(Mid(MyNumber, 2)) 

Else 

Result = Result & GetDigit(Mid(MyNumber, 3)) 

End If 

 

GetHundreds = Result 

End Function 

 

'********************************************* 

' Converts a number from 10 to 99 into text. * 

'********************************************* 

Private Function GetTens(TensText) 

Dim Result As String 

 

Result = "" 'null out the temporary function value 

If Val(Left(TensText, 1)) = 1 Then ' If value between 10-19 

Select Case Val(TensText) 

Case 10: Result = "Ten" 

Case 11: Result = "Eleven" 

Case 12: Result = "Twelve" 

Case 13: Result = "Thirteen" 
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Case 14: Result = "Fourteen" 

Case 15: Result = "Fifteen" 

Case 16: Result = "Sixteen" 

Case 17: Result = "Seventeen" 

Case 18: Result = "Eighteen" 

Case 19: Result = "Nineteen" 

Case Else 

End Select 

Else ' If value between 20-99 

Select Case Val(Left(TensText, 1)) 

Case 2: Result = "Twenty " 

Case 3: Result = "Thirty " 

Case 4: Result = "Forty " 

Case 5: Result = "Fifty " 

Case 6: Result = "Sixty " 

Case 7: Result = "Seventy " 

Case 8: Result = "Eighty " 

Case 9: Result = "Ninety " 

Case Else 

End Select 

Result = Result & GetDigit _ 

(Right(TensText, 1)) 'Retrieve ones place 

End If 

GetTens = Result 

End Function 

 

'******************************************* 

' Converts a number from 1 to 9 into text. * 

'******************************************* 

Private Function GetDigit(Digit) 
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Select Case Val(Digit) 

Case 1: GetDigit = "One" 

Case 2: GetDigit = "Two" 

Case 3: GetDigit = "Three" 

Case 4: GetDigit = "Four" 

Case 5: GetDigit = "Five" 

Case 6: GetDigit = "Six" 

Case 7: GetDigit = "Seven" 

Case 8: GetDigit = "Eight" 

Case 9: GetDigit = "Nine" 

Case Else: GetDigit = "" 

End Select 

End Function 

    สตูรแปลงตวัเลขเป็นคําอา่น   

 

24 

Option Explicit 

 

'**************** 

' Main Function * 

'**************** 

Function UnitText(ByVal MyNumber, UnitName1, UnitName2) 

Dim KeyUnit1, KeyUnit2, Temp 

Dim DecimalPlace, Count 

 

ReDim Place(9) As String 

Place(2) = " Thousand " 

Place(3) = " Million " 

Place(4) = " Billion " 
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Place(5) = " Trillion " 

 

' String representation of amount 

MyNumber = Trim(Str(MyNumber)) 

 

' Position of decimal place 0 if none 

DecimalPlace = InStr(MyNumber, ".") 

'Convert KeyUnit2 and set MyNumber to KeyUnit1 amount 

If DecimalPlace > 0 Then 

KeyUnit2 = GetTens(Left(Mid(MyNumber, DecimalPlace + 1) & "00", 2)) 

MyNumber = Trim(Left(MyNumber, DecimalPlace - 1)) 

End If 

 

Count = 1 

Do While MyNumber <> "" 

Temp = GetHundreds(Right(MyNumber, 3)) 

If Temp <> "" Then KeyUnit1 = Temp & Place(Count) & KeyUnit1 

If Len(MyNumber) > 3 Then 

MyNumber = Left(MyNumber, Len(MyNumber) - 3) 

Else 

MyNumber = "" 

End If 

Count = Count + 1 

Loop 

 

Select Case KeyUnit1 

Case "" 

KeyUnit1 = "No " & UnitName1 

Case "One" 

KeyUnit1 = "One " & UnitName1 
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Case Else 

KeyUnit1 = KeyUnit1 & " " & UnitName1 & "" 'without s 

End Select 

 

Select Case KeyUnit2 

Case "" 

KeyUnit2 = " Only" 

Case "One" 

KeyUnit2 = " and One " & " " & UnitName2 

Case Else 

KeyUnit2 = " and " & KeyUnit2 & " " & UnitName2 & "" 'without s 

End Select 

 

UnitText = KeyUnit1 & KeyUnit2 

End Function 

 

'******************************************* 

' Converts a number from 100-999 into text * 

'******************************************* 

Private Function GetHundreds(ByVal MyNumber) 

Dim Result As String 

 

If Val(MyNumber) = 0 Then Exit Function 

MyNumber = Right("000" & MyNumber, 3) 

 

'Convert the hundreds place 

If Mid(MyNumber, 1, 1) <> "0" Then 

Result = GetDigit(Mid(MyNumber, 1, 1)) & " Hundred " 

End If 
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'Convert the tens and ones place 

If Mid(MyNumber, 2, 1) <> "0" Then 

Result = Result & GetTens(Mid(MyNumber, 2)) 

Else 

Result = Result & GetDigit(Mid(MyNumber, 3)) 

End If 

 

GetHundreds = Result 

End Function 

 

'********************************************* 

' Converts a number from 10 to 99 into text. * 

'********************************************* 

Private Function GetTens(TensText) 

Dim Result As String 

 

Result = "" 'null out the temporary function value 

If Val(Left(TensText, 1)) = 1 Then ' If value between 10-19 

Select Case Val(TensText) 

Case 10: Result = "Ten" 

Case 11: Result = "Eleven" 

Case 12: Result = "Twelve" 

Case 13: Result = "Thirteen" 

Case 14: Result = "Fourteen" 

Case 15: Result = "Fifteen" 

Case 16: Result = "Sixteen" 

Case 17: Result = "Seventeen" 

Case 18: Result = "Eighteen" 

Case 19: Result = "Nineteen" 

Case Else 
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End Select 

Else ' If value between 20-99 

Select Case Val(Left(TensText, 1)) 

Case 2: Result = "Twenty " 

Case 3: Result = "Thirty " 

Case 4: Result = "Forty " 

Case 5: Result = "Fifty " 

Case 6: Result = "Sixty " 

Case 7: Result = "Seventy " 

Case 8: Result = "Eighty " 

Case 9: Result = "Ninety " 

Case Else 

End Select 

Result = Result & GetDigit _ 

(Right(TensText, 1)) 'Retrieve ones place 

End If 

GetTens = Result 

End Function 

 

'******************************************* 

' Converts a number from 1 to 9 into text. * 

'******************************************* 

Private Function GetDigit(Digit) 

Select Case Val(Digit) 

Case 1: GetDigit = "One" 

Case 2: GetDigit = "Two" 

Case 3: GetDigit = "Three" 

Case 4: GetDigit = "Four" 

Case 5: GetDigit = "Five" 

Case 6: GetDigit = "Six" 
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Case 7: GetDigit = "Seven" 

Case 8: GetDigit = "Eight" 

Case 9: GetDigit = "Nine" 

Case Else: GetDigit = "" 

End Select 

End Function 

    สตูรแปลงตวัเลขเป็นคําอา่น   

 

25 

Option Explicit 

 

Function NetYMD(Day1 As Date, Day2 As Date) As String 

Dim years, months, days, m 

 

years = Year(Day2) - Year(Day1) 

If Month(Day1) > Month(Day2) Then 

years = years - 1 

End If 

 

If Month(Day2) < Month(Day1) Then 

months = 12 - Month(Day1) + Month(Day2) 

Else 

months = Month(Day2) - Month(Day1) 

End If 

 

If Day(Day2) < Day(Day1) Then 

months = months - 1 

If Month(Day2) = Month(Day1) Then 

years = years - 1 
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months = 11 

End If 

End If 

 

days = Day(Day2) - Day(Day1) 

If days < 0 Then 

m = CInt(Month(Day2)) - 1 

If m = 0 Then m = 12 

Select Case m 

Case 1, 3, 5, 7, 8, 10, 12 

days = 31 + days 

Case 4, 6, 9, 11 

days = 30 + days 

Case 2 

If (Year(Day2) Mod 4 = 0 And Year(Day2) _ 

Mod 100 <> 0) Or Year(Day2) Mod 400 = 0 Then 

days = 29 + days 

Else 

days = 28 + days 

End If 

End Select 

End If 

NetYMD = CStr(years) + " years " + CStr(months) _ 

+ " months " + CStr(days) + " days " 

End Function 

 

Function NetYear(Day1 As Date, Day2 As Date) As String 

Dim years, months, days, m 

 

years = Year(Day2) - Year(Day1) 
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If Month(Day1) > Month(Day2) Then 

years = years - 1 

End If 

NetYear = CStr(years) 

 

End Function 

 

Function NetMonth(Day1 As Date, Day2 As Date) As String 

Dim years, months, days, m 

 

If Month(Day2) < Month(Day1) Then 

months = 12 - Month(Day1) + Month(Day2) 

Else 

months = Month(Day2) - Month(Day1) 

End If 

 

If Day(Day2) < Day(Day1) Then 

months = months - 1 

If Month(Day2) = Month(Day1) Then 

years = years - 1 

months = 11 

End If 

End If 

 

NetMonth = CStr(months) 

 

End Function 

 

Function NetDay(Day1 As Date, Day2 As Date) As String 

Dim years, months, days, m 
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days = Day(Day2) - Day(Day1) 

If days < 0 Then 

m = CInt(Month(Day2)) - 1 

If m = 0 Then m = 12 

Select Case m 

Case 1, 3, 5, 7, 8, 10, 12 

days = 31 + days 

Case 4, 6, 9, 11 

days = 30 + days 

Case 2 

If (Year(Day2) Mod 4 = 0 And Year(Day2) _ 

Mod 100 <> 0) Or Year(Day2) Mod 400 = 0 Then 

days = 29 + days 

Else 

days = 28 + days 

End If 

End Select 

End If 

 

NetDay = CStr(days) 

 

End Function 

    สตูรคํานวณระยะเวลา   

 

26 
Function PersonalTax(TaxableIncome)  

Const UpperRange0 = 50000 
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Const UpperRange1 = 100000 

Const UpperRange2 = 500000 

Const UpperRange3 = 1000000 

Const UpperRange4 = 4000000 

Const TaxRate0 = 0 

Const TaxRate1 = 0.05 

Const TaxRate2 = 0.1 

Const TaxRate3 = 0.2 

Const TaxRate4 = 0.3 

Const TaxRate5 = 0.37 

Const TotalTaxPay0 = 0 

Const TotalTaxPay1 = 2500 

Const TotalTaxPay2 = 42500 

Const TotalTaxPay3 = 142500 

Const TotalTaxPay4 = 1042500 

Select Case TaxableIncome 

Case Is >= UpperRange4 

PersonalTax = TotalTaxPay4 + _ 

(TaxRate5 * (TaxableIncome - UpperRange4)) 

Case Is >= UpperRange3 

PersonalTax = TotalTaxPay3 + _ 

(TaxRate4 * (TaxableIncome - UpperRange3)) 

Case Is >= UpperRange2 

PersonalTax = TotalTaxPay2 + _ 

(TaxRate3 * (TaxableIncome - UpperRange2)) 

Case Is >= UpperRange1 

PersonalTax = TotalTaxPay1 + _ 

(TaxRate2 * (TaxableIncome - UpperRange1)) 

Case Is >= UpperRange0 

PersonalTax = TotalTaxPay0 + _ 
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(TaxRate1 * (TaxableIncome - UpperRange0)) 

Case Is < UpperRange0 

PersonalTax = TaxRate0 * TaxableIncome 

End Select 

End Function 

    สตูรคํานวณภาษีหกั ณ ทีจ่า่ย   

 

27 

Public Function SigFig(X As Variant, SigFigs As Integer) As Variant 

 

'Rounds X to Sigfigs significant figures 

'Many thanks to John N. of Locum Destination Consulting for sharing his 

SigFig() function for rounding to significant figures. 

'http://www.pcqna.com/Excel_Rounding.htm 

 

Dim Powers As Double, Sign As Long 

On Error GoTo ErrHandler 

If SigFigs < 1 Then GoTo ErrHandler 

Sign = Sgn(X) 

X = Abs(X) 

Powers = 10 ^ (Int(Log(X) / Log(10#)) + 1) 

'Application.Round() in next line is an Excel function; adjust as needed 

SigFig = Sign * Application.Round(X / Powers, SigFigs) * Powers 

Exit Function 

ErrHandler: 

SigFig = CVErr(xlErrValue) 

End Function 
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'Further developed by Somkiat Foongkiat 

'http://xls.i.am 

'Excel Expert Training 

 

Public Function SigFigDown(X As Variant, SigFigs As Integer) As Variant 

Dim Powers As Double, Sign As Long 

On Error GoTo ErrHandler 

If SigFigs < 1 Then GoTo ErrHandler 

Sign = Sgn(X) 

X = Abs(X) 

Powers = 10 ^ (Int(Log(X) / Log(10#)) + 1) 

SigFigDown = Sign * Application.RoundDown(X / Powers, SigFigs) * 

Powers 

Exit Function 

ErrHandler: 

SigFigDown = CVErr(xlErrValue) 

End Function 

 

 

Public Function SigFigUp(X As Variant, SigFigs As Integer) As Variant 

Dim Powers As Double, Sign As Long 

On Error GoTo ErrHandler 

If SigFigs < 1 Then GoTo ErrHandler 

Sign = Sgn(X) 

X = Abs(X) 

Powers = 10 ^ (Int(Log(X) / Log(10#)) + 1) 

SigFigUp = Sign * Application.RoundUp(X / Powers, SigFigs) * Powers 

Exit Function 

ErrHandler: 

SigFigUp = CVErr(xlErrValue) 
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End Function 

 

 

Public Function PowerNum(X As Variant) As Double 

X = Abs(X) 

PowerNum = (Int(Log(X) / Log(10#)) + 1) 

End Function 

 

Public Function RoundSP(Num As Variant, NumDigits As Integer) As 

Variant 

Dim PowersX As Double, PowersZ As Double, Sign As Long 

Dim X1 As Variant, X2 As Variant, X3 As Variant 

Dim Y1 As Variant, Y2 As Variant 

Dim Z1 As Variant, Z2 As Variant, Z3 As Variant 

 

On Error GoTo ZeroHandler 

Sign = Sgn(Num) 

Num = Abs(Num) 

 

X1 = Application.RoundDown(Num, NumDigits + 1) 

PowersX = 10 ^ (Int(Log(X1) / Log(10#)) + 1) 

X2 = X1 / PowersX 

X3 = Right(X2, 1) 'หาตวัเลขหลกัถดัไป 

 

Y1 = Application.RoundDown(Num, NumDigits + 1) 

Y2 = Num - Y1 'หาวา่ถดัจากนัน้มคีา่อะไรอยูอ่กี 

 

Z1 = Application.RoundDown(Num, NumDigits) 

PowersZ = 10 ^ (Int(Log(Z1) / Log(10#)) + 1) 

Z2 = Z1 / PowersZ 
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Z3 = Right(Z2, 1) 'หาตวัเลข ณ หลกันัน้ 

 

If (X3 > 5) _ 

Or ((X3 = 5) And (Y2 <> 0)) _ 

Or ((X3 = 5) And (Z3 - Application.Odd(Z3)) = 0) _ 

Then 

RoundSP = Sign * Application.Round(Num, NumDigits) 

Else 

RoundSP = Sign * Application.RoundDown(Num, NumDigits) 

End If 

Exit Function 

ZeroHandler: 

RoundSP = Sign * Application.Round(Num, NumDigits) 

End Function 

 

 

Public Function SigFigSP(X As Variant, SigFigs As Integer) As Variant 

Dim Powers As Double, Sign As Long 

On Error GoTo ErrHandler 

If SigFigs < 1 Then GoTo ErrHandler 

Sign = Sgn(X) 

X = Abs(X) 

Powers = 10 ^ (Int(Log(X) / Log(10#)) + 1) 

SigFigSP = Sign * RoundSP(X / Powers, SigFigs) * Powers 

Exit Function 

ErrHandler: 

SigFigSP = CVErr(xlErrValue) 

End Function 

 

Public Function CountDecimal(X As Variant) As Integer 
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X = Abs(X) 

If X < 1 Then 

CountDecimal = Len(X) - Len(Int(X)) 

Else 

CountDecimal = Application.Max(0, Len(X) - Len(Int(X)) - 1) 

End If 

End Function 

 

Public Function CountInteger(X As Variant) As Integer 

X = Abs(X) 

If Int(X) = 0 Then 

CountInteger = 0 

Else 

CountInteger = Len(Int(X)) 

End If 

End Function 

 

Public Function CountSF(X As Variant) As Integer 

Dim Powers As Double, X1 As Variant 

X = Abs(X) 

Powers = 10 ^ (Int(Log(X) / Log(10#)) + 1) 

X1 = X / Powers 

CountSF = Len(X1) - 1 

End Function 

    Significant Figure   
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General Functions 

1 =SUM(Sheet1:Sheet10!A1:A100)   

    รวมคา่ในเซลล ์A1:A100 ของทกุ sheet ตัง้แต ่sheet 1 ถงึ 10   

 

2 =COUNTA(Sheet1:Sheet10!A1:A100)   

    นับเซลล ์A1:A100 ทีม่คีา่ของทกุ sheet ตัง้แต ่sheet 1 ถงึ 10   

 

3 =COUNTIF(data,"<0")   

    นับจํานวนเซลลท์ีม่คีา่นอ้ยกวา่ 0   

 

4 =COUNTIF(data,"yes")   

    นับจํานวนเซลลท์ีม่คีา่ "yes"   

 

5 =COUNTIF(data,"*")   

    นับจํานวนเซลลท์ีม่คีา่ใดๆ   

 

6 =COUNTIF(data,"s*")   
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    นับจํานวนเซลลท์ีม่คีา่นําดว้ยตวัอกัษร "s"   

 

7 =COUNTIF(data,"*s*")   

    นับจํานวนเซลลท์ีม่ตีวัอกัษร "s"   

 

8 =COUNTIF(data,"yes")+COUNTIF(data,"no")    

    นับจํานวนเซลลท์ีม่คีา่ "yes" หรอื "no"   

 

9 =COUNTIF(data,"???")   

    นับจํานวนเซลลท์ีม่คีา่ 3 ตวัอกัษร   

 

10 =COUNTIF(data,">=1")-COUNTIF(data,">10")   

    นับจํานวนเซลลท์ีม่คีา่ระหวา่ง 1 ถงึ 10   

 

11  =SUMIF(A2:A10,"Jan",C2:C10)   

    รวมคา่ของ C2:C10 ในตําแหน่งซึง่ A2:A10 = "Jan"   

 

12  =COUNTIF(A2:A10,"Jan",C2:C10)   
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    นับคา่ของ C2:C10 ในตําแหน่งซึง่ A2:A10 = "Jan"   

 

13 =SUMIF(A2:A10,"<>Jan",C2:C10)   

    รวมคา่ของ C2:C10 ในตําแหน่งซึง่ A2:A10 <> "Jan"   

 

14 =SUMIF(Month,"Jan",Sales)+SUMIF(Month,"Feb",Sales)   

    รวมคา่ของ Sales ในตําแหน่งซึง่ Month="Jan" หรอื "Feb"   

 

15 
=SUMIF(A1:A6,"Part#1",B1:B6) 

=SUMPRODUCT((A1:A6="Part#1")*(B1:B6)) 
  

    รวมคา่ของ Part#1   

 

16 =SUM(IF(FREQUENCY(data,data)>0,1,0))   

    นับจํานวนเซลลท์ีม่คีา่ unique numeric values    

 

17 
=IF(COUNTIF(A$2:A2,A2)>1,COUNTIF(A$2:A2,A2),"")  

=IF(COUNTIF(A$2:A2,A2)>1,"Dup","") 
  

    แสดงตําแหน่งเซลลท์ีม่คีา่ซํ้า   
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18 

=IF(A1>=1,INT(A1)&"' ","") & TEXT(MOD(A1,1)*12,"- 

0"&IF(ABS(MOD(A1,1)*12-ROUND(MOD(A1,1)*12,0))>1/32," 

0/"&CHOOSE(ROUND(MOD(MOD(A1,1)*12,1)*16,0),16,8,16,4,16, 

8,16,2,16,8,16,4,16,8,16),"")) &""""  

  

    
ปัดเลขความยาวจาก feet และ decimal feet ไปเป็น feet, inches 

แบบปัดคา่ 1/16 inch fractions. 
  

 

19 

=INT(A1/12)&"' " & TEXT(MOD(A1,12),"0"&IF(ABS(MOD(A1,12)-

ROUND(MOD(A1,12),0))>1/32," 

0/"&CHOOSE(ROUND(MOD(MOD(A1,12),1)*16,0), 

16,8,16,4,16,8,16,2,16,8,16,4,16,8, 16),"")) & """"  

  

    
ปัดเลขความยาวจาก inches และ decimal fractions ไปเป็น feet 

และ inches แบบปัดคา่ 1/16th inch fractions 
  

 

20 

=TEXT(A1,"0"&IF(ABS(A1-ROUND(A1,0))>1/32," 0/"& CHOOSE( 

ROUND(MOD(A1,1)*16,0),16,8,16, 

4,16,8,16,2,16,8,16,4,16,8,16),"")) &""""  

  

    
ปัดเลขความยาวจาก inches และ decimal fractions ไปเป็น inches 

only with rounded 1/16th inch fractions 
  

 

21 

=VALUE(LEFT(A1,FIND("'",A1)-1)) + 

VALUE(MID(A1,FIND("'",A1) +1,FIND("""",A1)-FIND("'",A1)-

1))/12  
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    เปลีย่นเลขความยาว จาก Feet and Inches ไปเป็น feet   

 

22 
=VALUE(LEFT(A1,FIND("'",A1)-1))*12 + 

VALUE(MID(A1,FIND("'",A1) +1,FIND("""",A1)-FIND("'",A1)-1))  
  

    เปลีย่นเลขความยาว จาก Feet and Inches back ไปเป็น inches   

 

23 

สตูร คนืคา่ 

=SUM(E4:E23) รวมคา่ใน E4:E23 

=SUBTOTAL(9;G4:G26) 
รวมคา่ใน G4:G26 เฉพาะ visible 

cells 

=SUMPRODUCT(E4:E13;F4:F13)
รวมผลคณูระหวา่งn E4:E13 คณูกบั 

F4:F13 

{=SUM(E4:E13*F4:F13)} เหมอืนสตูรขา้งตน้แตใ่ช ้array formula 

=SUMSQ(E4:E13) S(x²) 

=SUMX2MY2(E4:E13;E14:E23) S(x² - y²) 

=SUMX2PY2(E4:E13;E14:E23) S(x² + y²) 

=SUMXMY2(E4:E13;E14:E23) S(x - y)² 
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24 =COUNTBLANK(E2:E23)   

    นับเซลลว์า่ง   

 

25 =CELL("filename")   

    แสดง path- และ filenames   

 

26 =RAND()*100   

    แสดงเลขสุม่เป็นเลขทศนยิมระหวา่ง 0 ถงึ 100   

 

27 =RAND()*(100-50)+50   

    แสดงเลขสุม่เป็นเลขทศนยิมระหวา่ง 50 ถงึ 100   

 

28 =ROUND(RAND()*100,0)   

    แสดงเลขสุม่เป็นเลขจํานวนเต็มระหวา่ง 0 ถงึ 100   

 

29   A สตูรสะสม   
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1 100 =SUM($A$1:A1) 

2 200 =SUM($A$1:A2) 

3 300 =SUM($A$1:A3) 

4 400 =SUM($A$1:A4) 

5 500 =SUM($A$1:A5 

 

    สตูรยอดรวมสะสม   

 

30 =LEN(B1)-LEN(SUBSTITUTE(SUBSTITUTE(B1,"B",""),"b",""))   

    
count the number of "B"s, both upper and lower case, in the 

string in B1 
  

 

31 =OFFSET(Sheet1!$A$2,0,0,COUNTA($A$2:$A$20),1)   

    Dynamic Ranges   

 

32 
=RIGHT(A2,LEN(A2)-FIND("*",SUBSTITUTE(A2," ","*",LEN(A2)- 

LEN(SUBSTITUTE(A2," ",""))))) 
  

    To return the last name. Suppose cell A2 contains the name   
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"John A Smith" 

 

33 
=LEFT(A2,FIND("*",SUBSTITUTE(A2," ","*",LEN(A2)- 

LEN(SUBSTITUTE(A2," ",""))))-1) 
  

    
To return the first name, including the middle name (if 

present), 
  

 

34 =LEFT(B2,FIND(" ",B2,1))   

    
To return the first name, without the middle name (if 

present), 
  

 

35 =LEFT(A1,FIND(" ",A1,1))   

    Returning  First Word In A String   

 

36 =RIGHT(A1,LEN(A1)-FIND(" ",A1,1))   

    Returning All But First Word In A String   

 

37 

"Grades" which refers to ={0,"F";60,"D";70,"C";80,"B";90,"A"} 

 

=VLOOKUP(A1,Grades,2) 
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    to convert the number to the grade:   

 

38 
=IF(ROW()-ROW(TopRng)+1>TopN,"",LARGE(RankRng,ROW()-

ROW(TopRng)+1)) 
  

    

Ranking Numbers : to return the N highest or lowest values 

from a range of data  

Suppose we have a range of numeric data called 

RankRng.   Create a range next to RankRng (starting in the 

same row, with the same number of rows) called TopRng. 

Also, create a named cell called TopN, and enter into it the 

number of values you want to return (e.g., 5 for the top 5 

values in RankRng). Enter the following formula in the first 

cell in TopRng, and use Fill Down to fill out the range 

  

 

39 
=IF(ROW()-ROW(TopRng)+1>TopN,"",SMALL(RankRng,ROW()-

ROW(TopRng)+1)) 
  

    To return the TopN smallest values of RankRng   

 

40 =CELL("filename",A1)   

    To return the full sheet name (including the file path)   

 

41 =MID(CELL("filename",A1),FIND("]",CELL("filename",A1))+1,   
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LEN(CELL("filename",A1))-FIND("]",CELL("filename",A1))) 

    To return the sheet name, without the path   

 

42 
=MID(CELL("filename",A1),FIND("[",CELL("filename",A1))+1,FIND("]", 

CELL("filename",A1))-FIND("[",CELL("filename",A1))-1) 
  

    To return the file name without the path   

 

43 

=LEFT(CELL("filename",A1),FIND("]",CELL("filename",A1))) Or  

=SUBSTITUTE(SUBSTITUTE(LEFT(CELL("filename",A1),FIND("]", 

CELL("filename",A1))),"[",""),"]","") 

  

    To return the file name with the path   

 

44 

=RadiusEarth*ACOS(COS(RADIANS(90-

(Lat1*24)))*COS(RADIANS(90-(Lat2*24)))+ 

SIN(RADIANS(90-(Lat1*24)))*SIN(RADIANS(90-(Lat2*24)))* 

COS(RADIANS(24*(Long1-Long2)))) 

  

    

Great Circle Distances  

Lat1 is the latitude of point 1, entered as DD:MM:SS. 

Long1 is the longitude of point 1, entered as DD:MM:SS. 

Lat2 is the latitude of point 2, entered as DD:MM:SS. 

Long2 is the longitude of point 2, entered as DD:MM:SS. 

RadiusEarth is the radius of the earth (3,963 miles or 6,377 
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kilometers). 

 

45 

=RadiusEarth*ACOS(COS(RADIANS(90-

Lat1))*COS(RADIANS(90-Lat2))+ 

SIN(RADIANS(90-Lat1))*SIN(RADIANS(90-

Lat2))*COS(RADIANS(Long1-Long2))) 

  

    

mixing hemispheres, enter Northern and Western coordinates 

as positive, and Southern and Eastern coordinates as 

negative 

  

 

46 
=LEFT(A2,IF(ISERROR(FIND(",",A2,1)),LEN(A2),FIND(",",A2,1)-

1)) 
  

    To return the last name of the full name in A2   

 

47 

=TRIM(IF(ISERROR(FIND(",",A2,1)),A2,MID(A2,FIND(",",A2,1)+1, 

IF(ISERROR(FIND(" ",A2,FIND(",",A2,1)+2)),LEN(A2), 

FIND(" ",A2,FIND(",",A2,1)+2))-FIND(",",A2,1)))) 

  

    To return the first name    

 

48 

=TRIM(RIGHT(A2,LEN(A2)-IF(ISERROR(FIND(" ",A2, 

FIND(" ",A2,FIND(",",A2,1)+2))),LEN(A2), 

FIND(" ",A2,FIND(" ",A2,FIND(",",A2,1)+2))-1))) 
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    To return the middle name    

 

49 =MAX(A1:A10,B1)   

    

the highest score ever reached  

the Tolls->Options dialog, click on the Calculation tab, and 

check the Interations check box 

  

 

50 =SUM(INDIRECT("A1:A10"))   

    =SUM($A$1:$A$10),   

 

51 
=A1&IF(AND(A1>=10,A1<=14),"th", 

CHOOSE(MOD(A1,10)+1,"th","st","nd","rd","th","th","th","th","th","th")) 
  

    return the number in A1 with the suffix appended   

 

52 =RANK(C7,C$7:C$16)+COUNTIF(C$7:C7,C7)-1   

    Unique Ranks    

 

53 
=COUNT(C$7:C$16)-

(RANK(C7,C$7:C$16)+COUNTIF(C$7:C7,C7))+2 
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    Reverse Unique Ranks    

 

54 =CELL("filename",A1)   

    D:\driveM\excel\TAXES\[1996FEDT.XLS]Sheet1    

 

55 
=LEFT(CELL("filename",A1),FIND("[",CELL("filename",A1),1)-1)  

=INFO("directory") 
  

    D:\driveM\excel\TAXES\   

 

56 
=SUBSTITUTE(LEFT(CELL("filename",A1),FIND("]",CELL("filename",A1),1)-

1),"[","") 
 

    D:\driveM\excel\TAXES\1996FEDT.XLS   

 

57 
=SUBSTITUTE(SUBSTITUTE(CELL("filename",A1),"[",""),"]"," [") 

& "]" 
  

    
D:\driveM\excel\TAXES\1996FEDT.XLS [Sheet1]  

  
  

 

58 
=SUBSTITUTE(LEFT(LOWER(CELL("filename",A1)),FIND("]", 

CELL("filename",A1))-1),"[","") & " [" & 

MID(CELL("filename",A1),FIND("]",CELL("filename",A1))+1,28) & 
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"]" 

    d:\drivem\excel\taxes\1996fedt.xls [Sheet1]   

 

59 
=MID(CELL("filename",A1),FIND("[",CELL("filename",A1),1)+1,FIND("]", 

CELL("filename",A1),1)-FIND("[",CELL("filename",A1),1)-1) 
  

    1996FEDT.XLS   

 

60 

=RIGHT(CELL("filename",A1),LEN(CELL("filename",A1))-

FIND("]", CELL("filename",A1)))  

=MID(CELL("filename",A1),FIND("]",CELL("filename",A1))+1,99)  

=SheetName() 

  

    Sheet1    

 

61 

=INFO("directory")  

directory, memavail, memused, numfile, origin, osversion, recalc, 

release, system, totmem 

  

    C:\WINNT\Profiles\Administrator\Personal\    

 

62 
=UPPER(LEFT(A37,1)&"."&MID(A37,FIND(" ",A37&" ")+1,1)&". 

") 
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    Extract the first two initials   

 

63 
=IF(LEN(A11)=0,"",IF(ISERR(FIND(" 

",A11)),A11,LEFT(A11,FIND(" ",A11)-1))) 
  

    Extract the first word   

 

64 

=len(a1)-len(substitute(a1,"a",""))     — lettercase must match  

=len(a1)-len(substitute(upper(a1),"A",""))     — lettercase does 

not matter 

  

    Find number of occurrences of a character in a cell       

 

65 =LEN(A1)-LEN(SUBSTITUTE(A1,",",""))+(LEN(TRIM(A1))>0)    

    Find the number of items separated by commas   

 

66 
=LEN(SUBSTITUTE(TRIM(A1),CHAR(32),CHAR(32)&CHAR(32)) 

)-LEN(TRIM(A1))+1 
  

    Find the number of words in a string   

 

67 =LEN(A1)-LEN(SUBSTITUTE(A1,"aa","")))/LEN("aa")   

    Find the number of occurences of a string in a single cell   
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68 =countif(A1:J1,"aa")       

    
Find the number of cells in a range that have string as their 

value 
  

 

69 

=IF(ISERR(FIND("/",E22)),E22,MID(E22,FIND("/",E22,1)+1,99)) 

=IF(ISERR(FIND("/",E22)),"",MID(E22,FIND("/",E22,1)+1,99)) 

  

  

    Return string after first "/" character   

 

70 
=NOT(ISNUMBER(VALUE(LEFT(D7,1))))  

=IF(LEFT(TRIM(D7))="","",NOT(ISNUMBER(VALUE(LEFT(D7,1))))) 
  

    First Character checked as alphabetic character   

 

71 =SUBSTITUTE(A1," ","")   

    Remove All Spaces   

 

72 

=IF(MOD(INT(16*(+B2-

INT(B2)+0.0312)),16)=0,TEXT(B2,"#"),IF(MOD(INT(16*(+B2-

INT(B2)+0.0312)),8)=0,TEXT(B2,"# 

0/2"),IF(MOD(INT(16*(+B2-INT(B2)+0.0312)),4)=0,TEXT(B2,"# 

0/4"),IF(MOD(INT(16*(+B2-INT(B2)+0.0312)),2)=0,TEXT(B2,"# 

  



218 

 

Copyright of www.ExcelExpertTraining.com 

0/8"),TEXT(B2,"# 0/16"))))) 

    to reduce 8/16's to 1/2, 10/16 to 5/8   

 

73 =SUMPRODUCT(B2:B6,C2:C6)/SUM(C2:C6)   

    Weighted Average   

 

74 =OFFSET(MySheet!$A$1,0,0,COUNTA(MySheet!$A:$A),1)    

    Dynamic Named Ranges   

 

75 

=POWER((SUM(IF(values0,values*(POWER(1+rRate,(MAX(dates)-

dates)/daybase)) ,0)))/(SUM(IF(values<0,values/(POWER 

(1+iRate,(MAX(dates)-dates)/daybase)) ,0)))*-1,1/((MAX(dates)-

MIN(dates))/daybase))-1  

  

    

combine the functionality of the XIRR and MIRR functions  

values is the row or column range of cashflows  

dates is the row or column range of corresponding dates  

iRate is the interest rate you pay on the money used in the 

cash flows  

rRate is the interest rate you receive on the cash flows as you 

reinvest them 

daybase is days-in-year basis to use (usually 360 or 365).  
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76 

=MROUND(Num,IF(VALUE(RIGHT(Num/10^(INT(LOG(ABS(Num)))-

Plc+1),2))=0.5,2,1)* SIGN(Num)*10^(INT(LOG(ABS(Num)))-Plc+1))  

=MROUND(Num,IF(VALUE(RIGHT(Num/Fact,2))=0.5,2,1)*SIGN(Num)*Fact) 

 

    

'bankers rounding' for a number (Num) to a given number (Plc) of 

significant digits 

define 'Fact' as =10^(INT(LOG(ABS(Num)))-Plc+1),  

 

 

77 =INDEX(FREQUENCY((A1,A3,A5),20),2)    

    นับจํานวนเซลลซ์ึง่ไมไ่ดต้ดิตอ่กนั และมคีา่มากกวา่ 20   

 

78 
=LEN(A1)-LEN(SUBSTITUTE(A1,"B",""))  

=LEN(A1)-LEN(SUBSTITUTE(SUBSTITUTE(A1,"B",""),"b","")) 
  

    นับตวัอกัษร b ในเซลล ์   

 

79 

=SUM(LEN(A1)-LEN(SUBSTITUTE(A1,B1,"")))/LEN(B1)  

=SUM(LEN(A1)-

LEN(SUBSTITUTE(UPPER(A1),UPPER(B1),"")))/LEN(B1) 

  

    นับจํานวนคํา B1 ในประโยค A1   

 

80 =A1&IF(OR(VALUE(RIGHT(A1,2))={11,12,13}),   
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"th",IF(OR(VALUE(RIGHT(A1))={1,2,3}),CHOOSE(RIGHT(A1), 

"st","nd","rd"), "th")) 

    Ordinal Number   

 

81 
=IF(AND(A1>0,A1<257),IF(A1>26,CHAR(CEILING(A1/26,1)+63),"") 

&CHAR(IF(MOD(A1,26)=0,26,MOD(A1,26))+64),"") 
  

    แปลงเลขที ่column เป็นตวัอกัษร column   

 

82 
=MID(A1,FIND("*",SUBSTITUTE(A1,"\","*",LEN(A1)-

LEN(SUBSTITUTE(A1,"\",))))+1,LEN(A1)) 
  

    แยกชือ่ file จาก c:\MainDir\ชือ่ file   

 

83 
=IF(ISERR(LEFT(A1,FIND(" ",A1)-1)),A1,LEFT(A1,FIND(" ",A1)-

1)) 
  

    แยกคําแรกออกจากประโยคภาษาองักฤษ   

 

84 

=IF(LEN(A4)-LEN(SUBSTITUTE(A4," ",""))=0, A4, 

RIGHT(A4,LEN(A4) -FIND("*",SUBSTITUTE(A4," ", "*", LEN(A4)-

LEN(SUBSTITUTE(A4," ","")))))) 

  

    แยกคําสดุทา้ยออกจากประโยคภาษาองักฤษ   
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85 =RIGHT(A1,LEN(A1)-FIND(" ",A1,1))   

    แยกคําทีเ่หลอืซึง่ไมใ่ชคํ่าแรก ออกจากประโยคภาษาองักฤษ   

 

86 

=LEFT(A1,FIND(" ",A1)-1)  

=IF(ISERR(MID(A1,FIND(" ",A1)+1,IF(ISERR(FIND(" ",A1,FIND(" 

",A1)+1)),FIND(" ",A1),FIND(" ",A1,FIND(" ",A1)+1))-FIND(" 

",A1)-1)),"",MID(A1,FIND(" ",A1)+1,IF(ISERR(FIND(" 

",A1,FIND(" ",A1)+1)),FIND(" ",A1), FIND(" ",A1,FIND(" 

",A1)+1))-FIND(" ",A1)-1)) 

=RIGHT(A1,LEN(A1)-FIND("*",SUBSTITUTE(A1," ","*",LEN(A1)- 

LEN(SUBSTITUTE(A1," ",""))))) 

  

    แยก first name, middle names, last names   

 

87 
=IF(OR(LEFT(A1,2)="Mr",LEFT(A1,3)="Mrs",LEFT(A1,2)="Ms"), 

RIGHT(A1,LEN(A1)-FIND(" ",A1)),A1) 
  

    ตดัคํานําหนา้ชือ่ออกจากชือ่   

 

88 
=LEN(SUBSTITUTE(TRIM(A1),CHAR(32),CHAR(32)&CHAR(32)))-

LEN(TRIM(A1))+1 
  

    นับจํานวนคําในเซลล ์   
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89 

=LEFT(TRIM(A1),FIND(" ",TRIM(A1),1)-1)&" 

"&RIGHT(TRIM(A1),LEN(TRIM(A1))-IF(ISERROR(FIND(" 

",TRIM(A1),FIND(" ",TRIM(A1),1)+1)),FIND(" 

",TRIM(A1),1),FIND(" ",TRIM(A1),FIND(" ",TRIM(A1),1)+1))) 

  

    ตดั middle names ออกจากชือ่นามสกลุ   

 

90 

=SUBTOTAL(9, INDIRECT(ADDRESS( ROW(C3),COLUMN(C3) 

)&":"& ADDRESS( ROW(C3), 

ROW(INDIRECT(COLUMN(C3)&":"&COLUMN(G3))) ))) 

  

    Cumulative Sum คา่ในเซลล ์C3:G3   

 

91 
=MAX( 0, MIN( เวลาสิน้สดุกะ, กําหนดสิน้สดุ ) - MAX( เวลาเริม่กะ, 

กําหนดเริม่ ) ) 
  

    ระยะเวลาทีใ่ชใ้นกะนัน้   

 

92 =IF( Date>=Start, Amount, 0 )   

    แสดง Amount เมือ่ถงึวันทีกํ่าหนด   

 

93 =IF( Date<=Stop, Amount, 0 )   

    แสดง Amount เมือ่ยงัไมเ่ลยวนัทีกํ่าหนด   
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94 =IF( AND( Date>=Start, Date<=Stop ), Amount, 0 )   

    แสดง Amount ในชว่งวันทีกํ่าหนด   

 

95 
=IF( AND( Date>=Start, Date<=Stop, OR( MOD( Date-

Start+1,Cycle ) = 1,Cycle = 1 ) ), Amount, 0 ) 
  

    แสดง Amount ในชว่งวันทีกํ่าหนด และกําหนดเป็นชว่งๆตาม Cycle   
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Day and Time Formulas 

1 =DATEDIF(Date1,Date2,Interval)    

    

คํานวณระยะเวลาระหวา่งชว่งทีกํ่าหนด 

Interval Code ความหมาย 

 "m" จํานวนเดอืนสะสม 

 "d จํานวนวนัสะสม 

 "y" จํานวนปีสะสม 

 "ym" จํานวนเดอืนทีเ่หลอื เมือ่นับปีชนปี

 "yd" จํานวนวนัทีเ่หลอื เมือ่นับปีชนปี 

 "md" 
จํานวนวนัทีเ่หลอื เมือ่นับเดอืนชน

เดอืน 
 

  

 

2 

=DATEDIF(วนัเกดิ,NOW(),"y") & " years, " & DATEDIF(วนัเกดิ

,NOW(),"ym") & " months, " & DATEDIF(วนัเกดิ,NOW(),"md") & " 

days" 

  

    คํานวณอาย ุ   
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3 =AND((TDate>=MIN(TDate1,TDate2)),TDate<=MAX(TDate1,TDate2))   

    ตรวจสอบวา่ TDate อยูร่ะหวา่ง TDate1 ถงึ TDate2   

 

4 

=IF(OR(Date2<VDate1,VDate2<Date1),Date2-

Date1+1,IF(OR(AND(Date1<=VDate1,Date2>=VDate2), 

AND(Date1>=VDate1,Date2<=VDate2)),MAX(0,(Date2-Date1)-(VDate2-

VDate1)), 

IF(OR(AND(Date1<=VDate1,Date2<=VDate2),AND(Date1>=VDate1,Date2>V

Date2)), 

MAX(0,(VDate1-Date1))+MAX(0,Date2-VDate2),NA()))) 

 

    

นับจํานวนวันในระหวา่งชว่งวนัทีกํ่าหนด 

   

ชือ่ ความหมาย 

Date1 วนัทีเ่ริม่งาน 

Date2 วนัทีเ่สร็จงาน 

VDate1 
วนัเริม่ ซึง่ไมต่อ้งการนับเป็นวนั

ทํางาน 

VDate2 
วนัสดุทา้ย ซึง่ไมต่อ้งการนับเป็น

วนัทํางาน 
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NWRange ตารางวนัหยดุ 

 

 

5 

=IF(OR(Date2<VDate1,VDate2<Date1),NETWORKDAYS(Date1,Date2,NWRang

e), 

IF(OR(AND(Date1<=VDate1,Date2>=VDate2),AND(Date1>=VDate1,Date2<=

VDate2)), 

MAX(0,NETWORKDAYS(Date1,Date2,NWRange)-

NETWORKDAYS(VDate1,VDate2,NWRange)), 

IF(OR(AND(Date1<=VDate1,Date2<=VDate2),AND(Date1>=VDate1,Date2>V

Date2)), 

IF((Date1>=VDate1),0,NETWORKDAYS(Date1,VDate1-1,NWRange))+ 

IF((Date2<=VDate2),0,NETWORKDAYS(VDate2+1,Date2,NWRange)),NA()))) 

 

    นับวนัเฉพาะวนัธรรมดา ไมนั่บวนัหยดุสดุสปัดาหห์รอืวนัหยดุอืน่  

 

6 
=IF(OR(IDate2<RDate1,IDate1>RDate2),0,(MIN(IDate2,RDate2)-

MAX(IDate1,RDate1)+1)) 
  

    

นับจํานวนวันทีอ่ยูใ่นทัง้สองชว่งเวลาเหมอืนกนั 

   

ชือ่ ความหมาย 

IDate1 วนัเริม่ตน้ของชว่งแรก 

IDate2 วนัสดุทา้ยของชว่งแรก 
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RDate1 วนัเริม่ตน้ของชว่งทีส่อง 

RDate1 วนัสดุทา้ยของชว่งทีส่อง 

NWRange ตารางวนัหยดุ 

 

 

7 
=IF(OR(IDate2<RDate1,IDate1>RDate2),0, 

ABS(NETWORKDAYS(MIN(IDate2,RDate2),MAX(IDate1,RDate1),NWRange)))
 

    นับวนัเฉพาะวนัธรรมดา ไมนั่บวนัหยดุสดุสปัดาหห์รอืวนัหยดุอืน่  

 

8 
=MAX(0,NETWORKDAYS(MAX(D$5,$B6),MIN(DATE(YEAR(D$5),MONTH(D$5)+

1,0),$C6))) 
 

    

สรปุจํานวนวนัทํางานแตล่ะเดอืน  

 

 

 

9 
=MAX(0,(MIN($C17,DATE(YEAR(D$16),MONTH(D$16)+1,0))-

MAX($B17,D$16)+1)) 
  

    สรปุจํานวนวนัแตล่ะเดอืน    
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1

0 

=MAX(0,NETWORKDAYS(MAX(DATE(D$27,1,1),$B28),MIN(DATE(D$27,12,31

),$C28))) 
 

    

สรปุจํานวนวนัทํางานแตล่ะปี  

 

 

 

11 
=MAX(0,(MIN($C39,DATE(D$38,12,31))-

MAX($B39,DATE(D$38,1,1))+1)) 
  

    

สรปุจํานวนวนัแตล่ะปี  
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12 
=FLOOR("5/"&DAY(MINUTE(B2/38)/2+56)&"/"&B2,7)-34  

=FLOOR(DAY(MINUTE(B2/38)/2+56)&"/5/"&B2,7)-34  
  

    
วนั Easter  

B2 เป็นปีทีต่อ้งการหาวนั Easter 
  

 

13 =TRUNC(((B6-DATE(YEAR(B6),1,0))+6)/7)   

    เลขทีส่ปัดาห ์   

 

14 

=INT((A1-SUM(MOD(DATE(YEAR(A1-MOD(A1-2,7)+3),1,2), 

{1E+99,7})*{1,-1})+5)/7)   

=1+INT((A1-DATE(YEAR(A1+4-WEEKDAY(A1+6)),1,5)+ 

WEEKDAY(DATE(YEAR(A1+4-WEEKDAY(A1+6)),1,3)))/7) 

  

    เลขทีส่ปัดาหต์าม ISO   

 

15 =RIGHT(YEAR(A1),2)&TEXT(A1-DATE(YEAR(A1),1,0),"000")   

    เปลีย่นวนัทีป่กต ิเป็น Julian Date   

 

16 =DATE(IF(0+(LEFT(A1,2))<30,2000,1900)+LEFT(A1,2),1,RIGHT(A1,3))   

    เปลีย่น Julian date เป็นวนัทีป่กต ิ   
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17 

=DATE(IF(0+(LEFT(A1,2))<30,2000,1900)+LEFT(A1,2),1,RIGHT(A1,3)) 

- 

DATE(IF(0+(LEFT(A2,2))<30,2000,1900)+LEFT(A2,2),1,RIGHT(A2,3)) 

  

    ระยะเวลาระหวา่งสอง Julian Dates   

 

18 =DATE(IF(0+(LEFT(A1,2))<30,2000,1900)+LEFT(A1,2),1,RIGHT(A1,3)+A2)  

    เพิม่จํานวนวันนับจาก Julian Date  

 

19 
=IF(ROW(A1),CALL("Xlcall32","Excel4","2JRJ",74))  

=IF(ROW(A1:A4),CALL("Xlcall32","Excel4","2JRJ",74)) 
  

    วนัปรับปรงุคา่ครัง้สดุทา้ย   

 

20 

=IF(INT(StartDT)=INT(EndDT),"0 days " & ROUND(24*(EndDT-

StartDT),2)&"hours",MAX(NETWORKDAYS(StartDT+1,EndDT-

1,HolidayList),0)+INT(24*(((EndDT-INT(EndDT))-(StartDT-

INT(StartDT)))+(DayEnd-DayStart))/(24*(DayEnd-DayStart)))&" 

days "&MOD(ROUND(((24*(EndDT-INT(EndDT)))-

24*DayStart)+(24*DayEnd-(24*(StartDT-INT(StartDT)))),2), 

ROUND((24*(DayEnd-DayStart)),2))&" hours ") 

  

    
ระยะเวลาเป็นวนัและชัว่โมง ระหวา่งชว่งเวลาทีกํ่าหนด 
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ชือ่  ความหมาย  ตวัอยา่ง 

 StartDT 
 วนัทีแ่ละเวลา

เริม่ตน้ 

 25-Oct-99 

13:00 

 EndDT 
 วนัทีแ่ละเวลา

สิน้สดุ 

 28-Oct-99 

15:00 

 DayStart 
เวลาเริม่งาน

ประจําวนั 
 9:00 

 DayEnd 
เวลาเลกิงาน

ประจําวนั 
 17:00 

 HolidayList  ตารางวนัหยดุ  H1:H10 

 

 

21 

=IF(INT(StartDT)=INT(EndDT),ROUND(24*(EndDT-StartDT),2), 

(24*(DayEnd-DayStart)*(MAX(NETWORKDAYS(StartDT+1,EndDT-

1,HolidayList),0)+INT(24*(((EndDT-INT(EndDT))- 

(StartDT-INT(StartDT)))+(DayEnd-DayStart))/(24*(DayEnd-

DayStart))))+MOD(ROUND(((24*(EndDT-INT(EndDT)))-

24*DayStart)+(24*DayEnd-(24*(StartDT-INT(StartDT)))),2), 

ROUND((24*(DayEnd-DayStart)),2))))  

  

    นับจํานวนชัว่โมงทํางาน   
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22 =IF(OR(WEEKDAY(A4+1)=1,WEEKDAY(A4+1)=7),A4+3,A4+1)   

    ลําดบัวนัทีเ่ฉพาะวนัทํางานปกต ินับตัง้แตว่นัแรกในเซลล ์A4   

 

23 =DAY(DATE(YEAR(A1),MONTH(A1)+1,0))    

    เลขทีจํ่านวนวนัในแตล่ะเดอืน หรอืเลขวนัทีส่ดุทา้ยของเดอืน   

 

24 =DATE(YEAR(A1),MONTH(A1)+1,0)   

    วนัทีส่ดุทา้ยของเดอืน   

 

25 =DATE(YEAR(A1),MONTH(A1),0)   

    วนัทีส่ดุทา้ยของเดอืนกอ่น   

 

26 
=DATE(Yr,Mon,1+((Nth-(DoW>=WEEKDAY(DATE(Yr,Mon,1))))*7)+ 

(DoW-WEEKDAY(DATE(Yr,Mon,1)))) 
  

    

return the date of Nth day-of-week for a given month and year. 

For example, it will return 26-March-98 for the 4th Thursday of 

March, 1998.   Days-of-week range from 1 to 7, with Sunday = 

1 and Saturday = 7.  

Where Yr, Mon, Nth,  and DoW are cell references or values 

indicating Year, Month, Nth, and Day-Of-Week. 
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27 
=DATE(Yr,1,1+(Nth-(Dow>=WEEKDAY(DATE(Yr,1,1))))*7)+ 

Dow-WEEKDAY(DATE(Yr,1,1)) 
  

    

return the date of Nth day-of-week for a given  year  

Where Yr,Nth, and DoW are cell references or values indicating 

Year, Month, Nth, and Day-Of-Week 

  

 

28 =TRUNC((B1-A1)/7)&" Weeks "&MOD(B1-A1,7)&" Days"   

    จํานวนสปัดาหร์ะหวา่งชว่งเวลาทีกํ่าหนด   

 

29 =IF(ISERROR(VLOOKUP(WEEKDAY(A1),WorkDays,1,0)),FALSE,TRUE)   

    ตรวจสอบวา่ เป็นวนัทํางานปกตหิรอืไม ่   

 

30 =ROUNDUP(MONTH(A1)/3,0)   

    เลขทีไ่ตรมาส   

 

31 
=TRUNC(((A1-DATE(YEAR(A1),1,1))/7))+1+ 

IF(WEEKDAY(DATE(YEAR(A1),1,1))>WEEKDAY(A1),1,0) 
  

    เลขทีส่ปัดาหข์องวนัทีกํ่าหนด   
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32 =DATE(YEAR(A1)+1,MONTH(A1)+6, DAY(A1)+10)   

    วนัทีนั่บถดัไปอกี 1 ปี 6 เดอืน 10 วนั   

 

33 =IF(A1>B1,B1+1-A1,B1-A1)   

    ระยะเวลาระหวา่งชว่งเวลา   

 

34 =TIME(HOUR(A1),MROUND(MINUTE(A1),B1),0)   

    

ปรับเวลา ในเซลล ์A1 เป็นเลขชัว่โมง ครึง่ชัว่โมง หรอืสบิหา้นาท ีทีใ่กล ้

ทีส่ดุ 

B1 เป็นเลขนาท ีซึง่ตอ้งการปัดเขา้สู ่

  

 

35 
=TIME(HOUR(A1),FLOOR(MINUTE(A1),B1),0)  

=TIME(HOUR(A1),CEILING(MINUTE(A1),B1),0)  
  

    ปัดเวลาขึน้ลงสูช่ว่งทีใ่กลท้ีส่ดุ   

 

36 =SUMPRODUCT(N(MONTH(A1:A20)=12))   

    นับจํานวนเซลลท์ีม่วีนัทีซ่ ึง่อยูใ่นเดอืนธนัวาคม   

 

37 =SUMPRODUCT((MONTH(A1:A20)=12)*(YEAR(A1:A20)=2000))   
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    นับจํานวนเซลลท์ีม่วีนัทีซ่ ึง่อยูใ่นเดอืนธนัวาคม ปี 2000   

 

3

8 

=SUMPRODUCT(N(A1:A20>DATE(2000,11,15))*N(A1:A20<=DATE(2000,12,

15)))  

=countif(A1:A20,">=16/11/2000")-countif(A1:A20,">15/12/2000") 

 

    
นับจํานวนเซลลท์ีม่วีนัทีซ่ ึง่อยูร่ะหวา่งวนัที ่16 พฤษจกิายน ถงึวนัที ่15 เดอืน

ธนัวาคม 
 

 

39 =(A1>B1)+B1-A1   

    หาระยะเวลาระหวา่งเวลาทีกํ่าหนด    

 

40 

  A B C 

1 TIME Time สตูรทีใ่ช ้

2 1 0:01:00 
=ROUNDDOWN(A2,-2) / 2400 + MOD(A2,100) / 

1440 

3 2 0:02:00 
=ROUNDDOWN(A3,-2) / 2400 + MOD(A3,100) / 

1440 

4 3 0:03:00 
=ROUNDDOWN(A4,-2) / 2400 + MOD(A4,100) / 

1440 

  



236 

 

Copyright of www.ExcelExpertTraining.com 

5 1200 12:00:00 
=ROUNDDOWN(A5,-2) / 2400 + MOD(A5,100) / 

1440 

6 1201 12:01:00 
=ROUNDDOWN(A6,-2) / 2400 + MOD(A6,100) / 

1440 

7 2400 0:00:00 
=ROUNDDOWN(A7,-2) / 2400 + MOD(A7,100) / 

1440 

8 3359 9:59:00 
=ROUNDDOWN(A8,-2) / 2400 + MOD(A8,100) / 

1440 

 

    เปลีย่นเวลาแบบทหาร เป็น เวลาแบบมาตรฐาน   

 

41 

=INT((A1-(DATE(YEAR(A1+(MOD(8-WEEKDAY(A1),7)-3)),1,1))-3+ 

MOD(WEEKDAY(DATE(YEAR(A1+(MOD(8-WEEKDAY(A1),7)-

3)),1,1))+1,7))/7)+1 

  

    คนืคา่เป็นเลขทีส่ปดาห ์   

 

42 =NOW()+12/24   

    เวลา 12 ชัว่โมงถดัไปจากเวลาปัจจบุัน (24 ชม / วนั)   

 

43 =NOW()+10/1440   
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    เวลา 10 นาทถีดัไปจากเวลาปัจจบุนั (1440 นาท ี/ วนั)   

 

44 =NOW()+30/86400   

    เวลา 30 วนิาทถีดัไปจากเวลาปัจจบุัน (86400 วนิาท ี/ วนั)   

 

45 

A2: =TODAY()  

B2: =A2-MOD(A2-2,7)  

C2: =B2 

  

    Monday week starting dates   

 

46 

=A2&IF(INT(MOD(A2,100)/10)=1, "th", IF(MOD(A2,10)=1, "st", 

IF(MOD(A2,10)=2,"nd", IF(MOD(A2,10)=3, "rd","th"))))  

=DAY(A2)&IF(INT(MOD(DAY(A2),100)/10)=1, "th", 

IF(MOD(DAY(A2),10)=1, "st", IF(MOD(DAY(A2),10)=2,"nd", 

IF(MOD(DAY(A2),10)=3, "rd","th"))))& " " & TEXT(A2,"mmmm, 

yyyy") 

  

    ตวัเลขและวนัทีแ่บบนับมคํีาวา่ st nd rd th ตอ่ทา้ย   

 

47 =MROUND(A22,1/(24*4))    

    Rounding to nearest quarter hour   
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48 =FLOOR(A22,1/(24*4))    

    Rounding down to nearest quarter hour   

 

49 =CEILING(A22,1/(24*4))   

    Rounding Up to nearest quarter hour   

 

50 =TEXT(NOW(),"dd mmmm yyyy")   

    
เปลีย่นเวลาเป็นรปูแบบตวัอกัษร จะไดจั้ดชดิซา้ยและยดืขา้มขอบขวา

ออกไปได ้
  

 

5

1 

(วนัทีแ่สดงในแบบของ US/Canada mm/dd/yyyy)  

   

  
04/14/200

1 
Sat 36995 

 First Day of Week  
04/08/200

1 
Sun =B1-WEEKDAY(B1)+1 

 Last Day of Week  
04/14/200

1 
Sat =B1-WEEKDAY(B1)+7 

 First Day of Month 04/01/200 Sun =DATE(YEAR(B1),MONTH(B1),1) 
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1 

 Last Day of Month 
04/30/200

1 

Mo

n 
=DATE(YEAR(B1),MONTH(B1)+1,0) 

 First Day of Year 
04/01/200

1 
Sun =DATE(YEAR(B1),MONTH(B1),1) 

 Last Day of Year 
12/31/200

1 

Mo

n 
=DATE(YEAR(B1)+1,1,0) 

 Closest Monday 04/16/200

1 

Mo

n 

=DATE(YEAR(B1),MONTH(B1),DAY(

B1) 

+CHOOSE(WEEKDAY(B1),1,0,-1,-2,-

3,3,2,1)) 

 Next Monday 04/16/200

1 

Mo

n 

=DATE(YEAR(B1),MONTH(B1),DAY(

B1) 

+CHOOSE( 

WEEKDAY(B1),1,7,6,5,4,3,2)) 

 Next Monday 04/16/200

1 

Mo

n 

=A1-WEEKDAY(A1,2)+8 

 1st Monday of 

Month 

04/02/200

1 

Mo

n 

=DATE(YEAR(B1),MONTH(B1), 

CHOOSE(WEEKDAY(DATE(YEAR(B1)

, 

MONTH(B1),1)),2,1,7,6,5,4,3)) 
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 2nd Monday of Mont

h  

04/09/200

1 

Mo

n 

=DATE(YEAR(B1),MONTH(B1),7 

+CHOOSE(WEEKDAY(DATE(YEAR(B

1), 

MONTH(B1),1)),2,1,7,6,5,4,3)) 

 3rd Monday of 

Month 

04/16/200

1 

Mo

n 

=DATE(YEAR(B1),MONTH(B1),14 

+CHOOSE(WEEKDAY(DATE(YEAR(B

1), 

MONTH(B1),1)),2,1,7,6,5,4,3)) 

 4th Monday of 

Month 

04/23/200

1 

Mo

n 

=DATE(YEAR(B1),MONTH(B1),21 

+CHOOSE(WEEKDAY(DATE(YEAR(B

1), 

MONTH(B1),1)),2,1,7,6,5,4,3)) 

 5th Monday of 

Month 

04/30/200

1 

Mo

n 

=IF(MONTH(DATE(YEAR(B1), 

MONTH(B1),28+ 

CHOOSE(WEEKDAY(DATE(YEAR(B1)

, MONTH(B1),1)),2,1,7,6,5,4,3)))= 

MONTH(B1),DATE(YEAR(B1), 

MONTH(B1),28 

+CHOOSE(WEEDATE(YEAR(B1), 

MONTH(B1),1)), 

2,1,7,6,5,4,3)),"none") 

 Last Monday of 

Month 

04/30/200

1 

Mo

n 

=DATE(YEAR($B$1), 

MONTH($B$1)+1,1)- 

WEEKDAY(DATE(YEAR($B$1), 
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MONTH($B$1)+1,6)) 

 For a different day of the week rotate the 2nd to last parameters in 

CHOOSE. 

   i.e. 7,6,5,4,3,2,1 for Wednesday instead of 2,1,7,6,5,4,3 for Monday as 

used in some of the formulae. 

 Formula in C1 & D1, downward   =IF(ISNUMBER(B1),WEEKDAY(B1),"

") 

 

       

 

5

2 

   

A B E 

Dates 

 format 

mm/dd/yyy

y 

สตูรทีใ่ช ้

First ddd 

of Month 
03/01/1999 =DATE(YEAR(B18),MONTH(B18),1) 

Last ddd 

of Month 
03/31/1999 =DATE(YEAR($B$18),MONTH($B$18)+1,1)-1 

First 

Sunday of 
03/07/1999 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 

MOD(1+7-
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Mo. WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1))

,7) 

First 

Monday 
03/01/1999 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 

MOD(2+7-

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1))

,7) 

First 

Tuesday 
03/02/1999 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 

MOD(3+7-

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1))

,7) 

First 

Wednesda

y 

03/03/1999 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 

MOD(4+7-

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1))

,7) 

First 

Thursday 
03/04/1999 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 

MOD(5+7-

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1))

,7) 

First 

Friday 
03/05/1999 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 

MOD(6+7-

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1))

,7) 
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First 

Saturday 
03/06/1999 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 

MOD(7+7-

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1))

,7) 

Last 

Sunday of 

Mo. 

03/28/1999 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+1,

7)) 

Last 

Monday 
03/29/1999 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+1,

6)) 

Last 

Tuesday 
03/30/1999 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+1,

5)) 

Last 

Wednesda

y 

03/31/1999 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+1,

4)) 

Last 

Thursday 
03/25/1999 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+1,

3)) 

Last Friday 03/26/1999 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+1,

2)) 
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Last 

Saturday 
03/27/1999 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 

WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+1,

8)) 

Last 

weeknum  

of yr 

53 =WEEKNUM(DATE(YEAR(B18),12,31),1) 

 

       

 

53 

   

Description สตูร 

The date for 

Monday in the 

previous week 

=TODAY()-WEEKDAY(TODAY(),2)-6 

The date for 

Monday in the 

current week 

=TODAY()-WEEKDAY(TODAY(),2)+1 

The date for 

Monday in the next 

week 

=TODAY()-WEEKDAY(TODAY(),2)+8 

Create a valid date =DATE(2002,12,24) 
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Create a valid date =DATEVALUE("1.1.1980") 

Count of days in a 

month 
=DAY(DATE(YEAR(A1),MONTH(A1)+1,0)) 

Last date in a 

month 
=DATE(YEAR(A1),MONTH(A1)+1,0) 

Determine which 

quarter a date 

belongs to 

=CHOOSE(MONTH(A1),1,1,1,2,2,2,3,3,3,4,4,4) 

 

        

 

54 

=DAY(A1)&IF(INT(MOD(DAY(A1),100)/10)=1, "th", 

IF(MOD(DAY(A1),10)=1, "st",IF(MOD(DAY(A1),10)=2,"nd", 

IF(MOD(DAY(A1),10)=3, "rd","th"))))& " " &TEXT(A1,"mmmm, 

yyyy") 

  

    Ordinal Date   
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List & Database Formulas 

1 =INDEX(Rng,MATCH(MAX(COUNTIF(Rng,Rng)),COUNTIF(Rng,Rng),0))   

    แสดงคา่ทีใ่ชบ้อ่ยทีส่ดุ   

 

2 =INDEX(Rng,MATCH(MIN(COUNTIF(Rng,Rng)),COUNTIF(Rng,Rng),0))   

    แสดงคา่ทีใ่ชน้อ้ยครัง้ทีส่ดุ   

 

3 

=INDIRECT(ADDRESS(ROW(Rng)+MATCH(C1,Rng,0)-1,COLUMN(Rng)-

ColsToLeft)) Or  

=INDIRECT(ADDRESS(ROW(Rng)+MATCH(C1,Rng,0)-1,COLUMN(A:A) )) 

  

    Left Lookups   

 

4 =IF(MAX(COUNTIF(Range1,Range1))>1,"Duplicates","No Duplicates")   

    ตรวจสอบคา่ซํ้า   

 

5 =IF(COUNTIF(Range1, A5)>1,TRUE,FALSE)   

    ตรวจสอบคา่ซํ้า   

 



247 

 

Copyright of www.ExcelExpertTraining.com 

6 =IF(COUNTIF(Range1,???)>1,"Duplicate","")   

    ตรวจสอบคา่ซํ้า   

 

7 =COUNTIF($A:$A,$A1)>1   

     ตรวจสอบคา่ซํ้าในแถวตัง้   

 

8 

=SUM(N(OFFSET(E1,ROW(1:5)-1,-1*ROW(1:5)+1)))  

=SUMPRODUCT(N(OFFSET(E1,ROW(INDIRECT("1:5"))-1,-

1*ROW(INDIRECT("1:5"))+1))) 

=SUM(N(OFFSET(E1,ROW(INDIRECT("1:5"))-1,-

1*ROW(INDIRECT("1:5"))+1)))  

  

    sum A5:E1 ตามแนวทะแยงมมุ   

 

9 

=INDEX(Range2,MATCH(Value,Range1,0))  

=LOOKUP(Value,Range1,Range2) 

=VLOOKUP(Value,Range12,2,FALSE) 

  

    สตูรคน้หาคา่   
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Conditional Formatting & Data 

Validation Formulas 

Conditional Formatting   

 

1 =MOD(ROW()-Rw,N*2)+1<=N   

    

กําหนดรปูแบบใหเ้ป็นแถบแบบเลขคี ่ 

Rw เป็นเลขทีบ่รรทดัแรก 

N เป็นจํานวนบรรทดัในแตล่ะแถบ 

  

 

2 =MOD(ROW()-Rw,N*2)+1>N   

    

กําหนดรปูแบบใหเ้ป็นแถบแบบเลขคู ่ 

Rw เป็นเลขทีบ่รรทดัแรก 

N เป็นจํานวนบรรทดัในแตล่ะแถบ 

  

 

3 =ISERROR(cell_reference)   

    กําหนดรปูแบบใหก้บัเซลลท์ีเ่ป็น Error Values    

 

4 =ISTEXT(A1)   

    เซลลซ์ึง่ไมใ่ชต่วัเลข   
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5 =A1>AVERAGE($A$1:$D$12)   

    เซลลซ์ึง่มคีา่เกนิกวา่คา่เฉลีย่   

 

6 =MONTH(A1)=6   

    เซลลซ์ึง่เป็นเดอืนมถินุายน   

 

7 =A1=TODAY()   

    เซลลซ์ึง่เป็นวนันี ้   

 

8 =IF(ISBLANK(A1),"",OR(WEEKDAY(A1)=7,WEEKDAY(A1)=1))   

    เซลลซ์ึง่เป็นวนัเสารอ์าทติย ์   

 

9 =A1=MAX($A$1:$A$30)   

    เซลลซ์ึง่มคีา่สงูสดุ   

 

10 
=OR( A1=LARGE($A$1:$A$30,1), A1=LARGE($A$1:$A$30,2), 

A1=LARGE($A$1:$A$30,3) ) 
  

    เซลลซ์ึง่มคีา่สงูสดุ 3 ลําดบัแรก   
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11 =MOD(ROW(),2)=0   

    row เลขคู ่   

 

12 =MOD(INT((ROW()-1)/4)+1,2)   

    row ชดุละ 4 row   

 

13 =MOD(ROW(),2)=MOD(COLUMN(),2)   

    row เลขคู ่และเป็น column เลขคู ่   

 

14 =IF(COUNTIF($A$1:$D$12,A1)>1,TRUE,FALSE)   

    เซลลซ์ึง่มคีา่ซํ้า   

 

15 =A2<A1   

    เซลลซ์ึง่ไมไ่ดเ้รยีงลําดบั   

 

16 
=LEN( SUBSTITUTE(TRIM(A1), CHAR(32), CHAR(32)&CHAR(32)) )-

LEN(TRIM(A1))+1>1 
  

    เซลลซ์ึง่มคํีามากกวา่ 1 คํา   
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17 =LEN(A3)-LEN(SUBSTITUTE(SUBSTITUTE(A3,"A",""),"a",""))>0   

    เซลลซ์ึง่มตีวัอกัษรตวั a   

 

18 =AND($B$1:$B$4<>"")   

    เมือ่เซลลอ์ืน่มคีา่ครบแลว้   

 

1

9 

=MATCH($A1&$B1&$C1&$D1,$F$6:$F$15&$G$6:$G$15&$H$6:$H$15&$I$6:

$I$15,0)>=1 
 

    
เซลลซ์ึง่มคีา่ตรงกบัคา่ในตารางทกุ column $F$6:$F$15 และ $G$6:$G$15 

และ $H$6:$H$15 และ $I$6:$I$15 
 

 

Data Validation   

 

1 =COUNTIF($A$1:$A$50,A1)=1   

    ป้องกนัการบันทกึขอ้มลูซํ้า   

 

2 =ISNA(VLOOKUP(A9,A$1:A8,1,FALSE))   

    ป้องกนัการบันทกึขอ้มลูซํ้ากบัขอ้มลูบรรทดัเหนอืขึน้ไป   
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3 =ISTEXT(A5)   

    รับเฉพาะตวัอกัษร   

 

4 =A2>A1   

    รับคา่ซึง่มากขึน้   

 

5 =LEFT(A2)="a"   

    รับคา่ซึง่นําดว้ยตวั a   

 

6 =COUNTIF(A3,"A????")=1   

    รับคา่ซึง่นําดว้ยตวั a และม ี5 ตวัอกัษร   
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Array Formulas 

สตูร Array ตอ่ไปนีต้อ้งสรา้งขึน้โดยกดปุ่ ม Ctrl+Shift+Enter จะเกดิเครือ่งหมายวงเล็บปีก

กาปิดหวัทา้ยสตูร 

1 

=SUM(IF(List>0,List,FALSE))  

=AVERAGE(IF(List>0,List,FALSE)) 

 

=MIN(IF(List>0,List,FALSE)) 

=MAX(IF(List>0,List,FALSE)) 

  

    
หาผลลพัธเ์ฉพาะคา่บวกเทา่นัน้ สามารถละไมต่อ้งใส่

คําวา่ FALSE ในสตูร 
  

 

2 

=SUM(IF(List<>0,List,FALSE))  

=AVERAGE(IF(List<>0,List,FALSE)) 

=MIN(IF(List<>0,List,FALSE)) 

 

=MAX(IF(List<>0,List,FALSE)) 

  

    
หาผลลพัธเ์ฉพาะคา่ทีไ่มเ่ทา่กบั 0 เทา่นัน้ สามารถละ

ไมต่อ้งใสคํ่าวา่ FALSE ในสตูร 
  

 

3 
=SUM(IF((List>=LLim)*(List<=ULim),List,FALSE)) 
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=AVERAGE(IF((List>=LLim)*(List<=ULim),List,FALSE)) 

=MIN(IF((List>=LLim)*(List<=ULim),List,FALSE)) 

 

=MAX(IF((List>=LLim)*(List<=ULim),List,FALSE)) 

    

หาผลลพัธเ์ฉพาะคา่ทีอ่ยูร่ะหวา่ง LLim ถงึ ULim สามารถ

ละไมต่อ้งใสคํ่าวา่ FALSE ในสตูร  

LLim เป็นขดีจํากดัลา่ง, ULim เป็นขดีจํากดับน 

  

 

4 

=IF(A1=B1,1,0)  

=SUM(IF(A1:A10=B1:B10,1,0)) 

=SUM((A2:A10="Phone")*(B2:B10="Smith")*C2:C10) 

=SUM(IF((A2:A10="Fax")+(B2:B10="Jones"),1,0)) 

=SUM(IF(MOD((A2:A10="Fax")+(B2:B10="Jones"),2),1,0)) 

=SUM(IF((A2:A10="Fax")+(B2:B10="Jones")<>2,1,0) 

  

    

นับจํานวนเซลลต์ามเงือ่นไข โดยใชส้ตูร SUM ตวัเลข 1 โดย

ไมต่อ้งใชส้ตูร COUNT  

สงัเกตการใชเ้ครือ่งหมายบวก หรอื เครือ่งหมายคณู 

  

 

5 =SUM((Month="Jan")*(Region="North")*Sales)   

    รวมคา่ของ Sales ในตําแหน่งซึง่ Month="Jan" AND   
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Region="North" 

 

6 =SUM((Month="Jan")*(Region<>"North")*Sales)   

    
รวมคา่ของ Sales ในตําแหน่งซึง่ Month="Jan" AND 

Region<>"North" 
  

 

7 =SUM((Month="Jan")*(Region="North"))   

    
นับคา่ของ Sales ในตําแหน่งซึง่ Month="Jan" และ 

Region="North" 
  

 

8 =SUM((Month="Jan")*(Sales>=200)*(Sales))   

    
รวมคา่ของ Sales ในตําแหน่งซึง่ Month="Jan" และ 

Sales>= 200 
  

 

9 =SUM((Sales>=300)*(Sales<=400)*(Sales))   

    รวมคา่ของ Sales ระหวา่ง 300 ถงึ 400   

 

10 =SUM((Sales>=300)*(Sales<=400))   

    นับคา่ของ Sales ระหวา่ง 300 ถงึ 400   
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11 =SUM((A1:A10>=5)*(A1:A10<=10)*A1:A10)   

    รวมคา่ระหวา่ง 5 ถงึ 10   

 

12 =SUM((A1:A10>=5)*(A1:A10<=10))   

    นับจํานวนเซลลท์ีม่คีา่ระหวา่ง 5 ถงึ 10   

 

13 

สตูรนับ คนืคา่ 

=SUM((F4:F23="yes")+(F4:F23="no")) 

นับจํานวนเซลล์

ทีม่คํีาวา่ yes 

หรอื no 

=SUM(MOD(G4:G23,2)) 
นับจํานวนเซลล์

ทีม่เีลขคี ่

=SUM(IF(MOD(G4:G23,2)=0,1,0)) 
นับจํานวนเซลล์

ทีม่เีลขคู ่

=SUM(IF((F4:F23="yes")*(G4:G23>10),1,0))
นับจํานวนเซลล์

แบบและ 

=SUM((F5:F24="yes")*(G5:G24>10)) 
นับจํานวนเซลล์

แบบและ 
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=SUM((F4:F23="yes")+(F4:F23="no")) 
นับจํานวนเซลล์

แบบหรอื 

 

    
สงัเกตวา่คํานวณแบบหรอื ใชเ้ครือ่งหมายบวก สว่นแบบและ ใช ้

เครือ่งหมายคณู 
  

 

14 

=SUM(IF(MOD(ROW($A$1:$A$20),N)=0,$A$1:$A$20,0))  

=SUM(IF(MOD(ROW($B$3:$B$22)-

ROW($B$3)+1,N)=0,$B$3:B$20,0)) 

=SUM(IF(MOD(ROW($B$3:$B$22)-

ROW($B$3),N)=0,$B$3:B$22,0)) 

  

    รวมคา่ทกุๆตําแหน่งที ่N ตรงกนั   

 

15 =IF(COUNTIF($A$1:A1,A1)=1,A1,"")   

    แยกขอ้มลูทีไ่มซ่ํ้าออกมาแสดง   

 

16 =IF(COUNTIF($A$1:$A$10,B1)>0,B1,"")   

    แยกขอ้มลูทีซ่ํ้ากนัจากตารางตา่งกนัออกมาแสดง   

 

17 =IF(COUNTIF($A$1:$A$10,B1)=0,B1,"")   
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แยกขอ้มลูทีอ่ยูใ่นตารางหนึง่ ซึง่ไมซ่ํ้ากบัขอ้มลูในอกี

ตารางออกมาแสดง 
  

 

18 =AVERAGE(IF((A1:A60>=Low)*(A1:A60<=High),A1:A60))   

    เฉลีย่คา่ทีอ่ยูร่ะหวา่ง Low ถงึ High   

 

19 
=AVERAGE(LARGE(A1:A60,ROW(1:10)))  

=AVERAGE(LARGE(A1:A60,ROW(INDIRECT("1:10"))))
  

    

เฉลีย่คา่ทีม่ากทีส่ดุ 10 อนัดบัแรก  

ใหเ้ปลีย่น "1:10" เป็น "1:N" เพือ่กําหนด N ลําดบัแรกที่

ตอ้งการ 

  

 

20 =AVERAGE(SMALL(A1:A60,ROW(INDIRECT("1:10"))))   

    

เฉลีย่คา่ทีน่อ้ยทีส่ดุ 10 อนัดบัแรก  

ใหเ้ปลีย่น "1:10" เป็น "1:N" เพือ่กําหนด N ลําดบัแรกที่

ตอ้งการ 

  

 

21 =SUM(IF(ISERR(data),1,0))   

    นับจํานวนเซลลท์ีม่คีา่ error   
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22 

สตูร คนืคา่ 

=SUM(E4:E13*F4,F13) 

รวมผลคณูของ

ตาราง E4:E13 คณู

ดว้ย F4:F13 

=SUM((E4:E23)*(MOD(ROW(E4:E23) 

-ROW(E4),2)=0)) 

รวมคา่แบบบรรทดั

เวน้บรรทดั 

=SUM((E4:E23)*(MOD(ROW(E4:E23) 

-ROW(E4),5)=0)) 

รวมคา่ทกุๆบรรทดัที ่

5 ของแตล่ะชดุ 

=SUM(IF(MOD(I4:I23;2)=0,I4:I23,0)) 
รวมคา่เฉพาะคา่ที่

เป็นเลขคู ่

=SUM(IF(MOD(I4:I23,2)<>0,I4:I23,0)) 
รวมคา่เฉพาะคา่ที่

เป็นเลขคี ่

=SUM(IF((E4:E23>50)*(H4:H23="North"),

E4:E23,0)) 

รวมคา่เฉพาะคา่

แบบและ 

=SUM((E5:E24>50)*(H5:H24="North") 

*E5:E24,0) 

รวมคา่เฉพาะคา่

แบบและ 

=SUM((H4:H23="North")*E4:E23 

+(H4:H23="South")*E4:E23) 

รวมคา่เฉพาะคา่

แบบหรอื 
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23 =OFFSET(List,MAX(ROW(RevList))-ROW(),0)    

    กลบัลําดบัคา่ในแนวตัง้   

 

24 
=OFFSET(RowList,0,MAX(COLUMN(RevRowList))-

COLUMN()) 
  

    

กลบัลําดบัคา่ในแนวนอน  

RowList เป็นตารางขอ้มลูเดมิตามแนวนอน, 

RevRowList เป็นตารางเก็บคา่ทีจั่ดลําดบักลบัขา้ง 

  

 

25 

=OFFSET(CList,COLUMN()-MIN(COLUMN(RList)),0) 

=OFFSET(CList,MAX(COLUMN(RevRList))-

COLUMN(),0) 

  

    
ตะแคงตารางแนวตัง้ CList เป็นแนวนอน RList  

RevRList เป็นตารางแนวตัง้ทีส่ลบัคา่ 
  

 

26 

=OFFSET(RowList,0,ROW()-MIN(ROW(TXList)))  

=OFFSET(RowList,0,MAX(ROW(TList))-ROW()) 
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ตะแคงตารางแนวนอน RowList เป็นแนวตัง้ TXList  

TList เป็นตารางแนวนอนทีส่ลบัคา่ 
  

 

27 
=ADDRESS(MIN(IF(NumRange=MIN(NumRange),ROW(NumRange))), 

COLUMN(NumRange),4) 
 

    Address ของคา่ทีน่อ้ยทีส่ดุคา่แรก  

 

28 

=ADDRESS(MAX(IF(NumRange=MIN(NumRange),ROW(NumRange)* 

(NumRange<>""))), 

COLUMN(NumRange),4) 

 

    Address ของคา่ทีน่อ้ยทีส่ดุคา่สดุทา้ย  

 

29 
=ADDRESS(MIN(IF(NumRange=MAX(NumRange),ROW(NumRange))), 

COLUMN(NumRange),4) 
 

    Address ของคา่ทีม่ากทีส่ดุคา่แรก  

 

30 
=ADDRESS(MAX(IF(NumRange=MAX(NumRange),ROW(NumRange)* 

(NumRange<>""))),COLUMN(NumRange),4) 
 

    Address ของคา่ทีม่ากทีส่ดุคา่สดุทา้ย  
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31 =INDEX(Rng,MATCH(MAX(COUNTIF(Rng,Rng)),COUNTIF(Rng,Rng),0))  

    คา่ทีใ่ชซ้ํ้ามากทีส่ดุ  

 

32 
=(MAX((DataRange2<>"")*ROW(DataRange2)))-

ROW(DataRange2)+1 
  

    นับจํานวนบรรทดัทีม่ขีอ้มลู   

 

33 
=INDIRECT(ADDRESS(MAX((DataRange2<>"")*ROW(DataRange2)),

COLUMN(DataRange2),4)) 
 

    คนืคา่สดุทา้ยลา่งสดุในแถวตัง้แถวแรก  

 

34 
=INDIRECT(ADDRESS(MAX((DataRange2<>"")*ROW(DataRange2)),

COLUMN(DataRange2)+1,4)) 
 

    คนืคา่สดุทา้ยลา่งสดุในแถวตัง้แถวทีส่อง  

 

3

5 

=SUM(IF(FREQUENCY(IF(LEN(Range1)>0,MATCH(Range1,Range1,0),""

), 

IF(LEN(Range1)>0,MATCH(Range1,Range1,0),""))>0,1)) 

 

    นับจํานวนคา่ทีเ่ป็น Unique   
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36 =SUM(1/COUNTIF(A1:A10,A1:A10))   

    นับจํานวนคา่ทีเ่ป็น Unique กรณีไมม่ ีblank   

 

37 =SUM(N(FREQUENCY(A1:A10,A1:A10)>0))   

    
นับจํานวนคา่ทีเ่ป็น Unique ใชก้บัตารางตวัเลขหรอื

เซลลว์า่ง 
  

 

38 

=ADDRESS(ROW(DataRange2),COLUMN(DataRange2),4)&":"& 

ADDRESS(MAX((DataRange2<>"")*ROW(DataRange2)), 

COLUMN(DataRange2)+COLUMNS(DataRange2)-1,4) 

  

    
แสดง range ทีม่ขีอ้มลู data เชน่ DataRange2 เป็นตารางขอ้มลู 

H7:I25 โดยเซลล ์H7:I17 มตีวัเลขอยู ่นอกจากนัน้เป็นเซลลว์า่ง 
  

 

39 

=RIGHT(A1,LEN(A1)-

MAX(ROW(INDIRECT("1:"&LEN(A1))) 

*(MID(A1,ROW(INDIRECT("1:"&LEN(A1))),1)=" 

"))) 

  

    แสดงคําสดุทา้ยขวาสดุ   

 

40 
=MID(A10,SMALL(IF(MID(" "&A10,ROW(INDIRECT 

("1:"&LEN(A10)+1)),1)=" 

",ROW(INDIRECT("1:"&LEN(A10)+1))), 
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B10),SUM(SMALL(IF(MID(" "&A10&" ",ROW(INDIRECT 

("1:"&LEN(A10)+2)),1)=" 

",ROW(INDIRECT("1:"&LEN(A10)+2))), 

B10+{0,1})*{-1,1})-1) 

    แยกคําออกจากประโยค ซึง่มเีครือ่งหมายวรรคแยกแตล่ะคํา   

 

41 

=MID(A10,SMALL(IF(MID(" "&A10,ROW(INDIRECT 

("1:"&LEN(A10)+1)),1)=" 

",ROW(INDIRECT("1:"&LEN(A10)+1))), 

B10),SUM(SMALL(IF(MID(" "&A10&" ",ROW(INDIRECT 

("1:"&LEN(A10)+2)),1)=" 

",ROW(INDIRECT("1:"&LEN(A10)+2))), 

B10+C10*{0,1})*{-1,1})-1) 

  

    

แยกคําลําดบัทีต่อ้งการออกจากประโยค  

A10 เป็นประโยคทีม่คํีาอยู ่

B10 เป็นเลขทีคํ่าเริม่ตน้ทีต่อ้งการ 

C10 เป็นจํานวนคําทีต่อ้งการ เริม่ตน้จาก B10 

  

 

42 
=SUM(IF(WEEKDAY(A2-1+ROW(INDIRECT("1:"&TRUNC(B2-

A2)+1)))=C2,1,0)) 
  

    

นับจํานวนวันจันทรห์รอืวนัอืน่ๆ จากชว่งเวลาทีกํ่าหนด  

A2 เป็นวนัเริม่ตน้ 

B2 เป็นวนัสิน้สดุ 

C2 เป็นเลขทีข่องวนัในสปัดาห ์(1=Sunday, 
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2=Monday,...,7=Saturday) 

 

43 

=IF(ROW()-ROW(NoBlanksRange)+1>ROWS(BlanksRange)-  

COUNTBLANK(BlanksRange),"",INDIRECT(ADDRESS(SMALL( 

(IF(BlanksRange<>"",ROW(BlanksRange),ROW()+ 

ROWS(BlanksRange))), 

ROW()-ROW(NoBlanksRange)+1),COLUMN(BlanksRange),4))) 

  

    
ตดัเซลลว์า่งออกจากตาราง BlanksRange ใหเ้ป็นตารางใหม ่

NoBlanksRange เหลอืเฉพาะเซลลท์ีม่คีา่เทา่นัน้  
  

 

44 
=SUM(IF(IF(B$5>=F6:F10,F6:F10-F5:F9,$B$5-F5:F9+1)>0, 

IF(B$5>=F6:F10,F6:F10-F5:F9,$B$5-F5:F9+1),0)*G5:G9) 
  

    

Progressive Pricing คํานวณจํานวนเงนิทัง้หมด ใชห้ลกั FIFO 

สตูรนีม้ปีระโยชนอ์ยา่งมาก ใชก้บัปัญหาอืน่ๆ เชน่ อตัราภาษีแบบ

กา้วหนา้ การตดั Stock แบบ FIFO 

  E F G H 

4   Quantity UnitPrice   

5   1 5   

6   10 4   

7   30 3   
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8   60 2   

9   100 1   

10   9999999     

11         

 

 
    

 

 

45 

  A B C D E 

1 Part# ALPHA 

portion 

NUMERIC

portion 

    

2 ab2 ab 2 

{=LEFT(A2, 

MIN(IF(ISNUMBER( 

MID(A2,{1,2,3,4,5,6},1) 

*1),{1,2,3,4,5,6},7))-

1)} 

=RIGHT(A2, 

LEN(A2) -

LEN(B2))*1 

3 OP30 OP 30 

{=LEFT(A6, 

MIN(IF(ISNUMBER( 

MID(A3,{1,2,3,4,5,6},1) 

*1),{1,2,3,4,5,6},7))-

1)} 

=RIGHT(A3, 

LEN(A6) -

LEN(B6))*1 
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4 OP1221 OP 1221 

{=LEFT(A8, 

MIN(IF(ISNUMBER( 

MID(A4,{1,2,3,4,5,6},1) 

*1),{1,2,3,4,5,6},7))-

1)} 

=RIGHT(A4, 

LEN(A8) -

LEN(B8))*1 

 

    แยกคําทีเ่ป็นตวัอกัษรออกจากตวัเลข  

 

46 

=INDIRECT(ADDRESS( ROW(MyRange) +INT((ROW() -

ROW(CxRV))/COLUMNS(MyRange)), 

COLUMN(MyRange)+MOD(ROW() -ROW(CxRV), 

COLUMNS(MyRange)),4,,"Sheet1"))  

=INDIRECT(ADDRESS( ROW(MyRange) +MOD(ROW() -

ROW(CxCV),ROWS(MyRange)), 

COLUMN(MyRange)+INT((ROW() -

ROW(CxCV))/ROWS(MyRange)), 4,,"Sheet1")) 

=INDIRECT(ADDRESS( ROW(MyRange) +INT((COLUMN() -

COLUMN(RxRV))/COLUMNS(MyRange)), 

COLUMN(MyRange)+MOD(COLUMN() -COLUMN(RxRV), 

COLUMNS(MyRange)), 4,,"Sheet1")) 

=INDIRECT(ADDRESS( ROW(MyRange) +MOD(COLUMN() -

COLUMN(RxCV),ROWS(MyRange)), 

COLUMN(MyRange)+INT((COLUMN() -

COLUMN(RxCV))/ROWS(MyRange)),4,,"Sheet1"))  

  

    ตะแคงตารางเป็นแนวตัง้    
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MyRange เป็นตารางขอ้มลู มขีนาด M rows และ N 

columns 

CxRV เป็นตารางผลลพัธ ์
 

 

47 

=OFFSET($B$5,MIN(IF(COUNTIF($G$11:G11,$B$5:$GR$10)=0, 

ROW($B$5:$GR$10)- 

ROW($B$5))),MOD(MIN(IF(COUNTIF($G$11:G11,$B$5:$GR$10)=0, 

ROW($B$5:$GR$10)- ROW($B$5) +(COLUMN($B$5:$GR$10)-

COLUMN($B$5))/1000)),1)*1000)  

=INDEX(tbl,MIN(IF(COUNTIF($A$1:A1,tbl)=0,ROW(tbl)- 

MIN(ROW(tbl))+1)), 

MATCH(0,COUNTIF($A$1:A1,INDEX(tbl,MIN(IF( 

COUNTIF($A$1:A1,tbl)=0,ROW(tbl) -MIN(ROW(tbl))+1)),,1)),0),1)  

  

 

    list of unique entries in an n * m array   

 

48 =AND(NOT(ISNA(MATCH(Range1,Range2,0))))    

    ตรวจสอบวา่ขอ้มลูใน Range1 แสดงใน Range2   

 

49 

=MMULT(N(ROW(INDIRECT("1:"&ROWS(A)))=TRANSPOSE( 

ROWS(A)+1-ROW(INDIRECT("1:"&ROWS(A))))),A)  

=MMULT(A,N(ROW(INDIRECT("1:"&COLUMNS(A)))=TRANSPOSE 
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(COLUMNS(A)+1-ROW(INDIRECT("1:"&COLUMNS(A))))))  

    กลบัขา้งตาราง  

 

50 

=OR(A1=2,A1=3,ISNA(MATCH(TRUE,A1/ROW(INDIRECT( 

"2:"&INT(SQRT(A1))))= 

INT(A1/ROW(INDIRECT("2:"&INT(SQRT(A1))))),0)))  

  

    ตรวจสอบวา่เป็นตวัเลข prime number   

 

51 =MATCH(TRUE,EXACT("A",MyRange),0)    

    case-sensitive MATCH    

 

52 

17 = 5x + 3y + 2z  

13 = 2x + 4y + z  

22 = 3x + 2y + 5z  

Put the coefficients of the unknowns in, e.g., A1:C3 (i.e., 5,3,2 in 

A1:C1, 2,4,1 in A2:C2, etc.);  

Put the constants (17, 13, 22) in, e.g., D1:D3;  

Highlight, e.g., E1:E3 and array enter (i.e., enter with 

Ctrl+Shift+Enter instead of just Enter)  

=MMULT(MINVERSE(A1:C3,D1:D3)  

and the solution vector (1,2,3) will appear in E1:E3; i.e., x=1, 

y=2, z=3 For a set of equations that does not have a solution, 
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the #VALUE error will appear in E1:E3.  

    solve a set of simultaneous equations    

 

53 

=SUM(N(MATCH(MID(A1,ROW(INDIRECT("1:"&LEN(A1))),1), 

MID(A1,ROW(INDIRECT 

("1:"&LEN(A1))),1),0)=ROW(INDIRECT("1:"&LEN(A1)))))=LEN(A1)  

 

    ตรวจสอบวา่ตวัอกัษรในเซลลม์ซีํ้ากนัหรอืไม ่  

 

54 
=SUM(VALUE(MID(A1,ROW(INDIRECT("1:"&LEN(A1))),1))*10 

^(ROW(INDIRECT ("1:"&LEN(A1)))-1))  
  

    กลบัขา้งหลกัตวัเลข   

 

55 

A1:D1 = {1,2,3,4}  

A5:D5 = {5,6,7,5}  

=SUM({1,2,3,4}*{5,7,6,5}) = 57  

=SUM(A1:D1*INDEX(A5:D5,5-COLUMN(A5:D5))) 

  

    
สตูรเพีย้นโดยไมท่ราบสาเหต ุเมือ่สรา้งสตูรสดุทา้ยลงในเซลลเ์ดยีวจะ

คํานวณผดิ ตอ้งสรา้งสตูรลงในเซลล ์2 เซลล ์
  

 

56 
=ROWS(iRng)-

ROW(OFFSET($A$1,,,ROWS(iRng),)). 
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    กลบัตําแหน่งเซลล ์   

 

57 

=IF(T(OFFSET(iRng,ROWS(iRng)-

ROW(OFFSET($A$1,,,ROWS(iRng),)),,,))="",N 

(OFFSET(iRng,ROWS(iRng)-

ROW(OFFSET($A$1,,,ROWS(iRng),)),,,)),T(OFFSET 

(iRng,ROWS(iRng)-ROW(OFFSET($A$1,,,ROWS(iRng),)),,,)))  

  

    กลบัตารางแนวตัง้   

 

58 
=LARGE(IF(MATCH(Rng,Rng,0)=ROW(Rng)-

MIN(ROW(Rng))+1,Rng,""),N) 
  

    Nth largest unique value in a column range   

 

59 
=SUM(N(FREQUENCY(IF(lookupRange="specifStr", 

MATCH(colRange,colRange,0)), MATCH(colRange,colRange,0))0))  
  

    นับจํานวนขอ้มลู unique ซึง่มตีวัอกัษรตามกําหนด   

 

60 

=SMALL(IF(MATCH(TheList,TheList,0)=ROW(TheList), 

ROW(TheList),""), 

ROW(INDIRECT("1:"&SUM(N(MATCH(TheList,TheList,0)= 

ROW(TheList))))))-1  

  

    แยกขอ้มลู Unique item ออกมา   
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61 
=IF(SUBTOTAL(3,OFFSET(Rge,ROW(Rge)-

MIN(ROW(Rge)),,1)),Rge,"") 
  

    create an array of filtered items in a column list.    

 

62 

=IF(MONTH(DATE(y,m,1))<>MONTH(DATE(y,m,1)-

(WEEKDAY(DATE(y,m,1))-1)+{0;1;2;3;4;5}*7+{1,2,3,4,5,6,7}-1), 

"", DATE(y,m,1)-(WEEKDAY(DATE(y,m,1))-

1)+{0;1;2;3;4;5}*7+{1,2,3,4,5,6,7}-1) 

  

    สรา้งปฏทินิของเดอืน   

 

63 
=SUM((WEEKDAY(DATE($B$2,$A3,ROW(INDIRECT("1:"& 

DAY(DATE($B$2,$A3+1,0))))))=C$1)*1) 
  

    
รวมจํานวนวนัของสปัดาห ์C1 ในเดอืน A3 และปี B2 ที่

กําหนด 
  

 

64 =SUM(IF(ISNONTEXT(data),1))   

    จํานวนเซลลท์ีไ่มเ่ป็นตวัอกัษร   

 

65 =SUM(IF(ISTEXT(data),1))   

    จํานวนเซลลท์ีเ่ป็นตวัอกัษร   
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66 =SUM(IF(ISLOGICAL(data),1))   

    จํานวนเซลลท์ีเ่ป็น logical   

 

67 =SUM(IF(EXACT(data,text),1))   

    นับจํานวนเซลล ์ซึง่ม ีtext ตรงกนั   

 

68 
=SUM(IF(LEN(data)-

LEN(SUBSTITUTE(data,text,""))>0,1)) 
  

    นับจํานวนเซลล ์ซึง่ม ีtext ตรงกนั แมบ้างสว่น   

 

69 

=(SUM(LEN(data))-

SUM(LEN(SUBSTITUTE(UPPER(data),UPPER(text),""))))/LEN(text)  

=(SUM(LEN(data))-SUM(LEN(SUBSTITUTE(data,text,""))))/LEN(text)

  

    นับจํานวนเซลล ์ซึง่ม ีtext ตรงกนั ทัง้หมดหรอืแมบ้างสว่น   

 

70 
=INDIRECT(ADDRESS(ROW(Data)+MATCH(MIN(ABS(Target-

Data)),ABS(Target-Data),0)-1,COLUMN(Data)+ColOffset)) 
  

    Closest Match   
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71 
=SUM((MATCH(Grades,{"F","D","C","B","A"},0)-

1)*CreditHours)/SUM(CreditHours) 
  

    GPA   

 

72 
=ADDRESS(ROW(Data)+MATCH(Target,Data,0)-

1,COLUMN(Data)) 
  

    ตําแหน่งเซลลท์ีม่คีา่อยูใ่นตารางแนวตัง้   

 

73 
=ADDRESS(ROW(Data),COLUMN(Data)+MATCH(Target,Data,0)-

1) 
  

    ตําแหน่งเซลลท์ีม่คีา่อยูใ่นตารางแนวตัง้   

 

74 
=INDEX(Code, 

MATCH(Make&Model,Range1&Range2,0)) 
  

    2 value lookup   

 

75 

=INDEX(Data, SMALL(IF(Data>0, 

ROW(INDIRECT("1:"&ROWS(Data)))), 

ROW(INDIRECT("1:"&ROWS(Data)))))  

IF(ISERR( SMALL(IF(Data>0, 

ROW(INDIRECT("1:"&ROWS(Data)))), 
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ROW(INDIRECT("1:"&ROWS(Data))))), "", INDEX(Data, 

SMALL(IF(Data>0, ROW(INDIRECT("1:"&ROWS(Data)))), 

ROW(INDIRECT("1:"&ROWS(Data)))))) 

    สรปุคา่บวก   

 

76 

=IF(ISERR(SMALL(IF(Data<>"",ROW(INDIRECT("1:"&ROWS(Data)))), 

ROW(INDIRECT("1:"&ROWS(Data))))), 

"",INDEX(Data,SMALL(IF(Data<>"", 

ROW(INDIRECT("1:"&ROWS(Data)))), 

ROW(INDIRECT("1:"&ROWS(Data)))))) 

 

    สรปุคา่ทีไ่มใ่ชเ่ซลลว์า่ง  

 

77 

=IF(INDEX(Data,ROWS(Data) - 

ROW(INDIRECT("1:"&ROWS(Data)))+1)="", "", 

INDEX(Data,ROWS(Data) - 

ROW(INDIRECT("1:"&ROWS(Data)))+1)) 

  

    กลบัตําแหน่งคา่ในตารางแนวตัง้   

 

78 

=LARGE(Data,ROW(INDIRECT("1:"&ROWS(Data))))  

=IF( ISERR( LARGE( Data, ROW( INDIRECT("1:"&ROWS(Data))))), 

"", LARGE( Data, ROW( INDIRECT("1:"&ROWS(Data))))) 

  

    เรยีงลําดบัตัวเลข จากมากไปนอ้ย   
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79 

=INDEX( data, SMALL( IF( MATCH(data,data,0) = 

ROW(INDIRECT("1:"&ROWS(data))), MATCH(data,data,0), ""), 

ROW(INDIRECT("1:"&ROWS(data))))) 

  

    Unique items in List   

 

80 =SUM(LARGE(Data,ROW(INDIRECT("1:"&n))))   

    รวมคา่ทีม่ากทีส่ดุ n ลําดับแรก   

 

81 
=IF(OR(TheName=NameList),"Found","Not 

Found") 
  

    ตรวจสอบวา่ มคีา่ TheName อยูใ่น NameList   

 

82 =SUM(IF(MyData=YourData,0,1))   

    นับจํานวนเซลลท์ีม่คีา่ไมเ่ทา่กนั เมือ่เทยีบ 2 ตาราง   

 

83 
=ADDRESS(MIN(IF(Data=MAX(Data),ROW(Data), 

"")),COLUMN(Data)) 
  

    ตําแหน่งเซลลซ์ึง่มคีา่สงูสดุ   

 

84 =MIN(IF(Data=MAX(Data),ROW(Data), ""))   
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    เลขที ่row ของเซลลซ์ึง่มคีา่สงูสดุ   

 

85 =SMALL(IF(Data=Value,ROW(Data), ""),n)   

    เลขที ่row ของเซลลซ์ึง่มคีา่ซํ้ากนัครบ n ครัง้   

 

86 =INDEX(Data,MATCH(MAX(LEN(Data)),LEN(Data),FALSE),1)   

    คํายาวทีส่ดุในตาราง   

 

87 =ISNA(MATCH(TRUE,ISNA(MATCH(MyList,Master,0)),0))   

    ตรวจสอบวา่ คา่ใน MyList มอียูใ่น Master   

 

88 =SUM(1*ISNA(MATCH(MyList,Master,0)))   

    จํานวนเซลลข์อง MyList ซึง่ไมม่อียูใ่น Master   

 

89 =INDEX(MyList,MATCH(TRUE,ISNA(MATCH(MyList,Master,0)),0))   

    คา่แรกของ MyList ซึง่ไมม่อียูใ่น Master   

 

90 
=SUM(VALUE(MID(ABS(A1),ROW(INDIRECT 

("1:"&LEN(ABS(A1)))),1))) 
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    รวมตวัเลขทกุหลกัในคา่จํานวนเต็ม   

 

91 

=MID(A4,MATCH(0,(ISERROR(MID(A4, 

ROW(INDIRECT("1:"&LEN(A4))),1)*1)*1),0),LEN(A4)-

SUM((ISERROR(MID(A4, ROW(INDIRECT( 

"1:"&LEN(A4))),1)*1)*1))) 

  

    แยกเฉพาะสว่นตวัเลขออกจากตวัอกัษร   

 

92 
=INDEX(Data,MATCH(SMALL(ABS(Target-

Data),1),ABS(Target-Data),0)) 
  

    คา่ทีใ่กลเ้คยีงทีส่ดุกบัคา่ทีต่อ้งการ   

 

93 
=INDIRECT(ADDRESS(MAX((ROW(4:503)* 

(A4:A503<>""))),COLUMN(A:A))) 
  

    คา่ลา่งสดุใน column A แมจ้ะไมไ่ดอ้ยูต่ดิกนั   

 

94 
=INDIRECT(ADDRESS(6,(MAX((TRANSPOSE( 

ROW(1:256))*(6:6<>"")))))) 
  

    คา่ขวาสดุใน row 6 แมจ้ะไมไ่ดอ้ยูต่ดิกนั   
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95 =SUM(1*(B6<=Sales))-(SUM(1*(B6=Sales))-1)/2   

    
ลําดบัทีข่องคา่ โดยใชลํ้าดบัแบบเฉลีย่กรณีซํ้ากนั ตา่ง

จากการใชส้ตูร =RANK(B6,Sales) 
  

 

96 =SUM(IF($E6&F$5=Date&Category,Amount))  

    Dynamic crosstabulation  

 

97 
=LEN(A1)+1-MATCH(" ",MID(A1,LEN(A1)+1- 

ROW(INDIRECT("1:"&LEN(A1))),1),0) 
  

    ตําแหน่ง space ขวาสดุ   

 

98 

=SUM((SUBTOTAL(9, INDIRECT(ADDRESS( ROW(E3),COLUMN(E3) 

)&":"& ADDRESS( ROW(E3), 

ROW(INDIRECT(COLUMN(E3)&":"&COLUMN(AI3))) )))<=B3)*1)+1 

  

    
จํานวนเซลล ์ซึง่ยอดรวม Cumulative Sum คา่ในเซลล ์C3:G3 มคีา่

มากกวา่หรอืเทา่กบั คา่ในเซลล ์B3 
  

 

99 
=INDEX(คา่ทัง้หมด,SMALL(IF(คา่ทัง้หมด<0,ลําดบัตวัเลข),ลําดบั

ตวัเลข),1) 
  

    คา่ตดิลบ   
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100 

=INDEX(Product, SMALL(IF((Type=YourType) *  

(Account=YourAcct) * (Date>=YourDate) * ROW(INDIRECT("1:"& 

ROWS(Product)))<>0, (Type=YourType) * (Account=YourAcct) * 

(Date>=YourDate) *  ROW(INDIRECT("1:"&ROWS(Product)))), 

ROW(INDIRECT("1:"&ROWS(Product)))),1) 

  

    แยกขอ้มลูซึง่มปีระเภท เลขทีบ่ญัช ีวนัที ่ตามตอ้งการ   

 

101 

=INDEX(Type, LARGE(IF( NOT(ISBLANK(Type)),  

MATCH(Type,Type,0)) * (IF( NOT(ISBLANK(Type)), 

MATCH(Type,Type,0))=ROW( INDIRECT("1:"&ROWS(Type)))), 

ROW(INDIRECT("1:"&SUM( IF( NOT(ISBLANK(Type)), 

1/COUNTIF(Type,Type))))) ) ) 

  

    Unique List   

 

102 
=INDEX(Product, MATCH( MAX(COUNTIF(Product,Product)),  

COUNTIF(Product,Product), 0),1) 
  

    คา่ซึง่ใชบ้อ่ยทีส่ดุ   
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การกาํหนดขอบเขตตารางแบบยดืหยุน่ 

งานทีส่รา้งขึน้ดว้ย Excel ไมไ่ดใ้ชตํ้าแหน่งอา้งองิ (Reference) เพือ่ใชใ้นสตูรคํานวณแตเ่พยีง

อยา่งเดยีว ตําแหน่งอา้งองิยงัถกูเรยีกใชใ้นคําสัง่ Conditional Formatting, Data Validation, 

Advanced Filter, Pivot Table, หรอืในคําสัง่อืน่ๆ แมแ้ตใ่นรหัส Visual Basic for Applications 

(VBA) ซึง่โดยทัว่ไปเมือ่มกีาร Insert หรอื Delete row หรอื column หรอืโยกยา้ยตําแหน่ง

ตาราง จะสง่ผลใหตํ้าแหน่งอา้งองิทีใ่ชเ้ดมิปรับเปลีย่นขนาดตามทนัท ีและหากรูจั้กใชช้ือ่ในการ

กําหนดตําแหน่งอา้งองิจะชว่ยทําใหกํ้าหนดตําแหน่งอา้งองิในสตูรไดง้า่ย และยงัทําใหตํ้าแหน่ง

อา้งองิทีใ่ชใ้นกราฟหรอื VBA ปรับขนาดตามไดอ้กีดว้ย ชว่ยทําใหไ้มต่อ้งเสยีเวลาสรา้งกราฟ

ใหมห่รอืตอ้งยอ้นกลบัมาแกไ้ขรหสั VBA อกีแมแ้ตน่อ้ย 

ขอบเขตตารางแบบยดืหยุน่ หมายถงึ ขอบเขตตารางทีส่ามารถยดืไดห้ดไดต้ามจํานวนรายการ

หรอืปรมิาณขอ้มลูทีม่เีพิม่ลด ทําใหไ้มต่อ้งใชว้ธิคีอ่ยๆ Insert เพิม่ row เพือ่ขยายพืน้ทีต่าราง

ใหม้เีซลลว์า่งเตรยีมไวสํ้าหรับขอ้มลูในอนาคต หรอืไมต่อ้งกําหนดขอบเขตตารางแบบฟุ่ มเฟือย

โดยสรา้งสตูรอา้งองิกบัทัง้ column เชน่  

=VLookup( IDCode, A:D, 3)  

ซึง่การกําหนดตําแหน่งอา้งองิ A:D เชน่นีจ้ะทําใหส้ตูรทํางานชา้ลงอยา่งมากและยงัทําใหแ้ฟ้มมี

ขนาดใหญข่ึน้โดยไมจํ่าเป็นอกีดว้ย 

ในบทความนีข้อแนะนําวธิกํีาหนดขอบเขตตารางแบบยดืหยุน่ ตัง้แตว่ธิ ีDynamic Cell ไปจนถงึ

วธิ ีDynamic Range ซึง่ใชส้ตูร Offset, Index, Indirect, Address ชว่ยในการกําหนดขอบเขต

ตารางแบบอตัโนมตั ิ

วธิกีาํหนดตาํแหนง่เซลลแ์บบยดืหยุน่ (Dynamic Cell) 

คนทัว่ไปมกัมองขา้มเรือ่งพืน้ฐานทีน่กึวา่ไมสํ่าคญัหรอืไมเ่คยคดิวา่ Excel ทําไดไ้ปใชส้ตูร 

Offset กําหนดขอบเขตตารางกนัเลย โดยหารูไ้มว่า่เมือ่นําตําแหน่งเซลลข์องเซลลเ์พยีงเซลล์

เดยีวหรอืเซลลใ์นแนวเดยีวกนัมาใชใ้หเ้ป็น จะทําใหเ้กดิขอบเขตตารางแบบยดืหยุน่ไดเ้ชน่กนั 

แถมเป็นวธิทีีง่า่ยกวา่เสยีอกีเพราะไมจํ่าเป็นตอ้งใชส้ตูร Offset ใหยุ้ง่ยาก 
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• $B$3 เป็นตําแหน่งเซลลอ์า้งองิเพือ่กําหนดเซลลอ์า้งองิเริม่ตน้ของตาราง 

• เลข 0 ตวัแรกในสตูร เป็นตําแหน่งจํานวน row ถดัไป สาเหตทุีใ่ชเ้ลข 0 เพือ่ชีว้า่

จดุเริม่ตน้ของตารางยงัคงอยูใ่น row เดยีวกนักบัเซลลอ์า้งองิเริม่ตน้ของตาราง $B$3 

• เลข 0 ตวัทีส่องในสตูร เป็นตําแหน่งจํานวน column ถดัไป สาเหตทุีใ่ชเ้ลข 0 เพือ่ชีว้า่

จดุเริม่ตน้ของตารางยงัคงอยูใ่น column เดยีวกนักบัเซลลอ์า้งองิเริม่ตน้ของตาราง 

$B$3 

• เลข 5 เป็นสว่นของความสงูของตาราง ในทีน่ีแ้สดงวา่มคีวามสงู 5 row 

• เลข 3 เป็นสว่นของความกวา้งของตาราง ในทีน่ีแ้สดงวา่มคีวามกวา้ง 3 column 

หากตอ้งการใหส้ตูรนีป้รับขนาดแบบยดืหยุน่ (Dynamic Range) โดยทัว่ไปเฉพาะสว่นของ

ความสงูของตารางเทา่นัน้ทีจ่ะเพิม่ลดตามจํานวนรายการทีบ่นัทกึไว ้เมือ่ตอ้งการทําใหส้ตูร 

Offset ปรับขนาดความสงูตาม สามารถหาความสงูไดห้ลายวธิ ีดงันี ้

1. สตูร CountA($B:$B)-1 เพือ่นับจํานวนเซลลใ์น column B ทีม่ขีอ้มลูแลว้ลบทิง้เสยี 1 

เพราะไมต่อ้งการนับรวมหวัตารางเซลล ์B2 ซึง่มคํีาวา่ Id  

2. ใชส้ตูร CountA($B$3:$B$10000) เพือ่นับจํานวนเซลลท์ีม่ขีอ้มลูตัง้แตร่ายการแรกลง

มา อาจเผือ่ขนาดไวถ้งึ row 10000 

การใชส้ตูร CountA ใหเ้ลอืกใชก้บั column ทีม่ัน่ใจวา่มขีอ้มลูบนัทกึไวค้รบทกุรายการเสมอ 

หา้มมเีซลลเ์วน้วา่งแทรกอยา่งเด็ดขาด ซึง่โดยทัว่ไปในตารางหนึง่ๆตอ้งม ีcolumn หนึง่ซึง่ตอ้ง

บนัทกึครบทกุรายการอยูแ่ลว้ โดยเฉพาะ column ของรหสัหรอืวนัที ่

หากเป็นตารางซึง่มชีอ่งวา่งแทรกไวไ้มแ่น่นอน สามารถคํานวณหาความสงูของตารางได ้โดย

ใชส้ตูร Array {=MAX(IF(B:D<>0,ROW(B:D)))-MIN(IF(B:D<>0,ROW(B:D)))} 

• สตูร Array { =MAX(IF(B:D<>0,ROW(B:D)))} หาเลขที ่row สดุทา้ยของตาราง 

• สตูร Array { =MIN(IF(B:D<>0,ROW(B:D)))} หาเลขที ่row แรกของตาราง 

หมายเหต ุสตูร Array มวีงเล็บปีกกาปิดหวัทา้ยสตูร เกดิจากการกดปุ่ ม Ctrl+Shift+Enter 

พรอ้มกนัแทนการกดปุ่ ม Enter และอาจตอ้งปรับเพิม่ลดตวัเลขใหเ้ทา่กบัความสงูทีแ่ทจ้รงิหาก

ตารางในชว่ง column B:D มขีอ้มลูอืน่ซึง่ไมเ่กีย่วขอ้งบนัทกึอยู ่
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เมือ่หาความสงูของตารางดว้ยสตูรไดแ้ลว้ จากเดมิทีเ่ป็นสตูร =OFFSET($B$3,0,0,5,3) ใหนํ้า

สตูรคํานวณหาความสงูมาซอ้นกนักลายเป็นสตูร  

=OFFSET($B$3,0,0, CountA($B:$B)-1, 3)  

หรอืจะลงิคเ์ฉพาะผลลพัธข์องความสงูทีคํ่านวณไดม้าใชก้็ได ้กลายเป็นสตูร  

=OFFSET($B$3,0,0, เซลลห์าความสงู, 3) 

สตูร Offset ทีทํ่าหนา้ทีเ่ป็น Dynamic Range นี ้หากสรา้งลงไปในเซลลเ์ดยีวจะเกดิ error 

#VALUE! เสมอ เนือ่งจากสตูรนีห้าคา่หลายคา่มาใหจ้งึไมส่ามารถแสดงครบทกุคา่ในเซลลใ์ด

เซลลห์นึง่ได ้หากตอ้งการตรวจสอบวา่สตูรทํางานไดถ้กูตอ้งหรอืไม ่ใหก้ดปุ่ ม F2 ตามดว้ย F9 

จะพบวา่สตูรคนืคา่เป็นคา่ทัง้หมดในตารางนัน้ออกมาใหเ้ห็นแบบ Array 

={"a001","a",10;"a002","b",20;"a003","c",30;"a004","d",40;"a005","e",50} 

เมือ่เห็นคา่ทีแ่ทจ้รงิของสตูรแลว้ ใหก้ดปุ่ ม Esc เพือ่แกก้ลบัคนืเป็นสตูรตามเดมิ 

อกีวธิหีนึง่ในการตรวจสอบสตูร ใหค้ลกิลงไปในชอ่ง Formula Bar ลากเลอืกสตูรทัง้หมด 

=OFFSET($B$3,0,0, CountA($B:$B)-1, 3) แลว้กดปุ่ ม F5 แลว้กดปุ่ ม Enter เพยีงครัง้เดยีว 

จะพบวา่ Excel เปลีย่นสตูร Offset เป็นตําแหน่งอา้งองิ =B3:D7 พรอ้มกบัแสดงตําแหน่งใน

ตารางใหเ้ห็น จากนัน้ใหก้ดปุ่ ม Esc เพือ่แกก้ลบัคนืเป็นสตูรตามเดมิ 

เมือ่พบวา่สตูร Offset แสดงคา่หรอืชีตํ้าแหน่งไดถ้กูตอ้ง ใหต้รวจสอบตําแหน่งอา้งองิทกุ

ตําแหน่งในสตูรวา่เป็น Absolute Reference เชน่ $B$3 และ $B:$B กอ่น จากนัน้จงึนําสตูรนี้

ไปตัง้ชือ่ใหเ้ป็น Formula Name โดยใชคํ้าสัง่ Formulas > Define Name ตอ่มาเมือ่ตอ้งการ

สรา้งสตูร VLookup, Match, หรอื Index ใหนํ้าชือ่ Formula Name ทีต่ัง้ขึน้นีไ้ปใชแ้บบ

เดยีวกบัการใชช้ือ่ Range Name โดยทัว่ไป 
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การคาํนวณยอดรวมเพือ่จดัทาํรายงาน 

การจัดเก็บขอ้มลูไวใ้นโครงสรา้งฐานขอ้มลูทีถ่กูตอ้ง เป็นองคป์ระกอบสําคญัชว่ยทําใหเ้กดิ

ความสะดวกและงา่ยในการหาคําตอบทีต่อ้งการ แตผู่ใ้ช ้Excel แบบมกังา่ยอาจหาทางทีง่า่ย

กวา่นัน้โดยปรับแตง่โครงสรา้งฐานขอ้มลูใหก้ลายเป็นหนา้รายงาน ทําใหไ้มส่ามารถใช ้

ฐานขอ้มลูไดเ้ต็มทีอ่กีตอ่ไป ยิง่กวา่นัน้หากรายงานทีต่อ้งจัดพมิพม์รีอ้ยหนา้ ก็มกัออกแบบ

ตารางรายงานเลยีนแบบหนา้รายงานทัง้รอ้ยหนา้ ทําใหแ้ฟ้มมขีนาดใหญข่ึน้อยา่งมากเนือ่งจาก

ตอ้งเตรยีมพืน้ทีใ่นชทีเดยีวกนั ตา่งชที หรอืตา่งแฟ้ม รอไวสํ้าหรับแสดงขอ้มลูทกุหนา้ 

พงึระลกึไวเ้สมอวา่ฐานขอ้มลูทีด่ตีอ้งคงสภาพโครงสรา้งเชน่เดมิไวต้ลอด การเปลีย่นแปลงที่

เกดิขึน้กบัตารางฐานขอ้มลูจะมเีพยีงการเพิม่รายการใหมต่อ่ทา้ยรายการเดมิลงไปเรือ่ยๆ หากไม่

จําเป็นจะไมม่กีาร insert row แทรก หรอื delete row ลบรายการทีบ่นัทกึไวท้ิง้ และหนา้

รายงานตอ้งหาทางสรา้งขึน้เพยีงหนา้เดยีวหรอืสตูรเดยีว แลว้หาทางเปลีย่นหนา้เดยีวหรอืสตูร

เดยีวนัน้ใหแ้สดงคําตอบหนา้อืน่ๆหรอืเรือ่งอืน่ๆไดโ้ดยไมต่อ้งสรา้งหนา้ใหมห่รอืสตูรใหมข่ึน้อกี 

หลงัจากฐานขอ้มลูมโีครงสรา้งทีแ่น่นอนชดัเจนแลว้ เมือ่ตอ้งการหาคําตอบเกีย่วขอ้งกบัตวัเลข

ยอดรวม มทีางเลอืกใหใ้ชคํ้าสัง่หรอืสตูรได ้ดงันี ้

• ใชส้ตูร SubTotal รว่มกบัคําสัง่ Filter และ Custom Views 

• ใชคํ้าสัง่ Data > SubTotal เพือ่สรา้งยอดรวมรายการแตล่ะประเภทขึน้ภายในตาราง

ฐานขอ้มลูนัน้ 

• ใชคํ้าสัง่ Data > Consolidate เพือ่รวมตวัเลขของหลายตารางตามตําแหน่งเรือ่ง

เดยีวกนัเขา้ดว้ยกนั 

• ใชส้ตูร Array SumIF หรอื DSum เพือ่หายอดรวมแยกประเภท แลว้ใชคํ้าสัง่ Data > 

What-if Analysis > Data Table เพือ่หายอดรายการอืน่ๆตอ่ 

• ใชคํ้าสัง่ Insert > Pivot Table เพือ่สรา้งตารางเปรยีบเทยีบตวัเลขคําตอบ 
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วธิจีดัการกบัความอว้นอุย้อา้ย...ของแฟ้ม 

แฟ้ม Excel ทีเ่ราเพิง่เปิดใชง้านขึน้ใหมใ่นวนันี ้จะเริม่มขีนาดแฟ้มใหญข่ึน้เรือ่ยๆ แลว้เมือ่วนั

เวลาผา่นไปสกัปีสองปี คอมพวิเตอรท์ีใ่ชอ้ยูก่็จะทํางานชา้ลงไปจนผดิสงัเกตโดยมเีหตมุาจาก

แฟ้มใหญข่ึน้มากนีแ่หละ ตวัผูใ้ช ้Excel มกัชอบวิง่ไปบอกหวัหนา้ ขอใหซ้ือ้คอมพวิเตอรเ์ครือ่ง

ใหมเ่พือ่จะไดทํ้าให ้Excel ทํางานเร็วเหมอืนเดมิ ซึง่ถา้ผมเป็นหวัหนา้ของคณุละ่กอ้ ... แทนที่

จะเปลีย่นคอมพวิเตอรเ์ครือ่งใหม ่ขอเปลีย่นตวัพนักงานเป็นคนอืน่จะดกีวา่ !!! เพราะแมจ้ะไดใ้ช ้

คอมพวิเตอรเ์ครือ่งใหมแ่ลว้ก็ตาม ตอ่มาพอแฟ้มเริม่ใหญข่ึน้อกี คอมพวิเตอรก์็จะชา้ลงไปอกี 

แลว้เราก็ตอ้งซือ้เครือ่งใหมท่ีเ่ร็วขึน้กวา่อกีหรอือยา่งไรกนั 

กอ่นทีจ่ะสายเกนิไป ผูใ้ช ้Excel ควรเขา้ใจกอ่นวา่ ทีว่า่แฟ้ม Excel ใหญข่ึน้นัน้ อะไรบา้งทีเ่ป็น

เหตใุหแ้ฟ้มมขีนาดใหญข่ึน้ แลว้อยา่นกึตอ่ไปวา่ แฟ้มใหญต่อ้งใชเ้วลาคํานวณนานกวา่แฟ้มที่

เล็กกวา่เสมอไป ซึง่เมือ่เขา้ใจประเด็นเหลา่นีแ้ลว้เราตอ้งหาทางออกแบบแฟ้มใหใ้หญพ่อดีๆ  ไม่

ใหญ ่ไมเ่ล็กเกนิไป และไมใ่ชเ้วลาคํานวณชา้จนรอไมไ่หว 

สิง่ทีม่ผีลตอ่ขนาดของแฟ้ม 

1. จํานวนเซลลท์ีใ่ช ้

2. จํานวนเซลลท์ีถ่กูอา้ง 

3. รปูแบบหรอื Format ทีใ่ช ้

จํานวนเซลลท์ีใ่ช ้

แฟ้ม Excel ในยคุแรก มขีนาดแฟ้มใหญม่ากเพราะกําหนดวา่ พืน้ทีต่ารางทกุเซลลต์ัง้แตเ่ซลล ์

A1 ไปจนถงึเซลลห์วัมมุขวาลา่งสดุทีม่ขีอ้มลูอยูถ่อืเป็นพืน้ทีซ่ ึง่ถกูใชง้าน ตอ่มา Excel ได ้

พัฒนาใหข้นาดของแฟ้มไมต่อ้งนับจากเซลล ์A1 แตใ่หนั้บเฉพาะเซลลท์ีถ่กูใชง้านเทา่นัน้ สว่น

เซลลท์ีเ่ราไมไ่ดเ้ขา้ไปแตะตอ้งแกไ้ขใสอ่ะไรลงไป ไมม่สีว่นกระทบตอ่ขนาดของแฟ้มแตอ่ยา่ง

ใด ซึง่ชว่ยใหเ้ราสามารถใชพ้ืน้ทีต่ารางไดส้ะดวก ไมต่อ้งออกแบบตารางใหช้ดิตดิกนัเป็นพดื 

เพือ่หาทางลดขนาดแฟ้มอยา่งแตก่อ่น  

ขอใหส้งัเกตวา่ ขนาดของแฟ้ม ไมไ่ดข้ึน้อยูก่บัจํานวนอกัขระทีม่อียูใ่นเซลล ์ไมว่า่จะพมิพเ์ลข 1 

ลงไปในเซลล ์100 เซลล ์หรอืพมิพเ์ลข 123 ลงไปในเซลล ์100 เซลล ์แฟ้มก็ยงัคงมขีนาด



316 

 

Copyright of www.ExcelExpertTraining.com 

ใหญเ่ทา่กนัเพราะใชจํ้านวนเซลล ์100 เซลลเ์ทา่กนั แตอ่ยา่งไรก็ตามในเซลลจํ์านวน 100 

เซลลท์ีส่มมตวิา่ถกูพมิพค์า่ลงไปนัน้ หากพมิพต์วัอกัษรหรอืสรา้งสตูรลงไปก็จะทําใหแ้ฟ้มมี

ขนาดใหญข่ึน้ตามลกัษณะของขอ้มลูทีพ่มิพล์งไป ซึง่ลําดบัขนาดแฟ้มจากเล็กไปใหญข่ึน้กบั

ประเภทของขอ้มลู ดงันี ้

1. ถา้เป็นตวัเลข แฟ้มจะเล็กทีส่ดุ ไมว่า่จะเป็นเลข 1 หรอืเลข 123 แฟ้มยงัคงมขีนาด

เทา่กนั 

2. ถา้เป็นตวัอกัษร แฟ้มจะใหญข่ึน้ ไมว่า่จะเป็นตวัอกัษร A หรอื ABC แฟ้มยงัคงมขีนาด

เทา่กนั (ใน Excel 2010 พบวา่ ขอ้ 1 และ 2 นีไ้มไ่ดม้ขีนาดแฟ้มตา่งกนั) 

3. ถา้เป็นสตูรและคนืคา่เป็นตวัเลข แฟ้มจะใหญข่ึน้ 

4. ถา้เป็นสตูรและคนืคา่เป็นตวัอกัษร แฟ้มจะใหญม่ากทีส่ดุ 

 จํานวนเซลลท์ีถ่กูอา้ง 

ในกรณีทีส่รา้งสตูร link ขอ้มลูขา้มแฟ้ม จะพบวา่แฟ้มปลายทางมขีนาดใหญข่ึน้มาก หรอื

บางครัง้จะมขีนาดใหญก่วา่แฟ้มตน้ทางเสยีอกี ทัง้ๆทีใ่นแฟ้มปลายทางมเีซลลท์ีใ่ชง้านเพยีง

เซลลเ์ดยีวก็ตาม เนือ่งจากในสตูร link ขา้มแฟ้มทีส่รา้งไวใ้นเซลลไ์ดนํ้าขอ้มลูจากแฟ้มตน้ทาง

มาเก็บไวใ้นแฟ้มปลายทาง เรยีกวา่ Cache Data  

ยกตวัอยา่งเชน่ สตูร =VLOOKUP(A1,[Input.xls]Sheet1!$B$2:$H$200,2) ทีห่าคา่จากแฟ้ม 

Input.xls ในชที Sheet1 ตัง้แตเ่ซลล ์B2:H200 นี ้จะทําให ้Excel แอบสรา้งตารางทีเ่รามองไม่

เห็นเก็บขอ้มลูจากแฟ้มตน้ทางทัง้หมดไวใ้นแฟ้มปลายทางทีม่สีตูรนีอ้ยู ่ซึง่ตารางทีม่องไมเ่ห็นนี้

แหละเป็น Cache Data 

Cache Data ชว่ยทําใหเ้มือ่เปิดแฟ้มปลายทางขึน้มาใชเ้พยีงแฟ้มเดยีว เราก็สามารถใชส้ตูร 

VLookup คน้หาขอ้มลูจากแฟ้มตน้ทางไดโ้ดยไมจํ่าเป็นตอ้งเปิดแฟ้มตน้ทางขึน้มาใชพ้รอ้มกบั

แฟ้มปลายทางแตอ่ยา่งใด แตก่็ทําใหแ้ฟ้มปลายทางมขีนาดใหญข่ึน้ 

รปูแบบหรอื Format ทีใ่ช ้

การกําหนดรปูแบบใหก้บัชทีทัง้ชทีพรอ้มกนัทเีดยีวทกุเซลล ์จะทําใหแ้ฟ้มมขีนาดเล็กกวา่การ

กําหนดรปูแบบเพยีงบางสว่นของตาราง เพราะ Excel จะใชว้ธิรัีบรูท้เีดยีววา่ชทีนัน้ๆใชร้ปูแบบใด 
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แตถ่า้ในตารางมกีารกําหนดรปูแบบตา่งกนัไปในแตล่ะสว่น จะทําให ้Excel ตอ้งรับรูล้ะเอยีดมาก

ขึน้วา่ พืน้ทีต่ารางสว่นใดใชร้ปูแบบใด จงึทําใหแ้ฟ้มมขีนาดใหญข่ึน้ 

ตามปกต ิExcel ไดกํ้าหนดไวใ้นคําสัง่ Excel Options ใหก้าชอ่ง Extend data range formats 

and formulas ไวแ้ลว้ตัง้แตต่น้ เพือ่ชว่ยใหเ้ซลลข์อ้มลูตวัเลขทีใ่ชง้านตดิตอ่กนัไวต้ามแนวตัง้

ตัง้แต ่3 เซลลข์ึน้ไป สง่รปูแบบทีกํ่าหนดไวใ้น 3 เซลลนั์น้ตอ่ไปยงัเซลลท์ี ่4 และเซลลต์อ่ๆไป

ใหท้นัท ีแลว้หากมเีซลลท์ีส่รา้งสตูรไวต้ดิตอ่กนัตามแนวตัง้ 4 เซลลอ์ยูแ่ลว้ คําสัง่นีจ้ะชว่ย 

copy สตูรและรปูแบบจากเซลลท์ี ่4 ไปยงัเซลลท์ี ่5 ตอ่ไปเรือ่ยๆใหเ้ชน่กนั (ขอใหท้อ่งไวว้า่ 

ครบ 3 ได ้4 ครบ 5 ไดส้ตูร หมายความวา่ เดมิครบ 3 เซลล ์จะไดร้ปูแบบตอ่ในเซลลท์ี ่4 แลว้

พอเริม่ครบ 5 เซลล ์จะไดท้ัง้สตูรและรปูแบบตามตอ่ไปใหเ้อง) อยา่งไรก็ตามคําสัง่นีจ้ะทํางาน

ตอ่เมือ่ขอ้มลูตามแนวตัง้ทีบ่นัทกึตอ่กนัไปเป็นตวัเลขทกุเซลล ์เชน่ ถา้บนัทกึตวัเลขเอาไว ้ก็

ตอ้งบนัทกึตัวเลขในเซลลต์อ่ไปเทา่นัน้ หากเมือ่ใดทีบ่นัทกึคา่เป็นตวัอกัษรลงไปในเซลลท์ีค่วร

เป็นตวัเลข ตอ้งลบคา่นัน้ทิง้ไปกอ่น จงึจะกระตุน้ใหคํ้าสัง่นีทํ้างานดงัเดมิ  

สิง่ทีผ่ลตอ่ความเร็ว 

ในเรือ่งความเร็วนีไ้มไ่ดเ้กีย่วขอ้งกบัความเร็วในการคํานวณของโปรแกรม Excel เทา่นัน้ แตย่งั

สง่ผลกระทบตอ่ความเร็วของมนุษยใ์นการใช ้Excel อกีดว้ย นับตัง้แตจ่ะชา้หรอืเร็วในการสรา้ง

งาน สรา้งเสร็จแลว้เมือ่นํามาแกไ้ขจะตอ้งเสยีเวลาแกไ้ขชา้หรอืเร็วเพยีงใดกวา่จะแกไ้ขเสร็จ 

บางคนใชเ้วลาสรา้งแฟ้มนดิเดยีวแตพ่อยอ้นกลบัมาแกไ้ขแฟ้มเดมิกลบัตอ้งเสยีเวลาแกไ้ขนาน

ขึน้มาก  

สําหรับผูส้นใจการทําให ้Excel คํานวณไดเ้ร็วทีส่ดุ ขอเชญิตดิตามไปอา่นบทความทีผ่มเขยีนไว ้

ในหวัขอ้ Excel @ The Maximum Speed ไดท้ี ่

http://www.excelexperttraining.com/extra/tactic/maxspeed.html สว่นในบทความนีจ้ะ

ไดอ้ธบิายเรือ่งทีแ่ปลกไปจากเดมิ  

มนษุยน์ีแ่หละตน้เหตขุองความชา้อุย้อา้ย 

แมย้คุนีเ้ราใชเ้ครือ่งคอมพวิเตอรแ์ทนเครือ่งคดิเลขกนัมากขึน้ แตแ่ทนทีเ่ครือ่งคอมพวิเตอรจ์ะ

ชว่ยใหทํ้างานไดเ้ร็วขึน้ หลายๆคนกลบัทํางานเสร็จชา้ลง จนแทบอยากจะยอ้นไปกดปุ่ มบน

เครือ่งคดิเลขทีต่นใชไ้ดเ้ร็วกวา่ ทัง้นีเ้นือ่งจากคนเราไมช่อบการเปลีย่นแปลง ชอบทําอะไรใช ้
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อะไรทีต่วัคุน้เคยมากอ่น พอจะใชค้อมพวิเตอรก์็คดิไมอ่อกวา่จะใชโ้ปรแกรมอะไร ฟังเขามาวา่

ถา้เรือ่งของตวัเลขตอ้งใชโ้ปรแกรม Excel แตถ่า้เรือ่งเก็บขอ้มลูตอ้งใช ้Access แลว้ถา้ขอ้มลูมี

ทัง้ตวัเลขและตวัอกัษรละ่ จะใชโ้ปรแกรมอะไรด ีบางคนอาจคดิงา่ยๆวา่ ถา้ขอ้มลูมเีลขมากกวา่ 

ก็ใหใ้ช ้Excel หรอืถา้ขอ้มลูมตีวัอกัษรมากกวา่ตวัเลข ก็ใหใ้ช ้Access แลว้กนั  

ในประเด็นของการเลอืกใชโ้ปรแกรม Excel หรอื Access นี ้ในเบือ้งตน้สําหรับคนทีเ่พิง่จับ

คอมพวิเตอร ์ขอแนะนําใหเ้ลอืกใช ้Excel กบังานทีต่อ้งการความยดืหยุน่ หรอืงานทีผู่ใ้ชย้งัไม่

มัน่ใจวา่จะจัดโครงสรา้งหนา้ตาของตารางขอ้มลูทีต่อ้งการเก็บไวอ้ยา่งไร เพราะ Excel มคํีาสัง่

ชว่ยสําหรับการโยกยา้ยขอ้มลูเตรยีมไวพ้รอ้ม และเราอยากจะยา้ยตารางไปเก็บไวท้ีช่ทีอืน่แฟ้ม

อืน่ ก็จะเห็นผลทนัทบีนหนา้จอกบัตา แถม Excel ยงัชว่ยแกไ้ขสตูรทีเ่กีย่วขอ้งกบัตารางซึง่ถกู

ยา้ยใหเ้สร็จ แลว้ตอ่มาภายหลงัพอมขีอ้มลูปรมิาณมากขึน้ เริม่มมีาตรฐานของโครงสรา้งตาราง

แน่นอนตายตวัแลว้ จงึคดิถงึ Access  

ครัน้เลอืกใช ้Excel สรา้งตารางเก็บขอ้มลูตอ่ไปสกัพัก คอมพวิเตอรแ์สนเร็วของเรากบัผูท้ีใ่ช ้

Excel ก็จะพรอ้มใจกนักอดคอทํางานชา้ลงไปเรือ่ยๆ โดยมสีาเหตยุอดนยิมดงัตอ่ไปนี ้

1. ออกแบบตารางเก็บขอ้มลูไมเ่ป็น พอเปิดแฟ้มขึน้ด ูแลว้งงไปหมดวา่ขอ้มลูอะไรอยู่

ตรงไหน 

2. เก็บขอ้มลูทีเ่กีย่วขอ้งกบัวนัที ่แตว่นัทีซ่ ึง่เก็บบนัทกึไว ้ไมส่ามารถนํามาใชคํ้านวณตอ่ได ้

3. เก็บขอ้มลูซํ้าซอ้นกนั พอจะแกไ้ขเป็นขอ้มลูใหมต่อ้งเสยีเวลาหาตําแหน่งเซลลใ์หพ้บ

กอ่นวา่อยูท่ีช่ทีใดแฟ้มใด 

4. แยกขอ้มลูทีเ่ก็บไวใ้นตารางเดยีวกนัออกจากกนัไมไ่ด ้ตอ้งฝืนบนัทกึขอ้มลูตอ่ไปเรือ่ยๆ

นับพันนับหมืน่บรรทดั 

5. สรา้งสตูรยากๆยาวๆแบบฉันเองคนสรา้งคนเดยีวเทา่นัน้ทีจ่ะแกะออก 

6. เลอืกใชส้ตูรไมเ่ป็น ชอบใชส้ตูรสัน้ๆทีค่นชอบ แต ่Excel ไมช่อบเพราะโปรแกรมจะ

ทํางานชา้ลง 

7. แยกตารางสตูรทีไ่มจํ่าเป็นตอ้งคํานวณพรอ้มกนัออกจากกนัไมไ่ด ้ทําใหต้อ้งเสยีเวลารอ

การคํานวณสตูรซํ้าโดยไมจํ่าเป็น 

8. ไมรู่จั้กแยกคา่ตวัแปรทีอ่าจเปลีย่นแปลงภายหลงัไวน้อกสตูร 

9. สรา้งชทีทีใ่ชคํ้านวณเรือ่งเดยีวกนัซํ้ากนัเต็มไปหมด แตล่ะชทีมตีารางหนา้ตาเดยีวกนั 

ตา่งกนัแตค่า่ทีนํ่ามาใชคํ้านวณ 

10. เลอืกใช ้VBA กบังานทีย่ังไมค่วรใช ้VBA แม ้VBA จะชว่ยใหเ้สร็จงานเร็วขึน้ แตก่็ไมใ่ช่

เร็วขึน้ไดเ้ต็มทีอ่ยา่งทีค่วร 
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สาเหตยุอดนยิมเหลา่นีแ้หละทีทํ่าใหเ้ราไดผ้ลลพัธจ์าก Excel ชา้ลง แตโ่ดยทัว่ไปผูใ้ช ้Excel ที่

ไมเ่คยนําผลงานไปเปรยีบเทยีบกบัผูอ้ืน่มกัจะหลงภาคภมูใิจในผลงานของตน และเขา้ใจผดิไป

วา่ตนไดใ้ช ้Excel ชว่ยสรา้งผลงานทีเ่ร็วขึน้ ดงันัน้การใหพ้ืน้ฐานในเรือ่งแนวทางการใช ้Excel 

ทีด่แีละถกูตอ้งจงึเป็นเรือ่งทีสํ่าคญัมาก  

แนวทางการใช ้Excel ทีด่แีละถกูตอ้ง 

• เราตอ้งมุง่หวงัทีจ่ะใช ้Excel ใหไ้ดผ้ลงานมากขึน้และเร็วขึน้แบบคอมพวิเตอร ์น่ันคอื 

ตอ้งสามารถนําแฟ้มทีส่รา้งไวแ้ลว้กลับมาใชซ้ํ้าแลว้ซํ้าอกี โดยไมจํ่าเป็นตอ้งแกไ้ขสตูร

หรอืโครงสรา้งตารางทีส่รา้งไวแ้ลว้อกีเลย 

• แยกโครงสรา้งตารางเป็น 3 ประเภท คอื ตารางทีใ่ชเ้ก็บขอ้มลู(ตวัเลขและหรอืตวัอกัษร) 

ตารางสําหรับสรา้งสตูรคํานวณ และตารางสําหรับแสดงเป็นรายงาน 

• พงึระลกึไวเ้สมอวา่ สกัวนัหนึง่ขอ้มลูในแฟ้มจะถกูเก็บไวจ้นทําใหแ้ฟ้มใหญแ่ละ Excel 

ทํางานชา้ลง ดงันัน้ตอ้งเตรยีมโครงสรา้งตารางทีพ่รอ้มตอ่การโยกยา้ยไปเก็บไวท้ีแ่ฟ้ม

อืน่ 

• ขอ้มลูทีเ่ก็บไวใ้นตารางทีใ่ชเ้ก็บขอ้มลูตอ้งจัดเก็บไวใ้นลกัษณะโครงสรา้งฐานขอ้มลูที่

สามารถนําไปใชก้บัเมนู Data หรอืใชก้บัสตูรพวก Lookup ไดท้นัท ี

• ขอ้มลูทีเ่ป็นตวัเลข ตอ้งมคีา่เป็นตวัเลขอยา่งแทจ้รงิ ซึง่มลีกัษณะทีต่อ้งชดิขวาของ

เซลลโ์ดยไมจํ่าเป็นตอ้งใช ้Format 

• หา้มพมิพข์อ้มลูใดๆซํ้าโดยไมจํ่าเป็น แตใ่หใ้ชส้ตูรนําคา่สง่ตอ่ไปใชเ้มือ่ตอ้งการใช ้

ขอ้มลูนัน้ซํ้า 

• ในชทีหนึง่ๆ พยายามสรา้งสตูรเดยีวซึง่สามารถนําไปใชไ้ดก้บัทกุตําแหน่งเซลลใ์นชที

นัน้ๆ ไมว่า่จะมกีารแกไ้ขทีทํ่าใหตํ้าแหน่งโครงสรา้งตารางเปลีย่นไปอยา่งไรก็ตาม 

• สตูรทีส่รา้งขึน้ตอ้งใชห้ลักการคํานวณทีง่า่ยตอ่การทําความเขา้ใจของตนเองและผูอ้ืน่ 

และเมือ่ทเีงือ่นไขเปลีย่นแปลงไปจากเดมิก็ไมจํ่าเป็นตอ้งแกไ้ขโครงสรา้งสตูรใหต้า่งไป

จากเดมิมากนัก 

• ตอ้งใชส้ตูรปรับคา่ในเซลลใ์หไ้ดค้า่ถกูตอ้งตามทีต่อ้งการกอ่นแลว้จงึใชคํ้าสัง่ Format 

ปรับการแสดงผลของคา่นัน้ในภายหลงั 

• ในโครงสรา้งสตูร หา้มใสค่า่คงทีใ่ดๆไวอ้ยา่งเด็ดขาด 
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• แทนทีจ่ะสรา้งสตูรยากๆยาวๆทีม่สีว่นการคํานวณทีซ่ํ้ากนัลงไปในตารางนับพันนับหมืน่

เซลล ์ซึง่ทําใหแ้ฟ้มใหญแ่ละคํานวณชา้ลง ควรหาทางกระจายโครงสรา้งสตูรออกเป็น

สตูรสัน้ๆหลายๆเซลลแ์ตใ่ชก้ารคํานวณครัง้เดยีว เพือ่ทําใหแ้ฟ้มเล็กลงและคํานวณเร็ว

ขึน้ 

• อยา่ลมืวา่ ตารางทีเ่ป็นสตูร จะมขีนาดแฟ้มใหญก่วา่ตารางทีเ่ป็นตวัเลขหรอืตวัอกัษร 

ดงันัน้แทนทีจ่ะใชส้ตูรคํานวณคา่ใดๆทีเ่ป็นคา่คงที ่เชน่ เลขลําดบั แนะนําใหใ้ชต้ารางที่

เป็นตวัเลขผลจากการคํานวณแทนไปเลยดกีวา่ 

• ในกรณีทีต่อ้งสรา้งสตูรทีอ่า้งองิกบัตารางแนวนอนแนวตัง้ แนะนําใหเ้ลอืกตารางตาม

แนวนอนกอ่นตารางแนวตัง้เพือ่สรา้งมาตรฐานวธิสีรา้งสตูรของตนเอง และนอกจากนัน้

ยงัสอดคลอ้งกบัโครงสรา้งของสตูร Excel เชน่ Index หรอื Offset จะใชตํ้าแหน่งอา้งองิ

ตามแนวนอนกอ่นแนวตัง้เสมอ 

• หากสรา้งสตูรทีต่อ้งนํามาใชซ้ํ้าแลว้ซํ้าอกี ควรตัง้ชือ่ตําแหน่งเซลล ์(Range name) ที่

สือ่ถงึทีไ่ปทีม่าของสตูร แทนการอา้งองิกบัตําแหน่งอา้งองิโดยตรง 

• ควรแยกสตูรทีไ่มจํ่าเป็นตอ้งคํานวณพรอ้มกนัออกเป็นแฟ้มแยกจากกนั (หรอือกีนัยหนึง่ 

ใหเ้ก็บเฉพาะสตูรทีต่อ้งคํานวณพรอ้มกนัเทา่นัน้ไวใ้นแฟ้มเดยีวกนั) เพือ่ทําใหเ้รา

สามารถเลอืกเปิดแฟ้มตามขอบเขตการคํานวณทีช่ดัเจน และทําใหแ้ฟ้มมขีนาดเล็กลง 

• ใหเ้ลอืกใช ้VBA เฉพาะเมือ่ตอ้งการใช ้Excel ทีเ่หนอืกวา่ปกตจิากสตูรและเมนูคําสัง่ที่

ทําได ้และรหสั VBA ทีใ่ชต้อ้งสามารถใชไ้ดต้อ่เนือ่งไปตลอดแมโ้ครงสรา้งตารางจะ

เปลีย่นแปลงตา่งไปจากเดมิก็ตาม 

• ทกุอยา่งมไีดก้็ตอ้งมเีสยี ไดอ้ยา่งก็ตอ้งเสยีอยา่ง ขอใหพ้จิารณาเปรยีบเทยีบขอ้ดี

ขอ้เสยีกอ่นทีจ่ะสรา้งงาน เพือ่ใหเ้หมาะสมกบัเงือ่นไขและสภาพแวดลอ้มของการ

ทํางาน 

แนวทางการลดความอว้น 

ลองคดิดวูา่ ถา้เราเก็บรายการขอ้มลูลงไปในชทีเต็มทัง้หมดทกุ row แลว้ จะนําขอ้มลูรายการ

ใหมไ่ปเก็บไวท้ีไ่หน จะเริม่ตน้เก็บไวใ้นชทีใหมใ่นแฟ้มเดมิหรอืจะเปิดแฟ้มใหม?่ 

ผูใ้ช ้Excel สว่นมากชอบเก็บขอ้มลูไวเ้รือ่ยๆในชทีเดมิแฟ้มเดมิเพราะสะดวกในการคน้หา

เรยีกใช ้ซึง่หากใชค้อมพวิเตอรร์ุน่ใหมม่คีวามเร็วสงูก็ไมต่อ้งรอนานนัก แตถ่า้เก็บขอ้มลูไวใ้น

แฟ้มเดมิตอ่ไปเรือ่ยๆ สดุทา้ยเจา้เครือ่งคอมพวิเตอรท์ีว่า่ทํางานเร็วก็จะทํางานชา้ลงชา้ลง นีเ่ป็น



321 

 

Copyright of www.ExcelExpertTraining.com 

เพราะเราชอบเก็บขอ้มลูไวใ้นแฟ้มเดมิตอ่กนัไป และก็ไมเ่คยมคีวามจําเป็นตอ้งใชข้อ้มลูทัง้หมด

ทีเ่ก็บไวพ้รอ้มกนัสกัครัง้เดยีว 

แลว้สตูรคํานวณทีส่รา้งไว ้มนัตอ้งถกูนํามาคํานวณใหมพ่รอ้มกนัทกุครัง้ทีม่ขีอ้มลูเปลีย่นแปลง

ไปแคเ่ซลลเ์ดยีวหรอืไม ่สตูรทีคํ่านวณหาตน้ทนุสนิคา้หรอืคา่ใชจ้า่ยซึง่มคีา่คงที ่ซึง่นานๆจงึจะ

มคีา่เปลีย่นแปลงไปสกัท ีจําเป็นหรอืทีร่วมตารางคํานวณคา่คงทีเ่หลา่นัน้ไวใ้นแฟ้มซึง่มสีตูร

คํานวณยอดกําไรจากการขาย 

จากนัน้เมือ่ถงึคราวตอ้งนําขอ้มลูนับพันนับหมืน่บรรทดั หรอืตารางรายงานทีต่อ้งพมิพนั์บรอ้ยนับ

พันหนา้มาแสดงใหด้นัูน้ เราใชส้ายตาดตูารางทัง้หมดหรอืกระดาษทกุแผน่ทีพ่มิพอ์อกมาพรอ้ม

กนัทกุหนา้หรอืไม?่ 

ผูส้รา้งงานตอ้งพจิารณาถงึประเด็นดังกลา่วขา้งตน้ไวเ้สมอ ตอ้งพรอ้มทีจ่ะแยกขอ้มลูทีเ่ก็บไวใ้น

แฟ้มไปเก็บไวใ้นแฟ้มอืน่ ขอ้มลูใดทีจํ่าเป็นตอ้งเก็บไวใ้ช ้เพือ่หาผลลพัธท์ีต่อ้งการจากการ

คํานวณรว่มกนัทกุครัง้ ก็ควรจัดเก็บไวใ้นแฟ้มเดยีวกบัตารางทีเ่ป็นสตูรคํานวณ แตถ่า้ไม่

จําเป็นตอ้งใชคํ้านวณพรอ้มกนัก็ควรแยกออกเป็นแฟ้มตา่งหากทําใหแ้ฟ้มมขีนาดเล็กลง แลว้จงึ

ใชส้ตูร link ขอ้มลูขา้มแฟ้มมาใชคํ้านวณตอ่ตามแตว่า่เราจะเลอืกเอาขอ้มลูมาใชจ้ากแฟ้มไหน 

ซึง่จะชว่ยใหใ้ชต้ารางสตูรหนา้เดยีวตารางเดยีวแตส่ามารถคํานวณผลลพัธไ์ดต้ามแตข่อ้มลูที ่

link มาใชอ้กีตอ่หนึง่  

ในกรณีที ่link ขอ้มลูขา้มชที ใหใ้ชส้ตูร Indirect เลอืกนําขอ้มลูจากชือ่ชทีทีต่อ้งการมาใชใ้น

ชทีคํานวณ สว่นกรณีที ่link ขา้มแฟ้ม ใหใ้ชคํ้าสัง่ Change Source เพือ่เลอืกชือ่แฟ้มทีต่อ้งการ

มาใชใ้นแฟ้มคํานวณ 
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ผลจากสตูรทีม่ตีอ่ขนาดแฟ้มและความเร็วในการคาํนวณ 

ขอนําผลการทดสอบจากการใชส้ตูรคํานวณหลายหลายประเภทมาเลา่สูก่นัฟัง และขอใหล้อง

หาขอ้สรปุกนัเองวา่ สตูรแบบไหนดกีวา่กนัและเพราะเหตใุด (โดยการทดสอบนีไ้ดจ้ากการสรา้ง

สตูรลงไปในตารางขนาดใหญต่ัง้แตเ่ซลล ์D1:D55,000 และใช ้Excel 2003 กบั Pentium D 

3.0 GHz)  

กรณีใชส้ตูร SumIF เพือ่หายอดรวมตามเงือ่นไขเดยีว 

• สตูร SumIF ใชเ้วลา 4 วนิาท ี/ ขนาดแฟ้ม 2,984 KB เชน่ 

=SumIF(IDRange,ID,NumRange) 

• สตูร SumIFArray ใชเ้วลา 38 วนิาท ี/ ขนาดแฟ้ม 6,089 KB เชน่ 

{=Sum(IF(IDRange=ID,NumRange))} 

• สตูร SumArray ใชเ้วลา 47 วนิาท ี/ ขนาดแฟ้ม 5,547 KB เชน่ 

{=Sum((IDRange=ID)*NumRange)} 

• สตูร SumProduct แบบใสเ่ครือ่งหมาย -- ใชเ้วลา 44 วนิาท ี/ ขนาดแฟ้ม 2,987 KB

เชน่ =SumProduct(--(IDRange=ID),NumRange) 

• สตูร SumProduct แบบใสเ่ครือ่งหมายคณู ใชเ้วลา 50 วนิาท ี/ ขนาดแฟ้ม 2,986 KB

เชน่ =SumProduct((IDRange=ID)*NumRange) 

กรณีใชส้ตูร SumIF เพือ่หายอดรวมตามเงือ่นไข 2 เง ือ่นไขตอ่เนือ่งกนั 

• สตูร SumIF ใชไ้ดเ้พยีงเงือ่นไขเดยีวจงึไมไ่ดนํ้ามาทดสอบ 

• สตูร SumIFArray ใชเ้วลา 2 นาท ี23 วนิาท ี/ ขนาดแฟ้ม 9,716 KB เชน่ 

{=Sum(IF(IDRange=ID,IF(KeyRange=Key,NumRange)))} 

• สตูร SumArray ใชเ้วลา 2 นาท ี39 วนิาท ี/ ขนาดแฟ้ม 8,633 KB เชน่ 

{=Sum((IDRange=ID)*(KeyRange=Key)*NumRange)} 

• สตูร SumProduct แบบใสเ่ครือ่งหมาย -- ใชเ้วลา 2 นาท ี30 วนิาท ี/ ขนาดแฟ้ม 

5,168 KB เชน่ =SumProduct(--(IDRange=ID),--(KeyRange=Key),NumRange) 

• สตูร SumProduct แบบใสเ่ครือ่งหมายคณู ใชเ้วลา 2 นาท ี33 วนิาท ี/ ขนาดแฟ้ม 

5,165 KB เชน่ =SumProduct((IDRange=ID)*(KeyRange=Key),NumRange) 
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• สตูร SumProduct แบบใสเ่ครือ่งหมายคณูทกุตวั ใชเ้วลา 2 นาท ี42 วนิาท ี/ ขนาด

แฟ้ม 5,166 KB เชน่ 

=SumProduct((IDRange=ID)*(KeyRange=Key)*NumRange) 

• สตูร SumProduct แบบใสเ่ครือ่งหมายคณู 1 ใชเ้วลา 2 นาท ี50 วนิาท ี/ ขนาดแฟ้ม 

5,171 KB เชน่ =SumProduct((IDRange=ID)*1,(KeyRange=Key)*1,NumRange) 

กรณีใชส้ตูร VLookup VS Match 

• VLookup แบบ Approaching Match ใชเ้วลาไมถ่งึ 1 วนิาท ี/ ขนาดแฟ้ม 2,979 KB 

แตถ่า้หาคา่ไมพ่บ (Not Available) ใชเ้วลา 3 วนิาท ีเชน่ 

=VLookup(ID,DataRange,2) 

• Match แบบ Approaching Match ใชเ้วลาไมถ่งึ 1 วนิาท ี/ ขนาดแฟ้ม 2,976 KB แต่

ถา้หาคา่ไมพ่บ (Not Available) จะแสดงตําแหน่งสดุทา้ย ใชเ้วลาไมถ่งึ 1 วนิาท ีเชน่ 

=Match(ID,IDRange)  

• VLookup แบบ Exact Match ขนาดแฟ้ม 2,981 KB โดยจะใชเ้วลานานขึน้หากตําแหน่ง

คา่ทีใ่ชห้าหา่งจากบรรทดัแรกมากขึน้ แตถ่า้หาคา่ไมพ่บ (Not Available) ใชเ้วลา 7 

วนิาท ีเชน่ =VLookup(ID,DataRange,2,0)  

• Match แบบ Exact Match ขนาดแฟ้ม 2,979 KB โดยจะใชเ้วลานานขึน้หากตําแหน่ง

คา่ทีใ่ชห้าหา่งจากบรรทดัแรกมากขึน้ เชน่ =Match(ID,IDRange,0) 

นอกจากนัน้ยงัไดท้ดสอบสตูรบวกลบคณูหาร ซึง่ Excel คํานวณเร็วมากใชเ้วลาคํานวณไมถ่งึ

วนิาท ีแตพ่บวา่ขนาดแฟ้มจะเล็กหรอืใหญข่ึน้กบัความยาวของสตูรทีใ่ช ้เชน่ =1+2+3+4+5 มี

ขนาดแฟ้มใหญก่วา่ =A2+5 โดยที ่A2 มสีตูร =1+2+3+4 เพือ่คํานวณสว่นแรกแยกไวก้อ่น 
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เมือ่ตอ้งเลอืกระหวา่งขนาดแฟ้มหรอืความเร็วในการคาํนวณ 

ประเด็นเรือ่งความอว้นอุย้อา้ยของแฟ้มตามทีก่ลา่วมาทัง้หมดในบทความนีจ้ะไมเ่ป็นสาระสําคญั

หากคดิแตเ่พยีงวา่ ถา้แฟ้มใหญข่ึน้ หรอืคอมพวิเตอรช์า้ลง เราก็ซือ้คอมพวิเตอรเ์ครือ่งใหมห่รอื

ซือ้ RAM มาเพิม่หน่วยความจําในเครือ่งใหม้ากขึน้ก็แกปั้ญหาไดแ้ลว้ แตถ่า้คดิกนังา่ยๆเชน่นี ้

ปัญหาทีเ่กดิจากการใช ้Excel จะยิง่มคีวามสลบัซบัซอ้นมากขึน้ โดยเฉพาะอยา่งยิง่เมือ่ใช ้

Excel 2007 ขึน้ไป โดยในชทีหนึง่มกีวา่ 10,000 column และกวา่ 1 ลา้น row ซึง่ยอ่มทําให ้

ผูใ้ช ้Excel ทีข่าดความรูพ้ืน้ฐาน และขาดวนัิยในการสรา้งงาน สรา้งแฟ้มงานทีจ่ะยอ้นกลบัมาทํา

รา้ยตวัเองในทีส่ดุ 

แตถ่า้ตอ้งเลอืกระหวา่งขนาดแฟ้มหรอืความเร็วในการคํานวณ ในความคดิเห็นสว่นตวัขอเลอืก

ความเร็วในการคํานวณวา่มคีวามสําคญัมากกวา่เรือ่งของขนาด เพราะปัญหาเรือ่งขนาดแฟ้มเป็น

ปัญหาทีแ่กไ้ขไดไ้มย่าก แคห่าทางแยกตารางทีไ่มจํ่าเป็นตอ้งถกูเรยีกใชง้านพรอ้มกนัออกไป

เก็บเป็นแฟ้มตา่งหากก็ทําใหแ้ฟ้มเล็กลงเรยีบรอ้ยแลว้ และแมจ้ะแยกตารางออกเป็นแฟ้มเล็กๆ

ไมไ่ด ้เรายงัสามารถจัดเก็บแฟ้มลงไปในสือ่ไดห้ลายชนดิ ไมว่า่จะเป็น USB Drive, CD, DVD, 

หรอืฮารด์ดสิก ์ซึง่ปัจจบุนัมคีวามจมุากขึน้กวา่แตก่อ่นมากในขณะทีม่รีาคาลดลง 

สว่นประเด็นในเรือ่งความเร็วของการคํานวณนัน้แมถ้อืวา่สําคญักวา่เรือ่งขนาดแฟ้ม แตค่วามเร็ว

เป็นเรือ่งของความรูส้กึ เป็นเรือ่งยากทีจ่ะหาเกณฑม์าวดัวา่อยา่งนีเ้ร็วหรอืชา้ มกัใชค้วามรูส้กึ

ของคนทีต่อ้งน่ังรอคอยคําตอบเป็นตวัชีว้ดั ถา้ยงัรอกนัได ้ก็ยงัไมเ่ดอืดรอ้นหาทางอืน่ทีจ่ะทําให ้

แฟ้มคํานวณเร็วขึน้ ดงันัน้ประเด็นเรือ่งความเร็วในการคํานวณ จงึตอ้งถอืเป็นภาระหนา้ทีข่อง

ผูส้รา้งงาน ตอ้งคอยตดิตามเสมอวา่สตูรหรอืวธิทีีต่นเพิง่สรา้งใหมล่งไปในตาราง สง่ผลใหแ้ฟ้ม

งานนัน้คํานวณชา้ลงไปกวา่เดมิอยา่งผดิสงัเกตหรอืไม ่และตอ้งลองสรา้งสตูรหลายๆแบบที่

สามารถใหคํ้าตอบเดยีวกนั แตใ่ชเ้วลาคํานวณเร็วทีส่ดุ ซึง่ควรพจิารณาผลในระยะยาวทีม่ตีอ่

ตวัเองหรอืผูอ้ืน่ทีร่ว่มใชแ้ฟ้มงานเดยีวกนัดว้ยวา่ ทกุคนสามารถใชแ้ฟ้มงานไดส้ะดวก เมือ่

ตอ้งการยอ้นกลบัมาปรับปรงุแกไ้ข ตอ้งสามารถทําไดง้า่ยในระยะเวลารวดเร็ว แมจ้ะทําใหแ้ฟ้มมี

ขนาดใหญข่ึน้ และคํานวณชา้ลงก็ตาม 
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การออกแบบโครงสรา้งตารางคาํนวณ 

ในโปรแกรม Microsoft Excel มอีงคป์ระกอบอยูส่องอยา่งแทบไมเ่ปลีย่นแปลงเลยในหลายยคุ

หลายสมยัทีผ่า่นไป ไมว่า่จะเป็น Excel รุน่ใดก็ตามยงัคงมสีิง่นีใ้ชก้นัเรือ่ยมา สิง่ทีว่า่นีก้็คอื 

ตารางทีป่ระกอบดว้ยเซลลม์หีลาย row หลาย column และสตูรสําเร็จรปูอกีหลายรอ้ยสตูรตดิ

มาพรอ้มกบัตวัโปรแกรม ซึง่ผูใ้ดสามารถนําตารางและสตูรมาใชร้ว่มกนัไดเ้ป็นอยา่งด ีจะทําให ้

ใชโ้ปรแกรม Excel ทีม่รีาคาไมก่ีห่มืน่บาททํางานไดย้ดืหยุน่กวา่โปรแกรมสําเร็จรปูราคาแพง

เป็นแสนเป็นลา้นบาททเีดยีว 

บทความนีจ้ะแนะนําคณุใหห้าทางใชต้าราง Excel อยา่งสรา้งสรรค ์เพือ่ใชคํ้านวณหาผลลพัธใ์น

ปัญหาตา่งๆไดส้ารพัด เพยีงแคนํ่าตารางและสตูรสําเร็จรปูของ Excel มาใชร้ว่มกนัอยา่งมี

หลกัการ อยา่งเป็นขัน้เป็นตอน และอยา่งมเีหตผุล จะชว่ยใหค้ณุไดรั้บประโยชนม์ากขึน้กวา่แต่

กอ่น เชน่ 

1. สามารถคํานวณหาคําตอบในปัญหาทีไ่มเ่คยคดิวา่ Excel จะทําไดม้ากอ่น  

2. สตูรสัน้ลง และสามารถแกไ้ขสตูรไดง้า่ยและรวดเร็ว  

3. สามารถตรวจสอบความถกูตอ้งของการคํานวณในทกุขัน้ตอน  

4. สามารถขยายขนาดหรอืเคลือ่นยา้ยตําแหน่งเซลล ์เพือ่นําตารางไปใชซ้ํ้าใน
เซลลอ์ืน่ ชทีอืน่หรอืแฟ้มอืน่ไดท้นัท ี 

5. สามารถนําตารางไปใชใ้นงานคํานวณอืน่ทีใ่ชห้ลกัการเดยีวกนัไดท้นัท ีหรอื
หลงัจากผา่นการปรับปรงุเพยีงเล็กนอ้ย  

6. สามารถนําตารางไปใชง้านรว่มกบัเมนูคําสัง่ของ Excel ไดท้กุเมือ่ แมแ้ตก่ารนํา
ขอ้มลูไปแสดงผลตอ่ในรปูกราฟ  

7. แฟ้มคํานวณเร็วและมขีนาดแฟ้มเล็กลง แมจ้ะมตีารางขนาดใหญก่็ตาม 

ตารางคาํนวณคอือะไร 

เพือ่ทําใหเ้ขา้ใจตรงกนั จงึขอใหคํ้าจํากดัความในความหมายของตารางคํานวณกอ่นวา่ ตาราง

คํานวณในบทความนีม้ไิดห้มายถงึพืน้ทีต่ารางวา่งๆทีค่ณุจะเห็นทนัทบีนจอเมือ่เปิดโปรแกรม 

Excel ขึน้มาใชง้าน แตต่ารางคํานวณในทีน่ีม้คีวามหมายถงึตารางซึง่คณุสรา้งขึน้มาเองโดยมี

ขอ้มลูบนัทกึไวแ้ลว้ อาจเป็นขอ้มลูตวัเลข ตวัอกัษร หรอืสตูรใดๆก็ได ้ทัง้นีม้เีจตนาเพือ่ใชพ้ืน้ที่
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เซลลห์รอืตารางนัน้ในการคํานวณหาคําตอบทีค่ณุตอ้งการโดยเฉพาะ เชน่ ตารางคํานวณคา่แรง

ทีต่อ้งจา่ยใหล้กูจา้งทํางานในแตล่ะกะ ตารางคํานวณยอดตน้ทนุขายแบบ Fist-in First-

out ตารางคํานวณหาจํานวนสนิคา้ทีต่อ้งวางแผนสัง่ผลติ (Material Requirements Planning) 

หรอืตารางคํานวณเพือ่วางแผนการลงทนุ (Feasibility Study) เป็นตน้ 

ตารางทีไ่มถ่อืวา่เป็นตารางคํานวณในบทความนี ้ไดแ้ก ่ตารางฐานขอ้มลูซึง่ใชบ้ันทกึขอ้มลูดบิ

(ไมม่สีตูร) ตารางรายงานทีจั่ดโครงสรา้งเพือ่พมิพใ์นกระดาษหรอืแสดงผลใหเ้ห็นบนจอ หรอื

ตารางที ่Excel จัดโครงสรา้งใหเ้องอตัโนมตัจิากการใชคํ้าสัง่บนเมนู SubTotals หรอื Pivot 

Table 

ตารางคํานวณโดยทัว่ไปประกอบดว้ยพืน้ทีต่ารางยอ่ย 2 สว่น สว่นแรกเป็นพืน้ทีต่ารางสําหรับ

เก็บคา่ตวัแปรทีใ่ชใ้นการคํานวณ และพืน้ทีต่ารางอกีสว่นหนึง่ใชสํ้าหรับสรา้งสตูรคํานวณซึง่รับ

คา่มาจากคา่ตวัแปรในพืน้ทีส่ว่นแรกน่ันเอง โดยผูใ้ชง้านจะใชพ้ืน้ทีส่ว่นแรกในการพมิพค์า่ตวั

แปรตวัใหมล่งไป จากนัน้จะแสดงคําตอบจากการคํานวณใหเ้ห็นในตารางสว่นทีเ่ป็นสตูรคํานวณ 

ขอ้ควรพจิารณากอ่นเร ิม่สรา้งตารางคาํนวณ 

สมมตวิา่คณุกําลงัหาทางคํานวณคา่แรงทีต่อ้งจา่ยใหล้กูจา้งทํางานในแตล่ะกะ จะตอ้งคดิ

พจิารณาอะไรบา้ง 

1. กําหนดขอบเขตของความตอ้งการของคณุทีเ่ป็นไปไดว้า่มอีะไรบา้ง 
เชน่ ตอ้งการใชต้ารางในชทีหนึง่เพือ่คํานวณคา่แรงของพนักงานคนหนึง่ซึง่
ทํางานในวนัหนึง่ หรอืตอ้งการใชต้ารางในชทีหนึง่เพือ่คํานวณคา่แรงของ
พนักงานคนหนึง่ซึง่ทํางานในเดอืนหนึง่โดยแสดงเป็นรายวนัตอ่เนือ่งกนัไป หรอื
ตอ้งการคํานวณคา่แรงของพนักงานทกุคนในวันหนึง่ๆ หรอืตอ้งการคํานวณ
คา่แรงใหก้บัพนักงานทกุคนในเดอืนหนึง่โดยแสดงเป็นรายวนัตอ่เนือ่งกนัไป 
หรอืมคีวามตอ้งการอืน่ๆอกีบา้งไหม ทัง้นีเ้พือ่หาทางสรา้งตารางคํานวณเพยีง
ตารางเดยีวแตต่อ้งมคีวามยดืหยุน่สามารถนําไปใชคํ้านวณไดท้กุกรณีตามทีค่ณุ
ตอ้งการ(ทัง้ทีเ่คยตอ้งการในอดตีและอาจจะมมีากขึน้ในอนาคต)  

2. คน้หาเงือ่นไขทัง้หมดทีเ่กีย่วขอ้งในการคํานวณ ซึง่โดยทัว่ไปผูท้ีค่ลกุคลกีบัการ
บรหิารการจา้งแรงงานยอ่มตอ้งมเีงือ่นไขทีต่นนําไปใชใ้นงานอยูแ่ลว้ เชน่ 
เงือ่นไขเกีย่วกบัชว่งเวลาหรอืกะทีกํ่าหนดใหทํ้างานในแตล่ะวนัแบง่เป็นกีช่ว่ง แต่
ละชว่งใชเ้วลาทํางานมากนอ้ยเพยีงไร แบง่เป็นชว่งเวลาหยดุพักกีค่รัง้ แตล่ะครัง้
ใหห้ยดุพักไดน้านเทา่ใด ลกูจา้งตอ้งตอกบตัรหรอืบนัทกึการเขา้ทํางานไว ้
อยา่งไร บรษัิทมเีงือ่นไขในการจา่ยคา่จา้งแรงงานเป็นอยา่งไร ซึง่เงือ่นไขเหลา่นี้
จะตอ้งหาทางนํามาใชใ้นการคํานวณ  
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3. ในอดตีจนถงึปัจจบุนัใชว้ธิกีารคํานวณคา่แรงอยา่งไร มขีัน้ตอนการคํานวณที่
ชดัเจนเป็นมาตรฐานทีใ่ชก้นัไดต้ลอดมาหรอืไม ่หรอืมกีรณีพเิศษใดบา้งทีทํ่าให ้
ตอ้งคํานวณวธิอีืน่ตา่งจากทีเ่ป็นมาตรฐานนัน้ ใหเ้ก็บรวบรวมตวัเลขทีใ่ชใ้นแตล่ะ
ชว่งแตล่ะกรณีเอาไวเ้พือ่นํามาใชเ้ป็นตวัอยา่งสรา้งตารางคํานวณใน Excel และ
เพือ่ใชเ้ปรยีบเทยีบผลคํานวณทีเ่กดิขึน้วา่ตรงกนัหรอืไม ่ 

4. คน้หาความเป็นไปไดท้กุทางทีล่กูจา้งคนหนึง่จะเขา้งานในชว่งเวลาทีกํ่าหนด ซึง่
ในกรณีปัญหาการเขา้งานนีพ้บวา่มโีอกาสความเป็นไปไดท้ีจ่ะมชีว่งเวลาทํางาน
ซึง่สมัพันธก์บัชว่งเวลาทีกํ่าหนดหรอืกะหนึง่ๆถงึ 7 กรณี เชน่ ถา้สมมตวิา่
กําหนดใหก้ะทํางานจาก 8:00 ถงึ 10:00 น. ลกูจา้งสามารถมชีว่งทํางานตรงกบั
กะ(8:00-10:00) อยูภ่ายในกะ(8:30-9:00) ครอ่มกะทัง้กอ่นและหลงั(7:00-
12:00) ครอ่มกะเพยีงชว่งเริม่งาน(7:00-9:00) ครอ่มกะเพยีงชว่งเลกิงาน(9:00-
12:00) นอกกะชว่งกอ่นกะ(6:00-7:00) และนอกกะชว่งหลงักะ(11:00-12:00) 
ซึง่คณุจะตอ้งหาทางคดิสตูรเพยีงสตูรเดยีวใหส้ามารถคํานวณไดค้รบทัง้ 7 กรณี  

5. ขอใหย้ดึหลกัวา่ อยา่พยายามคดิหาสตูรลดัเพือ่คํานวณหาคําตอบใหแ้ลว้เสร็จ
โดยใชเ้ซลลส์ตูรเพยีงเซลลเ์ดยีว เพราะนอกจากสตูรจะตอ้งยาวเหยยีดซอ้นสตูร
กนัหลายชัน้จนแกะแทบไมอ่อกแลว้ ยงัอาจเป็นไปไมไ่ดเ้ลยทีจ่ะคดิหาสตูร
ขึน้มาใชไ้ด ้และคณุอาจป่วยเป็นโรคกระเพาะเพราะมวัแตค่ดิสตูรอยูท่ัง้วนัทัง้คนื  

6. แทนทีจ่ะคดิสตูรลดัสตูรเดยีวเซลลเ์ดยีว ขอใหแ้บง่การคํานวณออกเป็นขัน้ๆ แลว้
หาทางใชส้ตูรสําเร็จรปูที ่Excel มอียูใ่หไ้ดก้อ่น แตห่ากไมม่สีตูรสําเร็จรปูทีห่า
คําตอบไดโ้ดยตรง คณุตอ้งหาทางนําสตูรสําเร็จรปูทีม่มีาใชร้ว่มกนัโดยอาจนํามา
ซอ้นสตูรกนัในเซลลเ์ดยีว หรอืใชเ้ซลลแ์ยกคํานวณทลีะขัน้ แลว้จงึนําผลลพัธท์ี่
ไดจ้ากเซลลห์นึง่สง่ไปคํานวณตอ่ในสตูรของอกีเซลลห์นึง่ กลายเป็นทีม่าของ
ตารางคํานวณน่ันเอง  

7. ลองคน้หาวธิกีารคํานวณจากอนิเตอรเ์น็ต เชน่ คน้หาจาก Google เพือ่เรยีนรูจ้าก
ตวัอยา่งของคนอืน่ คณุอาจโชคดไีดต้วัอยา่งทีต่รงตามทีค่ณุตอ้งการ สามารถ
นําไปใชต้อ่ไดเ้ลย หรอืแคนํ่าไปดดัแปลงเพยีงเล็กนอ้ยกอ่นก็ใชก้บังานของคณุ
ไดแ้ลว้ ซึง่แมว้า่จะไดต้วัอยา่งไมต่รงกบัสิง่ทีต่อ้งการก็ตาม แตต่วัอยา่งเหลา่นัน้
น่าจะเป็นแนวทางใหค้ณุไดค้ดิพจิารณาและเกดิมมุมองทีก่วา้งขวางและชดัเจน
กวา่เดมิ 

 ข ัน้ตอนการสรา้งตารางคาํนวณ 

หลงัจากทีไ่ดพ้จิารณาขอบเขตความตอ้งการและพอไดเ้ห็นแนวทางสรา้งงานทีค่นอืน่ใชก้นัมา

กอ่นแลว้บา้ง คราวนีก้็ถงึประเด็นสําคญัวา่พอเปิดโปรแกรม Excel ขึน้มาแลว้ คณุจะเริม่ตน้

ออกแบบตารางกนัอยา่งไรด ีซึง่ลกัษณะของตารางคํานวณนีเ่องทีจ่ะชีใ้หเ้ห็นฝีไมล้ายมอืวา่ใคร

เยีย่มยทุธก์วา่กนั ถา้เทยีบกบัการสรา้งบา้นสกัหลังหนึง่แลว้ ขอ้พจิารณาทีผ่า่นไปเป็นเพยีงแค่
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การออกแบบครา่วๆและเตรยีมซือ้อปุกรณ์กอ่สรา้ง หนิ ทราย ปนูซเิมนต ์เตรยีมไวไ้มใ่หข้าด

ไมใ่หเ้กนิกวา่ความจําเป็น ขัน้จากนีเ้ป็นหนา้ทีข่องสถาปนกิและวศิวกรทีจ่ะตอ้งลงมอืกอ่สรา้ง

บา้นของจรงิใหส้วยหร ูดดู ีอยูส่บาย อากาศถา่ยเทสะดวก และสามารถตกแตง่ตอ่เตมิใหน่้าอยู่

ไปชัว่ลกูชัว่หลาน 

กอ่นอืน่ผมจําเป็นตอ้งขอเตอืนใหท้ราบขอ้ผดิพลาดทีผู่ใ้ช ้Excel ทัว่ไปมกัคดิออกแบบตาราง

อยา่งรวบรัดเกนิไป โดยการพยายามนําตารางคํานวณไปรวมกบัตารางทีใ่ชพ้มิพอ์อกไปเป็น

รายงานหรอืแสดงผลลพัธท์ีต่อ้งการบนหนา้จอคอมพวิเตอรไ์วเ้ป็นตารางเดยีวกนั ซึง่ความคดิ

เชน่นีจ้ะกลายเป็นอปุสรรคสําคญัทําใหไ้มส่ามารถใชเ้ซลลต์อ่เนือ่งกนัเพือ่จัดการคํานวณทลีะ

ลําดบั จงึขอแนะนําใหค้ดิแยกตารางคํานวณออกเป็นพืน้ทีต่า่งหากแยกจากตารางทีใ่ชพ้มิพ์

รายงาน แมต้อ้งทําใหเ้สยีพืน้ทีเ่ซลลม์ากขึน้โดยอาจตอ้งแยกออกเป็นชทีหลายๆชที แตจ่ะชว่ย

ทําใหส้ามารถออกแบบโครงสรา้งตารางคํานวณไดอ้ยา่งอสิระ แลว้ตอ่เมือ่ตารางคํานวณนี้

สามารถคํานวณหาคําตอบไดต้ามทีต่อ้งการแลว้ จงึคอ่ยนําผลลพัธท์ีไ่ด ้link ไปประกอบกนัเป็น

ตารางรายงานในทีส่ดุ 

โครงสรา้งพืน้ฐานของตารางคํานวณ ประกอบดว้ยสว่นทีเ่ป็นพืน้ทีต่ารางสําหรับรับคา่ตวัแปร 

และพืน้ทีต่ารางสําหรับสรา้งสตูรคํานวณ โดยใหย้ดึหลกัวา่สตูรทีส่รา้งขึน้ในตารางคํานวณนัน้ 

หากเป็นไปไดข้อใหค้ดิสรา้งสตูรลงไปในเซลลแ์รกเซลลเ์ดยีวทีห่วัมมุซา้ยบนสดุของตาราง 

จากนัน้เมือ่ copy สตูรนีไ้ปใชท้ีเ่ซลลส์ว่นอืน่ในตารางตอ้งสามารถใชส้ตูรเดมินัน้ไดโ้ดยไม่

จําเป็นตอ้งแกไ้ขสตูรใหแ้ตกตา่งกนัไปจากเดมิแตอ่ยา่งใด หรอือกีนัยหนึง่ใหใ้ชส้ตูรเดยีวกบัทกุ

เซลลใ์นตารางคํานวณใหไ้ด ้แตถ่า้ไมส่ามารถสรา้งสตูรเดยีวทีเ่ซลลห์วัมมุ ก็ขอใหพ้ยายาม

สรา้งสตูรเดยีวในแตล่ะแนว row หรอื column 

เพือ่ทําใหเ้ห็นโครงสรา้งตารางคํานวณแบบงา่ยๆ ขอยกตวัอยา่งการสรา้งตารางคํานวณสตูรคณู

มาพจิารณากนัตามรปูตอ่ไปนี ้ 
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รปูตารางนีเ้ป็นตวัอยา่งการคํานวณสตูรคณูแม ่2 ถงึ 5 โดยกําหนดใหนํ้าไปคณูเลข 1 ถงึ 5 

• ใหแ้ยกเซลลรั์บตวัแปรวางไวต้ามแนวคูข่นานกบัพืน้ทีคํ่านวณโดยอาจวางไวเ้ป็น
แนวหวัตารางดา้นบน (C2:F2) หรอืหวัตารางดา้นขา้ง (B3:B7) ซึง่ตวัแปรทีว่า่นี้
เป็นเซลลรั์บตวัเลขทีค่ณุอาจมคีวามตอ้งการเปลีย่นแปลงเป็นคา่อืน่ในอนาคต   

• C3:F7 เป็นพืน้ทีเ่ซลลท์ีค่ณุตอ้งหาทางสรา้งสตูรลงไปทกุเซลล ์โดยใหส้รา้ง
สตูรลงไปทีเ่ซลล ์C3 ซึง่เป็นตําแหน่งเซลลห์วัมมุซา้ยบนเพยีงเซลลเ์ดยีว ใหม้ี
สตูร =C$2*$B3 จากนัน้ให ้copy ไป paste ทกุเซลลใ์นพืน้ที ่C3:F7 

โปรดสงัเกตวา่ตวัอยา่งสตูรคณูนีเ้ป็นตวัอยา่งการนําคา่ไปคํานวณแบบ 1 ตอ่ 1 หมายถงึ เซลล์

สตูรหนึง่ๆจะรับคา่จากเซลลต์วัแปรตามแนวนอนหรอืแนวตัง้เพยีงขา้งละ 1 เซลลเ์ทา่นัน้ ซึง่ใน

ปัญหาอืน่อาจจําเป็นตอ้งใชก้ารคํานวณทีซ่บัซอ้นมากขึน้ โดยเซลลส์ตูรหนึง่ จะใชเ้ซลลต์วัแปร

มากกวา่เซลลเ์ดยีวก็เป็นไดโ้ดยใชส้ตูรพวก Lookup ชว่ยในการเลอืกขอ้มลูมาใชคํ้านวณ 

นอกจากเซลลส์ตูรจะรับคา่มาจากเซลลต์วัแปรแลว้ เซลลส์ตูรยงัอาจรับคา่ตอ่มาเซลลส์ตูร

คํานวณในขัน้กอ่นไดอ้กี ซึง่จะเห็นไดช้ดัจากตารางคํานวณงบการเงนิหรอืวางแผนการผลติทีม่ี

ยอดคงเหลอืปลายงวดสง่ตอ่ไปตัง้เป็นยอดคงเหลอืตน้งวดของชว่งเวลาถดัไป 

ตารางคํานวณทีด่ตีอ้งมคีวามยดืหยุน่สามารถคํานวณใหผ้ลลพัธไ์ดต้ามตอ้งการตลอดไปไมว่า่จะ

มกีารโยกยา้ยหรอืแยกตารางตวัแปรไปวางไวท้ีช่ทีอืน่เหนอืแฟ้มอืน่ ดงันัน้พอสรา้งตาราง

คํานวณเสร็จ ขอใหท้ดลอง cut ตารางไปวางไวท้ีตํ่าแหน่งอืน่หรอืโยกยา้ยเซลลต์วัแปรแยก

ออกจากกนั เพือ่พสิจูนว์า่ตารางคํานวณยงัคงสามารถใหผ้ลลัพธถ์กูตอ้งตามเดมิหรอืไม ่

ตวัอยา่งตารางคาํนวณหาระยะเวลาทีใ่ชใ้นกะ 

สมมตวิา่ลกูจา้งคนหนึง่เขา้งานตัง้แตเ่วลา 7:00-9:00 น. ใหส้รา้งตารางคํานวณหาระยะเวลาที่

เขาทํางานในกะทีกํ่าหนดซึง่เริม่ตัง้แตเ่วลา 8:00-10:00 น.  

จากคําถามขา้งตน้นี ้คณุคงคดิคําตอบในใจไดว้า่ตอ้งทํางานในกะเป็นเวลา 1 ชัว่โมงใชไ่หม 

เพราะลกูจา้งคนนีอ้อกจากงานเวลา 9:00 น. จงึนับระยะเวลาตัง้แตเ่ริม่กะตอน 8:00 น. ไป

จนถงึเวลาทีเ่ขาออกจากงาน ไดเ้ป็นระยะเวลา 1 ชัว่โมง (8:00-9:00) ซึง่คงหาทางสรา้งสตูร

คํานวณไดไ้มย่าก แตถ่า้เขามชีว่งทีเ่ขา้ทํางานหลากหลายกรณีจะใชส้ตูรอยา่งไร 

1. ตรงกบักะ (8:00-10:00)  

2. อยูภ่ายในกะ (8:30-9:00)  
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3. ครอ่มกะ ทัง้กอ่นและหลัง (7:00-12:00)  

4. ครอ่มกะ เพยีงชว่งเริม่งาน (7:00-9:00)  

5. ครอ่มกะเพยีงชว่งเลกิงาน (9:00-12:00)  

6. นอกกะ ชว่งกอ่นกะ (6:00-7:00)  

7. นอกกะ ชว่งหลงักะ (11:00-12:00) 

 

 

 

สตูรคํานวณหาระยะเวลาทํางานทีใ่ชใ้นกะ ในเซลล ์H4 = MAX(  0,  MIN(F4,D4)  -

  MAX(E4,C4) ) โดยแยกอธบิายแตล่ะสว่นในสตูรได ้ดงันี ้

• MIN(F4,D4) เป็นการนําเวลาปลายกะมาเทยีบกบัเวลาปลาย job (เวลาออก
จากงาน) เพือ่หาเวลาสดุทา้ยทีเ่ป็นไปไดท้ีเ่กดิขึน้กอ่น  

• MAX(E4,C4) เป็นการนําเวลาตน้กะมาเทยีบกบัเวลาตน้ job (เวลาเริม่เขา้งาน) 
เพือ่หาเวลาสดุทา้ยทีเ่ป็นไปไดท้ีเ่กดิขึน้หลงัสดุ  

• MIN(F4,D4)-MAX(E4,C4) คํานวณหาระยะเวลาทํางานทีใ่ชใ้นกะ  

• MAX(0,xxx) ปรับผลลัพธท์ีคํ่านวณไดใ้หไ้มม่ทีางตํา่กวา่ 0 

สตูร = MAX(0,MIN(F4,D4)-MAX(E4,C4)) นี ้เป็นสตูรสััน้ๆทีส่ามารถใชแ้ทนสตูร IF เพราะ

หากจะใช ้IF ในการคํานวณก็จะตอ้งนํา IF มาซอ้นกนัถงึ 7 ชัน้ 
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ตารางคาํนวณตอ้งมากอ่น สว่นสตูรลดัมาทหีลงั 

ทกุวนันีค้ณุสามารถคน้หาสตูรคํานวณเพือ่หาคําตอบในปัญหาตา่งๆไดโ้ดยตรงจากอนิเตอรเ์น็ต 

หรอืยกคําถามไปหารอืในฟอรัมถามตอบปัญหา Excel ไดไ้มย่าก หลายๆครัง้ทเีดยีวทีจ่ะไดรั้บ

คําตอบเป็นสตูรซอ้นกนัยาวเหยยีดเป็นหนา้ จนอดทึง่ในความสามารถของคนทีส่รา้งสตูร

เหลา่นัน้ไมไ่ดว้า่เขาคดิสตูรกนัมาไดอ้ยา่งไร 

หากจะไลเ่รยีงลําดบัความเกง่เกีย่วกบัการใช ้Excel แลว้ การทีเ่กง่มคีวามสามารถสรา้งสตูร

ยากๆยาวๆได ้ถอืวา่เป็นความเกง่ขัน้สงูทีม่กัเป็นความสามารถเฉพาะตวั ยากทีค่นอืน่จะ

เลยีนแบบหรอืเขา้ใจทีไ่ปทีม่าของสตูรทีนํ่ามาซอ้นกนั เพราะคนเกง่แตล่ะคนมกัเลอืกใชส้ตูรที่

ตนถนัดแตกตา่งกนัไป แตอ่ยา่งไรก็ตาม ในเรือ่งสตูรทีต่วัผมเองคดิขึน้นัน้ หลายๆครัง้ทเีดยีวที่

พบวา่ไมส่ามารถแกะสตูรยาวๆทีต่วัเองเป็นคนตน้คดิ จงึเป็นสิง่ทีน่่าเป็นหว่งอยา่งยิง่วา่ ในเมือ่

แมแ้ตต่วัผูท้ีค่ดิสตูรขึน้เองยงัไมส่ามารถเขา้ใจทีไ่ปทีม่าของแตล่ะสว่นในสตูรยาวๆไดเ้ลย แลว้

ไฉนผูอ้ืน่จะเขา้ใจสตูรทีต่นไมไ่ดส้รา้งเองหรอืสามารถนําสตูรไปดดัแปลงใชง้านไดเ้ลา่ ดงันัน้

การสรา้งสตูรยากๆยาวๆใหแ้กผู่อ้ ืน่ใช ้จงึเป็นการสรา้งปัญหาระยะยาวใหเ้กดิขึน้กบัผูใ้ชส้ตูรที่

ตนเองไมไ่ดเ้ป็นคนสรา้ง เพราะวา่เมือ่ใดทีเ่งือ่นไขในการคํานวณแตกตา่งไปจากเดมิ เมือ่นัน้ก็

จําตอ้งยอ้นกลบัมาตัง้คําถามใหค้นอืน่ชว่ยสรา้งสตูรใหมใ่หอ้กี 

แทนทีจ่ะใชส้ตูรลดัซึง่เป็นสตูรซอ้นกนัยาวเหยยีด แนะนําใหก้ระจายการคํานวณออกเป็นหลาย

เซลลเ์พือ่แยกคํานวณแตล่ะอยา่งกอ่น แลว้จงึนําผลลพัธท์ีไ่ดไ้ปคํานวณหาผลลพัธส์ดุทา้ย จะ

เป็นวธิชีว่ยสรา้งความเขา้ใจใหเ้กดิขึน้ถงึทีไ่ปทีม่าของสตูรวา่คดิกนัมาไดอ้ยา่งไร 

ยกตวัอยา่งสตูรคํานวณหาชือ่แฟ้ม ซึง่ดแูลว้ยากทีจ่ะจํา และไมม่ทีางรูว้า่มหีลกัการคดิมาได ้

อยา่งไร 

=MID(CELL("filename"),FIND("[",CELL("filename"))+1,FIND("]",CELL("filenam

e"))-FIND("[",CELL("filename"))-1) 

สตูรนีม้ทีีม่าจากสตูร  

=MID(ขอ้ความทีม่ชี ือ่แฟ้ม, เลขตําแหน่งเครือ่งหมาย [, เลขจํานวนตวัอกัษรของชือ่

แฟ้ม) 

แยกคํานวณแตล่ะสว่นไดต้ามรปูตอ่ไปนี ้
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แทนทีจ่ะใชส้ตูรยาวจนจําแทบไมไ่หวในเซลล ์B7 ใหเ้ริม่จากการใชส้ตูรหาคา่ทีเ่กีย่วขอ้งกบั

การแยกคําทลีะขัน้ ดงันี ้

1. เซลล ์A1 ใชส้ตูร =CELL("filename") เพือ่หาชือ่แฟ้ม โดยคําตอบทีไ่ดจ้ะแสดง
ทัง้ชือ่ drive ชือ่โฟลเดอร ์ชือ่แฟ้ม และชือ่ชที  

2. เซลล ์B3 และ B4 ใชส้ตูร =FIND("[",$A$1) และ =FIND("]",$A$1) เพือ่
คํานวณหาตําแหน่งของเครือ่งหมายวงเล็บ [ ] ตามลําดบั  

3. เซลล ์B5 ใชส้ตูร =MID(A1,B3+1,B4-B3-1) เพือ่แยกเฉพาะสว่นทีเ่ป็นชือ่แฟ้ม
ออกมาใชง้าน 
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การออกแบบโครงสรา้งตารางคาํนวณรว่มกบัสตูรลดั 

จากสตูร = MAX(0,MIN(F4,D4)-MAX(E4,C4)) ซึง่ใชคํ้านวณหาระยะเวลาทีใ่ชใ้นกะซึง่ได ้

อธบิายทีไ่ปทีม่าของแตล่ะสว่นในสตูรแลว้วา่เป็นอยา่งไร จากนีข้อใหค้ณุคดิตอ่ไปอกีวา่จะนํา

สตูรนีไ้ปใชใ้นการวางแผนโดยจําเป็นตอ้งนําสตูรนีไ้ปใชร้ว่มกบัตวัแปรอืน่ๆ เชน่ ชว่งเวลาของกะ

อืน่ๆ ชว่งเวลาเขา้งานในวันอืน่ๆหรอืเวลาเขา้งานของลกูจา้งคนอืน่ ตลอดจนหาทางคํานวณ

คา่แรงทีต่อ้งจา่ยออกเป็นตวัเงนินัน้ ตอ้งออกแบบตารางคํานวณใหม้หีนา้ตาอยา่งไรด ี

 

ตวัอยา่งนีข้อสมมตวิา่ในกําหนดเวลาทํางานแตล่ะวัน ตัง้แต ่6:00-24:00 น.นัน้ ถกูแบง่ออกเป็น 

8 กะ แตล่ะกะเริม่จากชว่งเวลา 6:00, 8:00, 10:00, 12:00, 13:00, 17:00, 19:00, และ 

22:00 โดยกําหนดคา่แรงในชว่งกะทีเ่ริม่ 8:00, 10:00, 13:00, และ 17:00 ใหใ้ชอ้ตัราคา่แรง

ปกต ิสว่นกะอืน่ๆมอีตัราคา่แรง OT 1.5 เทา่ของอตัราปกต ิ

แรกสดุผมตดัสนิใจวา่ จะยงัไมนํ่าประเด็นเรือ่งคา่แรงมาใชใ้นการคํานวณ โดยตอ้งการคํานวณ

ใหไ้ดร้ะยะเวลาทีใ่ชใ้นแตล่ะกะใหไ้ดก้อ่น เพือ่เผือ่วา่จะสามารถใชต้วัเลขระยะเวลาไปใชใ้นงาน

วางแผนอืน่ทีอ่าจเกีย่วขอ้งไดอ้กี เชน่ หากตอ้งการวดัประสทิธภิาพในการทํางาน ก็อาจนํา

ระยะเวลาทีใ่ชใ้นแตล่ะกะไปคณูกบัอตัรากําลงัผลติมาตรฐาน แลว้นํามาเปรยีบเทยีบกบัผลงานที่

ผลติไดจ้รงิในแตล่ะกะวา่ดกีวา่หรอืตํา่กวา่มาตรฐานอยา่งไร 

ในการออกแบบตารางคํานวณใหเ้ลอืกวางแนวตารางทีอ่าจจะมรีายการเพิม่ใหเ้พิม่ไดใ้น

แนวนอน จะสะดวกกวา่การวางตารางทีเ่พิม่ไวต้ามแนวตัง้ ดงันัน้จงึกําหนดใหแ้บง่หวัตารางที่

เป็นกะตา่งๆไวต้ัง้แตเ่ซลล ์E5:L5 เพราะเชือ่วา่สว่นนีค้งไมม่กีารปรับเพิม่จากเดมิมากนัก แลว้

กําหนดใหใ้ชต้ารางดา้นซา้ยสดุเรยีงลําดบังานแตล่ะงานไปเรือ่ยๆ จากเซลล ์B6:D10 



334 

 

Copyright of www.ExcelExpertTraining.com 

ตวัเลขเวลาเริม่กะทีบ่นัทกึไวใ้นเซลล ์E5:L5 นัน้ ยงัถกูนําไปกระจายแยกเป็นเวลาเริม่กะ 

(From) และเวลาสิน้สดุของกะ (To) ไวท้ีเ่ซลล ์E2:L3 เพือ่แสดงใหเ้ห็นชดัเจนขึน้วา่แตล่ะกะมี

เวลาเริม่ตน้และสิน้สดุอยา่งไร และยงัเผือ่ไวใ้ชก้บัสตูรคํานวณหาระยะเวลาทีใ่ชใ้นกะอกีดว้ย จะ

ไดทํ้าใหส้ตูรมกีารใชตํ้าแหน่งอา้งองิในแนวเดยีวกนัไปตลอด ชว่ยใหส้รา้งและแกะทีไ่ปทีม่าได ้

งา่ยขึน้  

สว่นดา้นของรายละเอยีดการทํางานนัน้ ในชว่งแรกนีใ้ชเ้ลขทีง่านเรยีงไปเรือ่ยๆไวก้อ่นในเซลล ์

B6:B10 ซึง่ในอนาคตอาจเปลีย่นจากเลขทีง่าน ไปเป็นชือ่คน หรอืเลขเครือ่งจักรแทนก็ได ้ทัง้นี้

เพือ่ใชแ้สดงชือ่รายการเทา่นัน้วา่เป็นการทํางานของใคร และสามารถพมิพร์ายการตอ่ไปไดอ้กี

นับหมืน่รายการตามแนวนอน 

กําหนดใหบ้ันทกึเวลาเริม่งาน (Start) และออกจากงาน (Stop) คูข่นานกบัเลขที ่Job ไวใ้น

เซลลต์ัง้แต ่C6:C10 และ D6:D10 ตามลําดบั 

ตารางตัง้แตเ่ซลล ์E6:L10 ใชส้ตูร =MAX(0,MIN( E$3, $D6 ) - MAX( E$2, $C6 )) เพือ่

คํานวณหาระยะเวลาทีทํ่างานในแตล่ะกะ โดยสรา้งสตูรนีล้งไปในเซลล ์E6 เซลลเ์ดยีวแลว้ 

copy ไป paste เพือ่ใชคํ้านวณทกุเซลลต์ัง้แต ่E6:L10 

เพือ่แสดงใหเ้ห็นเฉพาะตวัเลขเวลาทีคํ่านวณได ้ไมใ่หแ้สดงตัวเลขเวลาทีเ่ทา่กบั 0 จงึเลอืกใช ้

Format แบบ hh:mm;; และใชส้พีืน้แยกแตล่ะกะทีใ่ชอ้ตัราคา่แรงปกตอิอกจากพืน้ตารางสว่นที่

ใชอ้ตัราคา่แรงพเิศษ (OT) 

จากนัน้สรา้งสตูรรวมหายอดระยะเวลาทีทํ่างานในชว่งอตัราปกตแิละชว่งอตัรา OT ไวใ้นตาราง

ดา้นขวาตัง้แตเ่ซลล ์N6:O10 ซึง่เมือ่นําไปคณูกบัเลขอตัราในเซลล ์Q4 และ R4 แลว้ ทําให ้

คํานวณหาคา่แรงแยกประเภทของอตัราแตล่ะตวัแสดงใหเ้ห็นในตาราง Q6:R10  

วเิคราะหล์กัษณะโครงสรา้งตารางคาํนวณทีใ่ช ้

1. พืน้ทีต่ารางทีใ่ชรั้บตวัแปร เชน่ B6:B10, C6:C10, D6:D10, และ E5:L5 ถกูวาง
ไวเ้ป็นแนวคูข่นานกบัแนวตารางสตูรคํานวณ E6:L10  

2. สตูรคํานวณในพืน้ทีต่าราง E6:L10 เกดิจากสตูรในเซลล ์E6 เพยีงเซลลเ์ดยีวที่
นําไป paste ตอ่ใหเ้ซลลอ์ืน่ๆ ทําใหส้ะดวกในการแกไ้ขสตูรไมต่อ้งคน้หาและ
แกไ้ขสตูรในเซลลแ์ตล่ะเซลล ์ 

3. ตารางกําหนดเวลาแตล่ะชว่งกะ E2:L3 ชว่ยชีช้ดัวา่แตล่ะกะมเีวลาใด ชว่ยให ้
สรา้งสตูรคํานวณไดง้า่ยขึน้และยงัทําใหม้คีวามเขา้ใจชดัเจนมากขึน้สําหรับ
ผูใ้ชง้านทัว่ไป ซึง่ในอนาคตหากไมต่อ้งการแสดงพืน้ทีส่ว่นนีก้็สามารถโยกยา้ย
ไปซอ่นทีอ่ืน่  
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4. จดุเดน่ของโครงสรา้งตารางซึง่ชว่ยใหส้ามารถคํานวณคา่แรงในแตล่ะอตัราได ้
คอื การใชต้ารางแบง่ออกเป็นแตล่ะกะเพือ่แยกคํานวณหาระยะเวลาทีใ่ชใ้นกะ
นัน้ๆกอ่น และยงัชว่ยใหส้ามารถตรวจสอบความถกูตอ้งของการคํานวณไดง้า่ย 
ชดัเจนกวา่การคดิสตูรยากๆยาวๆเพยีงเพือ่คํานวณแยกแตล่ะกะใหแ้ลว้เสร็จใน
เซลลเ์ดยีว  

5. ในแงข่องเลขตวัเงนิคา่แรงทีโ่ดยทัว่ไปถอืเป็นเรือ่งปกปิด ไดถ้กูแยกคํานวณใน
ตาราง Q6:R10 ชว่ยใหส้ามารถใชต้ารางสว่นนีใ้นการบรหิารคา่แรงไดโ้ดยตรง
และสามารถโยกยา้ยตารางไปแยกเก็บไวเ้ป็นเรือ่งลบัในชทีอืน่หรอืแฟ้มอืน่  

6. เลขที ่Job ในตาราง B6:B10 นัน้ ในอนาคตสามารถบนัทกึรหสัหรอืชือ่ลงไป
แทน จากนัน้จงึนําสตูร Vlookup หาเวลาทํางานมาแสดงโดยอตัโนมตัใินตาราง 
C6:D10 ไดด้ว้ย หรอือาจใชคํ้าสัง่ Data > Table เพือ่สง่ตวัแปรลงไปแทน
เลขที ่Job เพือ่คํานวณลดัหายอดคา่แรงไดท้นัทโีดยไมจํ่าเป็นตอ้งยอ้นกลบัมา
เพิม่รายการใหม ่ 

7. สามารถใชก้บัการคํานวณหาคา่แรงไดห้ลายกรณี เชน่ คา่แรงของลกูจา้งคนหนึง่
ในวนัหนึง่ หรอืคา่แรงของลกูจา้งคนหนึง่รายวนั หรอืคา่แรงของลกูจา้งเรยีงตวั
ไปทกุคนในแตล่ะวนั ซึง่คณุอาจใชช้ทีเดมิชทีเดยีวคํานวณ หรอื copy เป็นชที
ใหมเ่พือ่คํานวณแยกตามรายบคุคล 

หมายเหต ุ: 

1. การไลลํ่าดบังานในตวัอยา่งนีเ้ป็นการไลจ่ากบนมาลา่งหรอืจากซา้ยไปขวา ซึง่ใน
แงก่ารวางแผนกําหนดการณ์แลว้ เรยีกวา่ แบบ Push เพือ่หากําหนดเวลาทีง่าน
เสร็จ  

2. ถา้ไลลํ่าดบังานจากลา่งไปบนหรอืจากขวามาซา้ย จะกลายเป็นแบบ Pull เพือ่หา
กําหนดเวลาทีต่อ้งเริม่งาน  

3. หากตอ้งการแทรกระยะเวลาหยดุพักของแตล่ะ Job ซึง่ยอ่มมผีลทําให ้
กําหนดเวลาเริม่ตน้ของ Job ถดัไปชา้ลง สามารถปรับเพิม่ไดง้า่ยๆโดยสรา้งสตูร
หากําหนดเวลาเริม่งานใน Job ถดัไปใหม้คีา่เทา่กบั เวลาออกจากงานของ Job 
กอ่นบวกดว้ยระยะเวลาทีห่ยดุพัก  

4. ผูส้นใจตารางคํานวณหาระยะเวลาทีใ่ชใ้นกะ สามารถเรยีนรูไ้ดจ้ากการอบรม
หลกัสตูรประยกุตใ์ช ้Excel เพือ่วางแผนความตอ้งการวสัด(ุMRP)และจัดตาราง
การผลติ หรอืหลกัสตูรฉลาดใชส้ารพัดสตูร Excel อยา่งมอือาชพี 
หรอื download ตวัอยา่งไดฟ้รจีาก   
http://www.excelexperttraining.com/extreme/files/timeplan/timeconsu
me.xls  
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การออกแบบโครงสรา้งตารางคาํนวณ ภาค 2 

ตารางคํานวณในภาคแรกเกดิจากการใชส้ตูรทีม่โีครงสรา้งเดยีวกนัซํ้าในทกุเซลลข์องตาราง

คํานวณ โดยกําหนดใหห้าทางสรา้งสตูรขึน้เพยีงสตูรเดยีวในเซลลแ์รกตรงหวัมมุซา้ยบนสดุของ

ตาราง แลว้จัดการ Copy สตูรไปใชท้ัง้ตาราง และจากการทีใ่ชส้ตูรทีม่โีครงสรา้งเดยีวกนัไป

ตลอดนีย้อ่มแสดงวา่เป็นสตูรทีคํ่านวณหาคําตอบในเรือ่งเดยีวกนั จากนัน้เราจงึใชโ้ครงสรา้งของ

ตารางเป็นตัวชว่ยในการเลอืกใชคํ้าตอบจากตําแหน่งของเซลลท์ีเ่กีย่วขอ้งกบัคําตอบ ซึง่ตาราง

คํานวณแบบแรกนีไ้มเ่หมาะกบัการคํานวณทีม่คีวามสลบัซบัซอ้นมากนัก 

ในบทความภาคที ่2 จะนําโครงสรา้งตารางคํานวณทีม่คีวามซบัซอ้นมากขึน้มาใหศ้กึษากนัโดย

ขอเรยีกตารางคํานวณแบบนีว้า่ ตารางคํานวณแบบ Module ซึง่สามารถนําไปใชง้านกนัได ้2 

แบบ คอื แบบ Module เดีย่ว (Single Module) และแบบ Module รวม (Compound Module) 

ความหมายของ Module 

ผูท้ีเ่คยใช ้Excel สรา้งตารางคํานวณงบการเงนิมากอ่น ตอ้งทราบดวีา่กวา่จะคํานวณหายอด

กําไรขาดทนุมาไดต้อ้งคํานวณผา่นยอดรายรับหกัตน้ทนุขายเป็นกําไรขัน้ตน้ จากนัน้จงึนํายอด

ตวัเลขกําไรขัน้ตน้ไปหกัดว้ยคา่ใชจ้า่ยตา่งๆและภาษีเพือ่เป็นยอดกําไรขาดทนุ ซึง่ลกัษณะของ

การคํานวณงบการเงนินีแ่หละคอืลกัษณะของตารางคํานวณแบบ Module 

ในงานดา้นวางแผนการผลติมลีกัษณะการใช ้Excel แบบ Module เชน่กนั นับตัง้แตรั่บคําสัง่ซือ้

แลว้ตอ้งนํายอดไปเปรยีบเทยีบกบัสนิคา้คงคลงัเพือ่คํานวณหายอดวตัถดุบิทีต่อ้งใชต้ามกําลงั

การผลติทีม่อียู ่อกีทัง้ตอ้งกําหนดเวลาใหก้บัตวัเลขการสัง่ผลติหรอืจัดหาวตัถดุบิตามโครงสรา้ง

ผลติภณัฑใ์หไ้ดอ้กีวา่ ตอ้งการใชใ้นปรมิาณเทา่ใดและตอ้งเริม่สัง่ของเมือ่ใดเพือ่ใหส้ามารถ

ดําเนนิการตามขัน้ตอนการผลติแลว้ไดส้นิคา้สําเร็จรปูตามเวลาทีกํ่าหนด 

Module คอื ตารางทีป่ระกอบดว้ยเซลลส์ตูรคํานวณหลายๆเซลลซ์ึง่

คํานวณตอ่เนือ่งกนัไปทลีะขัน้ โดยผลการคํานวณทีไ่ดใ้นแตล่ะขัน้ไม่

จําเป็นตอ้งมคีวามหมายใดเลยก็ได ้แตเ่มือ่นํามาคํานวณรว่มกนัหรอื

คํานวณตอ่เนือ่งกนัแลว้ตอ้งทําใหไ้ดผ้ลลพัธต์ามตอ้งการ 
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จากคําจํากดัความของ Module ขา้งตน้ อาจทําใหค้ณุหลงภมูใิจวา่ตนเองเคยสรา้งตาราง

คํานวณแบบ Module นีม้านานแลว้ บทความนีไ้มเ่ห็นมอีะไรทีแ่ปลกใหมต่า่งจากทีค่ณุรูด้อียู่

แลว้ จงึขอใหล้องนกึดวูา่หากคณุสามารถใช ้Excel อยา่งคอมพวิเตอรไ์ดส้มบรูณ์จรงิ คณุตอ้ง

หาทางนํา Module ทีส่รา้งไวนั้น้มาใชซ้ํ้าแลว้ซํ้าอกีโดยไมจํ่าเป็นตอ้งสรา้ง Module ขึน้ใหม ่

และดว้ยตารางคํานวณแบบ Module ทีค่ณุมเีพยีง Module เดยีว จะทําอยา่งไรทีจ่ะนําตารางนัน้

มาใชซ้ํ้าแลว้ซํ้าอกี เพือ่หาทางใช ้Module เดยีว ชทีเพยีงชทีเดยีว หรอืแฟ้มเพยีงแฟ้มเดยีวกบั

งานคํานวณทีค่ณุคดิไมถ่งึวา่จะใช ้Excel ทําไดโ้ดยไมต่อ้งพึง่การเขยีนโปรแกรม Visual Basic 

มาชว่ยแมแ้ตน่อ้ย 

จดุประสงคข์องการสรา้งตารางคาํนวณแบบ Module 

1. เพือ่ลดความซบัซอ้นของสตูรคํานวณ จากเดมิทีต่อ้งสรา้งสตูรยากๆยาวๆลงไปในเซลล์
เพยีงเซลลเ์ดยีว เปลีย่นไปเป็นการกระจายสตูรแยกใหใ้ชเ้ซลลแ์ตล่ะเซลลม์สีตูรคํานวณ
ทลีะขัน้สง่ผลการคํานวณตอ่เนือ่งกนัไป ทําใหส้ตูรสัน้ลง และทําใหค้ณุเขา้ใจลําดบัการ
คํานวณไดง้า่ยขึน้  

2. เพือ่ทําใหค้ณุสามารถใช ้Excel กบัการคํานวณงานทีม่หีลายขัน้ตอนหรอืเกีย่วขอ้งกบั
การทํางานทีม่ลีกัษณะตอ่เนือ่งกนั  

3. เพือ่ชว่ยใหค้ณุสามารถลดขนาดแฟ้มและจํานวนตารางทีม่อียู ่

ลกัษณะโครงสรา้งตารางคาํนวณแบบ Single Module 

ตารางคํานวณแบบ Single Module มลีกัษณะตรงกบัความหมายของคําวา่ Single น่ันคอืเป็น

ตารางคํานวณแบบตารางเดยีวหรอืตารางเดีย่ว ทีส่ามารถคํานวณใหผ้ลลพัธท์ีต่อ้งการได ้

ครบถว้นภายในตารางคํานวณตารางเดยีว 

ผูใ้ช ้Excel ทัว่ไปมกัใช ้Excel กนัแบบผดิๆ จากความงา่ยของการใชต้ารางของ Excel เชน่ ถา้

รายงานทีต่อ้งการมรีอ้ยหนา้ เราก็มกัจะออกแบบตาราง Excel ใหม้คีวามยาวเหยยีดเลยีนแบบ

ตามหนา้กระดาษทีต่อ้งการพมิพ ์หรอืเมือ่ใดทีต่อ้งการรายงานตามรายเดอืน ก็มกัจะสรา้งชที

หลายๆชทีแยกเป็นชทีละเดอืนหรอืสรา้งตารางแบง่เป็นแฟ้มคํานวณตามรายเดอืน ซึง่ยงัดทีีใ่นปี

หนึง่มแีค ่12 เดอืน จงึทําใหม้จํีานวนชทีหรอืแฟ้มเพยีง 12 ชทีหรอื 12 แฟ้ม แตถ่า้เป็นงานที่

ตอ้งใชต้ดิตอ่กนัไปหลายปีหรอืแบง่รายงานตามวตัถดุบินับรอ้ยนับพันชนดิ เห็นทยีอ่มทําใหม้ี

จํานวนชทีหรอืจํานวนแฟ้มทีม่กีารคํานวณแบบเดยีวกนัซํ้ามากจนจดจํากนัไมไ่หว 
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ตารางคํานวณแบบ Single Module เป็นตารางคํานวณเพยีงตารางเดยีวทีค่ณุสามารถกําหนดให ้

ตารางคํานวณนัน้เลอืกรับตวัแปรตา่งไปจากเดมิไดต้ามตอ้งการ ทําใหส้ามารถใชต้ารางคํานวณ

เพยีงตารางเดยีวหรอืหนา้เดยีวเพือ่แสดงผลการคํานวณเปลีย่นไปเป็นตารางคํานวณรายละเอยีด

ของเดอืนทีต่อ้งการหรอืวตัถดุบิทีต่อ้งการ โดยใชโ้ครงสรา้งตารางแบง่ออกเป็น 3 สว่น ดงันี ้

1. สว่นของตาราง Input ใชสํ้าหรับเก็บตวัแปรทีต่อ้งการตามรายเดอืนหรอืแตล่ะชดุ ซึง่
ตาราง Input นีใ้ชจั้ดเก็บขอ้มลูรายเดอืนหรอืแตล่ะชดุไวเ้ป็นแนวนอนหรอืแนวตัง้ตดิกนั
ก็ได ้ 

2. สว่นของตารางสตูรตวักลางใชด้งึขอ้มลู เพือ่เลอืก Input ตามเลขเดอืนหรอืเลขที่
ของชดุ ซึง่มกัใชส้ตูร Index เพือ่เลอืกดงึขอ้มลูจากตาราง Input ในชทีเดยีวกนั หรอื
ใชส้ตูร Indirect เพือ่เลอืกดงึ Input จากตารางทีแ่ยกชทีกนั  

3. สว่นของตารางคาํนวณ เพือ่คํานวณตามคา่ทีรั่บมาจากตารางสตูรตวักลาง 
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ตวัอยา่งโครงสรา้งตารางคาํนวณแบบ Single Module ในชทีเดยีว 

 

(Download ตวัอยา่งไดจ้าก 

www.ExcelExpertTraining.com/extreme/files/database/singlemodule.xls) 

ตวัอยา่งนีเ้ป็นการคํานวณงบกําไรขาดทนุจากตวัอยา่งประกอบการอบรมหลกัสตูรสดุยอดเคล็ด

ลบัและลดัของ Excel ซึง่กําหนดใหม้ตีารางทีต่อ้งการคํานวณตามยอดขายและตน้ทนุทีต่า่งกนั

ไปอยู ่3 case แตล่ะ case กําหนดใหแ้ปรเปลีย่นยอดขายและตน้ทนุตา่งกนัไป ดงันัน้แทนที่

จะตอ้งสรา้งตารางคํานวณขึน้ 3 ตารางเพือ่แยกคํานวณแตล่ะ case ขอใหอ้อกแบบตารางในชที

เดยีวกนัแบง่เป็น 3 สว่น 

สว่นแรกใชสํ้าหรับบนัทกึตวัแปรแตล่ะ case ซึง่ในภาพใชต้ารางดา้นขวาสดุตัง้แต่

เซลล ์I3:K6 (ตัง้ชือ่ Range Name ตารางสว่นนีว้า่ MyData) แบง่แยกใหแ้ตล่ะ column 

บนัทกึตวัแปรของแตล่ะ case เชน่ case1 เป็นพืน้ทีต่ัง้แตเ่ซลล ์I3:I6 โดยกําหนดใหเ้รยีงลําดบั

ตวัแปรของยอดขายและตน้ทนุตอ่กนัไปใน column เดยีวกนั แลว้ใช ้column ถดัไปบนัทกึตวั

แปรของ case ตอ่ไปในทํานองเดยีวกนั 

สาเหตทุีต่อ้งจัดใหบ้นัทกึตวัแปรของแตล่ะ case ไวใ้นแนวตัง้เดยีวกนันัน้ เพือ่ทําใหส้ามารถใช ้

สตูร Index ดงึขอ้มลูตวัแปรทีเ่ก็บไวใ้นแนวตัง้เดยีวกนัไปพรอ้มกนั โดยสรา้งสตูร Index 

ตอ่ไปนีไ้วใ้นเซลล ์F3:F6 แบบ Array (โดยเลอืกเซลล ์F3:F6 แลว้สรา้งสตูร จากนัน้กดปุ่ ม 

Ctrl+Shift+Enter พรอ้มกนัเพือ่บนัทกึสตูรลงไปทเีดยีวทกุเซลล ์จะพบเครือ่งหมายวงเล็บปีก

กาปิดหวัทา้ยสตูรใหเ้อง) 
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=INDEX( MyData, 0, CaseNum ) 

• MyData เป็นตารางบนัทกึตวัแปรตัง้แตเ่ซลล ์I3:K6  
• เลข 0 เพือ่กําหนดใหส้ตูร Index ดงึขอ้มลูทกุ Row  
• CaseNum คอืเซลล ์F2 ใชสํ้าหรับใสต่วัเลข 1, 2, หรอื 3 ลงไป เพือ่ทําใหส้ตูร Index 

ดงึขอ้มลู Input จาก Case1, Case2, หรอื Case3 ตามลําดบั 

เมือ่ดงึตวัแปรตามตวัเลขของ CaseNum ทีต่อ้งการมาแสดงในเซลล ์F3:F6 ไดแ้ลว้ จากนัน้จงึ

สรา้งสตูร link ตามปกตไิปใชคํ้านวณงบกําไรขาดทนุในสว่นของตารางดา้นซา้ยสดุจากเซลล ์

D3:D9 

ในกรณีทีต่อ้งการเปรยีบเทยีบผลของการคํานวณทกุ case พรอ้มกนั ใหส้รา้งตาราง Data 

Table แบบ 1 ตวัแปร ทีใ่ช ้Row Input Cell เป็นเซลล ์CaseNum ตามรปูตอ่ไปนี ้

 

เซลล ์H11:K18 เป็นพืน้ทีต่ารางทีใ่ชก้บัคําสัง่ Data > Table แลว้กําหนดใหเ้ซลล ์F2 หรอื 

CaseNum เป็น Row Input Cell หรอืเซลลม์ีรั่บคา่ตวัแปรจากหวัตารางตามแนวนอน ซึง่

กําหนดใหใ้ชเ้ซลล ์I11:K11 บนัทกึหมายเลข 1, 2, 3 ซึง่หมายถงึเลขที ่case ไว ้สว่นหวัตาราง

ดา้นซา้ยสดุตัง้แต ่H12:H18 เป็นสตูรที ่link การคํานวณมาจากตารางคํานวณงบกําไรขาดทนุ

จากเซลล ์D3:D9 

เมือ่ตาราง Data Table นีทํ้างาน เราจะไดผ้ลลพัธก์ารคํานวณของแตล่ะ case เสร็จใน

พรบิตา แตถ่า้เขา้ใจขัน้ตอนการทํางานของ Excel ทลีะขัน้ จะพบวา่ Excel คอ่ยๆสง่ตวัเลขตวั
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แปร 1, 2, 3 บนหวัตารางดา้นบนไปทีเ่ซลล ์F2 หรอื CaseNum ทลีะคา่ จากนัน้สตูร Index จะ

ทําหนา้ทีด่งึตวัแปรแตล่ะตวัตามเลข case สง่ไปคํานวณในงบกําไรขาดทนุดา้นซา้ยสดุ แลว้จงึ

สง่ผลลพัธก์ลบัมาแสดงในพืน้ทีต่าราง I12:K18 ตาม case บนหวัตารางดา้นบนของพืน้ทีซ่ ึง่สัง่ 

Data > Table น่ันเอง (การใช ้Data > Table รว่มกบัสตูร Index นีจ้ะทําให ้Data > Table 

สามารถสง่ตวัแปรไปใชคํ้านวณไดไ้มจํ่ากดัจํานวนตวัแปร ถอืเป็นเคล็ดการใช ้Excel ทีน่อ้ยคน

นักจะใชเ้ป็น) 
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ตวัอยา่งโครงสรา้งตารางคาํนวณแบบ Single Module แบบแยก Input 

ไวใ้นชทีอืน่ 

ในกรณีทีก่ารคํานวณมคีวามสลบัซบัซอ้นมากขึน้หรอืมจํีานวนตวัแปรมากขึน้ คณุสามารถแยก

ตารางสว่นของการคํานวณผลลพัธไ์ปไวใ้นชทีอืน่ตา่งหาก เพือ่ทําใหส้ามารถจัดโครงสรา้ง

ตารางไดย้ดืหยุน่และแยกชทีเก็บขอ้มลูใหแ้ยกเป็นสว่นๆไดช้ดัเจนยิง่ขึน้ 

ในตวัอยา่งตอ่ไปเป็นการคํานวณทางสถติขิองการวดั (Calibration) กอ่นอืน่ขอเลา่ทีไ่ปทีม่า

ของตวัอยา่งตอ่ไปนีก้อ่นวา่ แตเ่ดมิทนัีน้แฟ้มมขีนาดใหญม่ากเพราะมชีทีนับรอ้ยชที แตล่ะชทีมี

สตูรคํานวณทางสถติยิากๆยาวเหยยีดหลายๆเซลล ์ 

ทกุครัง้ทีม่กีารผลติ ทางโรงงานตอ้งสุม่สนิคา้ทีผ่ลติไดส้ง่มาตรวจสอบคณุภาพกอ่น โดยวดัผล

ออกมาเป็นตัวเลขแลว้นําไปคํานวณทางสถติวิา่เป็นตวัเลขทีอ่ยูใ่นชว่งทีย่อมรับไดห้รอืไม ่ทกุ

ครัง้ทีจ่ะคํานวณ ก็ตอ้งเปิดชทีใหมแ่ลว้ copy ตารางคํานวณจากชทีเกา่มาแกต้วัเลขตามการวดั

ทีเ่กดิขึน้ใหม ่ดงันัน้ถา้ตอ้งคํานวณกนัทกุวนั วนัละหลายๆครัง้ ยอ่มทําใหม้ชีทีใหมเ่กดิขึน้ทกุ

ครัง้ 

นอกจากแฟ้มจะมขีนาดใหญเ่พราะมชีทีหลายๆชทีแลว้ สิง่ทีน่่าหว่งคอืทกุครัง้ทีต่อ้งสรา้งตาราง

คํานวณในชทีใหมนั่น้ อาจสรา้งตารางทีม่สีตูรคํานวณผดิเพีย้นไปจากสตูรทีส่รา้งไวใ้นชทีเดมิ 

หรอืแมคํ้านวณไดถ้กูตอ้ง แตน่านไปอาจพลัง้เผลอยอ้นกลบัไปแกไ้ขบางเซลลใ์นบางชทีใหต้า่ง

ไปจากทีเ่คยเป็น และเนือ่งจากมชีทีหลายชที จงึเป็นไปไดว้า่เมือ่ทําการแกไ้ขไปแลว้ อาจ

หลงลมืจําไมไ่ดว้า่แกไ้ขชทีชือ่ใด และแกไ้ขอะไรทีเ่ซลลใ์ดไปบา้ง ยิง่กวา่นัน้เมือ่ใดทีต่อ้งการ

แกไ้ขโครงสรา้งตารางคํานวณตามหนา้ตาใหมท่ีผู่บ้รหิารกําหนด ก็ตอ้งเสยีแรงเสยีเวลา

ยอ้นกลบัไปแกไ้ขชทีเกา่ทัง้หมดทีอ่าจมถีงึนับรอ้ยนับพันชทีเขา้ไปแลว้ทเีดยีว 

แทนทีจ่ะตอ้งเปิดชทีใหม ่ขอใหใ้ชห้ลกัการสรา้งตารางคํานวณแบบ Single Module โดยใช ้

โครงสรา้งตารางแบง่ออกเป็น 3 สว่น ดงันี ้

1. สว่นของตาราง Input ใชสํ้าหรับเก็บตวัแปรทีต่อ้งการตามการวดัคณุภาพสนิคา้แตล่ะ
ครัง้ ซึง่ตาราง Input นีใ้ชจั้ดเก็บขอ้มลูการวดัแตล่ะครัง้ไวเ้ป็นแนวตัง้ตดิกนั  

2. สว่นของตารางสตูรตวักลางใชด้งึขอ้มลู เพือ่เลอืก Input ตามเลขทีข่องเลขครัง้ใน
การวดั โดยใชส้ตูร Index เพือ่เลอืกดงึขอ้มลูจากตาราง Input ในชทีเดยีวกนั  

3. สว่นของตารางคาํนวณ เพือ่คํานวณตามคา่ทีรั่บมาจากตารางสตูรตวักลาง แต่
เนือ่งจากมกีารคํานวณทีซ่บัซอ้นและเป็นรายงานทีต่อ้งใชต้ารางขนาดใหญ ่จงึใหใ้ชช้ที
อกีชทีหนึง่เป็นสว่นของการคํานวณโดยเฉพาะ 
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จากเดมิซึง่ตอ้งมหีลายชที จงึกลายเป็นแฟ้มใหมซ่ึง่มชีทีเพยีง 2 ชที ชทีหนึง่เป็นชทีทีใ่ชบ้นัทกึ

ผลการวดัคณุภาพแตล่ะครัง้ แลว้ใชอ้กีชทีหนึง่เป็นชทีแสดงการคํานวณทางสถติ ิ( Download 

ตวัอยา่งไดจ้าก www.ExcelExpertTraining.com/extreme/files/analysis/uncerdbf.xls) 

โครงสรา้งภายในชทีสําหรบับนัทกึตวัเลขจากการวดั 

 

ตารางตัง้แตเ่ซลล ์E2:E21 ใชสํ้าหรับบนัทกึขอ้มลูจากการวดัครัง้แรกแลว้ใช ้column ถดัไป

บนัทกึขอ้มลูจากการวดัในครัง้ถดัไปตดิตอ่กนัไปตามแนว column โดยในตัวอยา่งนีต้ัง้ชือ่พืน้ที่

ตารางสว่นทีใ่ชบ้นัทกึขอ้มลูจากการวดันีว้า่ DataRange 

ตารางดา้นซา้ยตัง้แตเ่ซลล ์C2:C21 เป็นสตูร Index ใชสํ้าหรับดงึขอ้มลูทีบ่นัทกึไวต้ามเลขที่

ของการวดั ซึง่ใชต้วัเลข 1-20 ใน Column D ชว่ยในการชีตํ้าแหน่งเลขที ่row 

=INDEX( DataRange, D2, CaseNo ) 

• DataRange คอืพืน้ทีต่าราง E2:N21 ใชสํ้าหรับบนัทกึขอ้มลูจากการวดั  
• D2 เป็นเลขที ่row เนือ่งจากเป็นคา่แรกจงึใชด้งึคา่จาก row ที ่1  
• CaseNo เป็นเซลลรั์บเลขทีค่รัง้ของการวดั ซึง่ link มาจากชทีตารางคํานวณทางสถติ ิ
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โครงสรา้งภายในชทีสําหรบัคาํนวณทางสถติขิองการวดั 

 

เซลล ์B4 ถอืเป็นหวัใจของชทีนี ้เมือ่คณุพมิพเ์ลขที ่CaseNo ลงไป จะทําใหส้ตูร Index ใน 

column C ของอกีชทีหนึง่ตามภาพกอ่นหนา้นี ้ดงึขอ้มลูสง่ตอ่มาใชแ้สดงหรอืคํานวณในตาราง

คํานวณ Uncertainty Budget อกีทัง้ยงัใชเ้ซลล ์B4 รว่มกบัคําสัง่ Data > Table เพือ่สรปุ

ผลเปรยีบเทยีบการวดั หรอืใชร้ว่มกบัคําสัง่พมิพอ์ตัโนมตัทิีเ่ขยีนดว้ย VBA ตามนีไ้ดอ้กีดว้ย 

    For i = StartNum To StopNum 

        Range("CaseNo") = i 

        Calculate 

        ActiveWindow.SelectedSheets.PrintPreview

    Next i 

• StartNum เป็นตวัแปรกําหนดตวัเลขเริม่ของเลขที ่Case ทีต่อ้งการพมิพเ์ป็นรายการ
แรก  

• StopNum เป็นตวัแปรกําหนดตวัเลขสดุทา้ยของเลขที ่Case ทีต่อ้งการพมิพเ์ป็นรายการ
สดุทา้ย  

• For Next Loop จะสง่คา่ i ไปยงัเซลลช์ือ่ CaseNo เพือ่ดผูลกอ่นพมิพบ์นจอ (Print 
Preview) ซึง่ถา้เปลีย่นเป็นคําสัง่ Print ก็จะพมิพร์ายงานตามรายการทีต่อ้งการโดย
อตัโนมตั ิ
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การออกแบบโครงสรา้งตารางคาํนวณ ภาค 3 

ตารางคํานวณแบบ Single Module ในภาคนีเ้ป็นตารางคํานวณในกรณีทีแ่ยกชทีหรอืแยกแฟ้ม 

เพือ่ใชก้บังานทีม่กีารคํานวณสลบัซบัซอ้นมากกวา่เดมิ แทนทีจ่ะมตีารางคํานวณเพยีงตาราง

เดยีวแลว้ใชข้อ้มลูตวัแปรสง่คา่ใหมไ่ปคํานวณในตารางนัน้ๆในชทีเดยีวกนั คราวนีผ้มจะนําเสนอ

วธิกีารสรา้งตารางคํานวณพรอ้มกนัในหลายชทีหรอืหลายแฟ้ม จากนัน้จงึเลอืกนําผลการคํานวณ

จากชทีหรอืแฟ้มทีต่อ้งการไปนําเสนอผลงานตอ่ไป 

ผูใ้ช ้Excel ตอ้งคดิไวเ้สมอวา่ แมว้นันีข้อ้มลูทีเ่ก็บไวย้งัคงมไีมม่ากและสามารถใชช้ทีเดยีวเก็บ

ขอ้มลูทัง้หมดไวด้ว้ยกนั แตใ่นอนาคตขอ้มลูทีต่อ้งเก็บไวจ้ะตอ้งมปีรมิาณของขอ้มลูมากขึน้ไป

เรือ่ยๆ จากเดมิทีเ่คยเก็บไวใ้นชทีเดยีว จะกลายเป็นตอ้งเก็บไวใ้นชทีหลายชที และในทีส่ดุเมือ่

แฟ้มมขีนาดใหญม่ากแลว้ใชเ้วลาคํานวณชา้ลง ก็ตอ้งหาทางโยกยา้ยขอ้มลูแยกออกไปเก็บไว ้

ในแฟ้มใหมใ่นทีส่ดุ พฤตกิรรมเชน่นีถ้อืเป็นววิฒันาการของการใช ้Excel ทีเ่ราทกุคนหลกีหนไีป

ไมพ่น้ 

ดงันัน้การออกแบบโครงสรา้งตารางคํานวณทีด่ ีจงึตอ้งหาทางออกแบบตารางตัง้แตแ่รกใหใ้ช ้

พืน้ทีต่ารางแยกเป็นสว่นๆ เพือ่สามารถโยกยา้ยตารางจากเดมิทีเ่ก็บอยูใ่นชทีเดยีว ไปแยกเก็บ

ในชทีใหมห่รอืแฟ้มใหมไ่ดท้นัททีีต่อ้งการ 

หมายเหต ุบทความในภาคนีเ้ป็นเรือ่งตอ่เนือ่งกบัเรือ่งเดมิทีไ่ดเ้ขยีนอธบิายไปกอ่นแลว้ จงึขอ

แนะนําใหผู้อ้า่นเริม่ตน้ศกึษาจากบทความภาคแรกเป็นลําดบัไปจาก 

www.ExcelExpertTraining.com/blogs/ หรอืนติยสาร EWorld ฉบบัเดอืนกนัยายน 2551 เป็น

ตน้มา 

ลกัษณะของตารางคาํนวณ Single Module แบบแยกชทีหรอืแยกแฟ้ม 

1. ตารางคํานวณทีแ่ยกชทีนี ้มไิดห้มายความวา่ใหแ้ยกแตล่ะลําดบัของการคํานวณใหใ้ช ้
พืน้ทีต่า่งชทีแลว้สง่ผลการคํานวณไปคํานวณตอ่ในชทีอืน่ตอ่กนัไป แตเ่ป็นการรวมลําดบั
การคํานวณทัง้หมดไวใ้นชทีเดยีวกนั จากนัน้จงึสรา้งชทีใหมใ่หม้ตีารางคํานวณซํ้ากบั
ตารางคํานวณทีม่อียูใ่นชทีเดมิ เพยีงแตว่า่การคํานวณทีเ่กดิขึน้ในแตล่ะชทีจะเกดิจากตวั
แปรทีต่า่งกนั เชน่ ชทีเดมิใชคํ้านวณตวัเลขในอดตี สว่นชทีใหมใ่หใ้ชคํ้านวณตวัเลขใน
ปัจจบุนั จากนัน้จงึนําผลทีคํ่านวณไดนํ้ามาเปรยีบเทยีบหาความแตกตา่งระหวา่งอดตี
และปัจจบุนั 

2. เมือ่ใดทีใ่ชช้ทีหลายๆชทีแยกตารางคํานวณ ยอ่มแสดงวา่ชทีทัง้หมดยงัคงอยูใ่นแฟ้ม
เดยีวกนั เมือ่นัน้ยอ่มทําใหแ้ฟ้ม Excel มขีนาดใหญข่ึน้ ซึง่หากในการใชง้านไมไ่ด ้
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ตอ้งการใหท้กุตารางทําการคํานวณพรอ้มกนั ก็ไมจํ่าเป็นตอ้งเก็บชทีทัง้หมดไวใ้นแฟ้ม
เดยีวกนั ก็หาทางแยกชทีไปแยกเก็บเป็นแฟ้มไดท้นัท ีจากนัน้เมือ่ใดทีต่อ้งการใหแ้ฟ้ม
ใดคํานวณก็จัดการเลอืกเปิดเฉพาะแฟ้มทีต่อ้งการขึน้มาสัง่คํานวณ 

3. แตล่ะชทีหรอืแฟ้มลว้นมตีารางคํานวณทีม่โีครงสรา้งและลําดับคํานวณเดยีวกนั ซึง่ไมใ่ช่
เรือ่งยากทีจ่ะสรา้งชทีหรอืแฟ้มขึน้ใหมใ่หม้ตีารางคํานวณแบบเดมิเพราะเพยีงแค ่copy 
ตารางทัง้ตารางไปทบัก็ใชง้านไดแ้ลว้ แตถ่า้มกีารแกไ้ขสตูรคํานวณหรอืยา้ยตําแหน่ง
เซลลใ์นชทีใด จงึเป็นขอ้ควรระวงัวา่ตอ้งตดิตามไปแกไ้ขทกุชทีและทกุแฟ้มใหม้สีตูร
คํานวณและตําแหน่งเซลลต์รงกนัดว้ยในแตล่ะชทีหรอืแตล่ะแฟ้ม 

4. แทนทีจ่ะสรา้งตารางคํานวณแยกชทีหรอืแยกแฟ้มซึง่ทําใหเ้กดิขอ้ควรระวงัในการ
ตดิตามไปแกไ้ขสตูรในแตล่ะตารางคํานวณดงักลา่วขา้งตน้แลว้ ยงัมวีธิทีีด่กีวา่โดยการ
ใชช้ทีเดยีวเป็นตารางคํานวณ สว่นชทีอืน่ๆใหใ้ชสํ้าหรับเก็บคา่ตวัแปร จากนัน้จงึใชส้ตูร
ดงึขอ้มลูตวัแปรจากชทีทีต่อ้งการมาคํานวณในชทีเดยีว และเมือ่ใดทีต่อ้งการ
เปรยีบเทยีบผลของการคํานวณก็สามารถใช ้Data Table สรปุผลในลกัษณะ
เชน่เดยีวกบัโครงสรา้งตารางคํานวณ Single Module ในชทีเดยีวตามทีไ่ดแ้นะนําไวใ้น
ภาคกอ่น 

ตวัอยา่งโครงสรา้งตารางคาํนวณ Single Module  

แบบแยกชที (อยา่งงา่ย) 

 

(Download ตวัอยา่งไดจ้าก 

www.ExcelExpertTraining.com/extreme/files/database/singlemodule.xls) 

ตวัอยา่งนีด้ดัแปลงมาจากตวัอยา่งทีใ่ชใ้นการอบรมหลกัสตูรสดุยอดเคล็ดลับและลดัของ Excel 

จากเดมิซึง่รวมตวัแปรของงบการเงนิทัง้สาม case ไวต้ดิกนัในตารางเดยีวกนัในชทีเดยีวกนั 

เปลีย่นมาเป็นการแยกตวัแปรของแตล่ะ case ไวใ้นชทีตา่งหากของมนัเอง 

โปรดสงัเกตวา่นอกเหนอืจากตําแหน่งของตารางในชที Case1, Case2, และ Case3 ตอ้งใช ้

ตําแหน่งเซลลต์รงกนัทัง้สามชทีคอืใชเ้ซลล ์F3:F6 เก็บตวัเลขของยอดขายและตน้ทนุแลว้ การ

ตัง้ชือ่ชทีใหม้คํีานําหนา้วา่ Case เหมอืนกนัแลว้ตามดว้ยตวัเลข 1, 2, หรอื 3 ถอืเป็นสว่นสําคญั
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ทีจ่ะชว่ยใหส้ตูรทีใ่ชด้งึขอ้มลูจากชทีทีต่อ้งการสามารถทําไดง้า่ยขึน้ดว้ย ดงัรปูตอ่ไปนีซ้ ึง่เป็น

ชทีชือ่ SheetModule เป็นตารางคํานวณทีเ่ลอืกดงึขอ้มลูจากชทีชือ่ทีต่อ้งการมาคํานวณ 

 

1. ประเด็นสําคญัคอืตําแหน่งเซลล ์F3:F6 เป็นตําแหน่งเดยีวกบัขอ้มลูทีแ่ยกเก็บไวใ้นชที 
Case1, Case2, และ Case3 

2. เซลล ์F2 เป็นเซลลเ์ดยีวเทา่นัน้ทีม่กีารแกไ้ขตวัเลข คณุสามารถบนัทกึตวัเลข 1, 2, หรอื 3 
ลงไปเพือ่แสดงถงึเลขทีข่อง CaseNum ตาม case ทีถ่กูแยกไวใ้นชทีอืน่ ดงันัน้เมือ่นํา
ตวัเลขในเซลล ์F2 ไปตอ่ทา้ยกบัคําวา่ Case โดยใชส้ตูร =”Case”&$F$2 ยอ่มไดช้ือ่ชทีที่
ตอ้งการ (ตามภาพนี ้F2 มเีลข 2 บนัทกึอยู ่ดงันัน้สตูร =”Case”&$F$2 จงึคนืคา่เป็นคําวา่ 
Case2) 

3. สตูรในเซลล ์F3:F6 คอื 
=INDIRECT("Case"&$F$2&"!"&ADDRESS(ROW(),COLUMN())) 

3.1. สตูรสว่นตัง้แต ่"Case"&$F$2&"!" จะคนืคา่ออกมาเป็นคําวา่ Case2! 

3.2. สตูรสว่นของ ADDRESS(ROW(),COLUMN()) คนืคา่ออกมาเป็นตําแหน่งเซลลข์อง
เลขที ่row และเลขที ่column ของตําแหน่งเซลลท์ีม่สีตูรนีอ้ยู ่เชน่ ในเซลล ์F3 สง่ผล
ใหส้ตูร Row() มคีา่เป็น 3 และสตูร Column() มคีา่เป็น 6 เพราะ Column F เป็น 
Column ที ่6 จงึสง่คา่ไปยงัสตูร ADDRESS(3,6) ใหค้นืคา่เป็น $F$3 

3.3. เมือ่นําผลลัพธคํ์าวา่ Case2! มาเชือ่มกบัคําวา่ $F$3 ดว้ยสตูร 
"Case"&$F$2&"!"&ADDRESS(ROW(),COLUMN()) จงึไดช้ือ่ชทีกบัตําแหน่งเซลลท์ี่
ตอ้งการออกมาเป็นคําวา่ "Case2!$F$3" 

3.4. สตูร Indirect จงึหาคา่จากชือ่ชทีและตําแหน่งเซลล ์"Case2!$F$3" ไดต้วัเลข 200 
ตามตอ้งการ 

4. เมือ่หาคา่ดว้ยสตูร Indirect ในเซลล ์F3:F6 ไดแ้ลว้ จงึสง่คา่ตอ่ไปคํานวณในตารางคํานวณ
งบการเงนิในพืน้ทีต่ารางดา้นซา้ยสดุ D3:D6 เพือ่ใชคํ้านวณหา Margin  

เคล็ดลบัทีใ่ชร้ว่มกบัโครงสรา้งตารางคาํนวณ Single Module แบบแยกชที 

1. กรณีตอ้งการสรา้งชทีหลายชทีใหม้หีนา้ตาแบบเดยีวกนัโดยการสรา้งงานพรอ้มกนัเพยีงครัง้
เดยีว ใหเ้ริม่จากกดปุ่ ม Ctrl พรอ้มกบัคลกิที ่Sheet Tab เพือ่เลอืกชทีทีต่อ้งการ หรอืหาก
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ตอ้งการเลอืกทกุชทีทีต่ดิกนั ใหเ้ริม่จากอยูใ่นชทีแรกแลว้กดปุ่ ม Shift พรอ้มกบัคลกิเลอืก
ชทีสดุทา้ย ซึง่จะพบคําวา่ [Group] แสดงไวต้อ่ทา้ยชือ่แฟ้มทีป่รากฏอยูด่า้นบนสดุของ
หนา้จอ จากนัน้ทกุอยา่งทีค่ณุสรา้งลงไปในชทีจะถกูสรา้งพรอ้มกนัลงไปในชทีทกุชทีที่
เลอืกไวใ้น [Group] เดยีวกนั และเมือ่ตอ้งการเลกิงานใหค้ลกิเลอืกชทีอืน่ทีไ่มไ่ดเ้ลอืกไว ้
หรอืชทีอืน่ในกรณีทีเ่ดมิเลอืกไวท้กุชที ซึง่จะพบวา่คําวา่ [Group] หายไป 

2. กรณีตอ้งการสรา้งชทีหลายชทีใหม้หีนา้ตาแบบเดยีวกนัโดยไมต่อ้งใชว้ธิ ีCopy จากชที
ตน้แบบไปยังชทีอืน่ ใหเ้ลอืกชทีแบบ [Group] โดยกดปุ่ ม Ctrl หรอื Shift แลว้คลกิเลอืก
ชทีเชน่เดยีวกบัวธิใีนขอ้แรก จากนัน้ใหค้ลกิเลอืกพืน้ทีต่ารางทีต่อ้งการ แลว้สัง่ Home > 
Fill > Across Worksheets หรอืใน Excel 2003 ใหส้ัง่ Edit > Fill > Across Worksheets 

3. กรณีตอ้งการคํานวณหายอดรวมของทกุชที ใหเ้ริม่จากพมิพส์ตูร =sum( แลว้คลกิเซลลใ์น
ชทีแรกทีต่อ้งการ จากนัน้กดปุ่ ม Shift แลว้คลกิเลอืกชทีสดุทา้ยแลว้กดปุ่ ม Enter จะไดส้ตูร 
=SUM(Case1:Case3!F3) โดยสตูรนีจ้ะหายอดรวมของเซลล ์F3 จากทกุชทีตัง้แตช่ทีชือ่ 
Case1 ถงึ Case3 ใหท้นัท ีโดยไมต่อ้งเสยีเวลาสรา้งสตูรบวกตอ่กนัทลีะเซลลท์ลีะชที ตาม
สตูร =Case1!F3+Case2!F3+Case3!F3 อกีตอ่ไป  

4. กรณีตอ้งการคํานวณหายอดรวมของทกุชที ”เวน้” เฉพาะคา่จากชทีทีม่สีตูรยอดรวม ให ้
พมิพส์ตูร =sum('*'!f3) โดยขอสมมตวิา่ในแฟ้มม ี3 ชทีตดิกนัตามลําดบั คอืชือ่ Sheet1, 
Sheet2, และ Sheet3 ถา้สรา้งสตูรนีล้งไปใน Sheet1 จะไดส้ตูร 
=SUM(Sheet2:Sheet3!F3) แตถ่า้สรา้งสตูรลงไปใน Sheet2 จะไดส้ตูร 
=SUM(Sheet1!F3,Sheet3!F3) หรอืถา้สรา้งสตูรลงไปใน Sheet3 จะไดส้ตูร 
=SUM(Sheet1:Sheet2!F3) 

5. กรณีตอ้งการจัดการแสดงโครงสรา้งแตล่ะชทีใหด้ตูา่งกนัไปหลายๆแบบโดยอตัโนมตั ิใหจั้ด
โครงสรา้งตารางโดยอาจสัง่ Hide Row/Column ซอ่นสิง่ทีไ่มต่อ้งการแสดง เพือ่ทําใหเ้ห็น
เฉพาะพืน้ทีต่ารางเทา่ทีต่อ้งการกอ่น จากนัน้ใหส้ัง่ View > Custom Views > Adds แลว้
ตัง้ชือ่ View ใหก้บัโครงสรา้งตารางทีเ่ห็นอยูบ่นจอในขณะนัน้ จากนัน้ใหจั้ดหนา้ตาตาราง
ใหมใ่นชทีเดมิซํ้าหรอืในชทีอืน่ตามตอ้งการแลว้ตัง้ชือ่ Custom View เพิม่เตมิจนครบ แลว้
เมือ่ใดทีต่อ้งการไปทีช่ทีใดก็ไมจํ่าเป็นตอ้งใชว้ธิไีลค่ลกิไปทลีะชทีอกี แตใ่หส้ัง่ View > 
Custom View แลว้คลกิเลอืกชือ่ View แทน ซึง่วธินีีน้อกเหนอืจากชว่ยเลอืกตารางในชทีที่
ตอ้งการใหแ้ลว้ ในแตล่ะ View ยงับนัทกึ Print Settings และ Filter Settings ตามใหอ้กี
ดว้ย 

6. กรณีตอ้งการใชส้ตูรเพือ่คน้หาชือ่ชทีทกุชทีมาแสดงในเซลล ์ ใหใ้ชส้ตูร 
=GetSheetName(เลขทีช่ที) โดยสรา้งรหสั Function VBA ตอ่ไปนีไ้วใ้นแฟ้ม 
      Function GetSheetName(x) 
          GetSheetName = Sheets(x).Name 
      End Function 
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ข ัน้ตอนการปรบัโครงสรา้งตารางคาํนวณ Single Module จากแบบแยกชทีใหเ้ป็นแบบ

แยกแฟ้ม 

1. แกส้ตูร Indirect ในเซลล ์F3:F6 เป็นสตูร =Case1!F3, =Case1!F4, =Case1!F5, 
และ =Case1!F6 ตามลําดบัเพือ่ link ขอ้มลูมาจากชทีชือ่ Case1 ในตําแหน่งเซลล์
เดยีวกนั 

 
(Download ตวัอยา่งไดจ้าก 
www.ExcelExpertTraining.com/extreme/files/database/singlemodulelink.zip) 

2. Move ชทีชือ่ Case1, Case2, Case3 ไปเป็นแฟ้มใหม ่โดยใชว้ธิคีลกิขวาทีช่ ือ่ชที 
Case1 แลว้เลอืก Move or Copy จากนัน้คลกิเลอืก (new book) แลว้กด OK จะพบวา่
ชที Case1 ถกูยา้ยทัง้ชทีไปเป็นแฟ้มใหมท่ีม่ชีทีเพยีงชทีเดยีว แลว้ใหทํ้าซํ้ากบัชที 
Case2 และ Case3 ใหเ้ป็นแฟ้มใหมแ่ยกจากกนัโดยใชว้ธิเีดยีวกนันีอ้กี 

 
3. จัดเก็บแฟ้มทีเ่กดิขึน้ใหมจ่ากการยา้ยชที Case1, Case2, และ Case3 โดยตัง้ชือ่แฟ้ม

เป็น SingleModuleLinkFilesCase1.xls, SingleModuleLinkFilesCase2.xls, และ 
SingleModuleLinkFilesCase3.xls ตามลําดบั แลว้เมือ่กลบัไปคลกิดสูตูรในเซลล ์
F3:F6 ในชที SheetModule จะพบวา่สตูรเดมิทีเ่คยเป็นสตูร link ขา้มชทีถกูแกไ้ขเอง
เป็นสตูร link ขา้มแฟ้ม =[SingleModuleLinkFilesCase1.xls]Case1!F3, =
[SingleModuleLinkFilesCase1.xls]Case1!F4, =
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[SingleModuleLinkFilesCase1.xls]Case1!F5, และ =
[SingleModuleLinkFilesCase1.xls]Case1!F6 ตามลําดบัใหเ้อง 

 
4. เมือ่ตอ้งการดงึขอ้มลูจาก Case2 หรอื Case อืน่ ใหเ้ปิดแฟ้มปลายทางทีม่สีตูร link ขา้ม

แฟ้มแสดงอยูข่ ึน้มาใชง้านเพยีงแฟ้มเดยีว (โดยไมต่อ้งเปิดแฟ้มตน้ทาง) จากนัน้สัง่ 
Office > Prepare > Edit Links to Files หรอืใน Excel 2003 สัง่ Edit > Links 

 
5. ใหค้ลกิเลอืกชือ่แฟ้มตน้ทางเดมิ แลว้กดปุ่ ม Change Source จากนัน้ไลค่ลกิหาแฟ้มตน้

ทางใหมท่ีต่อ้งการ ซึง่เมือ่เลอืกแฟ้มตน้ทางใหมไ่ดเ้รยีบรอ้ยและกดปุ่ ม OK > Close 
กลบัมาแฟ้มปลายทาง จะพบวา่สตูรเกา่ถกูแกไ้ขใหด้งึขอ้มลูมาจากแฟ้มตน้ทางใหมใ่ห ้
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เองทนัท ี

 

ขอ้ควรระวงัในการใชข้อ้มลูที ่link ขา้มแฟ้ม 

1. โครงสรา้งภายในของแฟ้มตน้ทางตอ้งเหมอืนกนัทกุแฟ้ม โดยตําแหน่งเซลลใ์ดเป็น
ขอ้มลูอะไรกต็อ้งกําหนดใหท้กุแฟ้มใชตํ้าแหน่งเซลลเ์ดยีวกนัทัง้หมด 

2. หากแฟ้มตน้ทางมชีทีเดยีวแตใ่ชช้ือ่ชทีตา่งกนัเชน่ในตวัอยา่งนีใ้ชช้ือ่ชทีวา่ Case1, 
Case2, และ Case3 เมือ่สัง่ Change Source จะพบวา่ Excel สามารถปรับสตูร link 
ขา้มแฟ้มใหถ้กูตอ้ง แตถ่า้แฟ้มตน้ทางมหีลายชที ตอ้งตัง้ชือ่ชทีใหต้รงกนัทกุแฟ้มดว้ย 
มฉิะนัน้ Excel จะมขีัน้ตอนเปิดจอขึน้มาถามวา่ใหจั้บชือ่ชทีใดแทนดว้ยชือ่ชทีใด 

3. ถา้ตอ้งการแกไ้ขโครงสรา้งตารางโดยเฉพาะตําแหน่งเซลลใ์นแฟ้มตน้ทาง กอ่นจะแกไ้ข
ใดๆใหเ้ปิดทกุแฟ้มที ่link กนั ทัง้แฟ้มตน้ทาง แฟ้มปลายทาง รวมทัง้แฟ้มตน้ทางใหมท่ี่
ยงัไมไ่ด ้link ขึน้มาบนจอใหค้รบทัง้หมดกอ่น จากนัน้จงึคอ่ยทําการแกไ้ข เพือ่ทําให ้
Excel ไลแ่กตํ้าแหน่งอา้งองิในสตูรทีอ่า้งถงึแฟ้มทีเ่กีย่วขอ้งใหเ้อง (ถา้ไมไ่ดเ้ปิดแฟ้ม 
Excel จะละเลยไมส่นใจตามไปแกไ้ขใหแ้มแ้ตน่อ้ย) 

4. ถา้ตอ้งการ Save เพือ่ตัง้ชือ่แฟ้มใหมห่รอืยา้ย Folder ทีเ่ก็บแฟ้ม ใหส้ัง่ Save แฟ้มตน้
ทางกอ่นแลว้จงึ Save แฟ้มปลายทางทหีลงั (แตถ่า้ไมไ่ดแ้กไ้ขชือ่แฟ้มหรอืยา้ย Folder 
จะ Save แฟ้มใดกอ่นก็ได ้แตต่อ้ง Save ใหค้รบทกุแฟ้ม) 
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การออกแบบโครงสรา้งตารางคาํนวณ  

แบบ Compound Module 

เคยมคํีากลา่ววา่ Excel ไมส่ามารถนํามาใชก้บัการวางแผนความตอ้งการวสัดไุดห้รอก เราตอ้ง

หนัไปซือ้โปรแกรมสําเร็จรปูราคาแพงเป็นแสนเป็นลา้นบาทมาใชใ้นการวางแผนการผลติ ซึง่

โรงงานผลติสนิคา้หลายๆแหง่อาจคดิวา่ไมแ่พง เพราะเมือ่นําราคาโปรแกรมสําเร็จรปูไปเทยีบ

กบัมลูคา่ของโรงงานและสนิคา้ทีผ่ลติแลว้ถอืวา่เป็นสดัสว่นทีน่อ้ยมาก แลว้เมือ่นําโปรแกรม

สําเร็จรปูเหลา่นีม้าใช ้กลับพบวา่ไมส่ามารถนํามาใชก้บัการวางแผนการผลติไดอ้ยา่งสมบรูณ์

เสยีอกี ครัน้จะขอใหผู้ข้ายโปรแกรมสําเร็จรปูชว่ยแกไ้ขดดัแปลงโปรแกรมใหใ้หมก่็ถกูคดิ

คา่ใชจ้า่ยเป็นเงนิอกีมากมาย ทีแ่ยท่ีส่ดุก็คอื พอซือ้โปรแกรมมาใชไ้ดส้กัพัก เจา้ตวับรษัิททีข่าย

โปรแกรมใหก้ลบัปิดตวัเลกิกจิการไปแลว้ เป็นเหตใุหโ้ปรแกรมสําเร็จรปูทีไ่ดม้าถกูนํามาใชง้าน

แคค่รึง่ๆกลางๆหรอืถงึกบัเลกิใชไ้ปเลยก็ม ี

คนทีเ่กง่คอมพวิเตอรไ์มว่า่จะเป็นโปรแกรมเมอรห์รอืผูท้ีค่ลกุคลอียูใ่นแวดวง IT มกัเขา้ใจวา่

ปัญหาการคํานวณยากๆ ตอ้งหาทางเขยีนโปรแกรมหรอืหาซือ้โปรแกรมสําเร็จรปูทีถ่กูสรา้ง

ขึน้มาเพือ่ใชแ้กปั้ญหายากๆเหลา่นัน้โดยเฉพาะ แมแ้ตค่นทีเ่กง่ Excel ก็ตาม มกัชอบคดิวา่ตอ้ง

ใชโ้ปรแกรม VBA (Visual Basic for Applications) เป็นทางออกสดุทา้ยเมือ่ไมส่ามารถใชส้ตูร

หรอืคําสัง่บนเมนูของ Excel ชว่ยในการแกปั้ญหาทีว่า่ยากนัน้ได ้ซึง่ถา้วา่ไปแลว้ก็ไมใ่ชก่ารคดิ

ทีไ่มม่เีหตผุล เพราะปัญหาการคํานวณยากๆ ยกตวัอยา่งเชน่การวางแผนการผลติ มสีิง่ทีต่อ้ง

คํานงึถงึหลายอยา่งทีเ่กีย่วขอ้งกบัการวางแผน เชน่ เงือ่นไขทีเ่กีย่วขอ้งกบัยอดสนิคา้คงเหลอื

ตน้งวดปลายงวด ยอดวตัถดุบิทีต่อ้งสัง่ซือ้ซึง่ยงัสมัพันธก์บัโครงสรา้งผลติภณัฑห์รอือตัรา

สว่นผสม หากวตัถดุบิขาดมอืก็ตอ้งสัง่ซือ้มาสํารองไวใ้หเ้พยีงพอซึง่เกีย่วขอ้งกบัเงือ่นไขการ

ขายของผูข้ายเขา้ไปอกี และทัง้หมดนีย้งัตอ้งหาทางกําหนดเวลาทีจ่ะตอ้งสัง่ผลติเพือ่ใหไ้ด ้

จํานวนสนิคา้ตามตอ้งการ ณ กําหนดเวลาทีต่อ้งการ .... แคเ่ห็นปัญหาทีเ่กีย่วขอ้งเหลา่นีก้็แทบ

ไมอ่ยากจะคดิดว้ยสมองแลว้ใชไ่หม หลายตอ่หลายคนจงึพากนัตอบวา่ หนัไปซือ้โปรแกรม

สําเร็จรปูมาใชก้นัดกีวา่ 

จากประสบการณ์ทีผ่มคลกุคลอียูก่บั Excel มานานกวา่ยีส่บิปีพบวา่ คนทีเ่กง่ Excel มากๆมกั

ขาดความรูเ้รือ่งการวางแผนการผลติ สว่นคนทีเ่กง่ในการวางแผนการผลติก็มกัจะไมเ่กง่ Excel 

จงึทําใหไ้มม่ใีครทีส่ามารถนําความรูท้ัง้ Excel และการวางแผนการผลติมาใชง้านรว่มกนัเสยีท ี

ทางสมาคมสง่เสรมิเทคโนโลย ี(ไทย-ญีปุ่่ น) ไดก้รณุาใหผ้มเขา้อบรมหลกัสตูรการวางแผนการ
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ผลติทีส่มาคมจัดขึน้ ทําใหเ้กดิแนวทางใช ้Excel โดยออกแบบตารางคํานวณแบบ Compound 

Module นีข้ ึน้มา จงึใครข่อใชโ้อกาสนี ้ขอบคณุสมาคมสง่เสรมิเทคโนโลย ี(ไทย-ญีปุ่่ น) เป็น

อยา่งยิง่ ซึง่คงไมเ่ป็นการกลา่วทีเ่กนิไปวา่ ในโลกนีม้แีตป่ระเทศไทยของเราเทา่นัน้ทีม่ี

เทคโนโลยกีารออกแบบตารางคํานวณแบบ Compound Module หรอืหากประเทศอืน่ทําไดก้็

น่าจะเรยีนรูม้าจากเราอกีตอ่หนึง่ 

ลกัษณะโครงสรา้งตารางคาํนวณแบบ Compound Module 

โครงสรา้งตารางคํานวณแบบ Compound Module เกดิจากแนวความคดิทีจ่ะใชต้าราง Excel 

หลายๆเซลลต์อ่กนัสําหรับการคํานวณทีต่อ่เนือ่งกนัหลายๆขัน้ พอเซลลห์นึง่คํานวณขัน้หนึง่

เสร็จ ก็ใหส้ง่คา่ไปคํานวณตอ่ในอกีเซลลห์นึง่ แลว้สง่คา่ตอ่ๆกนัไปยงัเซลลท์ีอ่ยูใ่นพืน้ทีต่าราง

คํานวณชดุเดยีวกนั ซึง่ในตารางคํานวณชดุเดยีวกนันีอ้าจตอ้งใชจํ้านวนเซลลต์ัง้แต ่2 เซลลข์ึน้

ไปจนถงึนับรอ้ยนับพันเซลลก์็เป็นไดเ้พือ่ใหไ้ลคํ่านวณตัง้แตต่น้จนจบ 

แนวความคดิดงักลา่วนีฟั้งดแูลว้ก็ไมเ่ห็นเป็นเรือ่งแปลกใชไ่หม คณุเองก็ใชต้าราง Excel ใน

แบบทีก่ลา่วนีเ้ป็นกนัอยูแ่ลว้ เพยีงแตว่า่แทนทีจ่ะใชต้ารางคํานวณเพยีงชดุเดยีวเพือ่คํานวณให ้

ผลลพัธท์ีต่อ้งการแลว้เสร็จ เรายงัตอ้งหาทางใชต้ารางคํานวณชดุถดัไป ทีม่หีนา้ตาตาราง

เหมอืนกบัตารางคํานวณชดุแรก เพือ่ใชใ้นการคํานวณซํ้าแบบเดยีวกบัการคํานวณในตาราง

คํานวณชดุแรกซํ้าตอ่ไปอกีใหไ้ด ้โดยหาทางสรา้งสตูรในตารางคํานวณชดุถดัไปใหส้ามารถรับ

คา่จากตารางคํานวณชดุกอ่น (Simple Compound Module) หรอืเลอืกรับคา่ตารางคํานวณชดุ

ใดๆก็ไดม้าใชคํ้านวณซํ้าอกี (Dynamic Compound Module) 

องคป์ระกอบสําคญัทีเ่ป็นสว่นชว่ยใหเ้ราสามารถสรา้งตารางคํานวณขึน้เพยีงชดุเดยีว จากนัน้

สามารถสัง่ Copy แลว้นําไป Paste ใหเ้กดิตารางคํานวณชดุตอ่ไปซึง่มสีตูรซํ้ากบัตารางคํานวณ

ชดุแรกทกุเซลลก์็คอื ขอใหห้ลกีเลีย่งการกําหนดตําแหน่งอา้งองิใดๆในสตูรแบบ Absolute 

(เชน่ $A$1) แตใ่หใ้ชก้ารกําหนดตําแหน่งอา้งองิแบบ Relative (เชน่ A1) แทน หรอืถา้

หลกีเลีย่งไมไ่ด ้ก็ขอใหใ้ชตํ้าแหน่งอา้งองิแบบ Mixed ในแบบควบคมุตําแหน่ง Column ให ้

คงที ่(เชน่ $A1) โดยใหใ้ชใ้หน้อ้ยทีส่ดุ เพราะถา้กําหนดตําแหน่งอา้งองิ $A1 ไว ้จะตอ้ง Paste 

ตารางคํานวณชดุถดัไปในแนว Column เดมิเสมอ มฉิะนัน้การอา้งองิจะผดิเพีย้นจากตําแหน่งที่

ตอ้งการ 

ผูท้ีคุ่น้เคยกบัการสรา้งตารางคํานวณตอ้งทราบถงึประโยชนข์องการใสเ่ครือ่งหมาย $ เพือ่ชว่ย

ควบคมุตําแหน่งอา้งองิในสตูรวา่มคีวามสําคญัเพยีงใด แมเ้ครือ่งหมาย $ จะชว่ยใหเ้ราสรา้งสตูร
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แลว้ Copy ไปใชท้ีเ่ซลลอ์ืน่ไดท้นัท ีแตใ่นโครงสรา้งตารางคํานวณแบบ Compound Module นี ้

เครือ่งหมาย $ กลบัเป็นสิง่ตอ้งหา้ม ดงันัน้แมใ้นระหวา่งการสรา้ง Module แรกขึน้มาใชง้าน ซึง่

เราจําเป็นตอ้งอาศยัเครือ่งหมาย $ แตเ่มือ่สรา้งงานเสร็จแลว้ก็ตอ้งลบเฉพาะเครือ่งหมาย $ ที่

ใชใ้นเซลลท์ิง้ไป โดยใน Excel 2007 ใชคํ้าสัง่ Home > Find & Select > Replace หรอืใน 

Excel 2003 ใชคํ้าสัง่ Edit > Replace เพือ่สัง่เปลีย่นเครือ่งหมาย $ ใหห้ายไป  

ตวัอยา่งตารางคาํนวณ Compound Module อยา่งงา่ย 

Download ตวัอยา่งไดจ้าก 

www.ExcelExpertTraining.com/extreme/files/database/CompoundModule.xls 

 

ตวัอยา่งนีอ้ยูใ่นชทีชือ่ SimpleCompound เป็นตารางคํานวณหาระยะเวลาทีใ่ชใ้นการผลติ 

กําหนดใหผ้ลติสนิคา้ A, B, C, D (ProductName เซลล ์B4:B7) โดยสนิคา้แตล่ะชนดิตอ้งใช ้

เวลาในการผลติตา่งกนัไป เชน่ ในการผลติสนิคา้ A เมือ่ผา่นขัน้ตอนการผลติ 4 ขัน้ตอน (เซลล ์ 

C4:F4) ตอ้งใชเ้วลา 20 นาทใีนการผลติขัน้ตอนที ่1 จากนัน้ตอ้งใชเ้วลา 10 นาท ีตามดว้ย 30 

นาท ีและตามดว้ย 20 นาท ีในขัน้ตอนที ่2, 3, 4 ตามลําดบัจงึจะแลว้เสร็จ 

ในกระบวนการผลติสนิคา้ A, B, C, และ D นี ้หากกําหนดใหเ้ริม่ตน้ผลติในเวลา 8 นาฬกิา จะ

ผลติเสร็จในเวลาใด ทัง้นีกํ้าหนดใหเ้ลอืกผลติสนิคา้ A, D, C, B กอ่นหลังตามลําดบั (หรอืใน

อนาคตอาจจัดลําดบัการผลติกอ่นหลงัตา่งไปก็ได)้ โดยหาทางใหใ้ชร้ะยะเวลาผลติทีน่อ้ยทีส่ดุ 

เมือ่ผลติสนิคา้ใดเสร็จใหผ้ลติสนิคา้ชนดิตอ่ไปไดท้นัท ี

ตารางดา้นขวาทีเ่ซลล ์L4:L6 ของรปูขา้งตน้เป็นคําตอบทีไ่ดจ้ากการคํานวณ กลา่วคอื เมือ่เริม่

ผลติในเวลา 8 นาฬกิา จะผลติสนิคา้ทัง้หมดเสร็จในเวลา 11 นาฬกิา ถอืเป็นระยะเวลาผลติ

ทัง้สิน้ 3 ชัว่โมง 

ปัญหาทีต่อ้งคํานงึถงึในการกําหนดขัน้ตอนการผลติในตวัอยา่งนีก้็คอื เราตอ้งหาทางสรา้ง

ตารางคํานวณทีส่ามารถจัดลําดบัการผลติกอ่นหลังแบบใดก็ได ้อกีทัง้ตอ้งหาทางสรา้งสตูรให ้
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กําหนดเวลาเริม่ผลติในแตล่ะขัน้ตอนของสนิคา้แตล่ะตวั ตอ่เนือ่งกบัเวลาผลติเสร็จในขัน้ตอน

กอ่นหนา้ หรอือกีนัยหนึง่หา้มสัง่ผลติสนิคา้ชนดิถัดไป หากสนิคา้ชนดิแรกยงัอยูใ่นกระบวนการ

ผลติขัน้ตอนนัน้ๆ ดงัรปูตอ่ไปนี ้

 

ขอใหพ้จิารณาภาพ Gantt Chart ในลําดบัการผลติของ Process 2 จะพบวา่เมือ่สนิคา้ A ผลติ

เสร็จในเวลา 8:30 นาฬกิา แตย่งัไมส่ามารถนําสนิคา้ D มาผลติตอ่ใน Process 2 ไดท้นัท ี

เพราะในขณะนัน้สนิคา้ D ยงัอยูใ่นกระบวนการผลติของ Process 1 อยู ่ตอ้งรอจนถงึเวลา 8:40 

นาฬกิา จงึเริม่ผลติสนิคา้ D ใน Process 2 ตอ่ไปได ้แลว้ตอ่เมือ่สนิคา้ D ผลติเสร็จใน Process 

2 ก็สามารถนําสนิคา้ C และ B มาผลติตอ่ใน Process 2 ไดต้อ่เนือ่งทันท ี

 

Compound Module ในตวัอยา่งนีค้อืพืน้ทีต่ารางตัง้แตเ่ซลล ์B12:Z15 โดยกําหนดใหใ้ชเ้ซลล ์

B12 ตรงหวัมมุซา้ยบนสดุสําหรับบนัทกึชือ่สนิคา้ทีต่อ้งการลงไป จากนัน้เซลล ์C13:F13 จะดงึ

ระยะเวลาทีใ่ชใ้นการผลติ (Time Consumed) จากตาราง Time Consumed Table ดา้นบน

ของชทีลงมาใชง้าน โดยใชส้ตูร =VLOOKUP($B12,TimeConsumedTbl,C12+1,0) จากนัน้

เมือ่นําเวลาเริม่ผลติ 8:00 ในเซลล ์C10 มาบวกเพิม่ดว้ยระยะเวลาทีใ่ชใ้นการผลติ ทําให ้

คํานวณหา Start Time และ Stop Time ในพืน้ทีเ่ซลล ์C14:F15 
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เซลลสํ์าคญัทีส่ดุทีทํ่าให ้Compound Module สามารถนําไปใชง้านตอ่ไปไดใ้นตารางชดุอืน่คอื 

เซลล ์D14 มสีตูร =MAX(D10,C15) โดยขอใหส้งัเกตวา่ตําแหน่งเซลล ์D10 ทีกํ่าหนดไวใ้น

สตูร MAX นีเ้ป็นตําแหน่งเซลลท์ีอ่ยูเ่หนอืขอบเขตของตาราง Module (B12:Z15) เพือ่ใหใ้ช ้

ตําแหน่งเซลล ์D10 ซึง่ไมไ่ดกํ้าหนดเครือ่งหมาย $ ไวห้รอือกีนัยหนึง่คอืเซลลท์ีอ่ยูเ่หนอืพืน้ที่

ตาราง Module ขึน้ไปอกี 2 เซลล ์สําหรับนําเวลา Stop Time ของ Module กอ่นหนา้มาเทยีบ

กบัเวลา Stop Time ของ Module ตวัเอง (D10 vs C15) วา่ใหเ้ลอืกนําเวลาทีม่ากทีส่ดุมาใช ้

เป็นกําหนดการเริม่กระบวนการผลติในขัน้ตอนตอ่ไป 

หลงัจากสรา้ง Module แรกในเซลล ์B12:Z15 เสร็จแลว้ เมือ่ตอ้งการคํานวณหากําหนดการ

ผลติของสนิคา้ในลําดบัถัดไป ก็เพยีงแค ่Copy เซลล ์B12:Z15 ไป Paste ตอ่กนัลงไปแลว้

เปลีย่นชือ่สนิคา้ทีเ่ซลลห์วัมมุซา้ยของแตล่ะ Module ตามชือ่สนิคา้ทีผ่ลติในแตล่ะลําดับ ก็จะ

พบวา่ Module ทกุชดุคํานวณรว่มกนัไดร้ะยะเวลาและกําหนดการผลติแตล่ะขัน้ตอนตาม

ตอ้งการในทันท ี

 

โปรดสงัเกตวา่ แตล่ะ Module ถกูวางหา่งกนัโดยเวน้ระยะ 1 row ระหวา่งกนัเสมอ ทัง้นีเ้พือ่ทํา

ใหส้ตูร =MAX(D10,C15) จาก Module แรกเป็นสตูรดงึคา่จาก Stop Time ซึง่เป็น row 

ลา่งสดุของ Module ดา้นบนมาใชต้อ่ไปน่ันเอง 
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ตวัอยา่งตารางคาํนวณ Compound Module  

แบบ Dynamic 

ตวัอยา่งทีผ่า่นมาเป็นการกําหนดตําแหน่งอา้งองิทีเ่ชือ่มคา่จาก Module ทีว่างไวด้า้นบนตดิกนั 

เหมาะกบัการคํานวณทีม่ขีัน้ตอนตอ่เนือ่งกนัไปแบบเสน้ตรง แตห่ากการวางแผนการผลติตอ้ง

เกีย่วขอ้งกบัโครงสรา้งผลติภณัฑ ์(Bill of Materials : BOM) ในโครงสรา้งทีซ่บัซอ้นตามภาพ

ตอ่ไปนี ้ก็ตอ้งหาทางพัฒนาโครงสรา้งตารางคํานวณแบบ Dynamic 

 

จากภาพแสดงถงึการผลติสนิคา้ A ซึง่หากผลติเพยีง 1 หน่วย ( Unit = 1 ) ตอ้งอาศยัวสัด ุB 

จํานวน 2 หน่วยและ C จํานวน 3 หน่วย โดยในการผลติวสัด ุB ตอ้งใชว้สัด ุD จํานวน 2 หน่วย

และวสัด ุE จํานวน 2 หน่วย สว่นวสัด ุC ตอ้งใชว้สัด ุE จํานวน 2 หน่วยและวสัด ุF จํานวน 2 

หน่วย ซึง่ในการผลติวสัด ุF เองก็ตอ้งอาศยัวสัด ุG จํานวน 1 หน่วยและวสัด ุD จํานวน 2 หน่วย  

สว่นคําวา่ LT ยอ่มาจากคําวา่ Lead Time หมายถงึชว่งเวลานํา ซึง่เป็นระยะเวลาทีใ่ชใ้นการ

ผลติหรอืระยะเวลาทีต่อ้งรอคอยในการไดม้าของสนิคา้ จากภาพแสดงวา่สนิคา้ A ตอ้งใช ้

ระยะเวลาผลติ 1 วนั (หรอืหน่วยของระยะเวลาอืน่ๆก็ได ้ในตวัอยา่งนีข้อใชร้ะยะเวลาเป็นหน่วย

วนั) วสัด ุB, C, D, E, F, G ตอ้งใชร้ะยะเวลาผลติหรอืระยะเวลารอคอยเทา่กบั 2 วนั, 1 วนั, 1 

วนั, 2 วนัและ 3 วนั ตามลําดบั (โปรดศกึษารายละเอยีดเพิม่เตมิจากหนังสอื ระบบการวางแผน

และควบคมุการผลติ โดยรศ.พภิพ ลลติาภรณ์ สํานักพมิพข์องสมาคมสง่เสรมิเทคโนโลย ี(ไทย-

ญีปุ่่ น)) 

ในการออกแบบตารางคํานวณเพือ่วางแผนความตอ้งการวสัด ุ(Material Requirements 

Planning - MRP) ตอ้งหาทางสรา้งตารางคํานวณทีส่ามารถคํานวณตามโครงสรา้งผลติภณัฑท์ี่

อาจเปลีย่นแปลงไปจากเดมิ เชน่ เดมิสนิคา้ A มวีสัด ุB และ C เป็นโครงสรา้งในการผลติ หาก

ในภายหลงัมวีสัด ุG เพิม่เตมิ หรอืเลกิใชว้สัด ุB หรอืใชว้สัดอุืน่มาแทนที ่และหากตวัเลขจํานวน
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การใชว้สัดแุละ LT เปลีย่นแปลงไปจากเดมิ ก็ตอ้งหาทางประยกุตใ์ช ้Excel กบังาน MRP ได ้

โดยไมจํ่าเป็นตอ้งแกไ้ขสตูรคํานวณใหมแ่มแ้ตน่อ้ย 

อนึง่ในแงข่องโครงสรา้งผลติภณัฑย์งัมศีพัทคํ์าวา่ Parent กบั Child ทีต่อ้งทําความเขา้ใจ

เพราะเป็นหลกัการสําคญัทีนํ่าไปใชใ้นการสรา้งตารางคํานวณ เชน่ หากกําหนดใหส้นิคา้ A เป็น 

Parent ก็จะพบวา่มวีสัด ุB และ C เป็น Child แลว้หากกําหนดใหว้สัด ุB เป็น Parent ก็จะพบวา่

มวีสัด ุD และ E เป็น Child ซึง่จะเห็นวา่การพจิารณาความสมัพันธร์ะหวา่งการเป็น Parent-

Child เป็นการพจิารณาความสมัพันธร์ะหวา่งการผลติสนิคา้หรอืวสัดใุนลําดับหนึง่น่ันเอง 

ตวัอยา่งตอ่ไปนีม้าจากชทีชือ่ DynamicCompound ในแฟ้มชือ่ CompoundModule.xls 

 

โครงสรา้งตารางคํานวณแบบ Compound Module คอื พืน้ทีต่ารางตัง้แตเ่ซลล ์B6:P7 มเีซลล์

ทีใ่ชรั้บคา่ตวัแปรใน Column B, C, E, และ F โดยใชเ้ซลล ์B6 สําหรับบนัทกึชือ่ Item ในระดบั 

Child และใชเ้ซลล ์C6 บนัทกึชือ่ Parent โดยใชเ้ซลล ์E6 และ F6 บนัทกึตวัเลขสดัสว่นการ

ผลติและ Lead Time ตามลําดบั 

วธิกีารนํา Module ไปใชง้าน ใหเ้ริม่จาก Copy Module จากเซลล ์B6:P7 ไป Paste ตอ่ๆกนัไป

ใหค้รบตามจํานวนความสมัพันธร์ะหวา่ง Child->Parent ทีม่อียู ่(B->A, C->A, D->B, E->B, 

E->C, F->C, G->F, D->F) จากนัน้ใหบ้นัทกึคา่ใหมล่งไปในเซลลรั์บตวัแปรใน Column B, C, 

E, และ F ของแตล่ะ Module ใหค้รบถว้นถกูตอ้งตามทีกํ่าหนดไวใ้นโครงสรา้งผลติภัณฑ ์จะ

พบวา่พืน้ทีต่ารางใน Column H:P จะคํานวณจํานวนวสัดทุีต่อ้งการและกําหนดเวลาทีต่อ้งเริม่

สัง่ผลติเพือ่ใหไ้ดส้นิคา้หรอืวสัดเุสร็จตามกําหนดใหท้นัท ี
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หลกัการคํานวณทีใ่ช ้เกดิจากการหาตําแหน่งเลขที ่row สดุทา้ยของแตล่ะ Module (Last Row 

of Module) ใน Column D ใหไ้ดก้อ่น จากนัน้จงึใชเ้ลขเลขที ่row สดุทา้ยของแตล่ะ Module 

สําหรับดงึตวัเลขการสัง่ผลติจาก Module ของ Parent ไปใชใ้นการสัง่ผลติของ Module ทีเ่ป็น 

Child 

เพือ่ทําใหเ้ห็นลําดบัการคํานวณไดช้ดัเจนยิง่ขึน้ ขอใหด้ ูRow 14 ซึง่เป็นการสัง่ผลติวสัด ุE 

ใหก้บัวสัด ุC พอคณุบนัทกึชือ่วสัด ุC ลงไปในเซลล ์C14 จะพบวา่ในเซลล ์D14 คํานวณหาเลข 

9 มาให ้ซึง่เกดิจากสตูร =MATCH(C14,B$1:B$1001,0)+1 โดยสตูร Match จะนําชือ่ Parent 

C ไปเทยีบหาตําแหน่งจากพืน้ที ่B1:B1001 พบวา่ชือ่ C อยูใ่นลําดบัที ่8 จากนัน้นําไปบวก 1 

ใหก้ลายเป็นเลขที ่Row 9 ซึง่เป็นตําแหน่งเลขที ่row สดุทา้ยของ Module (Last Row of 

Module) ทีม่ ีChild ชือ่ C 

พอไดเ้ลข 9 ในเซลล ์D14 แลว้ จากนัน้จงึใชส้ตูรดงึตวัเลข 150 จากเซลล ์N9 สง่ตอ่มาใชท้ี่

เซลล ์N14 โดยใชส้ตูร =INDIRECT(ADDRESS($D14,COLUMN()))*$E14 โดยในการผลติ

วสัด ุC จํานวน 1 หน่วย ตอ้งอาศยัวสัด ุE จํานวน 2 หน่วย (เซลล ์E14 = 2) จงึตอ้งสัง่ผลติ E 

จํานวน 300 หน่วย (=150x2) สว่นวสัด ุE นัน้กวา่จะผลติเสร็จก็ตอ้งใชร้ะยะเวลา (LT) 2 วนั ทํา

ใหต้อ้งสัง่ผลติหรอืจัดหาวสัด ุE ลว่งหนา้ตัง้แตว่ันที ่5 จงึจะพรอ้มตอ่การนําไปใชผ้ลติตอ่ใน

วนัที ่7 

สว่นของสตูร =INDIRECT(ADDRESS($D14,COLUMN())) ในเซลล ์N14 ชว่ยดงึคา่มาจาก

เซลลท์ีท่ราบตําแหน่ง Row และ Column  โดยที ่D14 เป็นเลขที ่Row สว่นสตูร Column() จะ

หาเลขที ่Column N ณ ตําแหน่งของเซลลส์ตูร จงึทําใหเ้กดิสตูร Address(9,14) คนืคา่ออกมา

เป็นตําแหน่งเซลล ์$N$9 จากนัน้สตูร Indirect(“$N$9”) จงึดงึคา่จากเซลล ์N9 มาใหใ้นทีส่ดุ 

ตวัอยา่งจากชทีชือ่ DynamicCompound นีเ้ป็นการคํานวณอยา่งงา่ยเพือ่แสดงหวัใจของการ

เชือ่มโยงตวัเลขการสัง่ผลติ ณ กําหนดเวลาทีต่อ้งการของแตล่ะ Module เขา้ดว้ยกนั แตใ่นการ

ผลติจรงิยงัตอ้งคํานงึถงึตัวเลขสนิคา้ตน้งวดปลายงวดและตวัเลขอกีมากมายทีเ่ป็นเงือ่นไข

เกีย่วขอ้งกบัการผลติแตล่ะครัง้ จงึขอใหใ้ช ้Module ทีส่รา้งไวใ้นชทีชือ่ MRPModule แทน 
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วธินํีา Module ไปใชก้็ใชว้ธิ ีCopy ไป Paste ซํ้าตามโครงสรา้งผลติภณัฑเ์ชน่เดยีวกนั โดย

โครงสรา้งตารางคํานวณทีส่รา้งขึน้แบบสมบรูณ์นี ้Child แตล่ะตวั สามารถสัง่ผลติเป็นวัสดใุห ้

Parent ได ้3 ตวั (เซลล ์D20:D22) ทําใหไ้มจํ่าเป็นตอ้งเตรยีม Module ของ Child ซํ้ากนัเชน่

ตวัอยา่งทีผ่า่นมา 

จากนัน้เมือ่นําตวัอยา่งการทํา MRP จากหนังสอื ระบบการวางแผนและควบคมุการผลติ โดยรศ.

พภิพ ลลติาภรณ์ สํานักพมิพข์องสมาคมสง่เสรมิเทคโนโลย ี(ไทย-ญีปุ่่ น) หนา้ 136 มาวางแผน

ความตอ้งการวสัด ุจะเกดิเป็น Compound Module ทีคํ่านวณรว่มกนัตามตวัอยา่งทีเ่ปิดให ้

Download ไดจ้าก www.ExcelExpertTraining.com/extreme/files/database/ 

CompoundModuleMRP(Ans).xls ซึง่เป็นตวัอยา่งทีใ่ชป้ระกอบการอบรมหลกัสตูรการ

ประยกุตใ์ช ้Excel สําหรับวางแผนความตอ้งการวสัดแุละจัดตารางการผลติ ทีจั่ดอบรมขึน้ ณ 

สมาคมสง่เสรมิเทคโนโลย ี(ไทย-ญีปุ่่ น) 
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ตวัอยา่งในแฟ้ม CompoundModuleMRP(Ans).xls นอกเหนอืจากแสดงการใช ้Compound 

Module แบบซบัซอ้นโดยนําโครงสรา้งผลติภณัฑ ์2 โครงสรา้งมาใชร้ว่มกนัแลว้ ยงัแสดงวธิกีาร

สรา้งตารางฐานขอ้มลูเพือ่เก็บคา่ตวัแปร แลว้ใชส้ตูรดงึคา่จากตารางตวัแปรไปยงัเซลลรั์บคา่ใน 

Module ใหเ้องอกีดว้ยเพือ่ชว่ยอํานวยความสะดวกในการกรอกขอ้มลูและลดโอกาสผดิพลาด

จากการกรอกขอ้มลูผดิชอ่ง จากนัน้เมือ่ไดผ้ลลพัธท์ีคํ่านวณใน Compound Module เสร็จ

เรยีบรอ้ยก็ยงัแสดงวธิใีชส้ตูรดงึผลลัพธไ์ปสรปุเพือ่เปรยีบเทยีบกบัจํานวนการผลติทีเ่กดิขึน้จรงิ

ทีอ่าจแตกตา่งจากแผนการผลติทีว่างไว ้

บทสง่ทา้ย 

การออกแบบตารางคํานวณทีนํ่ามาอธบิายนี ้น่าจะเป็นการจดุประกายความคดิใหผู้ใ้ช ้Excel 

สามารถสรา้งสรรคง์านไดห้ลายหลายรปูแบบมากขึน้ ผมเชือ่วา่หลกัการหรอืแนวความคดิทีไ่ด ้

ใหไ้ปแลว้นีย้อ่มเป็นสิง่ทีสํ่าคญัมากกวา่ตวัอยา่งทีม่ปีระโยชนจํ์ากดัแคใ่ชก้บัการแกไ้ขปัญหา

หนึง่เสร็จแลว้ก็แลว้กนัไป ขอเพยีงสามารถนําหลกัการหรอืแนวความคดิไปพัฒนาตอ่ ยอ่มเป็น

แนวทางใหส้ามารถใช ้Excel แบบคอมพวิเตอร ์สามารถนํา Excel ไปประยกุตใ์ชก้บังานทีห่ลาย

คนคดิวา่ทําไมไ่ดม้ากอ่น หาทางสรา้งตารางคํานวณทีส่ะดวกตอ่การนํามาใชง้านซํ้าแลว้ซํ้าอกี 

งา่ยตอ่การแกไ้ข และทีสํ่าคญัคอืเป็นหลกัการทีง่า่ยตอ่ความเขา้ใจ 
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